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Working with Business Processes

The following explains how to work with Unifier business processes.

Within our documentation, some content might be specific for cloud deployments while other
content is relevant for on-premises deployments. Any content that applies to only one of these
deployments is labeled accordingly.

The following BPs are not currently supported for use with Unifier Mobile App:

v vV v vV vV vV v Vv

Line Item with CBS and WBS Codes
Payment Application

Project/Shell Creation

Request for Bid (RFB)

Reservation

Resource Booking

Timesheet

Note: The instructions and information presented in the Unifier
documentation are based on an out-of-the-box (OOTB) setup and before
being customized by the user.

In This Section

Best Practices for Working with BuSineSs ProCesSes.............uuuvveeiemieiiimiiiiiiiiiiiininnns 13
BUSINESS PrOCESSES ....uiiiiiiieiiiie ettt e e e e e e et e e e e e e e e e eeeana e e eeeas 15
Business Processes with Special BEhaVIOrs..........coovvvceiiiiieiiieeicee e 237
Business Process Forms, Managers Attributes, and Shell Dashboards - User Interface
.............................................................................................................................. 375
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Best Practices for Working with Business Processes

To assist you with producing results that are superior to those achieved by other means, Oracle
recommends the following methods as the most effective.

In This Section

AULO-Creation CONAILIONS ... ...vieieii et e et e et e e e e e e e e eeans 13

Auto-creation Conditions

If you are using a condition-based auto-creation process, ensure that you allow enough time
(depending on the number of running background jobs) for routing of the workflow.

When designing business processes, especially when you are designing the relation between
the business processes, note that there can be only one auto-creation job per record.

When the workflow advances, the system schedules an auto-creation job and executes it with
high priority. If the workflow advances again, before the auto-creation job is executed, then the
application will not schedule a new auto-creation job.

Notes:

= The manual auto-creation is transactional. The condition-based
auto-creation is not transactional.

= [f the option Do not evaluate condition based autocreation is
selected for the workflow, the BP creator's conditions will not be
evaluated irrespective of the conditions added in the auto-creation
setup. This helps to reduce processing time when there are no BP
creators on that step.

Because of the general way that processes are organized and relate to each other, when you
create a job, several factors come to play to determine the job processing time.

Regardless of the job prioritization (high priority or low priority), the system will hold, or delay,
processing the succeeding job when a record is being updated concurrently (for example,
through web service, RAP, or manual updates), until the current job, or auto-creation, is
complete. In other words, if a record is updated manually and the record auto-creation is in
progress, the next request that is submitted by way of “UpdateRecord” will not trigger an
auto-creation procedure because the previous job must finish first.

Example:

When a workflow advances from step 2 to step 3, the auto-creation initiates and is in
progress. When the workflow advances from step 3 to step 4, if the system detects that the
first job was not completed, the system will prevent the second job from completing
(auto-creation will not take place for the subsequent job).

Additional Information about Auto-creation Conditions
» Only manual auto-creation is form based.
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The auto-creation process does not depend on a business process form.

Reverse Auto-population (RAP) process begins when the workflow advances. RAP uses the
auto-creation process; therefore, RAP does not depend on a business process form.

» When a line item is auto-created (by using the line item auto-creation logic), the values in the
fields on the line item that are based on a data picker in that line item will not be
auto-populated.
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Transactions and collaboration are driven by business processes. Information is entered and
stored using electronic Business Process (BP) forms. Each time you fill out a BP form, you are
creating a new record. These forms may be routed to project or shell team members or other
users by way of workflows. The information that you enter into BP form fields may be used
throughout the system. Each field corresponds to a Data Element (DE) that can be identified,
reported upon, and tracked; some data element values may be rolled up to sheets such as a
cost sheet or resource sheet.

The look and feel of a field (Data Element) is determined by the Data Definition (DD) on which
the Data Element is based. The Data Definition determines whether the field is a text-entry field,
a drop-down list of options, a check box that you can select, a picker that is used to select an
existing record, and so forth.

The business processes can be associated with specific Project or Shell (Project/Shell-level BP),
or they can be applicable for the entire Company (company-level BP) and not to be specific to a
Project/Shell. The Administrator (Project/Shell or Company) determines which forms are to be
used and how the workflows operate.

In the Upper Form or Detail form of any BP, for a field with DD set as Integer data type with
input-type pull-down menu (option value for DE of type Integer), the field (and the field label) will
be displayed in the BP record:

a) If you do not select a value for the field (space), and

b) If the Administrator has set the value of zero for that DD set (Integer data type with
input-type pull-down menu).

Note: The above conditions apply to Attribute Forms and Reports.

Additional information about Unifier business processes

» BP records are stored in logs, which are accessible in the left Navigator. You can think of
these logs as filing cabinets, with each drawer storing a different type of BP.

» The non-workflow business processes will simply be stored as records.
» Business Process forms are designed in uDesigner.

For information about internationalization and CSV files refer to Unifier General User Guide.
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Workflow and Non-workflow BPs

Business processes (BPs) can be designed with or without workflows. A workflow specifies how
a business process should proceed, from start to finish. Workflows define how records are
routed and govern the behavior of each step in the business process. Each step uses the forms
that were designed for it in uDesigner.

Most business processes will include a workflow or workflows; however, some business
processes have a single purpose of storing data. These business processes are called
non-workflow BPs. An example of a non-workflow BP is a form that records a Warranty or
Estimate. The log for a non-workflow BP includes an Edit Record column that indicates whether
the record is in an editable state by displaying an Edit Record status icon . zlIf the record has a
status such as submitted, terminal, or initiated, no icon is displayed. A user can use the Create
New View option and the Show Edit Records parameter to filter the log to display only those
records that are in an editable state. For more information on setting up filtering, see Business
Processes in Company Logs and Logs Nodes.

After a workflow BP record is created by using any workflow schema (unique combination of
Setup Name + Workflow Name), the workflow record continues to reference the workflow
schema even if the status of the workflow schema has been set to Inactive.

This condition includes workflow records that are in the following statuses:

» Draft
» Initiation Step (I-Step)
» Also, this condition includes any workflow record at any other step in the workflow.

If there is an Active BP Template, then the template continues to create records referencing the
Inactive workflow schema. For instructions on creating a template, see Creating BP Templates
and Scheduling BP Creation (on page 100).

Editing the Due Date (due_date) Field

In the Workflow Settings field in the Workflow Setup of a BP, if the option Override Workflow
Due Date field set as Yes, you can edit the due date in the creation step.

In the Workflow Settings field in the Workflow Setup of a BP, if the option Override Workflow
Due Date field set as No, you cannot edit the due date in the creation step.

Also, you cannot edit the due date if:

» The work has started.
» The work has moved to the next step (is in-flight) in the workflow process.

Business Process Types

Different business needs require different types of business processes (BPs). In uDesigner,
many types of business processes are available that perform various functions within Unifier.
BP forms can be of the following types:

» Cost
» Document
» Line ltem

17
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Project/Shell Creation
Request for Bid (RFB)
Resource

Simple

Text

v v v v Vv

The following explains each type.

Cost Type BP

The Cost type business process form enables you to track and manage cost information and
interact with the Project/Shell cost sheet. Examples include base contracts or purchase orders,
change orders, budget change requests, invoices, fund appropriations, and leases.

Note: With version 23 and later, a Total row on a non-standard tab of a
line item grid is not displayed. For version 22 and earlier, the Total row
displays a 0.

Additional cost-related functionality includes schedule of values (SOV) and payment
applications.

In any change order (including change orders with Unit Cost-type Contract when the Unit Cost
Contract option is selected), when you select a reference SOV, for selecting an SOV line item,
the system uses the value of the Item Unit Cost field from the referenced SOV and makes the
field read-only.

Cost type Business Process Form Sub-types

The Cost type BP form has several sub-types that are used to perform specific cost-type
functions. The cost business process subtypes are:
» Commit at company level (also known as Blanket Purchase Order)
This sub-type allows tracking and control of costs at the company level above the CBS level.

It is independent of a budget or cost sheet, and it is used for tracking non-CBS expenses
across projects or shells.

Project/Shell level Commit at company level sub-type can be set up to reference a company
commit.

Example of Blanket Purchase Order

A Blanket Purchase Order is a type of purchase order that the customer makes with its
supplier. A Blanket Purchase Order contains multiple delivery dates over a period of time
(often negotiated) to take advantage of predetermined pricing. It is usually used when
there is a recurring need for expendable goods.

» Lineitems with CBS code
This sub-type relates directly to the Project/Shell cost sheet.

The business processes that use a CBS picker to reference CBS codes must use the Line
items with CBS code sub-type.

These business process transactions can directly affect the budget. Examples include Base
Commits, Change Commits, General Spends, and Payment Applications.
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Line items with fund code
This sub-type is used for fund appropriation at the Project/Shell level.

Business processes can be created to automatically allocate or consume funding source
funds, which are chosen using a Fund picker. These transactions are for fund management
and do not necessarily affect the budget. Transactions on Line items with fund code sub-type
roll up to the Fund Manager.

Line items with both CBS and fund code

This sub-type is used during fund appropriation at the CBS level. These transactions are for
fund management and do not necessarily affect the budget. Transactions on Line items with
both CBS and fund code sub-type roll up to the Fund Manager and Cost Manager.

Line Items with Both CBS and WBS Codes
This sub-type is used to roll up transaction data to the EVM-WBS Sheet and Cost Manager.
Line items with company accounts code

This is a company-level business process that can be used to roll up transaction data to the
company accounts sheet.

Line items with multiple codes

This sub-type is for business processes that can be used with a generic (non-CBS) cost
manager.

Cost-type BP Form and Picker Values

The picker field is used for selecting CBS codes, and the picker can be found on:

v v v v Vv

Cost-type BPs

Shell or project

Shell cost sheets
Schedule activity forms

Company-level and Shell-level business processes in form view and grid view when records
and line items are created or updated

The following information applies to the following pickers:

4
»
»
»

CBS Picker
CMO Picker
CMx Picker
Funding Picker

When you create or update a BP record:

»
»

The picker field enables you to select only relevant codes or data.

You can search for a code in picker, in the Line Iltem Details tab of your BP record Line
Items tab. This is so you can see a list of codes from the filtered list that matches your
search criteria.

By defining the query condition on pickers in BP Configuration, you can narrow down the list
of codes in picker, in the Line Item Details tab of your BP record Line Items tab. This is so
you can see a list of codes from the filtered list that matches your defined query conditions.
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» The picker has an auto-completion feature. If you know the code, begin typing in the picker
DE field, and the picker will show the top 10 matches. If you continue to type, the picker will
narrow the list as it matches more of the characters you type.

You can also auto-create a BP record with the picker value that matches a previously-defined
guery condition, at the source BP. This so you can automatically create records or line items by
ignoring the filter conditions that are set for the destination BP. The query condition is defined in
the BP Configuration.

For flat-structured cost sheet, the filters are applied to all nodes, and for the tree-structured cost
sheet the filters are applied to the leaf nodes, and the summaries are displayed base on the
rollups.

Note: Auto-population and Reverse Auto-population processes will work
in same way if the query conditions are defined in the picker.

When you create a new BP record by way of a CSV or Excel file import, or when you add a new
line item through the line-item CSV or Excel file import, the system will use the defined query
conditions in the picker. For BP record level import, if the CBS code does not match the query
conditions, then the validation happens during the record creation process, and the system
sends an email to the user that it has failed. For line item level import, the system displays a
message and shows the error in the CSV.

You cannot create a BP record if the picker DE is a required field, and the data that you have
entered does not match the available defined query conditions in the picker.

When you create a new BP record with line item by way of REST V1 and V2 web services, or
when you add a new line item through the REST V1 and V2 web services, the system will use
the defined query conditions in the picker. If the CBS code provided in the RESTful web services
does not match the query conditions, then the record or line item creation will fail with an error.

Document Type BP

The Document type business process form can be used as an "envelope" to package a set of
files, such as spreadsheets, drawings, and design documentation that flow from one group to
another.

The Advanced functionality allows documents to be attached to the form as line items, with line
item status control. This allows the ability to change the status (for example, approve or reject)
for each attached document. Examples are submittals and transmittals.

The following are the sub-types of Document type business process form:

» With folder structure

Both documents and folders can be uploaded to the business process. The folder navigator
in the lower left of the form displays the folder structure.

» Without folder structure

The folder structure will be ignored, and documents are attached in a flat list. The contents of
selected folders and sub-folders are attached.
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Line Item Type BP
The Line Item type business process form can:
» Lend itself well to business processes that involve miscellaneous information that you want
to document for a company or project, for example, a vendor contact list.
» Be useful for project-specific information that only needs to be documented on a single form,
such as the overall project scope, or meeting minutes.

The Line Item type business process form is also useful for collecting data that other (more
restricted) types of business processes cannot collect. For example, while a Simple type
business process form can be used to collect basic vendor information, a company-level Line
Item type business process form can collect additional vendor information, such as multiple
business addresses.

At the project level, you can use a Line Item type business process form to filter large numbers
of company records into smaller lists of records that are more appropriate for a specific project.

The Line Item type business process form uses a separate detail form to enter line items, which
then appear on a line item list at the bottom of the form.

For short line items, users can enter information directly into the line item list using a "grid view"
of the list.

You can design the Line Item type business process form to accommodate line item status, so
you can control modifications to individual line items based on their status.

The following are the sub-types of the Line Item type business process form:

» Generic

Use the Generic sub-type for all Line Item type business process forms unless you want to
filter the business process records.

To filter BP records, use the sub-type explained below.
» Lineitems to filter business process records

Use the Line items to filter business process records sub-type to filter company records into
smaller lists of records for your projects.

This sub-type is particularly suited for selecting specific vendors from a company's master
vendor list (vendor master list) to create a sub-set of the master list that contains vendors
who are appropriate for a particular project.

Used for this purpose, this sub-type can be linked (as a reference process) to an RFB to
supply a project-specific vendor list for bid invitations.

The system allows your company to only designate one "Vendors" business process as the
RFB master vendor list.

» Preventive Maintenance (If the module is available)

Use the Preventive Maintenance sub-type to maintain assets proactively and on a regular
basis, even when no issue has been reported on the asset.

The Preventive sub-type has the following classifications:
» Asset

» Asset Template

» PM Book (Preventive Maintenance Book)
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» PM Book Template
» Meter Reading

These classifications are available for selection from the Classification drop-down list, once
you select Preventive Maintenance.

Note: A Company can have more than one business of a particular
sub-type, for example, two or more Asset BPs, two or more Asset
Template BPs, and so forth).

Preventive Maintenance BP
Preventive Maintenance Business Process toolbar options:

» Form View (default view)
» Grid View
» Add
» Actions
» Import
» Consolidate Line Items
Reload
Print
» Print
» Export To CSV
» Export To Excel
» Search
» Find on Page
You can click the Gear menu to the left of each row in the grid or right-click rows to see the
following options:
» Copy
» Remove
» Group line items

Additionally, you can select multiple rows and right-click to see the following options:

Add line item below
Copy

Paste below
Remove

Group line items

v v v v Vv

Adding and Modifying Line Items

To add a line item to the grid, click Add. A blank row will be inserted and the following toolbar
options will be visible:

» Create
To add a new line item.
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» Search
» Find on Page

Note: Any fields that have default values will display them.

After a line item is created, you can double-click the cell to modify its content (if the form
properties permit modifications).

Error Reporting

If any rows have an error, the red Error icon appears in the first column. You can click the Error
icon to see an error message. Columns with required fields display red triangles in the
upper-right corner.

Hyperlink Fields and Image Fields

When you double-click a hyperlink field, the Hyperlink icon appears in the cell. When you click
the Hyperlink icon, a box appears. Here, you can enter the Name and URL that appear in the
cell.

When you double-click an image field, the Upload icon appears in the cell. Clicking the Upload
icon gives you the options of Browse and Document Manager. When you click Browse, the
File browser will open. When you click Document Manager, the image field from Document
Manager will appear.

Project/Shell Creation Type BP

The Project/Shell Creation type business process form enables you to create projects and shells
from the upper form of the business process or from line items.

The data necessary to create projects/shells is provided by this business process.

In addition to creating a new shell, this type of business process form can also be designed so
that you can choose the managers and employees who should be automatically assigned to the
shell when it is created.

This type of business process form enables you to create projects and shells using the designed
templates. You can use the Record Properties tab to define restrictions on who can view specific
tabs, such as, Linked Mail, Attachments, Reference Records, and so on. The system copies the
restrictions defined on the Record Properties tab of the Business Process setup from the
selected shell template to the new project.

Project/Shell Creation type business process form can also work with the Planning Manager by
automatically linking new projects/shells with planning items. That is, instead of linking a
planning item to a project in the Planning Manager, the Project/Shell Creation type business
process form can be designed to automatically create the link (when the project/shell is created)
and roll up data to the Planning Sheet from the business processes in that project/shell.

If integration was defined in the business process, the system can export/import a CSV template
for the Simple type business process form.
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Request for Bid (RFB) Type BP

The Request for Bid (RFB) type business process form allows companies to invite project- or
shell-related bids from different vendors.
» There is a business process form for requestors.
User requesting the bids.
» There is a business process form for bidders.
Bidders do not need to be existing users and are provided with a simple interface that does
not require special training to use.

See Request for Bid (RFB) Business Processes (on page 325) for more information.

Resource Type BP
The Resource type business process form works with the Resource Manager.
There are two subtypes of the Resource type business process form:

» Resource booking
This is a project-level business process.
In the upper form, you pick a date range to book resources.
The line item list displays a summary of booking rows.
You can create one resource booking BP per project.
» Time sheet

The time sheet business process can be designed to roll up hours and costs from the time
sheet to cost sheets.

There is one per company, but there can be multiple schemas.

Simple Type BP

The Simple type business process form consists of an upper form only (like a line-item-type BP
without the line items). It is used to add company or project or shell information that does not
require line items.

The Simple type business process form can be a:

» Company-level, non-workflow, single record.

» Company-level, non-workflow, multi record.

» Project-level, non-workflow or workflow, multi-record.
» Shell-level, non-workflow or workflow, multi-record.

An example of the Simple type business process form is a project information form to capture
basic reference information.

Text Type BP

The content of the Text type business process form is typically a text comment in the lower
portion of the form.
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Examples of text type BPs include:

» RFIs (Request for Information).
» Action items, which track issue resolution.

You can view responses from other users who may have acted on the record at a given step
while working on the record.

Note: The functions of the options presented below have been explained
in the preceding sections. This section explains new functions and
procedural differences.

A Text-type BP has the following tabs:

» Upper Forms (main form)
» Text Entry Form
» Response List form

In edit mode, you can see the:

» Upper Forms (main form) tab name: General
» Text Entry Form tab name: Collaboration

When you click the Collaboration tab, you can enter the response in the input box.

When you are viewing the form, the application displays the General tab and the Response tab.
You can filter the responses, based on user, by clicking the Posted By drop-down list. Each of
the responses received will be placed in a separate block, and no actions are permitted on these
blocks.

When you want to update a record, the following tabs are displayed:

» Upper Forms (main form): General
» Text Entry Form: Collaboration
» Response List form: Response

Note: In edit mode, the Response List form: Response looks the same
as the one seen in view mode.

Business Process Step Editor

The Step Editor designation allows someone other than the assignee to edit the business
process record. Step Editors can be added to the following workflow, or non-workflow, business
process types:

Line Item

Cost (all types, including Lease and Line Item with Multiple Codes)
Document

Simple

RFB

Text

v v v v v Vv
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If you are designated as a Step Editor on a business process, it means that you are a user, or
member of a group, who can open and edit a business process record without being granted
explicit record-level permission.

If you are a Step Editor on a business process, you can open and edit any record that you can
see listed in the business processes log, per your view access permission (View User Records,
View Company Records, or View All Records).

Note: You must have at least one of the above permissions to be able to
view the record in the log to access it to edit.

The Step Editors cannot edit a Workflow Business Process record until the task assignee
accepts the task and saves the draft.

Edits performed by Step Editors are not audited.

Edits performed on the end step of a Workflow Business Process affect the record directly
because no draft exists.

If there are multiple Step Editors, the last Step Editor, who saves changes/edits, overwrites all
other changes/edits.

If multiple Step Editors and the assignee are editing the business process record at the same
time, the data saved by the last edit overwrites all previous edits.

Example

If User 1 changes an amount field from 15,000 to 23,000 and saves the change, and User 2
changes an address field, but does not change the amount field on her copy of the form,
when User 2 saves her change, the system will commit User 2's edits and overwrite User 1's
changes. In this scenario, the amount field value will be 15,000.

For information about responding to your tasks, see Working with Tasks (on page 193) and
Completing Tasks via Email (on page 205).

Business Process Dates and Calendars

The system supports multiple calendars, enabling the Administrator to create a library of
calendars that can be selected for use at the Company or project/shell levels. The multiple
calendars let you have calendars to support varying work schedules (depending on locality) and
to account for holidays and other non-working days. For example, some countries in the Middle
East have weekends that are other than Saturday and Sunday.

Calendars affect the calculation of both business process workflow due dates and task due
dates, and formula calculations. When the calendar changes for the Company, or for the
project/shell, any subsequent computation of dates will use the new or changed calendar. Dates
are not affected for records that are in process. The Date Picker and the Date Only Picker will
show the changed calendar.
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Editing the Due Date (due_date) Field

In the Workflow Settings field in the Workflow Setup of a BP, if the option Override Workflow
Due Date field set as Yes, then you can edit the due date in the creation step.

In the Workflow Settings field in the Workflow Setup of a BP, if the option Override Workflow
Due Date field set as No, then you cannot edit the due date in the creation step.

Also, you cannot edit the due date if:

» The work has started.
» The work has moved to the next step (is in-flight) in the workflow process.

Working with Quick Calendar Entry

The Quick Calendar is available in the following business process types that were designed to
be "calendar-enabled."

» Document

» Line Item or Simple

The Quick Calendar is available for Space Manager.

Note: The functions of the options presented below have been explained
in the preceding sections (Reservation Business Process). This section
explains new functions and procedural differences.

The following scenarios describe the details when you click the Calendar option.
Viewing a Calendar in View only mode from log for Month: Viewing details of an existing event

The default view of the Calendar is set to Month.

When you hover over a date, on which an event or reservation has been created, the tool-tip
(Details) displays all event details such as:

» Name (Event)
» From (time)

» To (time)

» Status

» Creator

When clicking the Event, a Detail overlay is displayed with Name (time), From (time), To
(Date), Status & Creator.

The Tentative events are marked with a gray bullet, and the Confirmed events are marked
with a green bullet.
Create event in month view
When you click a date, for which an event has not created, an overlay is displayed. In the
Details overlay, you can enter values for:
» Name (Event)
» From (time)
» To (time)
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» Status
Note: You must have permission to make Quick Calendar entries.

When you click the calendar symbol (next to From and To fields), the calendar opens and
you can pick a date.

The Creator field is auto-populated with the name of the signed-in user.

When you click Done, the event details are saved, the overlay screen closes, and the saved
event is displayed on the Calendar.

When you click Cancel, the event details will not be saved and the overlay screen closes.
Edit event in month view
When you double-click a date cell, for an existing event, the Details overlay screen is
displayed.
Click Delete to remove the event.
Click Edit to open an overlay screen and edit the event details.
Viewing a calendar in View only mode from log for Week (Viewing details of an existing event)
Upon hovering over a date, on which an event/reservation has been created, the date will be

highlighted by en-circling it in Red color.

When you hover over an Event, the date of the event is highlighted by en-circling it in Red
color.

A tool-tip, Details, opens and displays the event details such as:
» Name (Event)
» From (time)
» To (time)
» Status
» Creator
The Tentative events are highlighted in gray, and the Confirmed events are highlighted in
green.
Create event in week view
When you click a date, for which an event has not created, an overlay is displayed. In the
Details overlay, you can enter values for:
» Name (Event)
» From (time)
» To (time)
» Status

Note: You must have permission to make Quick Calendar entries.

When you click the calendar symbol (next to the From and To fields), the calendar opens
and enables you to pick a date.

The Creator field is auto-populated with the name of the user who has signed in.
The To and From fields are auto-populated based on the time displayed.

28



Working with Business Processes

When you click Done, the event details will be saved, and the saved event is displayed on
the calendar.

When you click Cancel, the event details will not be saved.
Edit event in Week view
When you double-click a date cell, for an existing event, the Details overlay screen is
displayed.
Click Delete to remove the event.
Click Edit to open an overlay screen and edit the event details.
View mode for Day view
The events displayed for the day are marked with green highlight, in case the event is
confirmed.

The events displayed for the day are marked with grey highlight, in case the event is
tentative.

As a result, when you click an event, if the event status is confirmed, the event is marked
with green highlight, and if the event status is tentative, the event is marked with grey
highlight.
The event details for both cases above are displayed.
Create event in day view
When you click a time cell in Day view, an overlay is displayed. In the Details overlay, you
can enter values for:
» Name (Event)
» From (time)
» To (time)
» Status

Note: You must have permission to make Quick Calendar entries.

When you click the calendar symbol (next to the From and To fields), the calendar opens
and enables you to pick a date.

The Creator field is auto-populated with the name of the user who has signed in.
The To and From fields are auto-populated based on the time displayed.

When you click Done, the event details will be saved, and the saved event is displayed on
the calendar.

When you click Cancel, the event details will not be saved.
Edit event in Day view

When you double-click an event, for an existing event, the Details overlay screen is
displayed.

Click Delete to remove the event.

Click Edit to open an overlay screen and edit the event details.
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Other Calendar Features

Note: Other events, scheduled within the extended events, are displayed
accordingly.

Display of Mini-Calendar

A mini-calendar is displayed besides the Quick Entry Calendar, to enable you to go through
years and months irrespective of the selected view.

Display of Upcoming Events

A mini-calendar is displayed besides the Quick Entry Calendar, to enable you to go through
years and months irrespective of the selected view. A list of 10 future upcoming events are
displayed on calendar. For the current day, according to the current time, the future events are
displayed.

Example

If the event "Lunch Meeting" is scheduled for 2:00 PM to 3:00 PM, today, and the current
time is 3:30 PM, then the "Lunch Meeting" even is not displayed in the upcoming event list.

Business Process Forms

The forms are consistent throughout the system, with a similar look and feel. When you send a
workflow business process form to the next step, the assignee receives a task.

When you first open a task, it appears in "view" mode. Depending on your BP setup, the "view"
version of this form might let you:

Accept the task

Decline the task

Print the form

Terminate the record

Send Mailbox

Transfer ownership of the record

Add an assignee to the current step
Copy users to the current step

Audit the progress of the record

Add a comment, if you have permission

vV vV vV vV vV vV vV v v

v

If you accept the task, the form becomes editable. Depending on your BP setup, the editable, or
"action," version of this form might let you:

Undo task acceptance, which allows someone else to accept the task.
Decline the task, which takes you out of the list of assignees.

Select the step's next action.

Add or edit form content

Save a draft of the record

Terminate the record

Transfer ownership of the record

v v vV vV v v Vv
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» Display the view form of the business process
» Audit the progress of the record

» Add attachments, line items, and so on

» Send the form to the next step

The form appears similar to a paper form—you complete the form by typing information directly
into the form fields or choosing options through drop-down lists, pickers, or check boxes.

Note: The section labels are determined by the design and may vary.
The basic form functionality remains the same.

Parts of the Form
In general, most workflow business process forms consist of three major sections:

» Upper form
» Action (or Task) Details
Non-workflow business processes do not have an Action Details section.
» Line Item Details, unless otherwise noted.
You can minimize and later expand a business process form. For example, you might want to

minimize the General and workflow portions of the form to avoid scrolling through many line
items.

Toolbar: The workflow business process form has a toolbar at the top of the form. This allows
you to access all parts of the business process form, such as the Upper form and Line Item
Details, and has the following buttons in the upper-right corner:

» Send

» Save

» Menu Options: The options in this menu may vary per business process, but each workflow
bp has the following menu options:

» Print
= HTML
= PDF
=  Custom
» Reload
» Review
» Help

= (Business process name) Help
= User Productivity Kit
» Close
After you are done working on the business process form, click Send to route the workflow

business process to the specified recipients. You can click Save to save a draft of the form, so
you can work on it again. When you have completed work on the business form, click Close.
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Note: The Close action does not save the information on the form. To
save the information, you must click Save before you close the form.

Additional Elements of the Form

Upper Form: The upper portion of the business process contains the basic (General)
information that the form is managing, such as the name of the record and its description, who
created the record and when, and other general information. It may also contain fields for
referencing other forms, and it may contain fields that are required for specific functionality. This
is an example of an upper form for a business process type called Work Orders:

Workflow or Action Details: This section appears in the middle part of workflow business
processes. It is for viewing or assigning the next assignee in the workflow or shows the last
person who took action on it. Depending on how the workflow has been set up for the BP, the
next assignees may be predetermined, or you may be able to choose the next assignee or send
a copy of the BP to another user. You can print workflow progress using custom print.

Non-workflow business processes do not have an Action Details section.

When you finish a form, clicking Send will show the Workflow Action Details window. The To:
and Cc: buttons are active after you select a workflow action in the Workflow Actions
drop-down list.

Note: If there is only one possible workflow action for a step, the action
is auto-populated in the field.

You can track a step through the workflow by clicking the link Workflow Progress tab in the
right pane.

In Classic View, click the notepaper icon next to Task Notes in the Action Details section to add
notes to the routed task. These are notes for the task recipients.

Content or Lower Form: The lower portion of the form contains the details and main content of
the record, such as line items, file attachments for Document-type business processes such as
transmittals or submittals, or comments or instructions in text-type BPs such as RFls.
Simple-type BPs do not have a Content section.

The lower form of certain BPs may be organized using multiple tabs. The BPs that support tabs
in the lower form are:

» Line item type

» Cost type with the classification generic (line items with CBS codes, multiple codes, or
account codes)

» Cost type with the classification lease, and the subtype line items with multiple codes

Note: If the entire name is too long to appear on the tab, hover over the
tab. The system will display the complete name in a tool tip.

The tool bar in the line items log contains the following options:

» Form View
» Grid View
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Add

Actions

» Import
= Data From CSV File
= Data From Microsoft Excel File

Refresh

Print

» Print

» Export To CSV

» Export To Excel

Search

Find on Page

Notes:

= For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

= If you export data from a business process (BP) record, sheet (such
as an Activity Sheet), or log (such as Company Funding Sheet Log)
to Excel, be aware that depending on how your negative values are
formatted, you might need to configure your columns in Excel to
match the correct data type (Number). Otherwise, the columns will
not be treated as numeric and will not sum as expected. One
supported format includes placing the negative sign between the
currency symbol and the amount (for example, $-1,000).

The gear menu for each line item contains the following options:

» Copy
» Remove
» Add to Group

About summary line item
Example

When a subcontractor wants to provide input related to the cost of a Change Order, the
subcontractor can add summary line items to the change order without being able to see the
cost breakdown structure that the contractor, or the owner, is using. The contractor, or the
owner, can then review the summary line items and add them to the cost breakdown, for each of
the summary lines added by the subcontractor.

Auto-sequencing and Unique Values in Fields

The Administrator can specify values on business process upper or lower forms that enable
auto-sequencing, or that specify unique values (upper form only). These features are available
for both company-level and project-level business processes, and can be used on workflow and
non-workflow business processes.
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Auto-sequencing

The Administrator can configure auto-sequencing for certain data elements on a business
process form. This is in addition to the standard business process numbering, and allows the
numbering of up to two fields on an upper form, and two fields on a lower form. For example, the
Administrator can specify that a "Name" field uses auto-sequencing in order to number business
processes that have similar names. Auto-sequencing generation occurs for the business
process when you click:

» Send on workflow business processes

» Save on non-workflow business processes

» Submit on non-workflow business processes for line items
» Apply or OK for line items
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Notes:

= Fields configured for auto-sequencing are not available for Bulk Edit,
since the values for these fields are system-generated.

= The auto-sequence DEs, at both record level and line item level, are
generated when a record is submitted. For auto-sequence DEs
defined at the line item level, when line items are added, the format
of the auto-sequence is calculated but the value of the DE remains
blank. When the record begins the routing process, the
auto-sequence DEs are created. When other DEs use an
auto-sequence DE in a formula, subsequent updates to the line item
through any means will recalculate the formula.

= Auto-sequence DEs are generated only when a record advances. If
this value is used by any other formula DE, an update of the line item
is required to recalculate the formula (similar to the record_no DE in
the upper form). Any formula that uses an auto-sequence DE will not
be evaluated at the same time when the auto-sequence DE is
generated. The formula must be re-triggered by an update to the
record or line item.

= [f you import a Folder Structure Template in the Document Manager
or the Structure and Properties of a specific item in the Document
Manager and there are fields that are enabled for auto-sequencing in
the template or properties, the system applies the auto-sequencing
of formulas and other values. This setting is applied to existing
documents within the selected folder and to BP records generated
from the updated folder or document.

= When a DE is added to the lineitem form and configured using the
SYS Auto Sequence DD for a Summary Payment Application (SPA)
BP, the sequence counter increments the sequence based on the
line items present in the SPA BP. When the user adds lines to the
SPA BP, the sequence is applied per line item regardless of any cost
breakdowns that might have been added to any of the lines. (That s,
the individual cost breakdown entries are not counted in the
sequence and are not sequentially numbered.)

The following explains how the auto-sequenced fields work:

You can generate sequence numbers based on the unique values of parameters that have been
used in formatting the sequence number. You cannot modify the values of parameters once they
have been generated.

If the data elements, or parameters, do not have values, then this type of sequencing number
will not be generated.

The counter mechanism will increment based on the uniqueness of the value of the parameters.
Generating the sequence formatting is available for the following actions:

» “Send” on WF BPs, including the line items
» “Save” on NWF BPs
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»

“Submit” on NWF BPs for line items

If you remove a sequence-based data element from configuration, then data will not be
generated for any newly created BP records. The existing data will remain as is and will be
read-only.

The system audits the data elements based on the SYS Auto Sequence.

When you create a BP record by way of the user interface:

4
4
4

The system will not generate auto-sequence numbering if you reset one of the parameters.
Translation will not impact generating the sequence number.

Since the auto-sequence fields are defined as formulas and formulas will always consider
the value and not the label, you can use a parameter in an auto-sequence definition that has
a data-set, and one of the values does not have a label.

The configuration of auto-sequence setup will be retained in BPs:

v v v v v Vv

v v

»

When creating and updating BP records through the user interface (Ul).

When creating and updating BP records through the bulk update and bulk edit.
When creating BP records and line items by way of CSV files.

When auto-creating BP records.

When copying a BP record and then submitting, or sending, the copied BP record.

When updating a BP record by way of opening the BP record through a reference link, or
through a form sheet such as Cost Sheet.

When submitting a BP record after creating a line item, through line item consolidation.
When submitting a BP record after creating a line item and updating the line item through the
grid.

When creating and updating BP records through web services.

Unique values

The Administrator can configure unique value validation on data elements on business process
upper forms.
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Example

If a business process has a field called Invoice, and should enforce that each invoice
number is a unique string, this field can be configured to validate for a unique value. If you
attempt to enter a string that is not unique (has been entered on another business process),
you will get a warning message that an alternate value must be entered. Unique value
validation occurs for the business process when you click:

» Send on workflow business processes

» Save on non-workflow business processes

»  Submit on non-workflow business processes for line items
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Notes:

= If you use Bulk Edit to update multiple records and attempt to update
a field that has value uniqueness configured, only the first record will
update (and is therefore unique).

= When a unique data element is not part of the integration validation
form, the system will ignore the value sent via integration and restful
services in the created business process records.

The system does not generate the record number (the value in the “record_no” field) until the BP
record is moved from the creation step to the next step in the BP workflow. As a result, at the
creation step, the value for the “record_no” field in any formulas will be null.

Note: The system re-evaluates the values in the record number field
within the Publish Path (uuu_dm_publish_path) and the Record
Information Publish Path (uuu_dm_record_info_path) data elements,
after the record number is generated.

At the upper form level, any form level validation that is defined in the design and involves the
"uuu_attachment_count" field will be processed when you click Upload or after submitting the
form.

Note: If the 'Sys Auto Seq' type data element is dependent on a value
that is getting set only after the creation of the record, then Oracle
recommends that you run an update call to update all of the line items to
generate the auto-sequencing value.

Pickers

Pickers appear as selection lists on business processes and other components. These pickers
let the user choose elements such as dates, blanket POs, other users, companies, line items,
funds, or currencies.

Some pickers are designed to display a structure to guide you to the correct location where a
record resides, such as a specific project or a specific business process.

If the Include only current Project/Shell records option is enabled in the BP Data Picker
Configuration window in uDesigner, you can only select current shell records in the BP Data
Picker window or a drop-down list. However, if the project level BP Data picker is added in a
company-level business process, the system ignores the above option.

Note: If both the Show results matching any condition option and the
Include only current Project/Shell records option are selected in the
BP Data Picker Configuration window of uDesigner, the system displays
only those records that match either the Include current Project/shell
records option or any of the specified query conditions.

By using this additional structure, you can navigate more easily through your business process
records to the one you want. The Cost Control base product uses the following pickers:
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Picker

Description

Account Code

Found on cost-type business processes for
choosing company account codes.

Activity

Found on project- or shell-level business
process forms for selecting activities from
the master schedule sheet.

Note: Activity Picker is supported on
Timesheet BP (Line Item Details form) and
can be used for selecting activities from
the Master Schedule Sheet.

BP

For linking one business process to
another (for example, to tie invoice
business processes to purchase order
business processes). Often, the field will
be named something like Reference BP,
although this is up to the designer of the
business process. Depending upon the
design of the form, some fields may be
automatically populated when the
referenced business process is selected.

Note: The business process list that you
see will depend on your permissions.
Users who do not have permission to view
a BP that may be part of the business
process picker list will not see that
business process on the list.

Commit Line Item

Used when you create a new line item for
a change commit business process. This
picker displays a composite view of base
commit and change commits. The data
elements on the picker are reference,
description, and CBS code.

Currency

For selecting a currency on a cost-type
business process. If no currency is chosen
by the creator of the record, the default is
the project or shell currency. If there is not
a Currency picker on the form, the
currency defaults to the project or shell
currency.

Date

Displays an interactive calendar from
which the date can be chosen. For some
business processes, dates in Date pickers
can be set to automatically default. For
example, this defaulting can be useful in
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Picker Description

the case of entering a delivery date and
having the date default to today's date
rather than having to use the Date picker
to get a date.

Displays an interactive calendar from
which the date can be chosen. This picker
lets you select a date from the picker or
enter a date into the field. This picker lets
you choose the date only, with no
associated time or time zone. For
example, you would not need time and
time zone for a date like an equipment
purchase date. Also, for some business
processes, dates in Date Only pickers can
be set to automatically populate the server
date. For example, this defaulting can be
useful in the case of completing an
equipment purchase and having the date
default to today's date rather than have to
use the Date picker to get a date.

Date Only

On Cost business processes, for selecting
which fund (from the company funding
sheet) the business process will allocate
funds to or consume funds from.

Fund

Location For selecting a shell.

For selecting a planning item at the

Planning Item
company level.

For selecting a company-sponsored
project. You can use this picker to
auto-populate project data elements on
other BP fields. The picker is designed to
show Active, Inactive, View-Only, and
On-Hold projects.

Project
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Picker

Description

Project Template

For selecting a template to use to
auto-create a project.

Resource

On time sheet, booking, or assignment
business process, for selecting the
resource to report on or assign. This picker
always opens in Find mode and requires
you to enter at least one search criteria,
such as a name or a skill, to narrow the
field of names to choose from. For time
sheet business processes, use this picker
to select the personnel to report time on.
At runtime, the picker will default to
read-only mode and show the current
user's name, as the system assumes the
user will be reporting his or her own time.
However, depending on permissions, the
picker can be editable to allow others,
such as project managers, to complete
time sheets on behalf of other workers.

Role

On time sheet, booking, or assignment
business processes or for resource
allocation sheets. It allows you to choose
the role to report on or assign. On time
sheet business processes at the project
level, it will filter out those roles that have
already been booked for other projects

Shell

For selecting a company-sponsored shell
to auto-populate shell data elements on
other business process fields. The picker
is designed to show Active, Inactive,
View-Only, and On-Hold shells.

Shell Template

For selecting the template that should be
used by a business process to auto-create
a shell. The picker will show you a list of
active templates that have been created
for the shell.
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Picker

Description

User/Group

For selecting project/shell users (members
of a project team) or company users (all
users defined within a company). See
more information under User Picker and
Group Picker (on page 45).

CBS

On Cost-type business processes,
project/shell cost sheets, and on schedule
activity forms, for selecting CBS codes.

Week

On Resource or Time Sheet business
processes for selecting a specific week for
reporting.

Work Package

On Cost-type business processes, for

selecting a work package for a Cost Sheet.

This picker is populated with the work
packages that have been created.

The following lists all the pickers:

Account Code picker

Activity Picker

Allocation Template Picker

Asset Picker

Auto-update Status Setup Picker

Bid Picker

BP Picker

BP Line Item Picker

BP Line Item Data Picker

CBS Picker

CBS Code Picker

CMO Picker (Generic Cost Manager)
CMx (Code and Record based) Picker
CMx (Code based) Picker

Commit Line Item Picker

Company Picker

Configurable Manager [Name] Picker
Cost Attribute Picker

Cost Code Picker

VvV VvV vV VvV VvV VvV VvV VvV VvV vV vV VvV VvV VvV vV VvV vV v v
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Currency Picker

Data Picker

Date Picker

Date Only Picker

Fund Picker

Generic Cost Code Picker
Group Name Picker
Hyperlink Picker
Image Picker

Level Picker

Location Picker

P6 Activity Picker
Planning Item Picker/Planning Line Item Picker
Planning Period Picker
Project Picker

Project Template Picker
Resource Picker

Role Picker

Role Data Picker
Seasonal Date Picker
Shell Picker

Shell Code Picker
Shell Template Picker
Shell Data Picker
Single User Picker
SOV Picker

Space Picker

SYS Date Picker

User Picker

User Data Picker
WBS Code Picker
WBS Picker

Week Picker

Work Package Picker

WV VvV VvV VvV V¥V VvV ¥V VvV ¥V ¥V VvV VvV ¥V ¥V VvV VvV ¥V VvV VvV VvV VvV VvV VvV VvV VvV VvV vV VvV VvV vV vV vV v v

For the following details, for each picker, refer to the Unifier Data Reference Guide:

Data Element Name
Label that will Appear on the Form
Available for Forms on Mobile Device

>
>
>
» What it Does
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At run-time, when a record is selected for a BP Data picker, all the line items for referenced BP
Line Item Data Picker that meet the query conditions defined on the Line Item Data Picker are
displayed.

In the Action form, a line item data picker can be either editable or read-only.

» Editable: A line item from a line item data picker.
» Read-only: A disabled text box without select icon.

In the View form, a Line Item Data Picker will be read-only.
» Read-Only: A disabled text box without select icon.

If picker is read-only, the display element of the selected line item in previous step is displayed.
If no line item is picked, or the display element does not have value, picker shows empty text
box and is disabled.

Click the picker icon for BP Line Item Data Picker to view the detail forms of the source BP
displayed as different line items.

Note: The tabs that are visible in the picker configuration are shown.

All the source line items within each tab that satisfy the query conditions are displayed.
The Toolbar options are:

» Lineitem: This is a drop down that shows tabs from source BP. Tabs that are hidden in
picker configuration will not be shown.

» Find: All the BP search elements that were added in Find tab are shown. You can further
filter the line items based on the search parameters.

» Find on Page: Same behavior as in other logs in the system.
Line item log for each tab is displayed as designed.

CBS Picker

The CBS Picker has an auto-completion feature. If you know the code, begin typing in the CBS
Code field, and the picker will show the top 10 matches. If you continue to type, the picker will
narrow the list as it matches more of the characters you type.

In this picker, you can use the following keyboard shortcuts:

» Use the Up and Down arrows to move through the list

» Press the Enter key on a highlighted CBS code to confirm a selection

» Press the Backspace key to delete a selection

» Use the Tab key to make a selection and move to the next field on the form

In the CBS Picker log, you can click Find on Page to do a text-based search for each column.
You can click Find to filter CBS codes. When you click Find, any additional defined elements
become present and a Show CBS Hierarchy check box appears. To view the entire CBS
hierarchy of filtered CBS codes, select the Show CBS Hierarchy check box. When the Show
CBS Hierarchy check box is selected, summary level codes and child level codes become
visible beneath the CBS code.
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WBS Picker

When you select the WBS Picker, the field displays all WBS codes that are available in WBS
Sheet. You can select a leaf-level and summary-level WBS code per P6 project. The
auto-populate data elements that are defined from the WBS Picker will be populated for the
selected WBS code.

When the BP record (CBS-type or WBS-type) is routed to the next step, or to the terminal step,
then the amount or quality (amount and uuu_quantity data elements) will roll up to the WBS
Sheet, per selected WBS code in the BP record.

In the WBS Sheet, when you add the columns, which are of data source type SYS BP Currency
Amount and SYS BP Decimal Amount, then the amount and uuu_quantity data elements values
from the new Cost BP (Standard tab) line items will be rolled up.

When the BP record (CBS-type or WBS-type) is created and routed to the next step by way of
CSV import, SOAP services, and RESTFUL services, then the pertinent roll up will take place.
Refer to the Unifier Integration Interface Guide for more details.

Bulk Edit

When you bulk edit multiple BP records (CBS-type or WBS-type) and change the status, the
corresponding amount and quantity will roll up.

Note: You can use bulk edit to update all other data elements in the
action forms.

Bulk Action

You can route multiple records at a time by going to the Task log and selecting one of the
following options:

» Bulk Action with Preview

» Bulk Action without Preview

You can route the BP records (CBS-type or WBS-type) to the next step by using bulk action and
roll up will occur if the BP status is added as a column in the WBS Sheet.

For the current workflow BPs, you can route the BP record through email. When routing the BP
record through email to the next step, or terminal status, the corresponding amount and quantity
data elements are rolled up to the WBS Sheet, in the same way the same line item rolls up to
the Cost Sheet for the corresponding CBS Code.

The new BP records (CBS-type or WBS-type), are available to be used for User-Defined
Reports (UDRSs), similar to other BPs.

In a project:

» If the WBS has not been created yet, the system does not allow the creation of a new BP
record (CBS-type or WBS-type).

» When a BP record (CBS-type or WBS-type) is terminated, then the data rolls back from both
Cost Sheet and WBS Sheet.

» You cannot delete a WBS code that has line item data and is removed from P6.
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If the Cost Sheet is not locked, then the system does not allow you to route the new BP
record (CBS-type or WBS-type) to next step.

When you create a new BP record (CBS-type or WBS-type), the main form of the record
appears and each line item appears as a tab (Create New CBS/WBS BP window). The
following explains this form in detail.

The form is split into two panes. The left pane contains the upper form and contains tabs that
contain line item details:

4
4
4
»

General tab
Standard tab
Payments tab
Schedules tab

The right pane contains the following tab:

»

Attachments tab

To add attachments by way of browsing or Document Manager (if the uDesigner option is
selected).

General Comments tab

To add general comments (if the uDesigner option is selected).
Linked Records tab

To include a link to additional records, similar to other BPs.
Linked Mail tab

To include a link to emails.

The menu option (the three horizontal lines icon) enables you to conduct the following:

»

v v v Vv

Auto-create

To use if there are any BP creators on the form, where user can define scheduled
auto-creation.

Export Line Item Template

To use the CSV template to import the line items, in bulk.
Print

Reload

Help

Close

User Picker and Group Picker

Most pickers operate in the same way. However, the User/Group Picker has several features
that other pickers do not.

Note: If a User Administration design has been imported, the content of
the User/Group picker (in User view) can vary. The Find window and sort
order can also vary depending on the optional design created.
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User and Group Picker X
Wiew: Users/Groups - Q ﬁ

Available ltems Selected ltems

Name Company 3 Mame Company

| >

&«

Total: 42

To filter the user/group list

The list of users and groups in your company may be very long. To make reading the picker list
easier, you can filter the names on the list by project/shell and by user or group, or both.

To filter the list by project or shell, use the List Names From field and choose the name of the
project or shell. (This filter option is usually available only to administrators; for example, when
an administrator is adding project or shell members.)

To filter the list by user or group, use the Show By field to display users, groups, or both users
and groups on the list.

To select a user or group

1) To select a user or group for an action, select the name. To select multiple names, hold
down the Ctrl key while you click the names.

2) To add the names for the action, click Add. The names are displayed at the bottom of the
window.

3) Click OK.

To remove a user or group
If you change your mind, you can remove a hame from the action as follows:

1) At the bottom of the window, select the user or group you want to remove. To select multiple
names, hold down the Ctrl key while you click the names.

2) Click Remove. The names are removed from the bottom of the window.

3) Click OK.
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To view a user's profile

To view a user's profile, select the name and click the View Profile button. The View User
Profile window is displayed, showing work information for the user, including their Title, E-Mail,
Phone Number, and Company Address. Use the drop-down list to view the user's information for
either the company or shell level.

To see a list of group members

To see a list of the members in a group, select the name of the group and click the Members
button. The Member List window is displayed. To remove a user from the list, deselect the check
box beside their name.

Shell Data Picker
When you open the shell properties in User mode and use the shell data picker hyperlink:
» The shell data picker can be editable, read-only, or read-only with a hyperlink on the Action

form.

» The shell data picker can be read-only or read-only with a hyperlink (in read-only mode) on
the View form.

When you click the shell data picker hyperlink (in read-only mode) on the View form:

» If you are a member of the shell and have permission to the View form, then you can see
the View form in the shell details in view-only mode.

» If you are not a member of the shell, then you cannot see the View form.

» If you are a member of the shell and have "Modify Properties" permission (in Access
Control) for the shell, then you can view the Action form of the shell in view-only mode.

» If the shell administrator accesses the shell data piker hyperlink, then the administrator
will see the Action form of the shell in view-only mode.

Note: Starting in 19.12.3, when you select the shell data picker, only the
General tab information of the shell properties is seen.

Completing a BP Record Form

For detailed instructions on creating a BP record, see Creating a Business Process (BP)
Record.

To complete a Business Process (BP) form:

1) Complete the Main form. Fields marked with a red asterisk (*) require an entry.
2) Add line items, if applicable.

» If this is a cost or line item-type BP add line items as necessary.

» If this is a Document-type BP, attach any documents to the form.
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3) Add additional information, if applicable.

4

4

General comments.
Attachments to General comments.

4) After you have completed the form, do one of the following:
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If this is a non-workflow BP:

= Click Save to save your changes. Saving the form for the first time will save a new
BP record and subsequent saves just save changes incorporated in the BP
record.

= Click Submit to save and process the record data. The record will be displayed in
view-only mode.

After the non-workflow BP is 'submitted," it can impact any of the following:
- Roll up to the Sheets and Managers

- Cashflow auto commits

- Autocreation

- RAP

- Publish record info to DMS

When you create a record, the list of values for Status only displays those that are
marked Active. When you update a record for which the current Status has been marked
Inactive, you must select a different Status. The system uses the status values to track
the state of a business process record and any line items it may contain. For example, a
Pending status generally means people are still working with the record, while a Closed
status suggests the record is completed. Records in Closed status are typically marked
as Terminal, meaning the record has reached a point where no further input is either
required or desired. You can still access a non-workflow record in a terminal status as
long as the record is in Edit mode. However, if you click Submit when the record is in a
terminal status the record becomes permanently read-only and un-editable.

Note: For non-workflow business processes, the system evaluates the
specified upper form validations specified in uDesigner only when the BP
record is submitted by clicking the Submit option.

If this is a workflow BP:

When you have completed the form, click Send. The Workflow Action Details form is
displayed.

From the Workflow Actions drop-down list, select a workflow action. If there is only one
possible action name, then this step is pre-populated.

The Send For field displays the Step hame. The step hame is populated based on the
selected Action name and is a read-only field.

The To field displays the possible list of assignees for the workflow step. Use the
User/Group picker to select an assignee, if not already preassigned.
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Note: If the Assignment Policy is set to Preassigned, the Additional
Task assighees from record and tabs line is read-only.

e. The CC field displays only if the workflow step allows CC users. Use the User/Group
picker to select users who will receive notification on the BP record form. This field might
be pre-populated based on the step setup.

Note: If the Assignment Policy is set to Preassigned, the Additional CC
users from record and tabs line is read-only.

f. If the selected step has a due date, the details of the due date are displayed. If not
already preassigned, you can choose from one of the following options:

Set all task due dates as: Lets you set the same due date for all assignees.

Set individual task due dates: Allows you to assign different due dates for each
assignee one at a time.

Click the Calendar icon corresponding to the option you chose. The Date picker
opens. Select the month and year, and then click the date you want to select.

g. Click Send.

Editing Values on a BP Record Form

The following table describes the values:

Notes:

= Click X to clear out values. You can also clear all field values by

selecting = Menu > Reload.

= Use the Search and Find on Page options displayed on pickers to
find specific items. Use the pagination controls if multiple records are
present.

Form Values Description

Text fields Text fields have an input box.

Data Pickers You can click on the Picker & icon to

launch the picker screen and either select
a record and then click Select or double
click the record.

BP Pickers You can click on the Picker B icon to
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Form Values

Description

launch the picker screen and either select
a record and then click Select or double
click the record.

Line Item Picker

Use the Line Item picker to select a line

item. You can click on the Picker &=

icon to launch the picker screen and either
select a line item and then click Select or
double click the line item.

Q  Shell Picker

For selecting a company-sponsored shell
to auto-populate shell data elements on
other business process fields. The picker
is designed to show Active, Inactive,
View-Only, and On-Hold shells. You can
use the Type drop-down menu to view by
Shell types.

Space Picker

The space log and space types are
displayed. You can filter using the View
drop-down menu. Space types are
displayed on the left and the right grid
displays the log for the selected space

type.

Image Picker

For uploading images.

Hyperlink Picker

For adding and updating hyperlinks.

CBS Picker

On Cost-type business processes,
project/shell cost sheets, and on schedule
activity forms, for selecting CBS codes.

Work Package Picker

On Cost-type business processes, for
selecting a work package for a Cost Sheet.
This picker is populated with the work
packages that have been created.

Transaction Currency Picker

The Transaction Currency picker displays
the Project Currencies. Columns seen
here are Currency Name and Currency
Symbol.

User Picker

For selecting project/shell users (members
of a project team) or company users (all
users defined within a company). The
options you see are contextual. Use the >
or < controls to move the selected group or
user from the Available Items list to the
Selected Items list.
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Form Values Description

Commitment Summaries Picker (CM) For selecting commitment summary that is
used by a Generic Cost Manager in a
shell.

Account Code Picker For selecting company account codes
included in the Cost-type BP.

CMO Picker For selecting Generic Cost Code.

Seasonal Dates Picker For selecting Seasonal Dates record in the

system. This is a system-defined picker.

Supported Data Pickers

The following is a list of the data pickers supported in the BPs with redesigned user interface:
Note: These data pickers support the type ahead feature.

Account Code Picker
Activity Picker

Allocation Template Picker
Asset Picker
Auto-update Status Setup Picker
Bid Picker

BP Line Item Picker

BP Picker

CMO0 ,1 to 25 Picker
Commit Line Item Picker
Company Picker

Cost Attribute Picker
Cost Code Picker
Currency Picker

Date Only Picker

Date Picker

Fund Picker

Group Name Picker
Hyperlink Picker

Image Picker

Location Picker

P6 Activity

VWV VvV VvV VvV VvV VvV ¥V VvV VvV VvV VvV vV VvV VvV VvV VvV VvV VvV vV v v v
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Planning Item

Project Picker

Project Template Picker
SOV Picker

The system does not permit type ahead for the SOV Picker field, in both form view and grid
view.

Resource Picker

Role Picker

Seasonal Dates Picker
Shell Code Picker

Shell Picker

Shell Template Picker
SYS Date Picker

User Picker

WBS Code Picker
WBS Picker

Week Picker

Work Package Picker

v v v Vv

VvV vV vV vV vV vV vV VvV VvV v v v

Refer to the Unifier Data Reference Guide for details.

Creation Step

The create BP record form opens as a pop-up window. When you create a record, the list of
values the form contains tabs (main form and line item tabs), and toolbar options. The main form
is displayed as the first tab and each line item tab appears as subsequent tabs. The left pane
displays the record details and line item details. The right pane displays additional tabs
associated with the main form or line items. You can resize the left and right panes using the

Resize *icon.

Main form:

The main portion of the business process form contains information about the BP record, such
as the name of the record, description, who created the record and when, and other general
information. Additional informational blocks defined by your administrator are also displayed.
You can collapse and expand these blocks.

Toolbar Option Description

Save To save a draft of the form. You can view
your drafts under Home > Drafts.

52



Working with Business Processes

Toolbar Option Description

Send To route a workflow business process to
the specified recipients. This option is
displayed only for workflow BPs.

Submit Use Submit when you have finished
editing a record. Displayed on all Non
Workflow BPs when in Edit Mode.

The options you see under this menu are
based on the BP design.

Menu

» Auto-Create: Displayed on any BP that
can auto create other BPs.

» Print HTML, PDF and Custom:
Displayed on all BPs. You cannot print
draft records.

» Export Line item template: Displayed
on any BP that has detail form
integration interface defined.

» Reload: Displayed on all BPs. This
option will reload the page.

» Help: BP specific help option. Your
company or project/Shell administrator
may provide a custom Help file to give
you information about a specific
business process. If a custom help file
is available, it will be listed under the
Help menu for the business process
log or form.

» Close: Close the record.

The right pane displays the following tabs associated with the main form: Attachments,
Comments, linked Records, and Linked Mail. For Portal BPs, Attachments and Comments tabs
are displayed.

If the Attachments tab of the business process form contains any attachments, an Attachment

@ indicator is displayed. If the tab contains no attachments, the right pane is refreshed and the
indicator is no longer displayed.

If the Comments tab of the business process form contains any comments, a comment indicator
(B) is displayed. If the tab contains no comments, the right pane is refreshed and the indicator is
no longer displayed.
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Line Item form:

Line item tabs are displayed after the main form tab. All line items are displayed on the left pane,
and the right pane displays the details form associated with the selected line item. The right
pane contains the Details form, Attachments, and Linked Records. The Attachments tab is
displayed only if the line item form supports the addition of attachments. Query based tabs will

not be seen in the Creation step. The gear menu ( % ) displays next to each line item on the left
pane and contains all available actions you can perform on the line item. The following options

are displayed on the gear menu ( & ): Copy, Copy With Attachments (option seen only if
attachments exist), Add to Group, and Remove. The Copy, Add to Group, and Remove options
are displayed only if it is specified in the form design.

Toolbar Options Description

Add To add new line items. The Add button will
be seen only if the form design allows for
line item additions.

Actions The following actions will be seen:

» Import
» Consolidate Line ltems

C Refresh Refreshes the line items. All unsaved
manual edits will be lost.
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Toolbar Options Description
S Print Print Prints the list view. You can choose from:
Print, Export To CSV, Export To Excel.
Notes:

» For export to Microsoft Excel, the
system currently supports only Euro
(EUR) and United States Dollar (USD)
currency symbols.

» If you export data from a business
process (BP) record, sheet (such as an
Activity Sheet), or log (such as
Company Funding Sheet Log) to
Excel, be aware that depending on
how your negative values are
formatted, you might need to configure
your columns in Excel to match the
correct data type (Number). Otherwise,
the columns will not be treated as
numeric and will not sum as expected.
One supported format includes placing
the negative sign between the currency
symbol and the amount (for example,
$-1,000).

Q  Search Enables users to search for specific line
items across all pages.

Enables users to find items on the
displayed page. When you click this
option, the system inserts a row that lets
you enter filter parameters.

H

Find on Page

To expand or collapse line items groups.
These icons are displayed only when line

® Expand All Groups item groups are present.

© Collapse All Groups

Update Step

The following options are displayed when the form is in edit mode.

Toolbar Options Description

Send To route a workflow business process to
the specified recipients. This option is
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Toolbar Options

Description

displayed only for workflow BPs.

Save

To save a draft of the form. You can view
your drafts under Home > Drafts.

Submit

Use Submit when you have finished
editing a record. Displayed on all Non
Workflow BPs when in Edit Mode.

= Menu

The options you see under menu are
based on the BP design.

»

»

Auto-Create: Displayed on any BP that
can auto create other BPs.

Print HTML, PDF and Custom:
Displayed on all BPs.

Export Line item template: Displayed
on any BP that has detail form
integration interface defined.

Terminate Record: Displayed on all
BPs. This option is displayed only if the
user has permissions to terminate
records.

Transfer Ownership: Displayed on all
BPs. This option is displayed only if the
user has permission to transfer
ownership.

Undo Accept Task: Displayed on all
workflow BPs. This option is displayed
only after the user has accepted a
task.

View Map: Displayed on all BPs that
support geo-coding.

View Step

The View BP record form contains read-only fields and options that are applicable in the View
step. The form is divided into two panes- the left pane displays the main upper form and the line
items associated with the record, the right pane displays additional tabs associated with the
main form or line items. The main form is displayed on the left pane as the first tab, and each
line item tab appears as subsequent tabs. You can resize the left and right panes using the

Resize * icon.
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The main form contains Task Details and other informational blocks defined by your
administrator. You can collapse and expand these blocks. The Task Details section of the form
contains details of the assigned task and displays the following fields: From, To, CC (if
applicable), Sent For, and Task Due Date (displayed if the task has an assigned due date). This
section is not shown for users who have previously declined the task or are on the CC list.

The Attachments, Linked Records, General Comments, Linked Mail, Reference Records,
Workflow Progress (displayed if user has permission to view progress), and Audit Log (displays
only if user has the required permission) appears as tabs on the right pane. The information in
these tabs is read-only.

Toolbar Option Description
Accept Accept a task. This option is displayed for
workflow BPs. You may see this option if
your non-workflow BPs is an | Step record.
Decline Decline a task. This option is displayed for
workflow BPs. You may see this option if
your non-workflow BP is an | Step record.
= Menu The options displayed under this menu will
vary based on the BP design.
» Add more assignees (Displayed for
workflow BPs.)
» CC more users (Displayed for workflow
BPs.)
» Review
» View Record location
» Auto-Create
» Export Line Item Template
» Email as Attachment
» Print - HTML, PDF and Custom
» Terminate Record
» Transfer Ownership
» Help
» Close
Edit Edit non-workflow BPs. This option is
displayed only if you have permission to
edit.
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About Workflows

The Unifier workflow engine routes a business process form through your company's business
protocols.

When you participate in a business process workflow, you are taking action on the form (for
example, reviewing and approving an invoice, or responding to a request for information).
Depending upon the workflow setup, you may choose the next recipient of the business process
in the workflow, or this may be automatically selected for you. When you send the business
process to the next step, it proceeds along the workflow and records each action taken at each
step.

Fewigion

'y
Send for Revision Rasubmi Send Back Rajecl
for Clarfication

Rissmsys ApTinovad

Send far > Send for > Apprive
Rty Approval

In the workflow example above, the form is created and filled out, and then sent for review. The
reviewer has the option of sending the form for revision (after which, it is resubmitted to the
reviewer), or sending it on for approval. The approver may send the form back for further
clarification or revisions, may reject the form, or may approve the form. A rejection or approval
status essentially ends the workflow. At the approval or rejection step, the business process is
considered to be in a "terminal” status, and this status cannot be changed; however, comments
and certain edits can still be made to the record. From a terminal status, the business process
proceeds to the End step.

Note: A "terminal” status differs from a "terminated" status. A business
process is at a terminal status when it reaches the final step in the
workflow. A business process with a terminated status was stopped at
some point before it reached the final step in the process.

Auto-Populating Fields in a BP Record

Using the auto-population feature, you can automatically populate fields on a form or line item at
the time the form/line item is created. Auto-population can occur on business processes that are
in the same shell, or across shells. Using auto-population means that you do not have to enter
data in every field in a form. For example, this feature could automatically fill in a "Plant
Location" field from an attribute form.

For another example, the date field on a time sheet could be set up to default to the server date
and time so that you do not need to use a date picker. Or a field could be set up to automatically
display a title or other text that you would normally need to fill in on a frequent basis.

58



Working with Business Processes

In addition, auto-population can be used with the Unifier portal. When a user logs into the portal
to submit a form, such as a work order, the user's information, such as his/her location and
department, can be automatically populated on the work order. Or when an employee "move"
request is created, the current location of the employee can be auto-populated onto the move
request form.

Fields on a form can be auto-populated from the following sources:

Fields on an attribute form for managers (except a code-based configurable manager)
Fields on another business process form or line item

Fields on a user attribute form (via a user data picker)

Shell attribute forms

Fields from an upper form (to fields on a detail form)

Fields on single-record BPs at the company, shell, or project level

Fields on an SOV (for a payment application BP)

Fields from document properties of a line item attachment

The total value from a line-item numeric field (can populate a field on an upper form;
becomes a read-only field)

» A constant value that was specified for a field when the form was created

vV vV vV vV vV VvV vV v v

Reverse Auto-Populating (RAP) Fields in a BP Record

Some data elements on forms can be updated using "reverse auto-population.” These data
elements are specified when the form is designed. Reverse auto-population means that some
values can be automatically updated when other values are modified in a business process
form.

» The data fields in a business process form can be updated through reverse auto-population,
including those in the behavior set of a DDS.

» Reverse auto-population does not occur for projects and shells with View-Only or Inactive
status.

» Reverse auto-population is not supported for non-workflow business process records that
have an Inactive status.

» Reverse auto-population is not supported for single-record business processes, except in the
case of BPs existing under child shells, which can reverse auto-populate to single-record
BPs under any parent shell in the shell hierarchy.

» The system does not allow Reverse Auto-Population (RAP) for any data pickers that use the
BP Line Item selectors. None of data picker data elements (including the user data picker
data element) can have "Reference BP Line Item Selectors," when defining Reverse
Auto-Population (RAP). Other data elements can have "Reference BP Line Item Selectors,"
when defining RAP.

Reverse Auto-Populating (RAP) on line items will not cause the system to re-evaluate the upper
form elements that may depend on the line item values.
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Reverse Auto-Population in Auto-Created Business Processes

A business process can be designed to update the record or line item that auto-created it. For
example, a Meeting Minutes business process auto-creates Action Items business processes
from line items. If you update the Meeting Minutes business process line item, the Action Item
business process can be updated via reverse auto-population.

In another case, if a business process auto-creates a new line item for an existing record, that
line item can be updated with information from subsequent steps in the workflow.

Business cases that might use reverse auto-population:

» A work order could reference the line items on a preventive maintenance type business
process. Certain updates in the work order could be reverse auto-populated onto the line
items of the preventive maintenance type business process.

» Changes to the detail form in a business process under a child shell could result in
changes to the upper form of a single record non-workflow business process under any
parent shell in the shell hierarchy.

» Lease payment requests could be auto-created from a lease business process. An
approved payment request could reverse auto-populate the lease BP's line item status to
"approved."

» A move order business process could reference an asset record. Updates on the move
order could be reverse auto-populated onto the asset record.

» An office move order business process could reference a user attribute form. After the
move is complete, the user's new location could be updated on the attribute form. (This
kind of reverse auto-population is normally triggered when you choose a user from a data
picker, rather than when a business process is auto-created.)

Reverse Auto-Populate Status of Non-Workflow BP

The Status DE on a non-Workflow Business Process can be Reverse Auto-Populated (RAP)
from another non-Workflow or Workflow Business Process.

Example

A non-Workflow Asset Business Process (BP) (a non-workflow BP) record is in an
"In_Service" status. Another Business Process goes through approvals to shut down that
Asset. As a result, the Asset BP status changes to "Inactive."

The following explains the function of the Data Element (DE) of Data Definition (DD) = "Record
Status Pulldown" at runtime:

If the DE is set to Reverse Auto-Population on a BP form and a default value has been defined,
then the BP form renders the DE to display the default value. You can change the default value.

If the DE is not set to Reverse Auto-Population on a BP form, then the BP form renders a
read-only value because the BP form does not have a configured RAP, in which a dataset has
been defined for the DE.

Example

BP Form 1 is configured for RAP and two DDs (DD = "Record Status Pulldown") have been
set as A and B. The BP Form 1, will render the DE as Editable, Required, or Read-Only as
defined. If the DE is designated as "Editable," you can select A or B.
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BP Form 2 is not configured for RAP, so the BP Form 2 renders the DE as read-only,
irrespective of the settings. The DE value is the one that you have selected for BP Form B.

BP Form 3 is configured for RAP and two DDs (DD = "Record Status Pulldown") have been
set as C and D. The BP Form 3, will render the DE as Editable, Required, or Read-Only as
defined. As a result, the value from BP Form 1 is deleted. If the DE is designated as
"Editable,"” you can select C or D.

BP Form 4 is configured for RAP and two DDs (DD = "Record Status Pulldown") have been
set as D and E. The BP Form 4 will render the DE as Read-Only as defined. If you select C
in BP Form 3, the value is deleted. If you select D in BP Form 3, the value will be retained. If
the DE is designated as "Editable," you can select D or E.

If RAP is configured such that the destination is a non-Workflow BP, and the destination record
is in finished or edited state, then the RAP first brings the record to an "Edit" state and then back
to finished or edited state (rollback).

Reverse Auto-Populate Status of Workflow and non-Workflow BP Errors

The Reverse Auto-populate (RAP) will fail if an invalid or inactive Status has been defined in the
dataset value during RAP configuration of a destination non-Workflow BP. (Error messages
might include: RAP to "Status" has failed because an invalid value was detected in the source
element. Or: The data element cannot be updated in destination BP as record status is inactive.
Or: The selected record status is inactive in destination BP and cannot be updated.) The system
logs these errors, which you can send to the user who has been designated to receive source
BP error notifications in the Business Process Setup window > "Send error notification to." The
error email notification will have the following two additional fields to assist the recipient with
identifying the source:

» Destination Reference
» Source Reference
You can find the reasons for the reverse auto-population (RAP) failures in the audit log of the

business process record. In addition, on occasion the system generates error codes for reverse
auto population failures which can be used to troubleshoot the reverse auto population failures.

Reverse Auto-Populate Status and Email Messages

The Reverse Auto-populate (RAP) email messages will notify your if the RAP fails, during
runtime, and include the following details for better traceability:

Note: The Reverse Auto-population (RAP) option can take place
between different elements, if the option is included for those elements.

For Source Business Process and Destination Business Process:

» Destination Reference with BP Record number (Destination Reference: Where you have
the field with a value that can change through RAP.)

» Source with Source BP Name (Source Reference: Where you have the field with a value
that you can change, and as a result, update the Destination through RAP.)

» Source Reference with Source Record number
For Source Business Process and Destination P6 Activity Sheet:
» Destination Reference with P6 Activity ID (uuu_P6Activityld)
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» Source with Source BP Name

» Source Reference with Source Record number

For Source Business Process and Destination Asset:

» Destination Reference with Asset Name (uuu_asset_name)
» Source with Source BP Name

» Source Reference with Source Record number

For Source Business Process and Destination Planning:

» Destination Reference with Planning Item (uuu_planning_item), if feasible
» Source with Source BP Name

» Source Reference with Source Record number

For Source Business Process and Destination Shell:

» Destination Reference with Shell

» Source with Source BP Name

» Source Reference with Source Record number

The following is a sample of an RAP email message that displays the changes done when a
data element is reverse auto-populated.
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Viewing Messages or Cc'd Tasks

If someone copies you (Cc) on a task, it is not a task for you, but it is for your information only
and called a message. These business process record copies are listed in your Notifications
log. You will usually be notified by email when you have a new a message. If you receive an
email notification, click the hyperlink at the bottom of the email. You will be directed to the Sign
In screen and, after you log in, to the project or shell or company Notifications log.

Note: Noatifications for View-Only projects or shells are listed in the
Notifications log, but you cannot add general comments to these
messages.

Notifications are view-only snapshots of the form at a particular step and remain available for
viewing until the BP is sent to the next step. Notifications received for an end-step will remain
available in the log.

To view your messages from:

» Home workspace > Home node > click the Messages link listed under Items Requiring
Your Attention.

Home workspace > Notifications.
Project/Shell tab > User mode > Notifications.

Accessing a BP Record from an External System

The system provides a data element for business processes that can display a URL for access
to Unifier from an external system. If the business process contains this URL field, you can open
a view-only copy of the record from that external system.

For example, you might have notifications from the system that are sent to email programs, such
as Microsoft Outlook or Yahoo Mail. From that email program, you could open a view-only copy
of the business process. Or, you might have an approval process that resides outside of the
system. At a certain point in the workflow, the business process record data could be sent from
Unifier to that external approval process. From that external system, you could open a view-only
copy of the business process record.

Note: If this business process created records before this URL field was

added to the form, those records will not show data in the URL field.
Only new records will show data in the URL field. Any business process
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designed to be opened from an external system must be available in the
Master Log - Business Processes grouping node.

To open a business process from an external system

You must be an active member of the project, shell, or sub-shell, and have at least view
permission to the Master Log - Business Processes grouping node that lists/contains the
business process record you want to view.

Use the URL to access Unifier. This URL will open the Sign In window. After you are signed in,
the system will display the business process record in view-only mode.

Note: If the system has been configured to sign in users using single
sign-on (SSO), the Sign In window will not appear.

Depending on what permissions you have, you can take the following actions from this view-only
copy of the record:

Terminate the business process

Print the business process

Send Mailbox

Transfer ownership

View reference records

View the audit log

View record attachments, general comments, linked records, and linked Mailbox
Click line item tabs and open the line items in grid view

Use the Find feature to locate line items

Use any hyperlinked field, such as a picker, an image, or a URL, or the workflow progress
link

» View the assignees and cc'd users on the step

VvV vV vV vV vV vV vV v v v

Business Processes in Company Logs and Logs Nodes

The Company Logs grouping node is in Company Workspace, and the Logs grouping node
can be accessed in a project or shell. You can use the Company Logs grouping node and the
Logs grouping node to access the business processes which you have permission for.

Note: By default, the out of the box (OOTB) version of the product
includes a Company Logs grouping node in the Company Workspace
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and a Logs grouping node in projects and shells. If the Company
Administrator configures the User Mode Navigator for your organization
and modifies the appearance and organization of the modules and
business processes that are available in the left Navigator, the
Company Logs and Logs grouping nodes might be named differently.
For example, you might need to select the Budget Management module
in the left Navigator to view the Business Process log (BP log) for it.

You can use the enhanced Search option (described in the table) in the following logs and logs
nodes:

Vv vV vV vV vV vV vV v v v

Company Logs

Tasks log

Drafts log

Logs

Line Item Consolidation page
BP Picker

BP Data Picker
Query-Based Tab (QBT)
Bidder Log

Portal Log

To access the business processes in Company Logs grouping node

1)
2)

Go to the Company Workspace tab and switch to User mode.

In the left Navigator, expand the Company Logs grouping node to see the business
processes.

To access the business processes in Logs grouping node

1)
2)

Go to the project/shell tab and switch to User mode.
In the left Navigator, expand the Logs grouping node to see the business processes.

The following explains the log elements in both Company Logs and Logs grouping nodes. The
logs in each grouping node are divided into two panes, left and right.

The toolbar options and columns on the left pane are:

Create To create a new record and subsequently

add attachments, add comments, and
include link to other records.
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Actions To perform the following actions:
Import

Export CSV Template

Export Microsoft Excel Template
Create From Template

Bulk Edit

Print

Transfer Ownership

Terminate Record

v vV v vV vV vV v Vv

View To change the view of the log based on
the following options:

» All Records (default)

» Records Created by Me
» Records Received by Me
4

Records Created and received by
Me

» Records from My Company
» Create New View
Manage Views
Edit View To edit the current view.
Refresh To refresh the contents of the log.
Print To print or export the contents of the log.
Search Lets you search the log for a specific field

or combination of fields, which filters the
BP records based on the selected criteria.

In addition to completing the applicable
fields that are displayed in the Search
window, you can use the wildcard
characters percent (%) and underscore ()
to refine your search. The percent
character represents any number of
characters, including letters, spaces,
numbers and so on; the search returns all
results that contain the search string. The
underscore character represents one
character.

For example, in a Title field, enter Co%ts.
The list of results contains all records that
include a word that starts with Co and
ends with ts.
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Find on Page Lets you find items on the displayed page.
When you click this option, the system
inserts a row that lets you enter filter
parameters.

View Help Menu Enables you to access the:
» Specific help for the selected BP
» User Productivity Kit

The tabs on the right pane are as follows. The information in each tab corresponds to the record
that has been selected.

Note: Displaying a tab depends on the business process type, such as
Workflow or non-Workflow.

Record Details Enables you to see the details of the
record that are selected on the left page.
The record details seen depend on the
form that you have access to.

Workflow Progress Enables you to see the details of the
workflow progress which includes:
View Graphic

Title

Record Number

Current Step

BP Setup Used

Step Name

Assignee

Company: This column displays the
assignee's company name. For Partner
users, this column shows the
assignee's Partner Company name.
» Status

» Action

» Completion Date

You have the option of filtering (Filter By)
the information displayed on the workflow
progress.

v v vV vV vV vV v Vv
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Attachments Enables you to access the record
attachment, if available. For each
attachment, you can click the gear menu to
conduct the following:

» Open
» Open in AutoVue (You can also open

an attachment by double-clicking the
name of the attachment)

» Download

Additional View Form Accessibility in Record and Log Previews

When you view the record preview and the record details upon opening a record, the content
seen depends on the form that you have access to. Your administrator may have set up
restrictions to view certain form data and may have given access to a View form. This View form
may be different from the View form associated with the workflow.

If you have View restrictions for multiple View forms, then the first View form from the View
Forms list in the BP setup is displayed. If you do not have View restrictions, then the Step form is
displayed. This is applicable for Record Owners, Record Editors, and Step Editors.

If the end form is an Action form and you have View restrictions, then the appropriate View form
is displayed. However, if you do not have View restrictions, then the Action form is displayed.

If the end form is a View form and you have View restrictions, then the Restricted View form is
displayed. However, if you do not have View restrictions, then the View form that is part of the
end step of the workflow is displayed.

Record Content Impacted by Additional View Form Accessibility

The additional accessibility of View forms impacts all areas where you can open and view record
content. These areas are listed below:
Workflow BP and Task logs
Reference Records
Linked Records
Dashboard Drill Down Records
BP Picker, BP Data Picker, and BP Creator links
Permission-driven Data Sources
Cost Sheet, Funding Sheet, SOV Sheet, Schedule Sheet, and so on
Email Notifications
» If you have View restrictions for the View form in the BP setup, then the email has

the data elements that are part of the View form. In the case of a task assignee, if
the previous check box is not selected, then the email has the Step form elements.

» HTML and PDF Print views
» If you have access to a Restricted View form, then the View form data is
displayed.
I-Step Records
Mobile applications

Vv vV vV vV vV vV v Vv
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Note: Additional accessibility is not applicable for Master logs since the
BP setup is done at the project and shell levels.

When user is an |-Step Assignhee, and the record is in the |-Step (initiation step), the existing
form will be seen as read-only end-form for Workflow BP records and read-only action-form for
Non-workflow BP records.

If the user is an |-Step Assignee but not the creator of the record, and the record is in
post-creation step, then restricted view form will be seen if the I-step Assignee has access to
restricted view forms.

When I-Step Assignees have access to restricted view form, the following rules apply:

User Name User Role Record Status Form

The form that will be
seen upon opening
the record, as well
as in the Logs (BP

log) Preview.
User A I-Step Assignee Initiation Step Read-only Action
Form/End Form
User B I-Step Creation Step Action Form
Assignee-Creator
User C I-Step Assignee-Not | Creation Step Restricted View
a Creator Form

Deleting View Forms

When you delete a View form, the system removes the View form from View Forms tab in the
Business Process Setup window.

Important

When you delete a View form in the Staging environment and create a new View form, the new
form:
a) Gets the ID of the deleted form (permissions, users, and so on).

Company Workspace > Admin mode > uDesigner > Business Processes > BP ... View
Forms (delete or add new one).

b) Appears in the Business Process Setup automatically; meaning, it does not go through the
regular way of creating a new form, deployment, and then added (within the BP Setup
module).

Project/Shell > User mode > Business Processes Setup > BP ... (same as above) View
Forms (Deleted or added new one)

When you open a Non-Workflow Business Process, the system checks to see whether you have
the appropriate permissions.

Note: There are no changes to the Permissions tab in a Non-Workflow
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Business Process log and Access Control.

To be able to view Non-Workflow Business Process records, you must have the following
permissions:

4
4
4
4

Navigation-level access (left Navigator) to view the Non-Workflow Business Process record.
View All Records

View Company Records

View User Records

At the Non-Workflow Business Process log level, you must have at least the "View" permission
to view the record content.

The Views setting of the Permission Settings block (View Forms tab) of a Non-Workflow
Business Process sets the visibility of the data (including tabs) when you open the record.

Create a New View of aLog

1)

2)

3)

4)

5)

70

Open the applicable log and select Create New View from the View menu.
By default, the Columns tab is selected.

From the Available Columns box, select the columns that you need and click the Move icon
(the single arrow icon pointing to the right) to move your selected column to the Selected
Columns box.

The Selected Columns box contains the columns that are seen in the log view. The last
column in the Selected Columns box is not available for locking.

If you want all the available columns to be seen in the log view, select one column in the
Available Columns box, and click the Move All icon (the double-arrow icon pointing to the
right) to move all columns to the Selected Columns box.

To move multiple available columns at the same time, select one column in the Available
Columns box, hold down the Ctrl key, select each additional column from the Available
Columns box, and then click the Move icon (the single arrow icon pointing to the right) to
move all the highlighted columns to the Selected Columns box.

You can move each column in the Selected Columns box by using the:

» Move Up icon (the single up-arrow icon)

» Move Down icon (the single down-arrow icon)

You can move multiple columns in the Selected Columns box by using the:
» Move to Top icon (the double up-arrow icon)

» Move to Bottom icon (the double up-arrow icon)

To lock columns in the log view or determine the number of records, or both, use the
following drop-down fields in the New View window, respectively:

» Lock after selected Column
» Number of Records per Page
Complete the Filters tab.

If you want to view only non-workflow BP records that are in an editable state (that is, you
want to exclude records that have a status such as submitted, terminal, or initiated), select
the applicable options in the Record section, and then set the Show Edit Records option to
equals and to Yes.
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6) Complete the Group By tab.
7) Complete the Sort By tab.
8) When you are done, enter a name for your view in the View Name box, and click Save.

Creating a Business Process (BP) Record

You can create a business process (BP) record and access that record from any of the business
process logs (Company Logs in Company Workspace or Logs in a project or shell).

Note: You must have the proper permissions to create a BP record.

After a workflow record is created by using any workflow schema (unique combination of Setup
Name + Workflow Name), the workflow record continues to reference the workflow schema even
if the status of the workflow schema has been set to Inactive.

This condition includes workflow records that are in the following statuses:

» Draft
» Initiation Step (I-Step)
» Also, this condition includes any workflow record at any other step in the workflow.

If there is an Active BP Template, then the Template continues to create records referencing the
Inactive workflow schema. For instructions on creating a template, see Creating BP Templates
and Scheduling BP Creation.

A new BP record can be created in the following ways:

» Manually create a new BP record, starting with a blank form.

» Copy an existing BP record in the same log. The fields will be populated with the original
record entries, which can be edited as necessary.

Create a BP record from a template.

Auto-create a BP record from another record at a specified step (S-Step) in a workflow.
Auto-create a BP record when certain conditions are met or at a specified frequency.
Create a BP record from the Master Log - Business Processes grouping node.

Create a BP record from within the Document Manager, selecting the documents or folders
to include as attachments.
» Auto-create a BP record using the Scope Management feature of the Schedule Manager.

v v v v Vv

Before you begin Creating a Business Process (BP) Record

Be sure that you have the proper permission settings. All functions are controlled by fully
configurable permission settings, including creating business processes. Contact your project or
shell or company administrator regarding permission settings.

A business process (form and workflow) must be imported, configured, and set up by an
administrator before it can be used.

You cannot create records of other business processes in a business process log (except in the
Tasks log and Master Log - Business Processes grouping node).
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For a Workflow Business Process, when you create a record, if the next step is match step
Creation (per workflow setup), then the To list will be populated with the user who has signed in.

The users that have been removed from the group, and the newly added users, will not be
displayed in the Workflow page, when you create a BP record manually, by way of a template.

Gaps in Generated Business Process Record Number

The Business Process (BP) record number is sequentially generated when you create a record.
The newly generated record number is locked so that other records (being created at the same
time) cannot use that number. If the BP record cannot be created for any reason (for example,
Cost Sheet rules or validations that exist at the SOV level), the system only voids the generated
record number and does not reset the record numbering sequence to allow another BP record to
pick up that generated number. This operation generates gaps in BP record number generation.

Manually Creating a BP Record from a BP Log

The following is a general procedure that can be used to create a new BP record from any BP
log (Company and/or Project/Shell -- Company Logs and/or Logs).

Company Logs
To create a new BP record from Company BP log:

1) Go to the Company Workspace tab and switch to User mode.
2) Inthe left Navigator, expand the Company Logs grouping node.
3) Select a BP and open the BP log.
4) Click the Create icon to open the Create New <BP NAME> window.
The Create option is not available if you do not have the permission to create a record.

You cannot create records of other business processes in a business process log (except in
the Tasks log and Master Log - Business Processes grouping node).

Example

You cannot create a Meeting Minutes business process record in an Action Items business
process log.

5) When finished, click Create.

Shell or Project Logs
To create a new BP record from Project/Shell BP log:

1) Go to the project/shell tab and switch to User mode.
2) In the left Navigator, expand the Logs grouping node.
3) Select a BP and open the BP log.
4) Click the Create icon to open the Create New <BP NAME> window.
The Create option is not available if you do not have the permission to create a record.

You can no longer create records of other business processes in a business process log
(except in the Tasks log and Master Log - Business Processes grouping node).

Example
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You cannot create a Meeting Minutes business process record in an Action Items business
process log.

5) When finished, click Create.

Manually Creating a BP Record from the Master Log

If you have permission to create BP records, then you can go to the master log (Home
workspace > Master Log - Business Processes grouping node).

Note: The name of the Master Log - Business Processes grouping
node can be customized.

Auto-population and reverse auto-population are also supported for BP records that are created
or edited in the master log.

Note: The default elements and fields (log layout, view, search, and so
on) that are defined in the Standard Log determine the Standard user
interface elements and fields of all logs.

The following BP records actions and functions are not supported in the master log:

» Import template
» Export template
» Permissions

There are specific conditions for creating workflow BP records and non-workflow BP records in
the master log.

Creation conditions for workflow BP records:

» The BP must have an Active setup in the selected Project/Shell.
If no active setups exist for the BP, the system will notify you.
The selected Project/Shell controls the list of enabled workflow setups.
You must be an assignee on the Create step of the BP, within the selected Project/Shell.

If you save a BP record (during its creation) instead of sending it, the system lists the BP
record drafts folder (Home workspace > Drafts) and not the master log.

» After you create a BP record, the system lists the BP record in both the:
» Project/Shell BP log (Project/Shell > User mode > Logs)
» Master log (master log (Home workspace > Master Log - Business Processes
grouping node)

Creation conditions for non-workflow BP records:
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» The BP must have an Active setup in the selected Project/Shell.
If no active setups exist for the BP, the system will notify you.
You must be on the Creator list, for the BP, in the selected Project/Shell.
After you create a BP record, the system lists the BP record in both the:
» Project/Shell BP log (Project/Shell > User mode > Logs)
» Master log (master log (Home workspace > Master Log - Business Processes
grouping node)
To create a BP record from the master log:

1) Go to Home workspace.

2) Inthe left Navigator, expand the Master Log - Business Processes grouping node.
3) Select a BP and open the BP log.

4) Click the Create icon to open the New Record window.

5) Select a value for the Business Process Origin field.

The Details icon (Eg?:), next to the Select Business Process Origin field drop-down list in
the New Record window, lets you see a list of available options. The list on the left pane is
displayed according to your permissions. After you select an entry from the list and click
Select, your selected option becomes the value of the Select Business Process Origin
field of the New Record window.

The Select Business Process field displays the BP that you have selected to create a
record for.

The New Record window, for a BP, has a Select Workflow field which displays value if:
» The BP is a non-Workflow BP.
» There is only one Workflow schema available that you can choose.

6) When finished, click Create.

Single Record Business Process in Master Log
A single record BP is available at the shell level, and it lets you define additional shell attributes.

You can access the single record BPs, and their subsets, in the Business Processes functional
node of the master BP log (Master Log - Business Processes grouping node), if you have
permission. In the master log, you can access single record BPs and perform the following
actions:
» View and edit the BP record information.
» Perform bulk edit on the BP record, across all shells.
» Define filtered views.
The Business Processes log (under the master BP log) displays the following information in
columns:
» Project Number
Displays the shell number.
» Project Name
Displays the shell name.
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» Project Status
Displays the shell status.
» Title
Displays the uuu_title value from the record.
» Creator
Displays the name of the creator of the record.
» Record Status
Displays the single BP record status.
» Last Updated Date
Displays the date that the single BP record was last modified.
Similar to other BPs in the master log, when you have permissions, you can perform the
following actions (under the Actions option):
» Bulk Edit
> View

Users or Groups with View permission can:

» View the single record business process, per project or shell, within the log.
» Update the record if they have the Bulk Edit permission.

All the Data Elements (DEs) that can be bulk updated are based on the integration settings.

When you bulk edit the single record business process records in the master log, you can
update the common attributes across all shells or projects.

Additional Information about Single Record BPs, in Master Log
The following provides various scenarios related to the permissions granted to a user.

View permission for single record BPs, in master log will enable the user to view:

» Information about all of the records across all shells. Viewing all of the single record BPs
in the shell hierarchy, is based on the highest level of the hierarchy.

» All of the single record BPs across multiple shells, with Active and On-hold status. This
will prevent the need to navigate to the individual shells for updating the single record
BPs details.

Bulk Edit permission for single record BPs, in master log will enable the user to bulk update:
The default values of the single record BPs, for the selected shell instances, from the
master log.

You can navigate to updated single record BPs, in the master log, and verify that the default or
existing values have been updated.

To attain a hard copy, or electronic copy, of the single record BPs in the master log, you can
generate HTML, PDF, or custom format of the records by using the Print option.

For the single record BPs in the master log, you can view the following source information about
the record information under the following columns:

» Shell Number
» Shell Name
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4
4
4
4

Shell Status

Creator

Record Status

Last Updated Date

The system will maintain the shell-level BP permissions, when displaying the single record BPs

in master log. This ensures that you only edit the records that you are a member of its creators
or record editors, per the pertinent list at the shell-level.

You can:

»

Define a custom view for the master log which includes filtering option by columns. This lets
you view all the single record BPs according to your customized filtering and grouping.

Use the Find on Page option in the master log, and filter the existing single record BPs.
Use the Search option, based on the master log columns and filter the single record BPs
that | want to see.

Select multiple single record BPs, in the master log, click Bulk Edit (Actions options), and
see all of the DEs that have been defined in the Integration tab with direction set as Both.
Edit multiple DEs in the Bulk Edit window and click Update. This causes all of the selected
DE values to be updated, across all shells.

Manually Creating a BP Record from the Tasks Log

1) Go to the Home workspace and click the Tasks node.

2) From the Tasks log click the Create icon to open the New Record window. When you
create a BP record:

3)
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The Create option is not available if you do not have the permission to create a record.

You create records of other business processes in the Tasks log and Master Log -
Business Processes grouping node, only.

In a BP log (BPs within the Master Log - Business Processes grouping node or within
the Logs node), you can create records of that particular business process, only. For
example, when you go to the Master Log - Business Processes grouping node to
create a Budget Change BP record for your Cost Management, when you click Create,
the system does not let you select any other type of BP record other than a Budget
Change BP record.

You generate tasks for assignees on the next step, and the tasks appear in the
assignees' logs.

The newly created BP record (including the status) appears in the BP log, as the BP
record moves through the workflow.

Select a value in the Select Business Process Origin drop-down field.

The Details icon (EI'B), next to the Select Business Process Origin field drop-down field, in
the New Record window, lets you see a list of available options.
The list on the left pane is displayed according to your permissions.

Select the option from the left pane, select an entry from the list (on the right pane), and click
Select. The list of business process names includes those business processes that you have
the "Create" permission for.
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Your selected option becomes the value of the Select Business Process Origin field of the
New Record window.

If applicable and if you have the "Create" permission, select a workflow from the Workflow
drop-down field.

4) Inthe Select Business Process field, click the drop-down list and select a BP that you want
to create a record for.

The New Record window, for a BP, has a Workflow drop-down field which displays a value
if the BP is a non-Workflow BP.

Note: There is only one workflow schema available that you can choose.

5) When finished, click Create. The BP record is now created in the appropriate log.

1)

Creating a BP Record by Copying an Existing BP Record

You can copy an existing business process record to create another business process record of
the same type.

The original data in all data entry fields, including line items (if applicable), will be copied. For
most business processes, you will have the option to copy attachments to the new form. Other
attached information, such as general comments, linked records, and linked Mailbox, will not be
copied.

The copied record will reflect the data found in the original record. Auto-populated fields will not
be refreshed or recalculated.

For non-workflow BPs, copying a record results in creation of a record and not creation of a
draft.

In addition, you can restrict the line items to be copied and specify other copy options by using

the Copy with Conditions copy option. The Copy with Conditions lets you:
» Copy specific (rather than all) line items
» Include or exclude attachments
» Retain or remove references to records auto-created from an upper form
» Retain or remove references to records auto-created from line items (from all tabs)
» Include linked records

The above options are not available for Payment Applications.
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Business processes that have been auto-created and are currently in the Initiation step (prior to
the Create step in the workflow) cannot be copied. You cannot copy these business processes
until the record has been sent or is in a "finish edit" status.

To create a new BP record by copying another BP record in Company BP log:

1) Gotothe Company Workspace tab and switch to User mode.
2) In the left Navigator, expand the Company Logs grouping node.
3) Select a BP and open the BP log.

4) Click the gear menu ( %¥ ) next to the record that you want to copy and select one of the
following options:
» Copy with Attachments
» Copy without Attachments

5) Follow the prompts to complete copying your record for use.

To create a new BP record by copying another BP record in Project/Shell BP log:

1) Go to the project/shell tab and switch to User mode.
2) In the left Navigator, expand the Logs grouping node.
3) Select a BP and open the BP log.

4) Click the gear menu ( %¥ ) next to the record that you want to copy and select one of the
following options:
» Copy with Attachments
» Copy without Attachments

5) Follow the prompts to complete copying your record for use.

Note: You cannot create a new BP record by copying another BP record
in Tasks log (Home > Tasks functional node).

Reset on Copy of Record
A reset works on Workflow business process records, only.
If the Action form associated with the "Creation Step" of record has data elements that have
"Reset" property, then after copy the system resets the values of these fields.

» If the reset is done on an element that has a data set of value/label pairs, and if there is a
default value specified, then the default value is displayed.

» For fields with Data Picker as auto-population source, if the value of the Data Picker (as
auto-population source) has been reset, then the system resets the value of the field. This
means that the auto-population of the form fields from a Data Picker will change if the Data
Picker value is reset.

After a reset is done, any formula that depended on the Reset field will be re-evaluated.

If a default value has been specified for a Data Element with Reset property, then this default
value will be seen in the Upper Forms after the Reset operation has been performed. This
will be applicable to Upper Forms, only. Reset will not work for Line items since the system
will treat a reset operation as though the user has edited the record and saved it as a draft.
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Copying a BP Record in Master Log

To create a BP record by copying another BP record in master log (Master Log - Business
Processes grouping node):

Note: The name of the Master Log - Business Processes grouping
node can be customized.

1) Go to the Home workspace.
2) In the left Navigator, expand the Master Log - Business Processes grouping node.
3) Select a BP and open the BP log.

4) Click the gear menu ( %¥ ) next to the record that you want to copy and select one of the
following options:

» Copy with Attachments
» Copy without Attachments
» Copy with Conditions
5) Follow the prompts to complete copying your record for use.

Note: You cannot create a BP record by copying another BP record in
Tasks log (Home Workspace > Tasks functional node).

See Restricting Line Items by Using Copy with Conditions Option (on page 134) for more
details.

Visibility of Properties Tabs in BPs

In a company, a shell, or a project (Master Log, Company Logs, Single-Record BP Log,
Portal BP Log, and Logs nodes), when you open a business process and select a record, the
window displays the properties pane with a series of applicable tabs (record properties) such as
Record Details tab, Notifications tab, Record Properties tab, Attachments tab, Permissions
tab, and so on.

The Record Properties tab lets the administrator define restrictions within the BP setup on who
can view specific tabs. This rule also applies to the following nodes:

» Drafts
» Tasks

For the Attachments tab, if you have restrictions to download, you will only be able to view or
access the attachment; you cannot download or save the attachment to a local system.
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Auto-Creating BP Records
There are different ways of auto-creation:

1) Spawning a record at a particular point in a workflow (S-Step)

2) Auto-creating a record or line item when it reaches a particular condition or frequency
(I-Step)

3) Using a template that is scheduled to auto-create records

For auto-creating BP records in S-Step or |-Step, you must reset on creation step.

Notes:

= For auto-created records, the system will populate the due date time
for the auto-created record from the source record instead of copied
record, if the following conditions apply: the due date element in the
record is a formula (including today), and the source record is copied
from another record, and if there is a time gap between the source
and the copied record.

= When the system auto-creates a project-level Cost- or Commit-type
business process (BP) that contains an upper (main) form reference
to a company-level commit-type BP record (such as a Blanket
Purchase Order [BPQ]), the value is copied to the destination record
if a matching DE exists. However, if a BPO Lineitem Picker value
existed in the detail form of the source record, that value is not
copied over to the line items of the auto-created record.

= Because a Summary Payment Application (SPA) BP contains two
sub-tabs—Line Item and Cost Breakdown—on the Detail Form, the
system does not support I-Step or S-Step auto-creation of line items
from a non-SPA BP to an SPA BP.

Reset on Creation Step
The following rules apply:

» If the Action form associated with the Creation Step has Data Elements (DEs) that have
Reset property, then post auto-creation the values of these fields will be reset.

Regardless of whether the auto-created record is in I-Step or not, the values must get reset.

Fields with auto-population source, "Data Picker" whose value has been set as reset must
get reset.

After a reset is done, any formula that depended on the Reset field will be re-evaluated.
Reset will work for Workflow BPs only (This is an existing limitation).

If a default value in the reset field has been specified for a DE that has reset property, then
this default value will be seen in the Upper Forms after the Reset operation has been
performed post auto creation. This will be applicable to Upper Forms only.
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Note: Reset will not work for line items because the system will treat a
reset operation as though the user has edited the record and saved it as
a draft.

Auto-Create a BP Record from a Workflow Step (S-Step)

You can use design a business process form that automatically creates a new BP record, after
reaching a designated status in a workflow (for example, approved).

The user who owns the original record becomes the owner of the auto-created record. After
being created, the new record is sent automatically to the next step in the workflow if it is a
workflow business process. Non-workflow business process records will reside in the log.

Note: Business processes are not auto-created in projects or shells that
have the View-Only or Inactive status.

The original record can be set up to automatically populate upper form (header) information on
the new record, provided the data elements of the upper form fields are the same on both
records. That is, for example, if a Description field using the same data element appears on
both records, the text in the original record can be entered automatically into the new record.

Auto-Create a BP Record, or Line Item, Based on Conditions or Frequency

You can design a form that automatically creates a new record, line item, or planning item if
certain criteria are met. The criteria can be:

» A condition, such as a dollar amount.
» Afrequency, such as a daily or weekly time frame.

» Only for a record

» Line items cannot be created with a frequency trigger.
» Both a condition and a frequency.

When the business process, planning item, or line item reaches the condition or frequency
trigger(s), the form will automatically create a new record and send it to an Initiation step (I
Step). These forms contain a Creator field to activate the auto-creation, either automatically, or
manually. If you have Modify Ownership permission on the source record, you can auto-create
new records or line items. You can also override conditional auto-creation and immediately
invoke the auto-creation manually if necessary.

Note: If the line items have been grouped (as part of the administrator's
business process setup), you can manually invoke the auto-creation;
however, only those line items in a status of "pending creation" will be
grouped.
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Bypassing the | Step

During business process setup, the administrator can set up the auto-created workflow business
process to skip the initiation step and send the record directly into the workflow, where it
normally arrives at the first step after the Create step (or the first step in a conditional routing).
For a workflow business process, the administrator specifies the schema, the step in the
workflow that the record should use as its first step, the workflow duration, and the name of the
person or group who will be the owner of the auto-created record. When the record is created,
data will roll up to manager sheets at the appropriate status; however, if the system encounters
errors or invalid data, the record will remain at the Create step, and roll-ups will not occur until
the user resolves the errors.

For a non-workflow business process, the administrator can set up an auto-created record to
skip the initiation step. In this case, the system creates the non-workflow business process
record and lists it in users' logs in either:

» Edit mode. When the record is in edit mode, you can see the Submit button.
» Read-only mode. When the record is in read-only mode, you can see the Edit button.

If it appears in edit mode, the user will have to open the record and add or correct information
on the form. If it appears in read-only mode, the record is considered complete, and data will roll
up to manager sheets.

Note: Business processes are not auto-created in projects or shells that
have the View-Only or Inactive status.

Your administrator sets up the auto-creation by specifying:

The name of the person or group who will be the owner of the auto-created record.
(For workflow business processes) The workflow schema to use.

(For workflow BPs) Which step in the workflow the record should use as its first step
(For workflow BPs) The workflow duration

The criteria that will trigger the auto-creation

Whether or not attachments to the record or line item will be included when the record is
auto-created

» Whether or not records that were linked to the creating record should also be linked to the
newly created record, or to the new line item

» Whether or not the | Step should be bypassed when a new record is auto-created
» Whether or not the line items from line item tabs should be grouped

v v v v v Vv

Delete Error Lines

The Delete Error Lines option appears in the Errors and Warnings window when you finish
editing (or send) a BP when the BP line items are failing validation errors (such as required field
check, and so on). The Delete Error Lines option lets you delete the faulty BP line items and
route the BP record to the next step, if the BP line items are not needed.
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Note: After you delete the faulty BP line items, the system removes
them permanently without providing an option to access them.

If line item auto-creation fails

If the line-item creation is auto-created with a condition-based query (that is, not manually), the
system will send an email notification to the business process owner. The email will contain
location information so that the recipient can see where the auto-creation originated and where it
failed. Following are conditions under which line item creation can fail:

» The To field is empty. This is possible if the assignee becomes inactive after the schedule is
created or if a group is empty.

» The CBS code is invalid, which can happen if the CBS code becomes inactive after selecting
in the template.
The rules engine validation fails.
For payment applications, the associated SOV is locked, either by the payment application
record in routing, or by a change commit with a negative line item value. See Payment
Application Business Processes (on page 239) for details.

Note: If the destination business process does not exist or has not been
imported into the system, the location specified in the email notification
might be non-existent or incorrect.

Bypassing the Initiation Step (I-Step)

During the Business Process (BP) setup, the administrator can set up the auto-created workflow
BP to skip the Initiation step and send the record directly into the workflow, where it normally
arrives at the first step after the Create step (or the first step in a conditional routing).

Workflow BP

For a workflow BP, the administrator specifies the workflow schema to use, the step in the
workflow that the record should use as its first step, the workflow duration, and the name of the
person or group who will be the owner of the auto-created record. When the record is created,
data will roll up to any applicable manager sheets (for example, the cost sheet) at the
appropriate status; however, if the system encounters errors or invalid data, the record will
remain at the Create step, and roll-ups will not occur until the user resolves the errors.

Non-workflow BP

For a non-workflow BP, the administrator can set up an auto-created record to skip the initiation
step. In this case, the non-workflow BP will be created and will appear in the users' BP logs in
either an "edit" or "finish edit" mode. If it appears in an "edit" mode, the user will have to open
the record and add or correct information on the form. If it appears in a "finish edit" mode, the
record is considered complete, and data will roll up to any applicable manager sheets.

Additional information about bypassing the I-Step

In the following scenarios, If the auto-creation of a change commit BP is set to "Bypass I-Step,"
the auto-created record will remain in I-Step and the element "refid" will remain blank:
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» If the source BP form has no BP Data Picker, or BP Picker, pointing to the Change Commit
"refid" Base Commit BP.

» If the source BP form has more than one BP Data Picker, or BP Picker, that satisfy the
conditions needed to populate "refid" (map to the Change Commit "refid" Base Commit BP).
» If the conditions on "refid" picker are not satisfied by the value from the source BP, for

example, the "refid" picker allows an "Approved" Base Commit, only, but the source BP
sends a "Pending" record.

If the value from the source BP that is mapped to the "refid" element is set as: <null>.
When copying the Line Items form a source to the destination record:
» The source Detail form does not contain the element: uuu_sovlinum

» The destination Change Commit Detail tab contains the element: uuu_sovlinum

Note: In this scenario, the Line Items will be copied from the source to
destination, and the uuu_sov Il inum field will be set as blank. All other
fields will be mapped from source to destination Detail form.

In the above scenarios, because the "refid" is blank, no Line Items will get copied into the
"Standard" tab of the auto-created Change Commit record.

Note: If any other tab in the "Change Commit" is configured to copy Line
Items from the source, those Line Items will be copied.

You will be able to auto-create a "Change Commit" type BP from any type of BP Upper or Detalil
form.
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For Workflow BP, when By Pass I-step selected, the following process takes place:

Examples of Auto-Creation
You can use the auto-creation feature to manage events such as the following:

» Line ltems of Lease Business Process generating Payment Request BP records: A
lease business process with a pre-generated payment schedule can use this feature to
generate Payment Request records at appropriate days in advance of the payment due date
so that the record can be routed for approvals.

» Preventive Maintenance BP line items generating Work Order BP records: A Preventive
Maintenance type business process (Preventive Maintenance Book - PM Book) can be set
up to create Work Orders for assets at periodic intervals depending on the service needs of
the asset.
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In the Preventive Maintenance Book (PM Book), for:
» Floating Line Items holding non-terminal work orders, you cannot edit the following DEs:
= Family Identifier
* Line Item Status
= Schedule Type
» Fixed Line Items holding non-terminal work orders, you can edit the following DE:
* Line Item Status
» Create Action Iltems from Meeting Minutes: Auto-creation feature can be used to create
and assign tasks to different people creating a fully automated flow for routing of action items

from meeting minutes records that have lines items. For example, each line item Action Item
could auto-create a separate Action Item records from the meeting minutes record.

» Create a planning item from a business process: You can create a planning item from a
business process when the business process, with its details (such as expense estimates,
owners, and so on) has been approved.

» Add anew line item to an existing record: You can add a line item to an existing business
process. For example, a submittal registry record could contain line items that auto-create
separate submittal business process forms for each contractor on a project. In the course of
work, you might realize that the original submittal registry record is missing a submittal for an
architectural drawing. You could submit a new submittal business process form that would
add the missing architectural drawing submittal to the original registry record.

For Line Item Creation

» You cannot create a line item on a record that is at a terminal or terminated status.

» If you create a line item on a non-workflow cost type business process, the cost amount(s)
will roll up to the Cost Sheet.

» If you create a line item on a workflow cost type business process, the cost amount(s) will
not roll up to the Cost Sheet.

Exceptions for Auto-Creation

You cannot auto-create Payment Application business processes and General Spends business
processes because these business processes use the Schedule of Values (SOV), from a Cost
type business process.

You cannot auto-create a business process by using a Lease business process because the line
items of the Lease business process contain several system-defined data elements that cannot
be automatically included in other types of business processes.

Rules for Checking Conditions for Auto-Creation

There are rules that govern when the Unifier scheduler checks the conditions for auto-creation,
and then if these conditions are met, it auto-creates the BP.
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Rule 1

The Company Administrator selected the Enable Auto creation check box for BP Creator when
the auto-creation was set up.

If the Enable Auto creation check box is selected, it implies system based auto-creation, and the
BP Creator Select button is not displayed in User mode.

For non-workflow BPs: The condition check occurs on Submit. If condition met, creates record
and shows the link for the auto-created BP. If no condition is specified auto-creates records and
shows the link for the auto-created BP.

For workflow BPs: The condition check occurs on Send. If end step reached and Action Form
is used on End Step, the condition check occurs on Save instead of Send. If condition met,
creates record and shows the link for the auto-created BP. If no condition specified blindly
creates records and shows the link for the auto-created BP.

If the Enable Auto creation check box is not selected, it implies manual creation.
For non-workflow BPs: The condition check does not occur on Submit.
For workflow BPs: The condition check does not occur on Send.

BP Creator - Select button shown in User mode so that the user can create the business
process manually. If clicked, creates BP record without checking any condition, and creates
record and shows the link.

Rule 2

Date Trigger Condition check: Are checks on the specified Date Data Element. For workflow
or non-workflow BPs, this setup implies that the condition checks are done on a date instead of
Finish Edit/Send, if a link does not exist next to BP creator element. If a link exists, it will not
create any new records for that BP Creator element in the chosen line item of the record.

Rule 3

Trigger Condition check based on frequency (Periodic): Are checks on frequency for BP
Creator elements with Enable Auto creator checked. If specified, these are the only time
condition checks are done. This overrides any other checks for date. This is the only method to
create multiple records even if a link exists and a record has already been created for this BP
Creator element. The link created using this will always point to last auto-created record.

Auto-Creation in Operation

Upon auto-creation, the following are not copied to the auto-created Business Process (BP) from
the source BP:

» Line item status
» Creator fields
» Hidden tab data

When a line item is auto-created (by using the line item auto-creation logic), the values in the
fields on the line item that are based on a data picker in that line item will not be auto-populated.

These elements are copied from the source BP to the auto-created BP on certain conditions:
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» Configurable Manager codes and CBS codes are copied from the source business process
to the auto-created business process if the codes are available in the destination shell.

User/Group Picker values are copied only if they are available in the destination shell.
Transaction currency field is copied if that currency is available in the destination shell.

Change Commit

If you configure a BP Creator field to auto-create a "Change Commit," during the runtime the
field will behave the same way as any other BP Creator field. Also:

» A "Change Commit" type BP always holds a required BP Picker element (refid) on the BP
Upper form. In uDesigner, this BP Picker is configured to point to Base Commit BP.

» During the auto-creation of a "Change Commit," the required BP Picker element (refid) on
the BP Upper form gets populated with the value of the same BP Data Picker, or BP Picker
(the source BP). This value:

» Resides on the same form as the BP Creator, and

» Points to the same Base Commit type BP as the BP Picker element (refid) is configured
to point to in uDesigner.

Attachments

Including attachment in the Auto Creation tab of the BP setup enables the copying of
attachments from both the upper and detail forms.

When a record is auto-created and receives Line Items from a reference record during the
auto-creation, the Line Item attachments transfer from the source reference record.

If the option of including attachments in a BP setup BP creator configuration is checked, then the
source Line Items from a "Referenced" picker will be copied into the auto-created record with
attachments. This applies to BP creators on upper as well as detail form.

If an attachment existing in the Line Items of the Source BP record needs to get copied to the
upper form of the destination BP record, the project administrator can specify the levels for the
transfer of attachments: Upper form to Upper Form, Line Item to Upper Form, and so forth.

Example

An operations manual (existing as an attachment) in the Line Items of the Source BP of
Preventive Maintenance Book (PM Book) must be seen as an Upper form attachment on the
auto created BP record of the Work Order.

Note: The system will not error out for duplicate file attachments in
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auto-created records. Hence, the recommendation is to check for
duplicate file attachments in source records regardless of the level at
which they are attached when the Copy Line Item Attachments to the
Upper Form of the Record option is selected in the auto-creation setup.

The following provides more details:

The Business Process Setup window enables your administrator to provide additional levels of
granularity for copying attachments when auto-creations are happening from Record to Record
and Line Item to Record methods of Auto creation.

Record to Record

This is the option seen in the Creation Method field "Record Auto Creation: Upper
Configuration" in uDesigner > BP > Auto Creation Process > Upper. This option is
pre-populated by the system based on where the BP Creator is located. If the BP creator is
located in the upper form of the BP, this option will be seen in the above-mentioned field.

Line Item to Record

This is the option seen in the Creation Method field "Record Auto Creation: Detail
Configuration" in uDesigner > BP > Auto Creation Process > Detail. This option is
pre-populated by the system based on where the BP Creator is located. If the BP creator is
located in the detail form of the BP, this option will be seen in the above-mentioned field.

The Auto Creation tab (in the Business Process Setup window) provides the following
attachment options:

» Include Upper Form Attachments

» Include Detail Form Attachments
» Copy Line Item Attachments to Upper Form of the Record
» Copy Line Item Attachments to Line Items of the Record

» Bypass Initiation Step during auto creation
» Copy Linked Records

The following explains the results of the selections:

When the Include Upper Form Attachments option is selected, and the source is a Line Item
BP, the attachments from the Upper Form of the source record are copied over to the Upper
Form of the auto-created record.

» If the destination is a Line Item BP, then:

» The line items may get created but no attachments from the line items will get copied
over.

» If the destination is a Simple BP, then:
» No attachments from the line items will get copied over to the Upper Form.
When the Include Detail Form Attachments option is selected, and the source is a Line Item

BP, the Copy Line Item Attachments to Upper Form of the Record option will be selected by
default.
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Note: The Copy Line Item Attachments to Upper Form of the Record
option will be selected by default to inform you that because the
destination is a Simple BP, checking the option of Include Detail Form
Attachments will always add the line item attachments to the Upper
Form of the Simple BP.

» If the destination is a Line ltem BP, then:

» The attachments from the line items of the source record are copied over to the Upper
Form of the auto-created record. If the Upper Form of the source BP record has
attachments, the attachments will not get copied over.

» The line items may get created and any attachments from the source line items will get
copied over as Upper Form attachments. The line items from the source may be seen in
the auto-created record; however, the line items will not have any attachments.

» If the destination is a Simple BP, then:

» The attachments from the line items of the source record are copied over to the Upper
Form of the auto-created record. If the Upper Form of the source BP record has
attachments, the attachments will not get copied over.

When the Include Detail Form Attachments option is selected, and the source is a Line Item
BP, the Copy Line Item Attachments to Upper Form of the Record option will be selected by
default. The attachments from the line items of the source record are copied over to the line
items of the auto-created record. If the design of the source BP does not have any tab mapping,
the line items will not get created, and the line item attachments will not get copied over.

» If the destination is a Line Item BP, then:
» The line items created in the destination record will have attachments from the
corresponding line items of the source record.
» If the destination is a Simple BP, then:
» The option will not be available.

When the Include Upper Form Attachments and the Include Detail Form Attachments
options are selected, and the source is a Line Item BP, the Copy Line Iltem Attachments to
Upper Form of the Record option will be selected by default.

» For Line Item BPs and Simple BPs:

» The Upper Form attachments from the source record and the line item attachments from
the line items are copied over as an Upper Form record attachments in the destination
record.

When the Include Upper Form Attachments and the Include Detail Form Attachments
options are selected, and the source is a Line Item BP, the Copy Line Iltem Attachments to
Upper Form of the Record option will be selected by default.

» For Line Item BPs:

» The Upper Form attachments from the source record are copied over as an Upper Form
record attachments in the destination record. The Line Item BP attachments, from the
line items of the source record, will are over as line item attachments, if the design
permits the creation of line items.

90



Working with Business Processes

Note: When only the Include Detail Form Attachments option is
selected, the attachments from the Detail Form of the Line Item type BP
will not copied to a Simple BP, on Auto-Creation.

When the Include Upper Form Attachments is selected, the source is a Simple BP, the Copy
Line Item Attachments to Upper Form of the Record option is selected (disabled by the
system), and the Copy Line Item Attachments to Line Iltems of the Record option is disabled
by the system:
» If the source is a Simple BP:

» The only option that is available is the Include Upper Form Attachments.
» If the source is a Simple BP and the destination is either a Simple BP or a Line Item BP:

» The Upper Form attachments from the source record of the Simple BP is copied over as
Upper Form attachments in the destination record.

Schedule BP Auto-Creation Dynamically

Auto-created business processes can be scheduled for creation from setups created by an
administrator, or you can create them dynamically.

To create business process records using auto-creation
1) Navigate to a business process log and open the source BP record to use for auto-creation.

2) Openthe Menu Options = and select Auto-create.
3) Select the Enable Scheduled Runs check box.

4) Under Frequency, choose how often you want the auto-creation to occur: Daily, Weekly,
Monthly, or Yearly.

5) Under Range of Recurrence, specify the date range during which the auto-creation should
occur.

6) Click Done.

After the new record is auto-created, there is a link in the source record to the newly created
record. Click this link to access the auto-created record. The link always accesses the last
record created by the auto-creation.

After you create a workflow record, the system sends it to the assignees as an initiation task (|
Step) that will appear on their Tasks log and the Business Process (BP) log to which the record
belongs. If a new record is sent as an initiation task, users must accept the task to manually
launch the record.

After you create a non-workflow record, the system sends it to the designated creators as an
initiation task (I Step) that will appear on their Tasks log and the BP log to which the record
belongs. Users must accept the task to view the record.

Note: If your administrator has set up these business processes to
bypass the | Step, the new records will appear at different workflow
steps, or in different statuses. For more information, see Bypassing the
Initiation Step (I-Step) (on page 83).
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Stop Auto-Creation

To stop the creation of auto-created business process records

1) Navigate to a business process log and select the source record or records to use for
auto-creation.

2) Openthe Menu Options = and select Auto-create.
3) Deselect the Enable Scheduled Auto creation check box.
4) Click Done.

Create a BP Record, or Line Item, with Manual Auto-Creation

Note: For line item creation, you cannot add a line item to a record in a
terminal or terminated status.

To create a business process record or line item with manual auto-creation
1) Open the record that will auto-create the record or line item.
2) Click the Create button next to the creator field.

The field will display the words "Pending Creation."

The system immediately auto-creates the destination record or line item. The new,
auto-created record or line item will show a link to the source record that created it. You can
click this link to view the source record.

If you manually auto-create a line item, the system will validate the creation and tell you
immediately if there are errors that caused the auto-creation to fail.

The Reset button

When you manually auto-create a record or line item, the button beside the creator field changes
from Create to Reset. You can use this Reset button to break the link from this (the source)
record to the new record/line item so that you can auto-create another record or line item
manually. When you click the Reset button, it changes back to a Create button.

Note: You can find the reasons for the auto-creation failures in the audit
log of the business process record. In addition, the system occasionally
generates error codes for auto-creation failures, which can be used to
troubleshoot the auto-creation failures.

Auto-Create SPA Commits with Variable Unit Cost Lines

You can auto-create the SPA commits with both the Lump Sum and the Unit Cost line items.
You can also auto-create the SPA commits with the variable unit cost line items. Similar to other
cost line item types, the summary along with cost breakdown will be created if the source is a
cost BP and has line items with CBS Codes. This is applicable to both the record-level and the
line item auto-creation using the BP Creator and the Line item creator when the source and the
destination tabs are mapped in the auto-creation design.
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Source Business Process Destination Business Expected Results
Process
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The Cost-type BP of CBS
type, and the Line Item-type
BP (with the line items
having Cost line item-type)
selected as variable unit
cost type.

Summary Payment
Applications SOV BP (SPA
commits).

In the auto-created BP
record both the summary
line item and the cost
breakdown will be created if
all of the required field data
is defined.

In the summary line item for
the variable unit cost type,
both the uuu_quantity
and the amount are
populated. The cost
breakdown will be created
with the uuu_quantity,
uuu_unit_price, and the
amount.

The CBS Code, from the
source, will be copied in to
the cost break down in the
destination record.

If the Cost line item-type in
the source BP record is a
variable unit cost, and the
destination design does not
have the uuu_quantity and
the uuu_unit_price
elements, then the
auto-creation cannot take
place.

If the BP record is
auto-created across the
shell, and the CBS Code
does not exist, then only the
summary line item will be
created, with the quantity
and the amount values.

All other validations such as
the Cost line item-type
value and other required
fields will take place during
the auto-creation of the BP
record, and the
auto-created BP record will
be in the Creation Step, if
any of the required field
values are missing.
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SPA commits type BP

The Cost BP of CBS type
and Line item type BPs
(with their line items having
cost line item type selected)
as variable unit cost type.

In the auto-created BP
record, a line item will be
created if all of the required
fields are available, in case
of Bypass-I-Step and

S-Step auto-creation.

In case the required field
values are missing, the BP
record will remain in the
Creation Step.

Creating a BP Record in Document Manager

If you have permission to access the Document Manager grouping node (<project/shell> >
User mode > Document Manager), you can create a business process directly from the
Documents functional sub-node.

You can create a BP record from the Document Manager by:

» Selecting the files/folders that must be attached to the BP record.

» Not selecting the files/folders that must be attached to the BP record.

The following explains how to create a BP record from the Document Manager node without
selecting the files/folders that must be attached to the BP record.

1) Go to the project/shell tab and switch to User mode.

2) Inthe left Navigator, click Document Manager > Documents.

3) Inthe Documents log, click Create and select Business Process.

4) Inthe New Record window, select the business process type under Select Business
Process.

5) Click Create.

Note: The format of the business process form changes depending on
the availability of the standard forms (new user interface) option.

The name of the project/shell (for the Documentation Manager in which the business process is
being created) appears under Business Process Origin.

The Select Business Process field lists business processes that you have permission to
access.

After you select a business process:

» For a single workflow setup for the business process, the workflow name appears under
Select Workflow.
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» For multiple workflows setups for the business processes, the drop-down arrow in field under
Select Workflow lets you select a workflow setup for the newly created business process
record, from a list of applicable workflow setups.

Note: The list of workflow setups appearing in the drop-down list
depends on whether you (user) have been designated as an assignee in
the creation step.

If you create a business process and select files/folders when creating, the system adds the
files/folders as attachments for the business process record that you have just created.

» If you select one file, or multiple files, then the file, or files, will be included in the attachment
tab.
» If you select one folder, or multiple folders, then the folder, or folders, then:

» For Document Manager business processes that do not support folder structure, the
system displays an alert message and the documents from selected folders and
sub-folders are attached without the folder structure.

» For Document Manager business processes that support folder structure, the system
displays the folder structure.

Creating a BP Record from a Template

You can manually create BP records by copying a BP template, if you have created a business
process template for a BP.

Creating a BP record from a template is similar to copying an existing BP record. Any values in
any of the form fields on the template (either manually entered or auto-populated) will be copied
to the new record. The line items, file attachments, and attachments to line items will also be
copied; however, the other attached information, such as general comments, linked records, and
linked Mailbox, will not be copied to the new form.

Note: The users who have been removed from a group, or the users
who have been newly added to a group, will not be displayed in the
Workflow page, when you create a BP record manually by way of a
template.

To create a business process record from a business process template:

1) Go to the project/shell tab and open the business process log.
2) In the left Navigator, click a BP that you want to use.
3) Inthe BP log, click Actions (toolbar options).

4) Click Create From Template option (available for all Workflow type BPs, only) to open the
template list (<BP NAME> Template List) log or page. This page displays a list of
templates, if available. In this page, the right pane has the following tabs:

» General tab
» Schedule tab
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Simple-type Business Processes: The system enables the Refresh auto-populated and
calculated fields on record creation check box option if you use the Create From
Template option to create a template.

Click Create (toolbar options) and enter values for the following fields, in the General tab:
» Name

» Description

»  Workflow

» Copy Link Records

In the General tab, enter a name for the BP template (in the Name field) and select a
workflow (from the Workflow field drop-down).

If the BP has only one workflow, the system selects that workflow automatically.

If the BP has more than one workflow, a list of the workflows appears in the Workflow
drop-down list field.

The Cancel option lets you abort creating the template, cancel the changes, and reload the
previous template properties.

The Create option lets you save the template changes.
For information about the Schedule tab, see below for more information.
When finished, click Create. The new template will be displayed in the page.

Select the template from the list and click Open (by using the gear menu [ ¥ ] or by
double-clicking the template). The BP form opens (Template - <BP NAME>). The data is
populated based on the template. You can modify the data or enter additional data, where
allowed. After you are finished, you can:

Click Save to save the template.

When the BP is ready to move to the next step, click Complete to send the workflow to the
next.

Note: You can save the record by clicking Save, which saves a draft of
the record but does not affect the template.

You can double-click the newly created template (or an existing template) to open it for viewing.

If you have created a business process template for a BP, you can manually create BP records
by copying the template. For instructions on creating BP templates and scheduling BP creation,
see Creating BP Templates and Scheduling BP Creation (on page 100).

The template list (<BP NAME> Template List) log or page contains the following toolbar
options:

4
4
4

Create
Find on Page
Delete

You can select (Ctrl+click) multiple templates and delete them at the same time.

The template list (<BP NAME> Template List) log or page contains the following columns:

4
4

Name
Description

97



Business Processes User Guide

» Workflow
» Status

» Scheduled
» Creator

If there are templates created for the BP, select a template and click Open (gear menu &),

The BP form opens. The data is populated based on the template. You can modify the data or
enter additional data.

If there are no templates created for the BP, then the "No Templates are available" is displayed.
In this case, you must create a template as described below:

» Double-click a template to open it for viewing.
» Click Save to save updates to a newly created template.

The options available for gear menu are context-sensitive, based on the status of the template.
The following gear menu ( ¥ ) options are available for the items in the template list (<BP
NAME> Template List) log or page:

The following options are displayed when the template is in Draft status:

» Open

» Create Record

» Delete

The following options are displayed when the template is in Complete status:

» Open

» Create Record

» Delete

The following options are displayed when multiple templates, regardless of status, are
selected:

» Delete
Scheduling a Run

Use the Schedule tab to schedule a run. A template can be set for a scheduled run only if it is
marked as Complete (under Status). The fields in the Schedule tab are disabled until the
template is marked as Complete. The following options are available in the Schedule tab:

» Schedule
» Enable scheduled record creation

Note: You can schedule auto-creation of records when the template
marked as Complete (under Status).

» Frequency
» Daily
»  Weekly, end of day
» Monthly
» Quarterly
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» Yearly
» Range of Recurrence
» No end date
» End by
» Additional Information
» Auto-email creator if scheduled creation fails
When the template is in Complete status, and user is setting up the schedule, the Schedule tab
shows the following options:
» Cancel
» Save
When the template is in Draft status, after the Creation step, the Schedule tab shows the
following options:
» Cancel
» Save

Under other conditions the following two options are not available:

» Cancel
» Save

By default, the first template is selected, and the details for the first template are displayed on
the right pane.

In the creation step, no template will be highlighted on the left pane. After you save, the template
is added to the template list, highlighted on the left pane, and the details are displayed on the
right pane.

Template Status

Templates with Draft status

When you open a template that is in draft status, the system displays the following toolbar
options in the upper-right section:

» Complete

» Save

» Menu Options (=)
Auto-create
Export Line Item Template
Print (HTML and PDF)
Reload
Help
» [BP Name] Help
» User Productivity Kit
Close
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When you finish drafting and click Complete, the system displays the Workflow Action Details
window. In this window, you can enter all the workflow information and click Save when finished.
When you click Save, the toolbar options change to:

» Edit
» View Workflow

» Send

» Menu Options (=)

Templates with Complete status

When the template status is marked as Complete, the template turns into read-only mode. If
you decide to edit a template marked as Complete, you can open the template and click Edit.
This action changes the status of the template to Draft. In this case, the system checks to see if
there is any scheduled auto-creation for the template.

If a schedule is detected, the system displays a confirmation dialog box. If you click Yes, the
system changes the template status to Draft and stops the scheduled auto-creation for the
template; however, the system retains the previously entered scheduled runs information.

Creating arecord from a template with Complete status

When you select a completed template and click Create Record from the gear menu ( ), the
system opens the Create New [BP name]. The fields in Workflow [BP name] Details window
are populated with the workflow information that was stored at the time of drafting and
subsequent completing of the template, and will open when you click Send. The toolbar options
change to:

» Send
» Save

» Menu Options (=)

If you click Cancel in the Workflow [BP name] Details window to work in the Create New [BP
name] window to make necessary changes, or to review the record information, you must click
Send to route the record to the next step. In these two scenarios:

» The Workflow [BP name] Details window opens, but the fields will not be populated with
the workflow information that was stored at the time of drafting and subsequent completing
of the template.

» You must re-enter the workflow details as the system treats this instance as a one-time
creation.

Creating BP Templates and Scheduling BP Creation

You can create templates for project- or shell-level and company-level workflow business
processes.
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» Easy creation of records for business processes that you use often or are recurring (for

example, time sheets)

» Scheduling automatic creation of recurring BP records

This section discusses how to:

» Create and edit business process templates
» Schedule automatic business process record creation from the template

Note: When you create BP records from a BP template, any values in
any of the form fields on the template (either manually entered or
auto-populated) will be copied to the new record. Line items, file
attachments, and attachments to line items will also be copied. Other
attached information, such as general comments, linked records, and
linked Mailbox, will not be copied to the new form.

Creating a BP Template

You can create a template for any business process for which you have at least "view user
records" permission.

Note: Because draft option is not available for non-workflow business
process records, and draft option is essential in storing a business
record template, you can only create a template for a workflow business
process record.

To create a template

1)

2)
3)

4)
5)

6)

In User mode, open to the log containing the business process for which you want to create
the template.

In the Navigator, select the business process.

Click the Actions menu and choose Create From Template. The Template List window for
that business process opens. The window displays any templates that have been created for
the selected BP.

Click the Create button.
Use the information in the table below to fill in the General tab in the right pane.

Note: Although the Schedule tab is visible, it is disabled until you have
changed the status to Complete. At this point, you can use this template
to manually create BP records; however, if you want to schedule
automatic creation, you must first change the template status to
Complete.

Click Create.
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The system adds the template to the Template List with a status of Draft and opens the form
as it would in the create step of the workflow. This form will be used as the template.

7) Enter any information into the template form that you want to include in the records that you
create from it.

8) You can add line items as needed. You can also add file attachments, which will be attached
when a record is created from the template. This includes attachments to the record itself
and attachments to line items.

You can also add linked records, linked Mailbox, and general comments to the template, but
these will not be included in the records created from this template.
9) Click the Save button at the top of the form.

The system saves the template in Draft mode, and the window remains open. You can use
the template at this point to manually create BP records; however, if you want to schedule
automatic creation, you must first change the template status to Complete (see the following
procedure).

In this field: Do this:
Name Enter a name for the new template.
- Enter a description of what this template is
Description
used for.
Select the workflow that should be used for
Workflow

the BPs that will use this template.

Select the check box if you want to copy
Copy Linked Records any linked records whenever a record is
created from this template.

Changing Template Status (Draft and Complete)

Each template will either be in Draft mode or Complete mode. You can change the status of a
template between the two statuses at any time. The template status controls whether a BP
creation schedule can be defined.

If the template status is Draft, the template can be edited and used to manually create BP
records. Required fields and assignee information can be left blank. Scheduled record creation
cannot be performed.

If the template status is Complete, the Schedule tab in the right pane is activated and can be
used to define and schedule automatic record creation. The form is no longer editable (unless
changed back to Draft). Required fields and assignee information must be completed before the
status can be changed to Complete.
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To change the status of a business process template to Complete

1) In User mode, navigate to the log of the business process for which to edit the template.
Click the Actions menu and choose Create from Template. The Template List window
opens.

2) Hover over a template, click the gear menu ( ¥ ) and click Open. The template form opens.
3) Complete the BP form:
» Complete all required fields.

» Be sure the rest of the template form is filled out appropriately, including line items and
attachments, if applicable. Remember that if you will be scheduling automatic record
creation from this template, the information that you enter here will used for the creation
step and sent to the first step in the workflow.

4) Click Complete when finished. A validation check will verify that all required fields are filled
out.

5) After a successful validation check, the Workflow Action Details window will open.

» Select a workflow action for the first step in the workflow. If there is only one option, the
Workflow Actions field will be auto-populated.

» Add users to the To and CC field.

When the status is Complete, the template form becomes view-only. If you have defined a
record creation schedule in the Schedule tab, the schedule will be activated.

To change the status of a business process template to Draft

1) In User mode, navigate to the log of the business process for which to edit the template.
Click the Actions menu and choose Create from Template. The Template List window
opens.

2) Open the template form.
3) Click Edit.
4) At the confirmation window, click Yes.

In Draft mode, the template form becomes editable. Scheduled record creation is disabled until
you change the status back to Complete.

Scheduling Automatic BP Record Creation Based on a Template

You can schedule automatic BP record creation runs that are based on a BP template. The
templates must have a status of Complete before you can define and activate the schedule.

For information on manual creation from a BP template, see Creating a BP Record from a
Template (on page 96).

Note: Business process creation cannot be scheduled from a template
in projects or shells that have the View -Only or Inactive status.

To define a BP creation schedule
1) In User mode, navigate to the log of the business process for which to edit the template.

2) Click the Actions menu and choose Create From Template. The Template List window
opens.
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3) Select a template from the list to use for the automatically created BP records.
4) In the right pane, click the Schedule tab.

5) Complete the Schedule tab as described in the following section.

6) Click Save. The schedule is active as long as the template status is Complete.

In this field Do this
Select this check box if you want to enable
Enable scheduled record creation automatic record creation based on the

schedule defined below.

The frequency determines how often the
new records are created from the
template. The options are:

Daily

Weekly (select the day of the week)

Frequency Monthly (select the day of the month)
Quarterly (runs on the last day of the

calendar quarter)

Yearly (runs on the last day of the calendar
year)

All scheduled record creation is performed
at 11:59:59 PM (PST).

Choose one of the options:

No end date (runs until changed or

Range of Recurrence schedule is disabled)

End by (select an end date)

Select this option if you want the template
owner or creator to receive email
notification if the scheduled creation fails.
The email will contain location information
so that the recipient can see where the
auto-creation originated, and where it
failed.

Auto-email creator if scheduled creation
fails

Editing or Deleting a BP Template

Users with view permission to a business process log will be able to view any associated
templates. The template form and properties can be edited by the owner or creator and by users
with Modify Record Ownership.

Only the owner or creator of a template can delete it.
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To edit a template

1) In User mode, navigate to the log of the business process for which to edit the template.
Click the Actions menu and choose Create from Template. The Template List window
opens.

2) Open the template form.

3) If the template has a Complete status, click Edit.

4) The fields, line items, file attachments, and other data are editable. You cannot change the
workflow after the template has been created.

To delete a template
In the Template List window, select the template click Delete from the toolbar, or hover over the
template and click Delete in the gear menu ( % ). Click Yes to confirm.

Editing or Canceling a BP Template Schedule

To edit a business process schedule

You can edit the schedule information in the Schedule tab at any time. The Schedule tab is
active only when the BP status is Complete. After saving changes, the new schedule will be
activated immediately.

To pause or cancel scheduled business process creation
Do one of the following to deactivate scheduled BP creation:

» Open the template and select the Schedule tab. Deselect the Enable scheduled record
creation check box. To reactivate the schedule, select the check box.

» Open the template form and change the status to Draft (open the Complete template and
click Edit). As long as the template remains in Draft mode, the BP schedule will be inactive.
You can still manually create BP records from a draft template. To reactivate the schedule,
change the status back to Complete.

Failed Scheduled BP Record Creation

If a scheduled BP creation fails and the check box enabling notification has been selected on the
Schedule tab of the template Properties window, email notification is sent to the template owner.
The email contains location information so that the recipient can see where the auto-creation
originated and where it failed. Following are conditions under which scheduled record creation
can fail:

» The To field is empty. This is possible if the assignee user becomes inactive after the
schedule is created or if a group is empty.

» CBS code is invalid, which can happen if the CBS code becomes inactive after selecting in
the template.
If the rules engine validation fails.

For payment applications, if the associated SOV is locked either by the payment application
record in routing, or by a change commit with a negative line item value. See Payment
Application Business Processes (on page 239) for details.
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Note: If the destination business process does not exist or has not been
imported into the system, the location specified in the email notification
might be non-existent or incorrect.

Using CSV and RESTful Services

You can use CSV and RESTful Services to create a BP Record or Line Item with Line Item Data
Picker. When you export your CSV template, the Line Item Data Picker is shown and the
direction is set as an input or both, in the Integration tab in uDesigner.

When you create a record or line items using a CSV import:
» If the CSV input request has Line item Data Picker values, the following validations need to
be done:

» The associated data picker has a record selected. If a record is not selected, the system
displays the message: <value> is invalid value for Line item Data Picker <DE name>.

» The record selected verifies that the line item belongs to the selected record. If not
verified, the system displays the message: <value> is invalid value for Line item Data
Picker <DE name>.

» The line item exists.
If it does, the system runs the query conditions defined for the Line Item Data Picker.

If it does not, the system displays the message: <value> is invalid value for Line item
Data Picker <DE name>.

» The system identifies the specific erroneous records or line items for the following
scenarios:

= If form validation rule fails

» Data elements of the upper form are not unique

= |f records within an input file or request contains same unique DE value
= Multiple records or line items exist for a specific value

Similarly, all the following Restful Services support Line Iltem Data Pickers. The validations are
the same validations for users who try to create record using CSV import.

» Get BP Record List

» Get BP Record

» Get BP Record with attachments
» Create BP Record

» Create BP Record with lineitems
» Update BP Record

Note: You cannot create or update a non-workflow BP record for which
the input request file contains a Status value that is Inactive. If you
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submit a request that contains an inactive status, the system sends an
error message through email notification.

Using Microsoft Excel Template to Create BP Records and BP Line ltems in Bulk

Creating BP records, in bulk, through Microsoft Excel templates is available for all BPs that allow
bulk creation of records and line items.

A Microsoft Excel file or template supports formulas, special characters, and it has multiple
sheets.

Note: A CSV file or template does not support formulas or special
characters, and it does not have multiple sheets (Actions > Export CSV
Template).

When you click Actions, you can click the Export Microsoft Excel Template option to create a
single BP record or multiple BP records (bulk) that contain formulas, special characters, and
multiple sheets.

Note: This option will be seen for all users who have the View access to
the log.

For creating Line Items for a single BP record or multiple BP records (bulk) that contain
formulas, special characters, and multiple sheets, you can click the Menu Options icon
(available for BPs that support line item export) and click Export Line Item Template.

The supported Microsoft Excel file formats are the Excel workbooks having the ".xIsx" and
".xIsm" extensions.

Note: The Strict Open XML Spreadsheets having ".xIsx" extension is not
supported.

The supported Microsoft Excel versions are Excel 2010 (v14.0) and later.
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The supported Microsoft Excel functions are: ABS, ACOS, ACOSH, ADDRESS, AND, AREAS,
ASIN, ASINH, ATAN, ATAN2, ATANH, AVEDEV, AVERAGE, BIN2DEC, CEILING, CHAR,
CHOOSE, CLEAN, CODE, COLUMN, COLUMNS, COMBIN, COMPLEX, CONCATENATE, COS,
COSH, COUNT, COUNTA, COUNTBLANK, COUNTIF, COUNTIFS, DATE, DAY, DAYS360,
DEC2BIN, DEC2HEX, DEGREES, DELTA, DEVSQ, DGET, DMAX, DMIN, DOLLAR, DSUM,
EDATE, EOMONTH, ERROR.TYPE, EVEN, EXACT, EXP, FACT, FACTDOUBLE, FALSE,
FIND, FIXED, FLOOR, FREQUENCY, FV, GEOMEAN, HEX2DEC, HLOOKUP, HOUR,
HYPERLINK, IF, IFERROR, IMAGINARY, IMREAL, INDEX, INDIRECT, INT, INTERCEPT,
IPMT, IRR, ISBLANK, ISERR, ISERROR, ISEVEN, ISLOGICAL, ISNA, ISNONTEXT,
ISNUMBER, ISODD, ISREF, ISTEXT, LARGE, LEFT, LEN, LN, LOG, LOG10, LOOKUP,
LOWER, MATCH, MAX, MAXA, MDETERM, MEDIAN, MID, MIN, MINA, MINUTE, MINVERSE,
MIRR, MMULT, MOD, MODE, MONTH, MROUND, NA, NETWORKDAYS, NOT, NOW, NPER, NPV,
OCT2DEC, ODD, OFFSET, OR, PERCENTILE, PI, PMT, POISSON, POWER, PPMT,
PRODUCT, PROPER, PV, QUOTIENT, RADIANS, RAND, RANDBETWEEN, RANK, RATE,
REPLACE, REPT, RIGHT, ROMAN, ROUND, ROUNDDOWN, ROUNDUP, ROW, ROWS, SEARCH,
SECOND, SIGN, SIN, SINH, SLOPE, SMALL, SQRT, STDEV, SUBSTITUTE, SUBTOTAL,
SUM, SUMIF, SUMIFS, SUMPRODUCT, SUMSQ, SUMX2MY2, SUMX2PY2, SUMXMY2, T, TAN,
TANH, TEXT, TIME, TODAY, TRANSPOSE, TREND, TRIM, TRUE, TRUNC, UPPER, VALUE,
VAR, VARP, VLOOKUP, WEEKDAY, WEEKNUM, WORKDAY, YEAR, YEARFRAC.

The following topics explain how to use Microsoft Excel create a single BP record or multiple BP
records (bulk) and line items that contain formulas, special characters, and multiple sheets.

Microsoft Excel Format for Creating BP Records

The following applies to all business Processes where BP records can be created, in bulk, by
way of CSV import.

Note: The Request for Bid business process (RFB BP) does not support
bulk creation of records through CSV.

The following does not apply to managers such as Space Manager, Portfolio Manager,
Configurable Managers, Code and Records-based Configurable Managers, and Code-based
Configurable Managers that allow the creation of records by way of CSV import.

To create BP records, in bulk, through Microsoft Excel:

1) Inyour Shell go to the Logs grouping node (BP Logs) node and select a BP to open the BP
log.

2) From the toolbar options, click Actions, and click Export Microsoft Excel Template. This
option is only available for the users with View permission, to the log.

To be able to download your Excel template the integration interface must be defined for the BP
record. If the BP record does not have a defined integration interface, the entire import will be
aborted and no BP records or BP line items will get created. In such scenario, Unifier displays
the following error message: "Import could not be completed. There are errors in this template
file. These errors can be seen in the Import Data Template worksheet. Do you want to download
the file and fix the errors? Click 'Yes' to download the file and 'No' to upload a different template
file."

108



Working with Business Processes

MS Excel Template File

When you export your template file, the name of the exported template file will have the
following format: <BPName>_Template

Note: The name will always be the source string without spaces.

Example

If the BP name is Daily Reports, then the template file name will be:
Dai lyReports_Template.

MS Excel Template File Worksheets
The exported template file will have the following worksheets:

» Instructions worksheet
» Imported Data Template worksheet
» <Other User-Defined> worksheet

Instructions worksheet

This worksheet is generated automatically, and you cannot change the name of this
worksheet. The Instructions worksheet contains all of the relevant information about
entering the BP record and line item information data. The content of the instructions
worksheet will depend on the type of business process.

Imported Data Template worksheet

This worksheet is generated automatically, and you cannot change the name of this worksheet.
Always set by Unifier as the second worksheet in the template file, this worksheet contains the
Unifier data needed for creating BP record and line item.

Note: The name of this worksheet will be translated according to the
user's language preference.

The top section of this worksheet is dependent on the business process type.

» For the Cost BPs of Summary Payment Application SOV type, the "Enter date below"
section will have an additional row to enter the Cost Allocation. In addition to the H & D rows,
the CA row will also be seen. This row will have the asterisk symbol (*) for all the required
fields of cost allocation details.

» For the Simple BPs, the worksheet will have the "Enter data below" section and an H row
that contains the column headings.

» For Line items type of BPs, the first few rows will list all of the line item tabs. The first line will
have the static informational text "Line Item Tabs along with the respective detail form fields."
The tabs will be listed one below the other. The hidden tabs will also be displayed, similar to
the CSV template files. The "Tab Name" will be the first column followed by the detail form
fields. All of the required fields of the line item tab will be marked with an asterisk symbol (*).

<Other User-Defined> worksheet

A user may insert additional sheets for their reference. These sheets will not be processed
by Unifier at the time of import.
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This worksheet will not be processed by Unifier. An end-user (you) can add multiple
worksheets.

Note: The content of this worksheet will be ignored at the time of import.

Entering Data in the Microsoft Excel Template File

The following explains the general rules for entering data in the Excel template file.

You need to use the Import Data Template option in order to be able to enter data and
ultimately create records, or to create records with line items.

Note: Review the information on the Instructions worksheet to minimize
the import errors.

When entering data, you can:

» Enter data in all of the fields.

» Copy the values of a column from another sheet. This is to state that you can use the Excel
native features when entering data.

Use Excel formula feature to calculate values in the columns.
Enter UTF-8 character string in the String fields.

For all data types, Unifier will only process the data and not the format, when importing.

Example

A user may have entered -999.99 and the format on the cell may have been (999.99),
and the user will see the data in Excel as (999.99). When Unifier processes this data,
-999 .99 will get processed and not (999.99).

Creating BP Records by way of Importing a Microsoft Excel Template

To create BP Records by way of Importing MS Excel Template, click the Import option
(Actions > Import), select the Data From Microsoft Excel File sub-option, and follow the
prompts.

The Import option has the following sub-options:

Note: These options are displayed for users who can create new BP
records.

» Data From CSV File
» Data From Microsoft Excel File

Uploading

When you upload an Excel file, in the Upload Microsoft Excel File window (similar to the CSV),
you can select the Excel file (using the Select File option) and click Next to proceed with your
upload. See below for information about adding attachments.

110



Working with Business Processes

Validating Microsoft Excel File Content

There are multiple levels of validations that take place during the file import process. These
include:

» validations to ensure that the BP record has the required setup for the creation of records
through Excel in the Auto Creation tab of the BP setup.

» validations to ensure values have been entered in all of the required fields (for the creation of
the BP record, along with the line items). If the import fails, the imported file will now contain
error information.

Note: Leading and trailing spaces in data elements will be ignored for
validations. For example, data elements, "cost item", and "cost item ",
the latter including a trailing space character, are treated as identical
data elements.

After the initial validation ends, the file is processed further. At this stage, all validations
pertaining to system-level rules as well as user-defined form-level validations are performed. In
the event of a failure, an email notification with the reason for failure is sent to users and groups
identified in the business process setup.

Errors and Corrections

When an error is encountered in any of the rows, the entire import will be aborted and no BP
records or line items will get created. As mentioned earlier, when the import file contains errors,
Unifier will alert the user with the following message: "Import could not be completed. There are
errors in this template file. These errors can be seen in the Import Data Template worksheet. Do
you want to download the file and fix the errors? Click 'Yes' to download the file and 'No' to
upload a different template file."

Additional Information Regarding Importing a Microsoft Excel Template File

The name of a downloaded file is identical to the name of the imported Excel template file. If you
decide to download a file with errors, the Import Data Template worksheet displays errors in the
following format:

» On the first row of the worksheet, the following static text displays in an additional column:
"Following errors were encountered while importing the data from the template. This column
must be deleted after fixing all the errors. If this column exists in the file at the time of import,
the import will fail."

» Errors that are not specific to a row, display in the first H row that contains the data. For
example, errors such as the auto-creation setup not being met.

» A row with multiple errors displays all the errors in the error cell.
» Each row that has an error displays the actual error message in the first column.
» The following error format is used for the required fields:
"Values are missing in required fields: <Field Label 1>, <Field Label 2>"
For example,
Values are missing in required fields: Contract Reference
"Values are missing in required fields: <Field Label 1>, <Field Label 2>, <Field Label 3>"
For example,
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Values are missing in required fields: Type, Short Description, Asset Type
» For other form-level validations, the message will be displayed against the row.
For example,

Equipment Units Available cannot be less than 10. This number is required for
contingency purposes.

Adding Attachments

Similar to the CSV file import, you can add attachments. You can upload all the referenced
attachments in the Add Attachments section. You can use the Upload Microsoft Excel File
window (in the 'Add Attachments' step) to add attachments to your BP record, or line item,
during your import. The review section on the screen enables you to see the files that have been
uploaded and the files with upload pending.

For example, when you upload the Microsoft Excel file, all attachments listed in the Excel file
display in the Files to be Uploaded section. When, you upload each file, the status of the file
changes from Waiting for File to Ready to be uploaded.

In the Review section, you can perform sort operations on the Status column.

When you click Upload, Unifier uploads the attachments onto the respective BP record, or line
item, as required.

Validating Added Attachments
When you upload your attachments, Unifier performs validations and:

» If there is no data in the Attachments column of the Microsoft Excel file that is being
uploaded, Unifier processes the file as a file that does not need have any attachments that
need to be uploaded.

» If you have specified a name for the Attachment column (either at the BP record level or at
the line item level), Unifier ignores the column headings.

For validating a BP record level Excel import:

When creating BP records by way of using Excel file import from the BP log, Unifier does not
retain the Attachment option that was used in the validation form of the integration interface. If
you decide to import the attachments while using Excel import, Unifier will allow the import
action. If there are files that have been referenced in the Attachments column of the Excel file
and Unifier cannot find the files in the attachment payload (attachment missing), the
Attachments table will provide the following informational text: Some files are still waiting to be
uploaded. Do you want to proceed without uploading those files? If you click OK, Unifier will
ignore the missing attachments (from the Excel file) and creates BP records, or line items,
without any attachments. If you click Cancel, you will be returned back to the 'Upload
Attachments' step of the upload process.

If the Status value for some of the files in the review section states Waiting for the file, and you
click Upload, then the Attachments table will provide the following informational text: Some files
are still waiting to be uploaded. Do you want to proceed without uploading those files? If you
click OK, Unifier will ignore the missing attachments (from the Excel file) and creates BP
records, or line items, without any attachments. If you click Cancel, you will be returned back to
the 'Upload Attachments' step of the upload process.
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For validating a line item level Excel import:

When you proceed with a line item import, from a Line Item tab, if the option Upload
documents from My Computer is not selected in the design, then you cannot add attachments,
and the Attachments table will provide the following informational text: Uploading of
Attachments is not allowed.

If there are files that have been referenced in the Attachments column of the Excel file and
Unifier cannot find the files in the attachment payload (attachment missing), the Attachments
table will provide the following informational text: "Some files are still waiting to be uploaded. Do
you want to proceed without uploading those files?" If you click OK, Unifier will ignore the
missing attachments (from the Excel file) and creates the line items, without any attachments. If
you click Cancel, you will be returned back to the Upload Attachments step of the upload
process.

If there are files uploaded in the attachment payload, but the uploaded files are not present in
the Files to be Uploaded section of the Excel, Unifier will not upload those files. In this
scenario, the Status value will not change in the review section, for the files.

Audit Log

Each BP record created through Microsoft Excel import will be audited. The following is the audit
attributes:
» For Non-Workflow BPs:
» Event
Creation by way of Microsoft Excel Import
» Action
Create <BP Name>
» For Workflow BPs:
» Event
Creation by way of Microsoft Excel Import
» Action
<Action Name>

Microsoft Excel Format for Creating Line Items for BP Records

You can create line items through the Microsoft Excel > Export Line Item Template option
within the Menu Options toolbar.

Note: This option is not available in the Bidder portal. A bidder can
import or update existing lines that are part of the Requestor package
through CSV import only.

You can see Export Line Item Template option only if the integration interface has been
defined for the BP record. If the BP record does not have a defined integration interface, then
the option will not be made available. In addition, this options will be available when the BP
record is in Edit mode. The Export Line Item Template option will be seen whether or not the
Upper Form property allows the addition of line items. Finally, this option will not be available in
the End step of a Workflow BP.
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MS Excel Template File

When you export your template file, the name of the exported template file will have the
following format: <BPName>_Line Items_Template

Note: The name will always be the source string without spaces.

Example

If the BP name is Daily Reports, then the template file name will be: Dai lyReports_Line
Items_Template.xlsx.

MS Excel Template File Worksheets

The exported template file will have the following worksheets:

»
»
»

Instructions worksheet
Imported Data Template worksheet
<Other User-Defined> worksheet

Instructions worksheet

This worksheet is generated automatically, and you cannot change the name of this
worksheet. The Instructions worksheet contains all of the relevant information about
entering the BP record and line item information data. The content of the instructions
worksheet will depend on the type of business process.

Imported Data Template worksheet

This worksheet is generated automatically, and you cannot change the name of this worksheet.
Always set by Unifier as the second worksheet in the template file, this worksheet contains the
data needed for creating BP record and line item.

Note: The name of this worksheet will be translated according to the
user's language preference.

The top section of this worksheet is dependent on the business process type.

For Generic Line Item BPs

»

v v v v

The first row will have the following static informational text: "Line Item Tabs along with
the respective detail form fields"

The rows that follow will list all of the line item tabs.

The rows that follow will list all of the line item tabs.

All of the required fields will have the asterisk symbol (*).

The tabs are listed in the next rows, one after the other. The hidden tabs are also listed,
similar to a CSV template.

After all of the line item tab fields, the subsequent rows will contain the fields that the user
can enter details for the BP record or line item that needs to be created. The first row, in the
data entry section, will have the following static informational text: "Enter data below"
The D row will list all of the fields from all of the tabs.

The Tab Name field is the label of the first column, followed by the detail form fields.
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For Cost BPs of Summary Payment Application SOV type

The first row will have the following static informational text: "Line Item Tabs along with
the respective detail form fields"

The rows that follow will list all of the line item tabs.
All of the required fields will have the asterisk symbol (*).

After the D row, a CA row will be seen. This row will have the asterisk symbol (*) for all of the
required fields of the cost allocation details.

<Other User-Defined> worksheet

A user may insert additional sheets for their reference. These sheets will not be processed
by Unifier at the time of import.

An end-user (you) can add multiple worksheets.

Note: The content of this worksheet will be ignored at the time of import.

Entering Data in the Microsoft Excel Template File
The following explains the general rules for entering data in the Excel template file.

You need to use the Import Data Template option in order to be able to enter data and
ultimately create records, or to create records with line items.

Note: Review the information on the Instructions worksheet to minimize
the import errors.

When entering data, you can:

» Enter data in all of the fields.

» Copy the values of a column from another sheet. This is to state that you can use the Excel
native features when entering data.

» Use Excel formula feature to calculate values in the columns.

Note: If you enter a decimal value in the Line No. field of the imported
template, Unifier will ignore the decimal value and will treat this line as a
new line item and will create a new line item after the import. This
method is applicable to both Excel and CSV imports.

Creating Line Items by way of Importing the Microsoft Excel Template Data

The Import option displays only if you can create new BP records. The sub-options within the
Import option display only if the Upper Form properties allow the addition of line items. These
include:

» Data From CSV File
» Data From Microsoft Excel File

To create line items by way of Importing MS Excel Template:
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1) From the toolbar, click Actions, select Import), and then select Data From Microsoft Excel
File.

2) Follow the prompts.

Note: Spend-type BPs with configurable manager are not supported for
importing line items.

Uploading

When you upload a Microsoft Excel file, in the Upload Microsoft Excel File window (similar to
the CSV), you can select the Excel file (using the Select File option) and click Next to proceed
with your upload. See below for information about adding attachments.

Validating Microsoft Excel File Content

There are multiple levels of validations that take place during the file import process. To begin,
Unifier will check to ensure that all required fields for the creation of a line item have been met
successfully.

In case of any failures, the import will fail, and the same file that was used for importing the data
will be changed to contain information about the errors. After the initial check has been passed,
the system will process the file further.

Errors and Corrections

When an error is encountered in any of the rows, the entire import will be aborted and no BP
records, line items, will get created. As mentioned earlier, when the import file contains errors,
Unifier will alert the user with the following message: "Import could not be completed.
There are errors in this template file. These errors can be seen in the Import
Data Template worksheet. Do you want to download the file and fix the errors?
Click "Yes™ to download the file and "No" to upload a different template
file."

Adding Attachments

Similar to the CSV file import, you can add attachments. You can upload all the referenced
attachments in the Add Attachments section. You can use the Upload Microsoft Excel File
window (in the 'Add Attachments' step) to add attachments to your BP record, or line item,
during your import. The review section on the screen enables you to see what which files are
uploaded and which files are remaining.

Example

When you upload the Microsoft Excel file, all the attachments listed in the Excel file will be
read by Unifier, and they will get listed in the 'Files to be uploaded' section. As, and when,
you upload the files, the status of the respective file will turn from "Waiting for File' to 'Ready
to be uploaded'.

You can perform sort operations on the Status column in the review section.

When you click Upload, Unifier uploads the attachments onto the respective BP record, or line
item, as required.
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Validating Added Attachments
When you upload your attachments, Unifier performs validations and:

» If there is no data in the Attachments column of the Microsoft Excel file that is being
uploaded, the system processes the file as a file that does not need have any attachments
that need to be uploaded.

» If you have specified a name for the Attachment column (either at the BP record level or at
the line item level), the system ignores the column headings.

For validating a line item level Excel import:

When you proceed with a line item import, from a Line Iltem tab, if the option Upload
documents from My Computer is not selected in the design, then you cannot add attachments,
and the Attachments table will provide the following informational text: "Uploading of
Attachments is not allowed."

If there are files that have been referenced in the Attachments column of the Excel file and
Unifier cannot find the files in the attachment payload (attachment missing), the Attachments
table will provide the following informational text: "Some files are still waiting to be
uploaded. Do you want to proceed without uploading those files?" If you click
OK, Unifier will ignore the missing attachments (from the Excel file) and creates the line items,
without any attachments. If you click Cancel, you will be returned back to the 'Upload
Attachments' step of the upload process.

If there are files uploaded in the attachment payload, but the uploaded files are not present in
the Files to be uploaded section of the Excel, Unifier will not upload those files. In this scenario,
the Status value will not change in the review section, for the files.

After a successful import, the line items get created. Subsequently, the line item log will get
refreshed with the newly created line items.

Audit Log

Each line item created through Microsoft Excel import will be audited. The following is the audit
attributes:
» Event
<Tab Name>: Line Item created through Microsoft Excel Import
» Action
Add <Short Description>

Microsoft Excel Spreadsheet File Format For Bulk Update Export/Import Process

The following applies to all business processes where BP records are exported using the Bulk
Update option to a Microsoft Excel spreadsheet (.xIsx). For more details on how to use bulk
update, see Exporting BP Records Using Bulk Update From Business Process Log Node
(on page 218).

When you select BPs using the Bulk Update option, the exported spreadsheet is saved using
the following file formats:
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» For business processes containing only Main Form data, the spreadsheet is named by
default in the format <BP Name>_MainForm.xlIsx. For example, Warranty MainForm.xIsx.

» For business processes containing Main Form data and line item data, the spreadsheet is
named by default in the format <BP Name>_MainForm_Lineltems.xIsx. For example,
Warranty MainForm_Lineltems.xIsx.

The exported/imported spreadsheet contains the following worksheets/tabs:

» An Instructions worksheet
The Instructions worksheet is generated automatically. Depending on the type of business
processes included in the spreadsheet, the Instructions worksheet describes how to use the
spreadsheet to enter or update BP record and line item data.

» A Main Form worksheet
The Main Form worksheet is generated automatically as the second worksheet in the
spreadsheet. It is recommended to not rename or reorder this worksheet. The content of this
worksheet is dependent on the types of BPs included in the export/import. It contains the
Unifier data needed for updating existing BP records, and line items.

4

4

Each BP record is identified by read-only columns in the following order: Record ID and
Record Number.

The following columns/data elements are also read-only: Record Status, Creator,
Creation Date, Currency ID, Due Date, Status in WF, BP, Formula Data Elements
and data elements that are set to auto-populate from the sum of all line items data
elements from the Integration Validation Form.

The line item tab order is identical to the order in the selected records.
Custom date formats are honored in the spreadsheet.

The data elements with direction set as Input or Both are shown as columns in the
exported spreadsheet.
The name of the worksheet is translated according to the user's language preference.

» Worksheet for each line item tab
Each Line Item tab worksheet is generated with the following format:

4

The line item records and the data elements of each tab are listed in the same order as
displayed in the user interface.

Each line item record is identified by read-only columns in the following order: Record ID,
Line Item ID, Record number, and Line No. These columns cannot be renamed,
reordered, duplicated, or removed from the file.

The formula data elements and auto-populated data elements are read-only columns.
Worksheet names do not support the following special characters:\/? *: [ or]

Error File Spreadsheet Format of Bulk Update Import Process

When the Bulk Update Import process is Completed with Errors, an Error file is generated as a
Microsoft Excel spreadsheet (.xIs).

Use any of the following methods to download the error file:

» Download the error file from the Import Data History Details window.
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For more details, see Viewing Bulk Update Import Data History Details (on page 221).
» Download the error file from the email notification you receive when the import process is
Completed with Errors.
The error file contains the following worksheets / tabs:

» Instructions worksheet

The Instructions worksheet is generated automatically. Depending on the type of business
processes included in the spreadsheet, the Instructions worksheet describes how to use the
spreadsheet to resolve errors identified in BP records and line item data.

» Main Form worksheet

The Main Form worksheet is generated automatically as the second worksheet in the
spreadsheet. It is recommended to not rename or reorder this worksheet. It contains a list of
erroneous records identified in the Main Form.

» Column A of the Main Form describes the error identified for each erroneous record.

Note: All line items associated with the erroneous record in the Main
Form will not be validated. Therefore, the error file may not show all
errors related to the line items for the erroneous record.

» The following columns/data elements are also read-only: Record Status, Creator,
Creation Date, Currency ID, Due Date, Status in WF, BP, Formula Data Elements.

» Data elements that are set to auto-populate from the sum of all line items data elements
from the Integration Validation Form.

» The line item tab order is identical to the order in the selected records.

» Custom date formats are honored in the spreadsheet.

» The name of the worksheet is translated according to the user's language preference.
» Worksheet for each line item tab

Line item tabs with erroneous records are color-coded orange. Each Line Item tab worksheet
contains:

» The line item records and the data elements of each tab are listed in the same order as
displayed in the user interface.

» Column A in the relevant Line Item tab describes the error identified for each line item
record.

» Each line item record is identified by read-only columns in the following order: Record ID,
Line Item ID, Record number, and Line No. These columns cannot be renamed,
reordered, duplicated, or removed from the file.

» The formula data elements and auto-populated data elements are read-only columns.
» Worksheet names do not support the following special characters: \/ ? * : [ or ]

Viewing the Import Audit Log

1) Navigate to:
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2)

» (For BPs at the company level) Go to the Company Workspace tab, switch to User
mode, click Company Logs in the left Navigator, and select the applicable BP sub-node.

» (For BPs at the project/shell level) Open the project or shell, switch to User mode, click
Logs in the left Navigator, and select the applicable BP sub-node.

The system expands the navigator to show the list of BPs.

In the Actions menu, click View Import Audit Log.

The Import Audit Log for the selected BP type opens. You can view information pertaining to

the import process that created the BP, such as the name of the CSV or Microsoft Excel file

that was imported, the date that the BP was created and completed, the name of the user
who performed the import, and so on.

Filling Out a Business Process Form

To fill out a Business Process (BP) form:

1)
2)

3)

4)

Complete the Upper form. Fields marked with a red asterisk (*) require an entry.
Add line items, if applicable.

» If this is a cost or line item-type BP add line items as necessary.

» If this is a Document-type BP, attach any documents to the form.

Add additional information, if applicable.

»  Comments

» Attachments to Comments

When you have completed the form, do one of the following:

» If this is a non-workflow BP:

a. Click Save to save your changes. Saving the form creates a permanent record.
b. Click Submit to render the record in view-only mode.

The system uses statuses to track the state of a business process record and any
line items it may contain. For example, a Pending status generally means people
are still working with the record, while a Closed status suggests the record is
complete. Records in Closed status are typically marked as Terminal, meaning the
record has reached a point where no further input is either required or desired.
You can still access a non-workflow record in a terminal status if the record is in
Edit mode. However, if you click Submit when the record is in a terminal status
the record becomes permanently read-only and un-editable.

» If this is a workflow BP:

a. Click the Send button. At the Creation step, sending the form to the next step in the
workflow creates a permanent record.

= |f the workflow is not yet complete, the form will be forwarded to the next step
in the workflow.
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= If the workflow is complete (that is, your task was the last step of the workflow),
the record will appear as complete in the business process log.

a. When you send the form, the Workflow Action Details window will open. Select an
action from the Workflow Actions drop-down list. Action selections depend on the BP
design, for example, if this is a review step, an action that you may be able to select is
"Approve Budget Approval." Selecting a Workflow Action activates the other fields of the
Action Details. If there is only one possible workflow action for a step, the action is
auto-populated in the field.

b. In Action Details, designate assignees for the next step; that is, the users and groups
who will receive the record as a task on the next step in the workflow. If the next step is
the End step, then the To field will be preassigned.

Use the Workflow Progress hyperlink, in the Action Details section of a
Workflow BP, to open the Workflow Progress window and view the workflow
progress status.

When you accept the task, the form becomes editable. On the editable, or
"action," version of a form (belonging to an accepted task), you can see the view
form of the business process (Task Details). In the view form, you can view the
Workflow progress status by clicking on the Workflow Progress tab in the right
pane. This option is available for Workflow records of both company-level and
Project-level BPs.

Saving a Draft of a Workflow Business Process

At any time while filling out a business process form (whether creating one or responding to a
task), you can save your work as a draft and return to it later. The record remains in your Drafts
log until you send it.

Note: Saving a draft is only applicable to Workflow type of BP records.
For non-workflow type of BPs, saving a record results in creation of a
record and not a draft.

To save a draft copy of the workflow business process form

From the File menu of an open business record, click Save. A draft copy of the form with your
edits so far is saved in your Drafts log.

To view your drafts
Navigate to the Drafts log by doing one of the following:

» Click Drafts under the Home tab. The Drafts log lists all draft business processes.

» Go to your project or the Company Workspace and navigate to Drafts under the
Collaboration grouping node.
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Notes:

= Drafts for View-Only and Inactive projects or shells are not listed in
the Drafts log.

= The system displays the Tasks, Notifications, and Drafts functional
nodes, in the respective Company Workspace and Project/Shell,
based on the deployment of your User mode navigators.

To open a draft
Click the gear menu ( ¥ ) next to a record from the Drafts log and click Open.
To delete a draft

Click the gear menu ( ¥ ) next to a record from the Drafts log and click Delete. The draft form
will be permanently deleted. A draft is automatically deleted from the log after the record has
been sent or otherwise completed.

Accessing Custom Business Process Help PDF File

Your company or your Project/Shell administrator may provide a custom Help file to give you
information about a specific business process. This file is provided as a PDF file, which can be
read with Adobe Acrobat Reader. If a custom help file is available, it will be listed under the Help
menu for the business process log or form.

Adding and Managing Line ltems

Detailed information, such as transactions, can be entered as line items on BP records, if they
have been designed to accommodate documents that are attached as line items.

You can edit or delete line items on a BP form if the form is still editable; that is, before it
reaches its terminal status (for example, approved). If you add a new line item in any step (other
than the creation step), you can modify the line item until the BP is sent to the next step. The line
item status will always default to the default line item status specified in the design. Users with
permission can change the status if modification to the line item status is allowed in that step.

You can add attachments and comments to line items. In addition, you can filter, copy, and
consolidate line items.

You cannot change the transaction currency value after you create a BP and send it to the next
step in the workflow.

Note: Document and Line Item BPs can be designed to include line item
status control, which allows users to choose a status for individual line
items and control whether they can be modified.
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Adding Line ltems

To add a line item:

1) In abusiness process form, select a line item tab and click Add. The right pane displays the
Line Item Details.

2) Complete the Line Item Details section. You can expand and collapse these information
blocks.

3) If your line item supports attachments, you can add attachments. The Attachments and
Linked Records tabs are seen only after you save the line item. For more information, see
Adding Attachments.

4) When done, select from one of the following options:
» Save & Close: To save the information that you have entered and close the window.

» Save & Add New: To save information that you have entered and refresh the window in
order to add another line item.

» Cancel: To discard changes that you have made and close the window.

Editing and Deleting Line Items

You can edit the line items on a BP record only if the design permits modification of line items
and if the record has not reached the terminal step.

Note: If the line item contains Yet To Buy (YTB) or AFC values, it cannot
be modified.

To edit line items
1) Select the line item tab.
2) From the left pane, select a line item. The line item details are displayed on the right pane.
3) Update the line items.
4) When done, select from one of the following options:
» Save: To save the information that you have entered.

» Save & Add New: To save information that you have entered and refresh the window in
order to add another line item.

» Cancel: To discard changes that you have made and close the window.

To delete line items
1) Select the line item tab.
2) From the left pane, select a line item.

3) From the gear menu ( % ), select Remove.
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Note: When a line item is removed, the system removes link information,
both from the record the line item belongs to, and from the record that
the line item was linked to.

When you edit a line item grid, the row counts (at the bottom left corner of the grid) capture the
following actions:
» New

The count will depend upon the Add action and the Copy action on the line item. The number
gets updated when you add new line items.

» Deleted
The count will depend on the Remove action on the line item.

Note: These counts will not appear when the grid is in View only mode.

To edit an image field on aline item grid

An image field on the grid displays only an image icon; however, you can see a thumbnail of the
image if you double-click the icon. If you want to change or remove the image, double-click the
cell anywhere but on the icon. The system displays a menu, from which you can choose to
upload a different image or remove the image.

To edit a hyperlink field on a line item grid

If you want to change a hyperlink, double-click the cell anywhere but on the hyperlink. The
system displays the Hyperlink window, where you can change or remove the link.

To edit a check box field on a line item grid

When the field is opened in Grid View, it is rendered as a box that you can select or deselect.

If the list of line items is opened in Form View, all the line items for a given tab are displayed.
Similar to Grid View, the check box in the line item list is also rendered as a disabled box with
the value.

The Find on Page option in the grid renders the check box field as a text box that lets you type
Yes or No. If you type Yes, then the system selects the check box and the line item associated
with the check box is displayed along with the selected check box. If you type No, then the
system does not select the check box and the line item associated with the check box is
displayed along with the deselected check box.

This table lists the sub-types of business processes and locations that allow the edit of line items
on cost business processes:
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i Shell (CBS Shell (Generic Company oo
Sub-Type Code) Code) Workspace Edit Line ltem
Line Item with
CBS Code Yes No No Yes
Line Item with
Both Fund Code | Yes No No Yes
and CBS Code
Line Item with
Fund Code Yes No No Yes
Line Item with No No Yes No
Account
Line Item with
Asset Code No No Yes No
Line Item with
Multiple Codes No Yes No Yes
Commit at No No Yes No
Company Level

Copy Line Iltems

You can create a line item by copying an existing line item. You can choose to include any
attachments that are on the source line item; however, any links the line item has to other
records will not be copied.

To copy line items from the same form:

1) In abusiness process form, select a line item tab.

2) Select a line item to copy and select ¥ > Copy.
3) From the Line Item Details tab on the right pane, complete all the required fields.
4) Click Save.

Filtering the Line Item List

Some business processes can include many line items, and filtering the list of line items can
make the form easier to use. To narrow the list of line items you see, you must use the Search
function. The Search function will search for and display specific line items according to the
criteria you specify.

To filter the line item list

1) Open the BP form and click the Search icon ( Q ) in the line item tab.

The window shows fields from the line item list, which you can use to narrow the list of line
items you see.
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Each field shows an operator, such as "contains" or "equals," which you can use to specify

more precisely which line items you want to see on the list.
You can narrow the list of line items to show only certain class levels or cost categories.

2) To specify search criteria, first choose the operator you want to use on the field, such as
"equals," "does not contain," or "is empty".

3) Enter the value the field should contain, or click the Select button and select the value from

the list that appears.
4) Click Apply.
The system displays all the line items that met the search criteria you entered.

If you choose to, you can cancel the filtering action by clicking [Cancel Search], or by
clicking Clear and then Apply in the Search window. The system will restore the list of line
items to its unfiltered state.

The total amount displayed at the bottom of the screen lets you select:

» Total Amount
» Filtered Total Amount

Total Amount is defined as: Sum of the "Amount" field from across all the line items.

Filtered Total Amount is defined as: Sum of the "Amount" field from the line items which are
the result of the Search criteria.

When a Search is active, then the option that you select from the drop-down will be the "Filtered

Total Amount.”

When the Search is canceled, then the system will default the option back to Total Amount. At
any given point of time, you will be able to toggle between the two options.

Example

Filtered Total Amount

Line # Spend Category Amount
001 Labor $100
002 Materials $200
003 Labor $300

If the Search parameter is set to "Spend Category = Labor," then after applying of the filter:
Total Amount = $600.00; (Option selected); Filtered Total Amount = $400.00

If the Search parameter is set to "Spend Category = Agreements," then after applying of the
filter:

Total Amount = $600.00; (Option selected); Filtered Total Amount = $600.00
If the user cancels the Search, then:
Total Amount (Option selected) = $600.00; Filtered Total Amount = $600.00
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Note: There is no page total. The user has the option to select between
the above two mentioned totals.

Line Item Consolidation

Business processes can be designed to accommodate line item consolidation: the ability to
select individual line items from one or more BP records (the source BPs) and copy them into a
new record (the destination BP). The selected line items can be from the same BP type, or they
can be from different types, as long as they are compatible. The source and destination BPs
must be at the same level (both company level or both project or shell level). File attachments
can also be copied. For example, this functionality can be used to consolidate specific line items
from multiple change order requests submitted over a period into a single change commit.

This functionality is built into business processes through the design, which includes specifying
which BPs can be used for the source and destination. Also, the ability to filter the business
process records that can be consolidated (by status) can be added. This enables you to filter the
records you see in the list to consolidate by the record status, allowing you, for example, to
exclude records that have the status of Pending or Rejected.

Note: Line Items can be edited after consolidation, if your administrator
has enabled it by deselecting the “Prevent consolidating the same line
item across multiple records” check box.

There are some restrictions when consolidating line items from different BP types.

The top pane of the Line Item Consolidation page is used to select BPs and records, and the
bottom pane is used to select the line items. Pagination in the top and bottom panes is seen only
if the number of records and line items (in both available and selected panes) exceeds 1000 and
200 respectively. You can expand and collapse the top and bottom panes.

Top Pane Toolbar Options

Toolbar Options Description

Select Business Process This drop-down menu lists all BPs that
allow consolidations.

View This drop-down menu is context-sensitive
based on the selected BP.

Search Enables users to search for specific line

items. Search parameters seen here are
based on the Find parameters set for the
line item list. Search is performed on the
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Toolbar Options

Description

database and works across all pages.

Find on Page

Enables users to find items on the
displayed page. When you click this
option, the system inserts a row that lets
you enter filter parameters.

Consolidate from other locations

The Shell Picker window is displayed.
Select shell.

Bottom Pane Toolbar Options

Toolbar Options

Description

Select Tab

Displays the line item tabs visible in the
form. Select a tab.

Group By

Group line items by column header. This
drop-down menu lists all log columns for
the selected log view of the BP. By default,
the <record_no label>is selected.

Search

Enables users to search for specific line
items. Search parameters seen here will
be based on the Find parameters set for
the line item list. Search criteria defined for
each for each tab's log layout will appear
as search parameters. Search will be a
database search and will work across all
the pages.

Find on Page

Enables users to find items on the
displayed page. When you click this
option, the system inserts a row that lets
you enter filter parameters.

Include Attachments

This option will be checked by default.
When this option is checked, attachments
if any existing in the line items will get
copied over.

To consolidate line items:
1) Select a line item tab.

2) From the Actions menu, select Consolidate Line ltems.
3) From the Select Business Process drop-down top menu, select a BP.
4) Select one or more BP records in the Records from All Locations section.
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5) From the Available Line Item List pane, select the line item tab.
6) Select the line items and click the arrows to move it to the Selected line Items pane.
7) Click Done.

Additional Information:

» If you open a record from the shell and try to consolidate line items, you will see the shell
picker (BP location picker).

» If you open a record from a project, when you try to consolidate line items, you will not be
able to see the BP location picker.

» If you are opening the record at the company level, when you try to consolidate line items,
you will not be able to see the BP location picker.

» If data picker is configured for a BP, line item consolidation displays records across all shells
or projects. This is applicable for a source BP that is associated with a project or a shell.

» If there is a source BP that is associated with a data picker, the system hides the shell
location picker.

» If the records are displayed based on data picker configuration for a shell, the “Records from
<Shell Name>" label changes to “Records from All Locations” label.

You can consolidate line items that have Line Item Data Pickers. While copying, the system runs
the query condition defined for the Line Item Data Picker, under the destination business
process configuration.

» If the query condition does not return the value that is getting copied, the Line Item Data
Picker value will not be copied over.

» If the query conditions are met, only the Line Item Data Picker value will be copied in to
destination line item and any other auto-population based on this picker will be populated.

If in the destination BP Line Iltem Data Picker the tab is hidden, and you are copying line items
from another BP record where the Line Item Data Picker has that tab line item selected, then the
line item will be copied without the picker value.

The Line Item Data Picker value from the source line items cannot be copied in to the
destination if in the destination the record BP Data Picker has a different record or no record
selected.

» When consolidating line items from a Cost BP to a SPA type commits BP, if the Cost Line
Item Type in the source BP record is the Variable Unit Cost, and the destination design does
not have the uuu_quantity and the uuu_unit_price, the system will display this message:
Cost Line Item Type of Variable Unit Cost cannot be created. Detail Form design for this tab
must include the data elements uuu_unit_price and uuu_quantity. The functionality is the
same in the case with the auto-creation of the SPA commit record, from non-SPA BP.

» When consolidating line items, from a non-SPA BP to SPA type commit BP and in the
destination if the amount data element is not defined as formula of uuu_unit_cost *
uuu_quantity, the amount value in the copied line item will be zero (0).

» Validations to be considered when consolidating or auto-creating line items into SPA BP:
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» The costed amount total must be equal to the line item amount, based on the form
properties in the design.

» All the fields that are marked as required must have data in the destination line item.

» When the line items are auto-created from a non-SPA BP, if the CBS Code does not exist in
the destination, the BP record will be created in the I-step. In this case, only the summary
line will be created.

Grouping Line Items

If your BP design allows adding or copying of line items, you can also choose to group line items
into meaningful categories. You can select one or more line items to add to a group and each
group displays the line items under it. The groups are displayed in alphabetical order, and the
line items that are not part of a group are displayed under the group Not Grouped. You can
change the name of the groups and move line items between groups. When a record or line
items are copied, the groups are also copied.

Notes:

= The Manage Groups option is available for Line Item and Cost BP
types. The Manage Groups option is not available for SOV type BP
(Summary Payment Applications).

= By design, you cannot move a group from the Selected Columns
section to the Available Columns section.

To create a group

1) After the line items are created, open a business process record, and select a line item tab
(for example, Line Item List tab).

2) Select one or more line items.

3) Click the Actions drop-down menu and select Manage Groups to open the Manage
Groups window.

4) In the Manage Groups window, click the plus icon ( @ ) to create a group on a new row.

5) Enter a name, and description, for the new group.

Note: Avoid using the "<" character while naming a group.

6) Select one of the following options:

» Cancel: If you make any changes to the groups and click Cancel, the window closes without
any changes saved.

» Save: If you make changes and click Save, your changes will be saved, but the Manage
Groups window will still be available to make more changes.
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» Save & Close: If you make changes and click Save & Close, your changes will be saved,
and the Manage Groups window closes.

To edit group property
1) From the line item tab, select a group by hovering over the group name.

2) From the gear menu ( %), select Edit Group Properties.
3) Change the name or description of the group, and select Save.

Note: Avoid using the "<" character while naming a group.
You cannot change the properties of the default group Not Grouped.

To add line items to a group

1) Open a business process record, and select a line item tab.

2) Select one or more line items. To select multiple line items, you have to click Cancel or
Save.

3) From the gear menu ( & ), select Add to Group and select a group.

The group line item will appear at the top of the line items area of the business process form in
bold. The Amount column will show the sum total of the line items you added.

If a line item has been copied and the copy source is already in a group, then the new copied
line item will be in the same group.

If the option is enabled, then in the Line Items tab, the Amount column displays the total
amount (only the amount value).
To remove line items added to a group

Select a line item and from the gear menu ( % ), select Add to Group and select Not Grouped.
You can also choose to move line items to other groups.

To manage groups

From the toolbar, select Actions > Manage Groups to open the Manage Groups window and
display all the existing groups, excluding the Not Grouped items. The sorting order is ascending,
by default.

The Manage Groups option is only available for Line Item type BP and Cost type BP (excluding
the SPA type BP). When there is a flat list of line items in line item log, the Manage Groups
option is not available. The Manage Groups option is available when there is at least one group
available to select.

In the Manage Groups window, you can delete existing groups, also (click a row and click the

trash-can icon). You can select multiple groups, right-click (or click the gear menu [ £ ]), and
select Remove, to move the groups to the Not Grouped items.

The groups are sorted in alphabetical order. The sort order of the line items within the group will
be governed by the Line Item List Sort as set in uDesigner.
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To expand or Collapse Groups
From the line items tab, selectthe © Collapse all Groups or @ Expand all Groups icons.

To create line item groups by using CSV
You can group line items by CSV import.

The system inserts an additional column in the CSV file, Tab Name, D row. The cell under the
Group Name column contains the line item group name. It is optional to enter a value. The
column is provided so that you can assign line items to the groups, at the time of creation.

When you import a line item, if the group name that you enter in the template exists in the
record, the system adds a line to the group.

If the CSV template has multiple line items, and if few lines have Group Name value and others
do not, then the ones with the empty Group Name will be in the "Not Grouped" group at runtime.

If the CSV template has no Group Name specified for any of the line items, then the line items
will not be grouped.

Example
In the CSV template below, the user is attempting to create a Daily Report record.

The user has entered H for the upper form details and wants to create the record with line items
in Equipments, Materials, and Visitors tabs.

1) Six line items have been entered against the Equipments tab, and four of the line items
belong to a Group called "All Equipments.” The subsequent columns in the D rows pertain to
the line item details.

2) The two line items that do not have any group mentioned will go under "Not Grouped," post
import.

3) The two line items have been entered for the Materials tab. Post a successful import, the
group "Reinforcements"” will be created.

4) One line item has been entered against the Visitors tab, and the user does not want to group
this one line item. As a result, the Group Name value has been left blank, intentionally.
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Viewing Groups when Referencing Line Items by Way of Line Item Data Picker

You can create line item groups under each line item tab in a business process record and view
the line items by group. When referencing a line item within a source BP record, you can also
select a line item (from the line item data picker) that belongs to a specific group (for example,
contract type). This is to state that if your selected source record line items have groups, then
the line item data picker shows the line items along with the group names; otherwise, a flat list of
line items (that match the query conditions) is displayed.

In the line item data picker:

» The groups are displayed in ascending order.

» The line items that do not belong to any group will be displayed under "Not Grouped"
column, similar to the line item log.

» In aline item data picker, when line items are filtered using query conditions defined for your
environment, group names should be shown along with filtered line items. The same
behavior is applicable if additional user filters record using Search or Find on Page in the line
item data picker.

» When line items are filtered (using query conditions defined for your environment), the group
names are displayed along with the filtered line items. The same condition applies if you filter
a record using the Search or Find on Page options in the line item data picker.

If you select a group node in the line item data picker, then the select option will not be enabled;
therefore, you cannot pick a group from the line item data picker.

The type-ahead feature of the line item data picker displays:

» Display element value
» Line number
» Group Name

Adding Line Item Attachments

After a line item is in the process of creation, the Attachments tab will be available in the right
pane.

To add an attachment to a line item:

1) Go to the business process and click the Line Items tab.
2) Click Add to create a line item.
3) On the right pane, click the Attachments tab.
4) To select a file from your computer, select Add Attachment > Browse.
a. Drag and drop files from your computer, or click Browse and navigate to your file.
b. Select if you want to revise the file automatically if a file with the same name exists.
c. Click Upload.
5) To select a file from Document Manager, select Add Attachment > Document Manager.

a. Select afile. You can use Find on Page to help you find a file. You can expand and
collapse the document structure to navigate to your file.

b. Select the Copy Comments check box to copy the comments that are associated with
the file you are attaching.
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c. Click Select.

Removing Line Item Attachments

The ability to remove an attachment depends on certain conditions. When you are assigned to a
task that has a line item attachment, you can remove the attachment if you have uploaded the
attachment yourself; otherwise, only the record owner (the creator) of the Business Process (BP)
record can remove the attachments.

Note: If you are working in the Classic View, you (the assignee) can
delete attachments uploaded by yourself as well as deleting attachments
uploaded by other assignees, users after the current user (you) accepts
the task.

To remove a line item attachment:

1) Go to the business process and click the Line Items tab.
2) Select a line item from the log.
3) On the right pane, click the Attachments tab.

4) Click the gear menu to open the menu and click Remove ( & > Remove).

Restricting Line Items by Using Copy with Conditions Option

You can use the Copy with Conditions option (from the gear menu [ % ] next to the record) to
copy a specific line item, rather than copying all line items. You can also use this option to:

» Include, or exclude attachments
» Include linked records
» Retain or remove references to auto-created records or line items

These copy options are set up by your administrator and will appear in a list that you can choose
from.

If no copy options have been created, then the Copy with Conditions sub-menu option will be
disabled.

To restrict line items using the Copy with Conditions option:

Note: The following is applicable to Company, Project/Shell, and master
logs. This option is not available in the Tasks log.

1) Select a BP and open the BP log.

2) Click the gear menu ( %¥ ) next to the record that you want to copy and select Copy with
Conditions.

3) Follow the prompts to complete copying your record for use.

134



Working with Business Processes

Adding and Managing Line ltems Using the Grid View Feature

For Line Item business processes, the system provides a grid feature (Grid View) that shows
the line-item entry form in a lateral sheet view, where you can enter the data directly without
having to open a line item form. In this regard, the sheet works the same way the line-item entry
form works—rows might not be editable because of their statuses, auto-populated fields will be
filled in for single-record BPs, if a yet-to-buy amount has already rolled up from a cost BP to the
cost sheet, you will not be allowed to modify the line item, and so on.

Note: The Grid feature is best used for short line items.

The following shows the Standard View of the Grid View:

If a line item has any attachments, you will see a paper clip icon next to the line item number,
which you can click to view a list of all attachments connected to the line item. If a line item has
been linked to another business process record, a link icon will appear in the column directly to
the right of the attachments column. If you scroll to the right, you can see the total amount of all
line item attachments in the BP record.

Note: Attachments, linked records, and the Total Amount will only be
visible if the BP has been designed to allow these line item fields.

The grid feature (Grid View) shows the line item number and all the fields on the line item entry
form, including fields that are required, formulaic, or populated, as well as fields that are part of a
dynamic data set. The fields on this grid work the same way they do on a line item entry
form—pickers display picker windows, menus display lists, formula fields produce calculations,
date picker fields display calendars, and so on; however, radio buttons will appear as drop-down
(pull-down) menus, and image, hyperlink, and BP Creator fields have special behaviors.
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You can resize the columns by dragging, and sort the data by column (except for Row and
image fields). You can use the Tab and arrow keys to move from field to field and open them.
For business processes that include many line items, you can use the Search function to filter
the list to display only certain line items.

The grid feature (Grid View) is not available on:

RFB bidder forms

Line Item with CBS Code BPs (Transfer classification)

Standard tab of Payment Application Line Item with CBS Code BPs
Line Item with Asset Code BPs

Line Item with Multiple Codes BPs (Transfer and Lease classifications)
Simple type BPs

Text type BPs

Document type BPs

Resource Booking type BPs for project/shell

Project/Shell Creation BPs (Simple sub-type)

VvV vV vV vV vV vV vV v v v

What is not available on the grid:

» Summary row functions: Summary line items do not appear on the grid and cannot be
created on the grid. In addition, line items within the summary do not appear.

Transaction currencies
Line item consolidation
Import function

Behavior Set DEs in the Grid Feature

Because fields displayed in the grid feature (Grid View) can come from DDS, the behavior set
DEs can be seen in the grid. If you select Disabled and Clear for a behavior set that is present
on the grid, then the updated value is displayed in the grid. This value is either populated with a
value or left blank.

Last One to Save Over-Writes Other Edits (Except for Deleted Rows)

The Grid feature can be used simultaneously by multiple users. To accommodate multiple
editors using the grid simultaneously, the commit order of saved edits is on a line-by-line basis,
not on the entire grid view. If two users are editing the same line item, but different fields, at the
same time, the edits made by the last user to save that line item are the edits the system will
commit to the record.

For example, if User 1 changes an amount field from 15,000 to 23,000 and saves the change,
and User 2 changes a different field, but does not touch the amount field, when User 2 saves the
grid, the system will commit User 2's edits; and the amount field will show 15,000 rather than
23,000.
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The order of saved edits is particularly important for deleted rows on the grid. After a row is
deleted, it cannot be reinstated with a later edit. For example, if User 1 deletes a row and saves
the grid view, and User 2 changes the amount field in that row from 15,000 to 23,000 and saves
the grid view, the row will not be reinstated with the new amount of 23,000.

Error messages

If the system detects errors when you save line items, error messages will appear in a pop-up
window, with a red x marking which line item contains the errors.

Add Line Items using the Grid

1) On the business process form, select the tab containing the line items you want to add to.

2) On the Line Item window, click the Grid button. The Grid window opens, showing a new,
empty row at the bottom of the list to use for the new line item.

3) To enter data into the grid, double-click a cell in the new row. The cell opens for editing.

As soon as you begin adding a line, a change icon appears in the first column as a reminder
that a line item has been added to the record, and the Save button becomes active.

4) Fillin the fields on the grid as necessary.

5) (Optional) To include an attachment to a line item, click the Attach button in the right pane.
Select either Browse, to attach a file from your computer, or Document Manager, to attach
a file from the document manager.

6) To save the line item to the record, click Save.

When you save the line item, the system:

» Refreshes the grid view.

» Removes the change icon.

» Adds the line item to the list.

» Inserts a blank line at the bottom of the list for another new line item.

» Updates the line items on the business process form.

» Updates summary if configured to do so.

» Line item summaries, for totals and summary averages, update in real time.
7) To add additional line items, repeat steps 3 through 6.

Link Line Items to other Business Process Records

After you begin the process of creating a line item, you can link the line item to a business
process record in the Linked Records tab.

To link a line item to a BP record
1) On the BP form, select the tab containing the line item you want to link to a record.
2) Select the line item you want to link and click the Linked Records tab in the right pane.

3) Click Add. The Add Records window opens.

4) Move records from the Available Records list to the Selected Records list with the arrows
between the two lists. You can narrow your search with the options in the top toolbar.

5) Click Done.
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When you link a business process record, the Linked Records tab shows the Current View
for all records and provides the following details:

» Direction
» Type
The contents of the Type column indicates whether the linked record has been

associated automatically (by way of Line Item Consolidation), or manually (by way of
manual linking).

» Business Process
» Record Number

» Record Title

» Record Location

- If the BP is a company-level BP, then the Record Location shows the Company
Workspace tab name.

- If the BP is a Project-level BP, then the Record Location shows the Project name.
- If the BP is a Shell-level BP, then the Record Location shows the Shell location.

Notes:

= You cannot remove the link Type: Line Item Consolidation.

If there are multiple line items consolidated from the same BP record,
then the BP record will be seen as a linked record for that many line
items.

If the line item with the link Type: Line Item Consolidation moves to
the status, "Previously consolidated lines are available when terminal
status equals" in uDesigner or is terminated, the link will be
automatically removed.

If using a Detail form, click Linked Records in the lower-right corner of
the Detail form. You do not need to save the line item in order to link
a record.

Edit Line Items using the Grid

To edit line items using the line item grid

1) On the BP form, select the tab containing the line items you want to edit.

2) Click the Grid View icon.

3) On the Grid, double-click the cell you want to edit. The cell opens for editing.

As soon as you begin editing, a red change icon appears in the first column as a reminder
that the line item has been modified, and the Save button becomes active.

4) Click Save.
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When you save the line item, the system refreshes the grid view, removes the change icon,
and updates the line items on the BP form.

5) To edit additional line items, repeat steps 1 and 2.

Notes:
= When editing the element of Dynamic Data Set, use the drop-down
list to select the values or labels.

= When editing the element of Multi-line Text Data Element (DE)/field,
use the text box to conduct your in-line editing. You can change the
width of the box, but the height of the box is set according to the DE
properties (that is, Number of lines).

When you edit a line item grid, the row counts (at the bottom left corner of the grid) capture the
following actions:
» New

The count will depend upon the Add action and the Copy action on the line item. The
number gets updated when you add new line items.

» Deleted
The count will depend on the Remaove action on the line item.

Note: These counts will not appear when the grid is in view only mode.

To edit an image field on aline item grid

An image field on the grid displays only an image icon: however, you can see a thumbnail of the
image if you double-click the icon. If you want to change or remove the image, double-click the
cell anywhere but on the icon. The system displays a menu, from which you can choose to
upload a different image, or move the image.

To edit a hyperlink field on a line item grid

If you want to change a hyperlink, double-click the cell anywhere but on the hyperlink. The
system displays the Hyperlink window, where you can change or remove the link.

To edit a check box field on aline item grid
When the field is opened in Grid View, it is rendered as a box that you can select or deselect.

If the list of line items is opened in From View, all the line items for a given tab are displayed.
Similar to Grid View, the check box in the line item list is also rendered as a disabled box with
the value.

The Find on Page option in the grid renders the check box field as a text box that lets you enter
Yes or No. If you enter Yes, the system selects the check box, and the line item associated with
the check box is displayed along with the selected check box. If you enter No, the system does
not select the check box, and the line item associated with the check box is displayed along with
the deselected check box.
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Insert a Row into the Grid

Inserting a row in the grid can be convenient if you have a long list of line items. The system
automatically opens a new line item at the top of the list, but if the list is long, it can be more
convenient to insert line items wherever you are in the list. When you save the grid view, the
system re-sorts the added rows into their proper place.

To insert a row or rows
1) On the Grid, select a row and click the Add button on the toolbar.

To insert multiple rows, click the Add button again. The system inserts the row(s) below the
row you selected.

2) Fill in the line item fields and click Save.
The system reassigns the line numbers as follows:

» If any rows have been deleted during an edit, the line numbers are reused so that the line
numbering remains continuous. (Exception: If the amount on a CBS line item has been
rolled up to the cost sheet, the line number will not be reused.)

» After deleted line numbers have been reused, any new line items are assigned numbers
in ascending or descending order, depending on how the sort order was specified when
the Item log was created.

Manually create a business process from the Grid

A BP Creator field configured for automatic creation mode will appear as a read-only field on the
grid. But if the field is configured for manual creation, you can set up the business process
creation from the Grid. The new business process will be created when you finish editing the
form, or send the form on to the next step in the workflow.

To manually create a business process from the Grid
1) Double-click the BP Creator field.
The field will display the words "Pending Creation."
2) Click Close Window to close the Grid and return to the form.

3) On the form, click Submit (if this is a non-workflow BP), or Send to send the BP form on to
the next step in the workflow.

The system creates the business process. After the business process has been created, this
field will show a hyperlink to the new business process.

To prevent a business process from being created
1) Double-click the BP Creator field.
The field will display the words "Pending Creation."
2) Double-click the BP Creator field again.
The system clears the text from the field and will not create the business process.

Copy a Line Item on the Grid

1) On the form, select the tab containing the line item you want to copy.
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2) On the Line Item window, click the Grid button. The Grid window opens
3) Select the line item (or items, using the Ctrl key) you want to copy and click Copy in the
gear menu ( £).

4) The system pastes the copied line item(s) into the row(s) above the selected line. Edit values
in each column as necessary.

5) Click Save. The system renumbers the line item(s) with the next incremental number(s) and
updates the line items on the form.
You can copy cell values by way of:

a) Dragging cell value

When you click a field (cell) in a line item grid that is editable, the system displays a small
blue square icon (indicator) on the lower-right corner of the cell. The indicator is available for
fields that are editable.

You can drag the indicator to copy the cell value onto the cell below. After you copy the
value, the value in the recipient cell appears as modified (the font will be purple in color, and
the format will be italic.

When you drag the cell values for multiple cells, the pattern of values of the copied cells will
also be copied.

If you select two cells and drag the values into three cells, then the system will replace the
value of the third cell with the value of the first cell that was copied.

b) Changing cell value

When you want to change the value of a field (cell) that is editable in multiple line items, use
the Shift key to select the consecutive (adjacent) line items, click the cell, in one of the line
items, enter the value that you want, and click Enter. You can use the Ctrl key to select
inconsecutive (not adjacent) line items.

Note: The search functionality is not available when the grid is being
edited.

Adding and Managing Line Items in Document-type BP Without Folder Structure

Creating a Document-type Business Process Line Item Record
You can create a Document-type BP line item record:

» Through Form View (a single line item and without importing attachments):

» You cannot submit the record to the next level without completing the required fields. If
you try to save the line item without completing the fields, the system will not create the
line item.

» Through Form View (importing attachments):

» You can submit the record to the next level without completing the required fields, in the
line item, by way of the “import attachments” option.

» When you open the same line items that were created in the Form View, from the Grid
View, you can send the record to the next level without completing the required fields.

» Through Grid View:
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» You cannot submit the record to the next level without completing the required fields for a
single line item or for multiple line items created through bulk upload.

Adding and Managing Comments

Business processes provide a general comments section that allows you to add text comments
that are like notes that accompany the business process but do not become part of it.

Depending upon the workflow setup and your permission settings:

» During the Creation step, you can specify whether to prevent users from adding or deleting
hidden comments.
You can hide comments entered by other users.
You can add, update, hide, display, or delete your own comments.
You can attach supporting documents to your comments, which do not become part of the
attachments of the BP itself, or mark up attached documents. See Working with File
Attachments and Markups (on page 151).

» You can add general comments if you are a task assignee or if you have been copied (cc'd)
on the business process.

» You can add comments to a business process at the End step, and also at any status in a
workflow, including Terminated (which means the business process was stopped at some
point in the workflow). To add comments at those points in a workflow, you must have the
Add General Comments permission.

Note: Some users, such as project managers, may have an additional
permission that allows them to add general comments to any form
(workflow or non-workflow) that they can view, without accepting the
task.

You can add comments if you are not a task assignee, provided that you have the following
permissions for business process records:

» View
» Add General Comments

In this scenario:

» You can only add general comments when the business process record is in View mode.

» You will not be able to hide comments. The Hide Comment option is available for task
assignees who are working on an accepted task (an Action form associated with the
workflow step).
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Add Comments to a Business Process Form

When you add a new comment to a business process form, it remains as a draft until you send
the form to the next step in the workflow. Comments are editable in the draft stage; you cannot
modify the comment after it has been sent to the next step. Comments that are in draft mode
can be edited by right-clicking the-comment and clicking Edit. By default, comments you post
are automatically hidden; you can deselect the Hide box to make comments public. Private draft

comments have the following hidden icon ® next to them; when the record moves to the next
step in the workflow, the hidden icon changestored ¥ .

To add comments to the business process form
1) Open a business process record.

2) Select the main form (Record Details) tab.

3) From the right pane, select the Comments tab.
4) Enter your comments in the Comments box.

5) To add an attachment to a comment from your computer, click Attachment @ > Browse.
a. Drag and drop files from your computer, or click Browse and navigate to your file.
b. Select if you want to revise the file automatically if a file with the same name exists.
c. Click Upload.

6) To add an attachment from Document Manager, click Attachment @ > Document
Manager.

a. Select a file. You can select the Find on Page icon to help you find a file. You can
expand and collapse the document structure to navigate to your file.

b. Click Select.
7) Deselect the Hide check box to post a public comment.
8) Click Post.

Note: The Comments box does not recognize formatting, including line
breaks. Even if you press the Enter key to make a new line in the Text
Comments section, the final comment will not reflect the new line.

If the Comments tab of the business process form contains any comments, then a Comment [
indicator is displayed. If the tab contains no comments, then the right pane is refreshed and the
indicator is no longer displayed.

Copying Comments

To copy your comments:

1) From the Comments tab, right-click a comment and select Copy. A new comment row is
created.

2) Use the Comments box to add or edit the comment.

3) To add attachments, click Attachment @ and select Browse or Document Manager.
4) Click Post.
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Notes:

= Click an attachment to open it.

= To download and attachment, select the arrow next to the attachment
and select Download.

= To delete an attachment, select the arrow next the attachment and
select Delete.

Add Comments to a Document Type Business Process

To add comments to a document type business process
1) Open the document.

2) On the right of the screen, there will be a Comments widget. Enter your comments in the
Comments box.

3) To add an attachment to a comment from your computer, click Attachment @ > Browse.
Open a file from your computer.

4) To add an attachment to a comment from the document manager, click Attachment @ >
Browse. Select your file from the document manager that you'd like to attach.

5) Click Post.

This process also applies to documents attached to business process records.

Note: If the document type BP has been designed to use line item
status, and a specified status has already been reached (for example,
approved), the line item may no longer be editable, and you may not be
able to add comments to it.

View Comments

To view comments
1) Open a business process record.

2) Select the Comments tab from the right pane. A list of comments is displayed on the right
pane. The name of the user who posted the comment, the company name of the user, and
the timestamp when the comment was added or updated are displayed. You can also view
the attachments associated with the comment.

When the tab is expanded, the left pane displays the grid and the right pane displays the
content of the selected comment.

3) To filter the comments, use the Posted By drop-down menu to view comments by a specific
user or by all users.

Edit or Delete Comments

Comments on a business process record are displayed in the Comments tab.
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When you add a new comment to a BP form, it remains as a draft until you send the form to the
next step in the workflow. Comments are editable in the draft stage; you cannot modify the
comment after it has been sent to the next step. Comments can be deleted after being sent, only
if the BP workflow has been set up to allow deletion of comments.

To edit a comment

1) From the Comments tab, select a comment.
2) Right-click a comment, and select Edit.

3) Update your comments.

4) Click Post.

To delete a comment
1) From the Comments tab, select a comment.
2) Right-click a comment, and select Remove.

Deleting a comment will create an entry in the Audit Log tab for the business process.

» The Date column will list the date that the comment was deleted.

» The Event column will state that this event occurred in the comments of the business
process.

The Action column will state that the comment was deleted.
The New Value column will list the comment that was deleted.

Hide Comments

You can hide comments that you do not want to be generally viewed on workflow business
processes. If you have permissions, you can view previously hidden comments. Other users will
not be able to see the hidden comments unless they have the View Hidden Comments
permission set, and using that permission, can also unhide the hidden comments. As the creator
of the comment, you can view your own hidden comments, whether or not you have the View
Hidden Comments permission (until the comments are published).

Note: Hidden comments are never included in the PDF attached to
emails, regardless of a user's view permissions.

To hide or unhide comments

1) From the Comments window, right-click the comment, and click Edit.
2) Select the Hide check box.

3) Click Post.

Note: Due the nature of end steps, you cannot hide or delete comments

on the end step of the workflow, even if the end step is an action
(editable) form.
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Working with Query-Based Tabs
Query-based tab (QBT) enables the user to:

» View a filtered list of business process records associated with the parent business process.
Once the QBT in a business process is correctly configured and deployed, the QBT appears

in the business process for which the QBT has been configured.

» Create a new business process from the QBT in the same Project/Shell, where the parent
business process resides.

Users can create new business process records from the QBT provided that the users have
permission to create business process records for the Project/Shell that contains the
business process.

» Copy a business process in the same location as the parent business process.

Users can copy a business process either with or without attachments. In addition, a user
can copy any of the records in the QBT and create a new business process record. Note,
only one record at a time can be copied.

When the user copies a business process record in order to create a new business process,
the new business process record contains all the information present in the copied/based

business process record. So, in case of business records with attachments, the user has the

option of including or excluding (copying or not copying) the attachments when copying a
business process record.

» Search for business process records based on user-entered criteria.
Users can find any record from the list of records included in the QBT.

Notes:

= The fields available for the Find feature must be defined for the
business process.

= The source Business Process/Space/Level of the QBT must be active
for the tab to display.

Using or Viewing a Query-Based Tab
To use or view a Query-Based Tab (QBT):

1) Navigate to the parent Business Process log in your Project/Shell.
2) Open a record to view the QBT.

Note: The source Business Process/Space/Level of the QBT must be
active for the tab to display.

3) Click New or Copy to create a record. The new record will display if query conditions are
met.

146



Working with Business Processes

As a pre-process to defining the Query tab in the business process (applicable for Line Item,
Cost, and Document-type business processes), you must use a reference picker in one of the
upper forms of the business process, Space, or Level from where you want to create the Query
tab. For defining a Query tab, click on the Query Tabs link in uDesigner, click New, and select a
business process, Space, or Level. The system allows you to create a maximum of 8 tabs in
uDesigner, including the QBT.

Format of the Currency for Query-Based Data Element (QBDE)

When the values for the query conditions are set, you can see the QBDE values according to
the values that had been set up in the Modify Data Element window (selecting, or deselecting,
the Hide Currency Symbol in Cost type Business Process option). Go to your project (User
mode) and click the item.

When you open the record, you will see the same QBDE value, in the new user interface. You
can print the record. In the Classic View, the Upper Form contains the values, accordingly.

Administrator

Go to Company Workspace (Admin mode) > Configuration > Business Process.
Click a BP to open the Configuration window.

Click the Query tab.

Under the Query Conditions block, click the query element name, and click Modify.
Define the values under the Definition and Condition blocks and deploy.

Creating a Record from the Query-Based Tab

When creating a record from its own BP log, the “SYS Numeric Query Based” Data Definition is
updated when the user picks a reference process.

When creating a record from the Query Based tab of another BP (that auto-populates data to the
record being created), the “SYS Numeric Query Based” Data Definition is not updated, unless
the user:

- Manually changes the value.

- Uses a triggering element.

You cannot create a company-level business process record within a project, from a
Query-Based tab.

Using Query-Based Tab Logs

From the Query-Based tab log, you can view, create, and copy BP records. The following toolbar
options are displayed in the log.

Toolbar Options Description

Create Create records from the QBT. This button
is seen only if you have permissions to
create the record. Click the arrow to select
a workflow if multiple workflows exist for
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Toolbar Options Description

the BP

Q Refresh Refresh and reload the page

& Print Print Prints the list view. You can choose from:
Print, Export To CSV, Export To Excel.

Notes:

= For export to
Microsoft
Excel, the
system
currently
supports only
Euro (EUR)
and United
States Dollar
(USD) currency
symbols.

= |f you export
data from a
business
process (BP)
record, sheet
(such as an
Activity Sheet),
or log (such as
Company
Funding Sheet
Log) to Excel,
be aware that
depending on
how your
negative values
are formatted,
you might need
to configure
your columns
in Excel to
match the
correct data
type (Number).
Otherwise, the
columns will
not be treated
as numeric and
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Toolbar Options

Description

will not sum as
expected. One
supported
format includes
placing the
negative sign
between the
currency
symbol and the
amount (for
example,
$-1,000).

= Find on Page

Lets you find items on the displayed page.
When you click this option, the system
inserts a row that lets you enter filter
parameters.

Q  Search

Lets you search for specific line items
across all pages.

The gear menu ( ¥ ) displays next to each record and contains all available actions that you can

perform on the record. The following options are displayed in the gear menu ( % ): Open, Copy,
Copy With Attachments, and Copy Without Attachments. The copy options are displayed
only if you have permissions to create records in the current shell.

Query Based Data Element (QBDE) Evaluation
The Query Based Data Elements (QBDES) are evaluated through one of the following ways:

a) Based on the refresh conditions, when the record is opened (even from the draft).

b) Based on the manual editing of the trigger elements, through user interface (this does not
include the situation in which the record is initially created).

c) Based on when the record is created. That is, the system evaluates QBDE values based on
trigger element population, when a new record is created.

When you create a BP record (creation step of a BP record), the system evaluates the QBDES:

» When the trigger element is edited manually on the form in the creation step.
» When the trigger element is auto-populated.
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Note: If a BP Data Picker (BP Picker) or any Data Picker is selected as
a trigger element for QBDE and the picker value is automatically
populated (auto populated) instead of manual entered, the QBDE
element will not be evaluated.

QBDE Evaluation in BP Records Created through CSV import or RESTful Services

The system evaluates the QBDESs when the trigger element is populated by way of a record that
has been created through CSV, RESTful service (if the trigger element is entered in the input
CSV request), BP templates, and Bypass | Step or S Step auto-creation.

QBDE Evaluation in BP Records Created through Auto-Creation

When a business process record is auto-created through Bypass | Step and S Step, the system
evaluates the QBDE values in the auto-created records based on the trigger element population.
When a trigger element is used for QBDES, and the trigger element is auto-populated, the
system evaluates the QBDE values in the creation step of the auto-created record.

In the case of Bypass | Step auto-creation, if the auto-created record resides in Initiation Step,
the system does not evaluate the QBDESs.

The system evaluates formulas that use QBDE in the creation step of the BP form.

If the QBDESs are used in the workflow routing conditions, then the QBDE values will be
populated in the log and view form (if they are added after the successful creation of records). In
this scenario, the system evaluates the QBDE values after evaluating the auto-populated DEs
and formula DEs on the form.

You can use the QBDEs in business processes in the workflow routing condition, which lets you
determine the route of the workflow based on the value of the data element.

The system evaluates the formulas in QBDEs, in the creation step of a BP record.

The system will not evaluate the QBDE values based on trigger element population in BP
records that have been created by way of copy (with or without attachments). For example,
when you create a Budget Item BP, you can view the QBDE Assigned Budget value, evaluated
from the project cost sheet in the creation step.

In uDesigner, the trigger element "Contract No" is defined for QBDE in the "Assigned Budget"
and is set to auto-populate from a constant value. (uDesigner > Business Processes >
Budget Items > Upper Forms > ...)

You can view the QBDE in the "Assigned Budget" value when a new record is created--in
creation step as a trigger element "Contract No" is populated.

Element Properties > Auto Populate > Auto Populate window > Source Name: Constant
Value > Source Value: Contract > ... > Trigger Elements window > General tab: Contract
No is a trigger element for QBDE Assigned Budget and is set to auto populate from constant.

When you create a new Budget Item BP record, the system evaluates the QBDE in the
"Assigned Budget" value at runtime and displays the total amount (from project cost sheet
column) based on the trigger element auto-population.
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The system evaluates the QBDE values in the creation step of a BP record if the trigger element
is auto-populated by way of any source such as a single record BP, shell attributes, and so forth.

The system evaluates the QBDE values for the BP records that have been created through the
schedule BP creation template, whenever the trigger element is populated.

The draft BP records, in the creation step, can have their QBDE values re-evaluated only if the
trigger element field is not null. The QBDE value will be populated in the BP log when the BP
record is created or saved as draft.

Working with File Attachments and Markups

You can attach files to be routed with a business process (BP) form. These attachments may be
supporting documents that are attached to a BP record. You can also include attachments to the
Comments section of the BP.

By default, files attached to business processes are placed in the Unpublished Documents
folder in the Document Manager. A Publish Path data element can be designed in business
processes to specify the automatic publishing of documents to a specified path and override the
default. For details about automatic publishing of documents, see the Unifier Managers User
Guide.

Drawing files attached to Document-type business processes may be accompanied by multiple
reference files, which may need to be resolved when attaching a drawing file.

Notes:

= Before publishing a BP, you can rename an attachment.

= You cannot upload and attach two documents with the same name to
a BP record.

= For security, the Company Administrators can specify the list and size
of files that can be uploaded to the Company Properties page, by
users and per company policy. Contact your Company Administrator
for more information.

Adding Attachments

To add attachments to the main form of a business process record
1) Open a business process record.
2) Select the Attachments tab from the right pane.

3) To select a file from your computer, select Attachment @ > Browse.

a. Drag and drop files from your computer to the Drag and Drop box, or click anywhere in
the Drag and Drop box and navigate to your file.

b. Select if you want to revise the file automatically if a file with the same name exists.
c. Click Upload.

4) To select a file from Document Manager, select Attachment @ > Document Manager.
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a. Select a file. You can select the Find on Page icon to help you find a file. You can
expand and collapse the document structure to navigate to your file.

b. Select the Copy Comments check box to copy the comments that are associated with
the file you are attaching.

c. Click Select.

The Publish check box is disabled for documents that have been added from the Document
Manager. For files attached from your local system, the Publish column is automatically
checked; you can choose to un-check it.

If the Attachments tab of the business process form contains any attachments, then an

Attachment @ indicator (paper clip icon) is displayed. If the tab contains no attachments, then
the right pane is refreshed and the indicator is no longer displayed.

Additional Information about Adding BP Record Attachments

Text-type BPs do not support record-level attachments; therefore, you cannot add attachments
to upper form or action form.

Note: You cannot add record-level attachments to text-type BPs through
integration, using CSV (Excel) import or SOAP or RESTful services.

Upper Form

An upper form is the upper portion of a BP form. The upper form contains the basic
information that the form is managing, such as the name of a record and its description, who
created the record and when, and so on. It also contains general data entry, informational, or
reference fields for the BP form.

Action Form

The action form is the version of the BP form that opens when the recipient accepts the task
implicit in the form. As a BP arrives at each step in a workflow, the system notifies the
appropriate users, if they are involved in the step. When they open the natification, the
system displays a view-only form of the step's task. If the user accepts the task, the form
becomes an action form where the user can enter or edit information and attach additional
documents. See also “View Form” in the Unifier Data Reference Guide.

You can include attachments in all other types of BP records, by using the Attachments tab. To
include comments and comment attachments, go to the Comments tab.

You can add attachments to the text entry form, along with your comments. These attachments
can be viewed, in the response list. Attachments to comments are available in the unpublished
documents section.

Opening an Attachment

To open an attachment:

152



Working with Business Processes

1) Select the Attachments tab from the right pane. A list of attachments is displayed on the
right pane. File revisions are displayed under the Revisions tab only if the file has revisions.
The References tab is displayed only if there are references to drawing file attachments.

2) Select an attachment and select ¥ > Open in AutoVue, or double-click the name of the
attachment.

For more information on adding annotations and markups, see Add Markups to a Business
Process Attachment.

Renaming an Attachment
Before publishing a BP, you can update the name of (rename) an attachment.

1) Inthe right pane, select the Attachments tab.
A list of attachments is displayed.

2) For the attachment in the Unpublished Attachments list that you want to rename, click the
gear menu (%), and select Rename.

3) Inthe Rename Attachments dialog box, update the name, and click Save.

4) When the Notification message appears, click OK.

Attach Files to Comments Section of a Business Process

The Comments tab lets you enter your comments and attach documents or files that can
provide more information about a BP record.

Note: The Comments option cannot be used for updating any BP record.

To use the Comments option to enter your comment and attach files or documents:

1) Go to your project or shell (User mode), and open the BP record.

A Business Process (BP) record could be in a folder such as Project Delivery, Cost Manager,
Cost Controls, and so forth, in the left Navigator.

2) In the right pane of the BP record, click the Comments tab.
3) Click the Attach Files button (paperclip) and select one of the following options:
» Browse
» Document Manager
4) When you are finished adding attachments, click Post.
Note: The attachment sources (My Computer and Unifier Folder) are
available based on the BP design; these two options may not be
available for a given BP.

The following explains the file attachment options in detail.
» Attaching files to a Document-type BP from My Computer (on page 154)
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» Attaching files to a Document-type BP from Unifier Folder (on page 154)
Attach Files to a Document-type BP from My Computer

This option lets you attach files from your computer or your local system onto a Document-type
Business Process record.

After you select this option, the Upload Files window opens. You can add files to this list with
the Browse button. This will open your system's file manager where you can select files to open.

You can either drag and drop files into the attachment list or use your system's file manager to
add the files to the list. You cannot upload two files with the same name. After all files have been
added, click Upload to add them to the attachment list in the Comments tab.

Note: The system does not attach folders. If you select a folder, the
system attaches the contents of the selected folder, in a flat list.

By default, files attached to a business process are placed in the Unpublished Documents
folder in the Document Management grouping node (Project/Shell > User mode > Document
Management > Unpublished Documents).

A Publish Path data element can be designed in Business Processes to specify the automatic
publishing of documents to a specified path and override the default. For details about automatic
publishing of documents, see the Unifier Managers User Guide.

Attach Files to a Document-type BP from Unifier Folder
This option lets you attach files from the Document Manager (Documents folder).

When you select this option, the Select Files window opens, which displays all the folders of the
Project/Shell documents.

Navigate through the listed folders to find documents to attach. You can highlight multiple files
with Ctrl or Shift. After you have gathered all the applicable files, click Select.

Notes:

* Folders are not attached. Instead, the contents of a selected folder
are attached in a flat list.

= The system does not allow attaching files with duplicate file names.

By default, files attached to a business process are placed in the Unpublished Documents
folder in the Document Management grouping node (Project/Shell > User mode > Document
Management > Unpublished Documents).

A Publish Path data element can be designed in Business Processes to specify the automatic
publishing of documents to a specified path and override the default. Refer to Unifier Managers
User Guide for details about automatic publishing of documents.
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Document-Type Business Process Forms (Without Folder Structure)

A Document-type BP without folder structure does not maintain the folder structure of the
attached documents and folders, and the files (within the attached folders and sub-folders) are
listed in a flat list.

1) Go to the project/shell tab and switch to User mode.

2) Inthe left Navigator, click Logs and open a Document-type BP without folder structure.

3) Open arecord. By default, the record properties window (General tab) opens.

Note: Document BP without attribute form is not supported in the new
user interface.

The following explains each tab.
General tab.
On the upper-right side of the record window, you can Accept or Decline, and use the Menu
Options icon (three horizontal lines) to perform and access the following:
» Add more assignees
» Auto-create
» CC more users
» Email as Attachment
» Print (HTML, PDF, Custom)
» AutoVue Review
» Terminate Record
» Transfer Ownership
» Help (record help and User Productivity Kit)
» Close
On the left pane, you have the following options:
» Record No.
» Status
» Title
» Revision no.
» Issue Date
» BP Creator
» Other fields
On the right pane, you have the following tabs:
» Comments
» Linked Records
» Linked Mail
»  Workflow Progress
» Audit Log
» Reference Records
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The Maximize icon is also available to expand the screen.

Line Items <line items> tab. The line items for Document-type BP are displayed according to
the line item log designed in uDesigner.

On the upper-right side of the record window, you can Accept or Decline, and use the Menu
Options icon (three horizontal lines) to perform and access the following:
» Add more assighees
» Auto-create
» CC more users
» Email as Attachment
» Print (HTML, PDF, Custom)
» AutoVue Review
» Terminate Record
» Transfer Ownership
» Help (record help and User Productivity Kit)
» Close
On the left pane, you have the following toolbar options:
» View Comments by
» Download
» Refresh
» Print
» Search
» Find on Page
The following columns are also displayed:
= Name
= Record Comments (callout icon)
= Draft Comments (pen icon)
= Line Item Status
= Short Description
= Other fields
On the right pane, you have the following tabs:
» Line Item Details
» Attachments
» Linked Records

Refer to Unifier Managers User Guide for more details.

Adding Attachments to the Line ltem

1) Go to your Project/Shel and switch to User mode.

2) In the left Navigator, click Logs and open a Document-type BP without folder structure.
3) Open arecord. The record General tab opens, by default.

4) Click the Line Items <line items> tab.
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5) On the right pane, click the Attachments tab.

Attachments tab

When you create a line item, the system allows you to use the paper-clip icon to attach a file
to your record. After you save the line item, the Attachment tab appears for the record.

The Attachment tab provides additional details about an attachment in the following
columns:

4

4

Note: You can preview the file in the Attachment tab. Click the expand
icon to expand the window and see the file preview.

Publish (select or deselect)
Name

Bluebeam Session Status
Comments

Revised

Title

Pub. No.

Rev. No.

Issue Date

Size

Location

In addition, if there is a revision to an attachment, the following columns are displayed in the
Revisions block:

4

4

4

4

4

Publish (select or deselect)
Name

Comments

Ref.

Pub. No.

Upload Date

Size

Upload By

Rev. No.

Issue Date

Use the gear menu, next to the file to:

4

4

Note: After saving the line item, you must use the gear menu, next to the
attachment (file), to remove the attachment. Use the trash can icon to
remove your attachment prior to saving the line item.

Review

Open in AutoVue (You can also open an attachment by double-clicking the name of the
attachment)
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» Download
» Revise
» Remove

Importing Attachments (Without Folder Structure)

You can create line items in a Document Type BP without folder structure record and import
attachments into the line items (go to a Document Type BP without folders record, click Actions,
and select Import Attachments). For any Workflow, Non-Workflow, or Document Type BP
without folder structure record, you must ensure that all the required fields have values.

Document-Type Business Process Forms (With Folder Structure)

A Document-type BPs with folder structure maintains the folder structure of the attached
documents and folders, and the files (within the attached folders and sub-folders) are listed in a
flat list.

1) Go to the project/shell tab and switch to User mode.

2) In the left Navigator, click Logs and open a Document-type BP with folder structure.

3) Open arecord. By default, the record properties window (General tab) opens.

Note: Document BP without attribute form is not supported in the new
user interface.

The following explains each tab.
General tab.
On the upper-right side of the record window, you can Submit or Decline, and use the Menu
Options icon (three horizontal lines) to perform and access the following:
» Email as Attachment
» Print (HTML, PDF, Custom)
» AutoVue Review
» Transfer Ownership
» View Record Location
» Help (record help and User Productivity Kit)
» Close

On the left pane, you have the following options:
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» Record No.

» Status

» Publish Path

» Issue Date

» Other fields

On the right pane, you have the following tabs:

» Comments (use the paper clip icon to Browse uploaded files or go to Document
Manager to select files)

» Linked Records

» Linked Mail

» Reference Records

The Maximize icon is also available to expand the screen.

Line Items <line items> tab. The line items for Document-type BP are displayed according to
the line item log designed in uDesigner.

On the upper-right side of the record window, you can Submit or Decline, and use the Menu
Options icon (three horizontal lines) to perform and access the following:

» Email as Attachment

» Print (HTML, PDF, Custom)

» AutoVue Review

» Transfer Ownership

» View Record Location

» Help (record help and User Productivity Kit)
» Close

On the left pane, you have the following options:

» View Comments by

» Refresh

»  Print

» Search

» Find on Page

» Expand All Groups

The following columns are also displayed:

= Name
= Record Comments (callout icon)
* Line Item Status
= [Issue Date
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= Other fields
On the right pane, you have the following tabs:
» Folder Details

Refer to the Unifier Managers User Guide for more details.

Adding Attachments to the Line Item

1) Go to your Project/Shel and switch to User mode.

2) Inthe left Navigator, click Logs and open a Document-type BP without folder structure.

3) Open arecord. The record General tab opens, by default.

4) Click the Line Items <line items> tab.

5) On the right pane, click the Attachments tab.

Attachments tab
When you create a line item, the system allows you to use the paper-clip icon to attach a file
to your record. After you save the line item, the Attachment tab appears for the record.

The Attachment tab provides additional details about an attachment in the following
columns:

Note: You can preview the file in the Attachment tab. Click the expand
icon to expand the window and see the file preview.

» Publish (select or deselect)
» Name

» Bluebeam Session Status
» Comments

» Revised

» Title

» Pub. No.

» Rev. No.

» Issue Date

» Size

» Location

In addition, if there is a revision to an attachment, the following columns are displayed in the
Revisions block:

» Publish (select or deselect)
» Name

» Comments

» Ref.

» Pub. No.

» Upload Date

» Size
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» Upload By

» Rev. No.

» Issue Date

Use the gear menu, next to the file to:

Note: After saving the line item, you must use the gear menu, next to the
attachment (file), to remove the attachment. Use the trash can icon to
remove your attachment prior to saving the line item.

» Review

» Open in AutoVue (You can also open an attachment by double-clicking the name of the
attachment)

» Download
» Revise
» Remove

Importing Attachments (With Folder Structure)

You can create line items in a Document Type BP with folder structure record and import
attachments into the line items (go to a Document Type BP with folders record, open the folder,
open the record, click Actions, and select Import Attachments).

If the Enforce validations on Detail form option has been enabled in uDesigner, the Validate
Attachments dialog will display after you upload.

To upload attachments for import:

1) Drag and drop files from your computer to the Drag and Drop box, or click anywhere in the
Drag and Drop box and navigate to your file.

2) Select one or more files using the Shift or the CTRL keys.

3) Click Upload.
Each file is displayed as a line item.

4) Inthe Validate Attachments dialog, perform any of the following actions for each line item:
» Click Error Check to review all errors flagged for the uploaded attachments.
» Click Save if no errors display or all errors have been resolved.
» Click Cancel to discontinue the import.

For any Workflow, or Non-Workflow, Document Type BP with folder structure record you must
ensure that all the required fields have values.

Copying Folder (Standard View)
If you have permission to create folders in a Document-Type Business Process For (With Folder

Structure), then you can see an additional option in the gear menu ( % ): Copy. The gear menu
options will be:

» Add Sub Folder
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» Move
» Copy
» Delete

Note: The above gear menu options apply to the customer-created
folders only and not to the system-defined root folder, "Attachments."

Using the "Copy" option lets you copy a folder into the same path where it currently exists. In this
case, the name of the newly created folder will be: "Copy of <original folder name>."

Notes:

= The bracket ">" symbol between the source folder and the destination
folder has the hover over text: "Copy to."

= The option "Copy" remains disabled until you select a destination
folder.

= When the copy action is complete for a folder, the original source
folder continues to show as the selected folder in the grid.

Attach Files to Document-Type Business Process Forms

Document-type business processes, such as Transmittals or Submittals, can be used for routing
documents such as specifications or drawings for review.

Note: Comments and graphic markups can be added to individual files,
and the document list is easily accessible from the BP form.

Document-type BPs can be designed such that files can be added to individual line items. This
feature lets you assign line-item status to individual documents. If the status of the line item (and
therefore, the associated document) reaches a specified status, for example, Approved, then the
BP can be set up so that the line item is no longer editable. At this point, attachments and
comments to that line item are no longer allowed.

There are two subtypes of Document-type BPs:

» Document-type BPs with folder structure

A Document-type BPs with folder structure maintains the folder structure of the attached
documents and folders, and the folder structure is displayed in the lower-left pane of the
form.

For Document-type BPs with folder structure, the designer can specify that a configured
folder path be appended to the folder structure. This appended path is based on the path
configured in the uuu_dm_publish_path data element on the business process form, and
the selection of the Append Line Items Folder Structure to AutoPublish Path option,
which is documented in the Unifier uDesigner User Guide.

» Document-type BPs without folder structure

A Document-type BPs without folder structure does not maintain the folder structure of the
attached documents and folders, and the files (within the attached folders and sub-folders)
are listed in a flat list.
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To attach files to a Document-type BP:
1) Go to your project or shell (User mode), and open the BP record.
Note: A Business Process (BP) record could be in a folder such as

Project Delivery, Cost Manager, Cost Controls, and so forth, in the right
Navigator.

2) Go to the Line Item tab <tab name> (the very last tab) and click and open a line item.

3) Click the Attachments tab in the right pane, click Attach Files, and select one of the
following options:

» Browse (local system)
Or
» Document Manager (Document Management)

Note: The attachment sources are available based on the BP design
and both of these two options may not be available for a given BP.

The following explains each option in detail.

Attaching files to a Document-type business process with Browse
This option lets you attach files, from your computer or your local system.
After the Upload Files window opens, click Browse to open your system files.

Select the document that you want to attach.
Note: You cannot select a folder.

After you select the file, click Open . All selected files will be added to the Upload Files window.
When you have selected all files that you want to upload, click Upload in the lower-right corner.

After you attach your files, you can see the files listed in the Attachments tab, within the Line
Item tab. The Line Item tab <tab name> (the very last tab) has two panes. The pane on the left
displays the line items. The pane on the right displays the line item details, all attached files, and
any linked records.

When you upload a file from My Computer as an attachment, in order to be able to enter
file-related values for that attachment, the Detail Form design of Document Type with Folder
Structure BP (Advanced Document Type BP), must have the following fields:

» uuu_title
» uuu_revision_no
» uuu_issue_date

Note: When attaching files from the Document Manager, some fields on
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the line item may auto-populate with data from the document or folder
Properties window. Document-type BPs can be designed to
auto-populate certain data elements on the detail form with data from
matching data elements on the document attribute form.

By default, files attached to a business process are placed in the Unpublished Documents
folder in the Document Management grouping node (Project/Shell > User mode > Document
Management > Unpublished Documents).

A Publish Path data element can be designed in business processes to specify the automatic
publishing of documents to a specified path and override the default. Refer to the Unifier
Managers User Guide for details about automatic publishing of documents.

Attaching files to a Document-type business process with Document Manager
This option lets you attach files from the Document Manager (Documents folder).

When you select this option, the Select Files window opens, which displays all the folders of the
Project/Shell documents.

Navigate through the listed folders to find documents to attach. You can highlight multiple files
with Ctrl or Shift. After you have gathered all the applicable files, click Select.
Notes:

= Folders are not attached. Instead, the contents of a selected folder
are attached in a flat list.

= The system does not allow attaching files with duplicate file names.

By default, files attached to a business process are placed in the Unpublished Documents
folder in the Document Management grouping node (Project/Shell > User mode > Document
Management > Unpublished Documents).

A Publish Path data element can be designed in business processes to specify the automatic
publishing of documents to a specified path and override the default. Refer to the Unifier
Managers User Guide for details about automatic publishing of documents.

Add Markups to a Business Process Attachment

You can add markups, such as circles or other graphical elements as well as text, to a
document, which display directly on the document, but do not alter the document itself. Markups
are layered on top of a file, as if the markups had been done on an acetate sheet that had been
placed on top of the file. Each user who adds a markup is adding a new layer to the file.

To add a markup to an attachment on a business process using the Unifier Viewer, see topic
Revising and Reviewing Attachments in a Business Process (on page 167).

To add a markup to an attachment on a business process:

1) Open the business process that contains the attachment.
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2) Go to the Attachments tab and double click on the attachment to open.
3) Type a comment in the Comments box.

4) Click the Annotation icon @ to open the annotation toolbar.
5) Add graphic markups to the drawing as necessary, using the tools on the horizontal toolbar.

Note: Markups are tied to comments and will only be visible when the
comment that contains the markup is selected.

6) Click Post when finished.

If you would like to make changes to markups, right click on the comment and click Edit.
Markups can be removed or re-added with Undo and Redo. New annotations can be added as
well. When you have finished editing, click Post.

Viewing and Adding New Markups in AutoVue

In addition to adding markups to a BP attachment, you can add and view old markups
simultaneously. With this functionality, multiple members can add various markups across
shared files throughout the life cycle of a design document.

When you select AutoVue Review in the Gear menu of the Attachments tab, a View All
Markups option is available in the File Viewer of the Comments section. If you select View All
Markups, the document is displayed in View-Only mode.

You can also choose the markups that are displayed by selecting the check box next to each
markup. After selecting OK, all the chosen markups are displayed.

View Attachments in a Business Process
To view attachments:

1) Open a business process record.

2) Select the Attachments tab from the right pane. A list of attachments is displayed on the
right pane.

3) To view the Revisions and the References tabs, maximize the right pane. The References
tab is displayed only if there are references to drawing file attachments.

When you maximize the Attachment tab, the system selects the first file in the grid, by
default, and a preview of the file is displayed on the right side of the window.

The Previous and Next page buttons let you navigate between multiple pages.

The Revisions tab, located under the Attachments tab grid, lets you access the previous
version of the file that you have selected, if available.

The preview screen displays the following file types:

» Image
» PDF

The audio and video files cannot be previewed. You cannot preview DLL and SWF files, but you
can open them in AutoVue or download the attachment.
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Document Review

When you click and select a document, use the gear menu ( % ) to perform the following
operations:

4
4

Review

Open in AutoVue (You can also open an attachment by double-clicking the name of the
attachment)

Download

Revise

Remove

If you click Review, the Document Review window opens. This window has the following
sections:

»

»

Attachment grid

After you add an attachment to, or remove an attachment from, the upper form, the
Attachment grid will display the total number of the attachments upon clicking Upload. There
is no need to save, send, or submit the form in order to see the attachment count.

File viewer

Use the File viewer to perform the following operations, using the icons on top:

»

Maximize

To expand the viewer.

Download

To download a raw file.

Zoom

Rotate

To rotate the attached graphic.

Rotation happens clockwise, by 90 degrees.

Context-sensitive Cancel and Save options are made available when the system detects
rotation. The Save option lets you save the rotational changes, and the Cancel option lets
you reset the image back to its original state.

Rotation will not be permitted after the first annotation is complete.

Comments

To open the Comments pane.

The Comments pane lets you insert your comments and annotate the file.

Click the pin icon to see the annotation options (Brush, Pin, Square, Circle, and colors
palette).

You can remove your annotation by using the Clear option, when adding a new comment.
After you post an annotation, you cannot remove or update it.
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In annotation addition mode, you can mark up multiple areas and enter a comment. You can
create more than one annotation per comment. To view annotations, hover over the pin icon
and select View Annotations. You can also add multiple markups or annotations to a
comment. Use the pin icon to open the annotations options and add markups one after the
other. After you post the comment, the markups will be associated with that comment.

You can edit or delete a comment by selecting the comment block, right-click, and select Edit
or Remove options.

When you select Edit, you can edit the comments and annotations.
The Remove option removes the comment and associated annotations.

Download Attachments in a Business Process

To download an attachment
1) Select or open a business process record.
2) Select the Attachments tab from the right pane.

3) Select an attachment and select & > Download.

To download all attachments on a business process record
1) Highlight the business process record from the log.

2) Select the Attachments tab from the right pane.

3) Click the Download All button on the top toolbar.

All attached files will be downloaded in a zip file, containing all the downloaded attachments.

Record level attachments are placed in the root folder while attachments belonging to line item
tabs will be bundled under respective sub-folders in the zip file, with the name of the folder being
the name of the line item tab.

If multiple files have the same name, a numerical suffix may be added to the file name. If more
than 100 files have the same name, the suffix for the 101st file will have a time stamp as the
suffix instead.

Revising and Reviewing Attachments in a Business Process

You can revise/edit documents that are attached to any BP record or Line Item.

Note: Revising a document replaces the existing file (with the same
name) in a BP record or Line Item.

Revising attachments
1) Open a business process record.
2) Select the Attachments tab from the right pane.

3) Select an attachment and select & > Revise.

4) Select the file you want to revise and click % > Browse.
5) Select the revised file to upload, and click Open.
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6) Click Upload.
To see a list of revised documents, maximize the Attachments tab on the right pane.

If the name of a file that you attach to a BP record, or Line Item, matches the name of a file that
exists in the BP record, or Line Item, the system lets you automatically revise the existing file
(Revise automatically if file with same name exists) with the newly attached file.

Note: If the terminal status of a BP record has been reached, the system
disables the document revision option.

Reviewing attachments in a Business Process Record

If you have a BP record that has several attachments (documents) attached to the BP record, as
well as Line Items, you can review all the attached files in one place.

To review, select the attached document that you want to review, enter your comments, and
save the document back in the BP. The details are as follows:

1) Open the BP record that has attachments.
2) Click the gear menu ( % ), and select Review to open attachments in the default Unifier

Viewer. To open attachments in AutoVue, click the gear menu and select AutoVue Review.

The Review option is available for an Action Form as well as a View Form. The option
AutoVue Review is displayed only if your Unifier server is configured to use AutoVue.

3) Select the attachment that you want. The attachments and comments are displayed in the
BP Attachment Viewer.

4) Review the comments posted by others.

5) Enter your comments and post your comments on the document.
Using the Unifier Viewer:

Enter comments in the Comments box.

Click the paper clip icon to attach files to the comment.

Click the Annotation icon to display the annotation toolbar.

Use the annotation toolbar to mark up your document.

Click Post when finished.

Usmg AutoVue:

f. Click the Markup icon in the Comments and Revision window.

g. Use the markup toolbar displayed in the Document window to mark up up your
document.

h. Enter your comments in the Comments and Revisions window and click Post.
I.  Click the paper clip icon to attach files to the comment

6) Undo changes with the toolbar option or Ctrl+z.

7) Redo changes with the toolbar option or Ctrl+y.

peo T

168



Working with Business Processes

Notes:
= You can add comments in one document and then move on to the
next document.

= All comments are displayed in both viewers regardless of which
viewer the comments were added in. Markups are visible only in the
viewer they were made in.

= You can consolidate attachments and multiple comments (and their
respective mark ups). This option is available if you are viewing the
file in AutoVue.

= You can only make changes in comments that are in draft status. You
cannot make changes on existing comments.

8) Close the window when finished.

Additional information about the Review screen

If a BP record has reached the terminal status, (Terminal Status or Terminated Status), the
Review window opens in Read-Only mode.

If a hidden tab, on a BP record, contains attachments, the review screen does not display those
attachments.

If the attachments present on a Query-based tab (QBT), on a BP record, contains attachments,
the review screen does not display those attachments.

The Review screen does not display the line times for Cost BP Records of Summary Payment
Application (SPA) Schedule of Values (SOV) type. For this type of BP, you can include
comments in the General Comments field.

The Review screen lists all document revisions for each revised document.

The Review window lists all the BP Record-level and Line Item-level attachments grouped first
by BP Record attachments and then by Line Item attachments, according to the tab order.

When you select a file in the Review screen, the system displays the files content in the AutoVue
section of the screen. If you click the comment icon, the system opens the comments window.

View Graphic Markups in a Business Process Attachment
To view graphic markups:

1) From the BP Attachment Viewer, locate the comments pane. Markups are associated with a
specific comment.

2) Click a comment to view markups associated with the comment. Comments that have
markups will display the annotation icon @in the comment listing.
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Note: All comments are displayed in both viewers regardless of which
viewer the comments were added in. Markups are visible only in the
viewer they were made in.

Publish Attachments or Revised Attachments in a Business Process

By default, documents attached to BP record, or Line Item are published in the Unpublished
Documents folder. For Document-type BP record, or Line Item, with Folder Structure, the
Company Administrator can specify that a configured folder path be appended to the folder
structure. Refer to the Unifier Data Reference Guide for details.

The system publishes to the Document Manager:

» Documents attached to the BP record.
» Documents attached to the Line Item of the BP record.

Note: Comments related to a document attached to the BP record
and/or its Line Item are not carried over to the Document Manager when
published.

You can auto-publish attachments if a BP has been set up to Override DM Permissions by
your administrator or, you can include the uuu_dm_publish_path Data Element in the BP
record, or Line Item. Alternatively, if the folder path in the business process is invalid, navigate to
the Unpublished Documents node, select your file, and click Publish.

Remove Attachments from a Business Process

To delete an attachment
1) Open a business process record.
2) Select the Attachments tab from the right pane.

3) Select an attachment and select € > Remove.

Comparing File Attachments
The system lets you compare different revisions of a file that is attached to a:

» Business Process (BP) record.
» BP Line Item.
» Document in Document Manager.

To compare different revisions of a file, or document, that is attached to BP record and BP Line
Item:

1) Open the BP that has attachments.
2) Click Review to open the BP Attachment Viewer window.
3) Select an attachment.

170



Working with Business Processes

4) Click Analysis and select Compare.
5) Select the revision that you want to compare the current version with.
6) Follow the prompts and click Finish when done.

To compare different revisions of a file, or document, in Document Manager:

1) Goto Document Manager and open the folder.

2) Select afile that has revisions and click Open to open the View File window.
3) Click Analysis and select Compare.

4) Select the revision that you want to compare the current version with.

5) Follow the prompts and click Finish when done.

The system also lets you compare any Unifier file with a file on your local system.

1) Open the BP that has attachments.

2) Click Review to open the BP Attachment Viewer window.
3) Select an attachment.

4) Click Analysis and select Compare.

5) Deselect the check box for revisions.

6) Click Browse to select the file from your local system.

7) Follow the prompts and click Finish when done.

To compare file, or document, in Document Manager with a file on your local system:

1) Goto Document Manager and open the folder.

2) Select afile that has revisions and click Open to open the View File window.
3) Click Analysis and select Compare.

4) Deselect the check box for selecting revisions.

5) Click Browse to select the file from your local system.

6) Follow the prompts and click Finish when done.

Republishing DM Document from BP Record
When a BP type lets you select Republish if Publish Path is different from current location
(Move or Copy), then:

Note: This option is not available for the Text-type BPs (because these
types of BPs do not support attachments) and RFB BPs bidder upper
action form.

You can change the Publish option (in the Publish to Document Manager section) in the BP
record in any attachment that you add from the Document Manager (DM).
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When you select the Publish option, then you can Move, or Copy, the attachment to a location
(publish path as captured in the uuu_dm_publish_path). You can check Automatically select
all existing Record and Line Item Attachments for Republish. The user can also Select all or
deselect all attachments by checking or unchecking the check box in the column heading of the
attachments grid.

If the uuu_dm_publish_path is the same as the current location of the file in DM, then the file in
DM stays as is, and there will be no revision or republish.

If the uuu_dm_publish_path is different from the current location of file in DM, then:

»

If the Move option has been selected (in uDesigner), the file (with all its revisions) can be
moved from the original DM location to the new uuu_dm_publish_path. This type of move is
the same as a manual move of a file from one location to another location in DM, and it is
captured in the Audit Log. Furthermore, the BP record assignee (the user who initiated the
move action) is also captured in the Audit Log.

If the BP step assignee does not have Add Folder or Add Documents permission, then if the
BP step assignee:

» Selects Send or Finish Editing, the system displays the following alert:

The following attachment(s) cannot be moved to <label of DE uuu_dm_publish_path> as you
do not have permissions:

<File 1 Name>

<File 2 Name>

Do you want to proceed?
If the answer is Yes, the record is sent to the next step or finish edit without moving the
file.
If the answer is No, the record is not moved to next step or finish edit, and the record
stays at the current step giving the BP step assignee a chance to change the publish
path or take other action.

Note: If the source file is locked or checked out, then the source file
remains in the same state, at the destination after the move.

If the Copy option has been selected (in uDesigner), the latest revision of the file (from the
original DM location) is copied into the uuu_dm_publish_path. The new copied file, at a new
DM location, is linked to the BP record. The original file (with all its revisions) remains in the
original DM location, as is, and it is not linked to the BP record.

If the BP step assignee does not have Add Folder or Add Documents permission, then if the
BP step assignee:

» Selects Send or Finish Editing, the system displays the following alert:

The following attachment(s) cannot be copied to <label of DE uuu_dm_publish_path> as you
do not have permissions:

<File 1 Name>

<File 2 Name>

Do you want to copy these attachment(s) to Unpublished Documents?
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If the answer is Cancel, then the record stays at the current step.

If the answer is Skip, then the file (or files) will not be copied and stay as is. The original
file shows as an attachment and linked to the BP record. The record can be moved to
the next step or finish edit.

If the answer is Copy, then the file (or files) will be copied to the Unpublished Documents
for the project/shell. This new file in the Unpublished Documents is linked to the BP
record. The original file stays as is, and it is not linked to the BP record. The record
can be moved to the next step or finish edit.

For both the Move and Copy option, if the destination location already has a file with the same
name as the file that is being moved or copied, then the existing file will be revised with the new
file from the BP. And if:

»

The same name file in the destination is already checked out, the system revises the
checked-out file with new file from BP and leaves this new file as checked out in the new
location.

The same name file in destination is locked, the system revises the locked file and the newly
revised file will be locked (same as if a user revises a locked DM file attached to a BP
record).

The source file is in a checked out, or locked state, and at the destination the same name file
is also checked out or locked, then the destination file state remains (the final file at
destination location shows as locked or checked out based on its previous state in same
location). In these scenarios (when destination location has a file with same name), the
permission to revise the destination file has to be selected.

If the user has the permission:

4

»

In the case of Move, the source file revises the destination file with all its revisions. As a
result, if source file has two revisions, and the destination file has three revisions, then the
final file in destination location after the move will have five revisions (two revisions from
source file added on top of the three revisions in destination file).

In the case of Copy, only the latest revision of the source file revises the destination file.

If the user does not have the permission:

»

In the case of move, if Send or Submit is selected, the system displays the following alert:

The following attachment(s) cannot be moved to <label of DE uuu_dm_publish_path> as you
do not have permissions:

<File 1 Name>
<File 2 Name>

Do you want to proceed?
In the case of Copy, if Send or Submit is selected, the system displays the following alert:

The following attachment(s) cannot be copied to <label of DE uuu_dm_publish_path> as you
do not have permissions:
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<File 1 Name>
<File 2 Name>

Do you want to copy these attachment(s) to Unpublished Documents?

If the uuu_dm_publish_path is blank, then:

4

If the republish option as Move is selected, the file stays at the original location, and the file
will not be moved to Unpublished documents.

If the republish option as Copy is selected, the latest revision of that file is copied into the
Unpublished Documents.

Note: The above scenarios apply to both Upper Forms and Detail form
attachments of a BP record.

When a BP record moves from one step to the next (in uDesigner the Publish Path is different
from current location option is selected):

If the next step form has the option Publish Path is different from current location
checked, the same process occurs (as stated above). If you select Publish for an already
published attachment again, that attachment will be published to the uuu_dm_publish_path
again.

Note: This is the same as when the destination already has a file with
the same name as the one being published is triggered (as stated
above).

If the next step form does not have the option Publish Path is different from current
location checked, the same process occurs as for attachments from DM on a BP record.

Note: If you add any attachment to the BP record from the DM, the
attachment moves into the Published Attachments group, on the log. If
you add an attachment from a local area, then the attachment moves
into the Unpublished Attachments group. As the unpublished
attachments get published to the DM (upon clicking Submit or routing the
record to next step), those attachments move into the Published group.

About Linking Business Process Records to other Business Process Records

You can create a link from one business process to another, or from a line item to a business
process. Other users will be able to click the link and view the referenced business process.
Linked records are added and viewed from the Linked Records link at the bottom of the BP form.
If records have been linked, the number of records will appear next to the Linked Records link.

Note: This option is available only in BPs that have been designed to
accommodate linked records. A user's ability to view a linked BP record
is based on the user's permissions. If users cannot see the record in the
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log, they cannot see it in the link.

Linking BP Records to other BP Records

To link a business process record to another business process:

1)
2)

3)
4)

5)

6)

Open an existing BP record or create a record.
In the right pane of the BP form, click the Linked Records tab.

Click Add ( ¢ ). The Add Records window will open.

In the Select Business Process drop-down menu, select the type of business process of
the record you want to link. You can use the View drop-down menu or Find on Page options
to filter the list of available records.

From the resulting list of BP records, select the record(s) to link to the open business
process form click the single arrow pointing to the right to add it to the Selected Records
area. You can click the single arrow pointing to the left to remove records from the Selected
Records area, or press the double arrows in either direction to add or remove all records in
the log.

Click Done when finished.

To link a line item to a business process record:

1)
2)
3)
4)
5)
6)

7)

8)

Open an existing BP record or create a record.

In the left pane of the BP form, click the Line Iltems tab.

Select a line item from the log to link to a BP record.

In the right pane of the BP form, click the Linked Records tab.
Click Add. The Add Records window will open.

In the Select Business Process drop-down menu, select the type of business process of
the record you want to link.

From the resulting list of BP records, select the record(s) to link to the open business
process form click the single arrow pointing to the right to add it to the Selected Records
area. You can click the single arrow pointing to the left to remove records from the Selected
Records area, or press the double arrows in either direction to add or remove all records in
the log.

Click Done when finished.

To link a line item from a business process record to another business process record by
way of consolidation, use the Actions drop-down, select Consolidate Line Items, and
create a line item.

175



Business Processes User Guide

Note: The "Prevent consolidating the same line item across multiple
records" option must be enabled to prevent the user from consolidating
line items that have already been consolidated. If this option is enabled,
the line Items cannot be edited, later. The system ensures that the line
items can be consolidated only once, across all the business.

When you link a business process record, using any of the methods explained above, the
Linked Records tab shows the Current View for all records and provide the following details:

» Direction
» Type

The contents of the Type column indicates whether the linked record has been

associated automatically (by way of Line Item Consolidation), or manually (by way of
manual linking).

» Business Process
» Record Number

» Record Title

» Record Location

- If the BP is a company-level BP, then the Record Location shows the Company
Workspace tab name.

- If the BP is a Project-level BP, then the Record Location shows the Project name.
- If the BP is a Shell-level BP, then the Record Location shows the Shell location.

Notes:

= You cannot remove the link Type: Line Item Consolidation.

= [f there are multiple line items consolidated from the same BP record,

then the BP record will be seen as a linked record for that many line
items.

= If the line item with the link Type: Line Item Consolidation moves to
the status, "Previously consolidated lines are available when terminal
status equals" in uDesigner, or is terminated, the link will be
automatically removed.

Manage Linked Records

To view a linked record

1) Open a BP record and click the Linked Records tab in the right pane. If you are opening a
linked record associated with a line item, select a line item tab and select the line item.

2) From the Links Log, hover over the record link, click the gear menu ( % ), and click Open.
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To remove alinked record
1) Open a BP record and click the Linked Records tab in the right pane.

2) From the Links window, hover over the record link, click the gear menu ( %¥ ), and click
Delete.

Note: From this window, you cannot delete a record with a From
direction. To delete the record, you must open that record, click the
Linked Records tab, and remove it from the Links window.

Working with Linked Malil

The Linked Mail tab lets you link existing emails (Mailbox items) or compose new emails to a
BP record. On any action form, you can view the referenced mail. Click the Add drop-down
menu to view the following options:
» Mailbox
To link mail from your Mailbox
» Project Mailbox
To link mail from the Project Mailbox
» New Mail
To compose emails and add attachments from your computer or Document Manager. After
the mail is submitted, it gets linked to the record and displayed in the Linked Mail tab.

When the Linked Mail tab is maximized, the left section displays the grid, and the right displays
the functions, content, and attachments of the selected mail. If you are a participant in the email,
you can see the action buttons: Reply, Reply all, and Forward, as well as the More drop-down
menu, which has options to Flag, Clear Flag, Print, and Delete. If you are not a participant in
the mail, you can see the option to Print.

Opening or Deleting mail

From the grid, click the gear menu ( % ) and select Open or Delete. Alternatively, you can
double-click the mail, in the grid. When you select multiple mailbox items, the only option
available is Delete.

Viewing content of the linked record

To view the full content of the linked record, double-click an entry in the grid.

Composing Linked Mail

You can create and send a Mailbox message from the BP record. You must send the message
before sending the BP to automatically link it to the BP record. The Mailbox message will be
stored in the Project Inbox, the Sent Items node in the Home tab (Home workspace), and the
Inbox of recipients. In addition, if you or the recipient reply to the message, the reply will also
automatically be linked to the BP record.
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Note: If you create a Mailbox message and save it without sending, it
will remain in your Mailbox Draft log in the current project or shell.

To compose a message to link to a BP record
1) Select a BP record.
2) From the right pane, select the Linked Mail tab.

3) Click Add © and select New Mail.

4) Compose your message and click Send. The following additional options are displayed:
Save, Delete, Attach, Flag, Clear Flag, Print, CC, and Bcc.

After the mail is sent or saved, it will appear in the Linked Mail grid.

Adding from Project Mailbox

In addition to composing linked mail, you can link mail that exists within a mailbox to a business
process. The Project Mailbox option will be seen only if user has permissions to the Project
Mailbox.

To link message from the Project Mailbox to a BP record
1) Select a BP record.
2) From the right pane, select the Linked Mail tab.

3) Click Add & and select Mailbox or Project Mailbox. The Add from Mailbox window is
displayed.

4) Use arrows to select the messages you want to link from the Available Items column to the
Selected Items column.

5) Click Done.

Manage Linked Mail

You can view or remove linked Mailbox messages.
To view linked Mailbox messages

From the Linked Mail window, click the gear menu ( % ), and then click Open or double-click the
email. The Message window opens.

To remove a linked Mailbox message

From the Linked Mail window, click the gear menu ( %¥ ), and then click Delete.

Reply To or Forward a Linked Mailbox Message

If you receive a Mailbox message with the caption, This mail and any future replies are linked
to business process records, beneath the subject line, that Mailbox message is linked to one
or more BP records. If you click Reply, Reply All, or Forward and then send your response, the
reply will also automatically be linked to the BP record.
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View the List of Linked BPs from a Mailbox Message

To view linked BP records from a Mailbox message

1) Open the business process record.

2) Click the Linked Mail tab. The Linked Mail window opens, showing the emails that are
attached to the record.

3) Select the email you want to view, and use the gear menu ( %* ) to click Open or double-click
the email. The system opens the email.

4) Below the Subject line is an information icon with the following caption:
This Mailbox and any future replies are linked to business process records.

5) Click the business process records link. The system opens the Linked Business Process
Records window, which shows a list of all business process records to which this email is
attached.

You can select a business process record from the list to view its record details in the right
pane.

Send and Manage Linked Mailbox from RFB Forms

The Request for Bid (RFB) Business Processes (on page 325) have special linked Mailbox
functionality. For RFB business processes, the creator of the RFB form will be allowed to
correspond with internal users or with RFB bidders.

To send a Mailbox message from an RFB form

Open the RFB BP form and click the Proposal Management tab. You can send a message to
internal users of the system, which includes your Unifier project or shell team, or to invited
bidders.

To send a message to an internal user:

1) Click the Mail tab in the right pane.

2) Click Add [ and select Mailbox or Project Mailbox to add existing mail from another
mailbox, or select New Mail to compose a new message.

To send a message to a bidder:

1) In the left pane, hover over the desired bidder and click the gear menu ( % ).
2) Click Send Mail to compose a message.

Note: You will not be able to save a draft copy of composed mail if it is
being sent to a bidder.

Bidders will be allowed to view and access Mailbox after they are signed in to the system using a
special sign in.
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Bidders can also create and add Mailbox messages from the RFB form. The To field is
auto-populated with the requestor name. The Cc and Bcc buttons are not available; however,
bidders can fill in external Cc and Bcc fields with external email addresses. When bidders reply
or forward Mailbox messages, these will be linked with the record.

Bidders will not be able to create any new Mailbox after the bid due date.

Attaching External Emails from the Project or Shell Mailbox to a Record

The system collects all external emails it receives for a project or shell in a dedicated mailbox.
You can attach these external emails directly to a business process record. Other users can
view the email from a link on the record. A single email can be attached to more than one
business process record.

External emails that have been blind copied (Bcc'd) are not collected by the Mailbox.

To attach an external email to arecord
1) Open the business process record to which you want to attach the email.
2) Click the Linked Mail link at the bottom of the form. The Linked Mail window opens.

3) Click Add and choose Mailbox or Project Mailbox. The Add from Mailbox or Add from
Project Mailbox window opens, showing a list of the external emails that have been
received for the project or shell.

4) Select the emails you want to attach to the record, and click the right arrow button.
The system adds the email to the Linked Mail window.
5) Click done.

To open an external email attached to a record

1) Open the business process record.

2) Click the Linked Mail link at the bottom of the form. The Linked Mail window opens, showing
the emails that are attached to the record.

3) Select the email you want to view, and use the gear menu ( % ) to click Open. The system
opens the email.

From this email window, you can:

» Reply to the sender

» Forward the email to others in the project or shell
» Flag the email for follow-up

» Clear a Flag from the email

» Delete the email

»  Print the email

Note: You must have permissions to view, reply to, or delete external
emails.

To view linked BP records from a Mailbox message
1) Open the business process record.
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2) Click the Linked Mail button. The Linked Mail window opens, showing the emails that are
attached to the record.

3) Select the email you want to view, and use the gear menu ( %* ) to click Open or double-click
the email. The system opens the email.

4) Below the Subject line is an information icon with the following caption:
This Mailbox and any future replies are linked to business process records.

5) Click the business process records link. The system opens the Linked Business Process
Records window, which shows a list of all business process records to which this email is
attached.

You can select a business process record from the list to view its record details in the right
pane.

Sending Attachments for E-Signature

If you have configured and activated Company Properties > E-Signatures tab with details
about the entity that provides electronic signature technology (DocuSign or Adobe Sign), then
when you access your BP record Upper Form or Detail Form and open the properties window,
you can use the Attachments tab to send the attachment for signature.

The toolbar options and column headings for the Attachments tab are:

Attach Files (paper clip icon drop-down) | Lets you select a file by way of:
» Browse

» Document Manager

» Custom Print

Publish to Document Manager This column displays the hierarchy and the
location of the attachment.

Name This column displays the name of the
attachment.

Comments This column displays the comments
associated with the attachment.

Revise This column displays the revision
information about the attachment.

Upload Date This column displays the date that the
attachment was uploaded.

Title This column displays the title of the
attachment.

Other information about the attachment | These columns display other information
related to the attachment such as Pub.
No., Rev. No, and so on.

When you select an attachment in the Attachments tab, you can click the gear menu ( ¥ ) and
conduct the following operations:
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Review
AutoVue Review
Download
Revise

Remove

v v v v Vv

To sign documents within Document Manager and Business Processes using DocuSign or
Adobe Acrobat Sign (Adobe Sign), you can select one or more documents and send them to
one or more assignees for an electronic signature (e-sig). In addition, for documents in
Document Manager, you can select a document and self-sign it using DocuSign or Adobe Sign,
whichever E-Signature provider is configured for the project. This functionality is missing for
Business Process attachments. The Self-sign functionality is also available in BP record
attachments.

The self-sign is available for BP record upper as well as line item attachments. When you
conduct a self-sign, the file opens in DocuSign or Adobe Sign. The status of the signature is
reflected in the Attachments tab log, E-sighatures column. When the file is signed
(E-Signature status = Completed), the signed file gets added as a revision of the original file (as
a pdf file and name appended by "_signed.pdf").

Business Process records
In the Attachments tab for BP Upper form, or detail form:

» If you select multiple attachments that their E-Signature process has not yet been started, or
it is complete, the system enables the option Send for E-signature.

» If the E-Signature process of any of the selected attachments is ongoing, the system
disables the option Send for E-signature.

» If you select multiple attachments such that their E-Sighature process for at least one of
them is In-Progress, when you right-click, you have the option Recall E-Sign Request. If you
select recall, for each selected attachment with E-Signature status = In-Progress:

» The E-Signature request sent out to each signee who has not yet completed the
E-Signature request (Status = In-Progress) is set to recalled, and the E-Signature Status
in the E-Sign Log is set as recalled.

» The E-Signature Status column in the Attachments tab is set as recalled.

» The E-Signature status in the E-Signatures node for each signee who has not yet
completed the E-Sign task is set as recalled.

Note: Adding an attachment as a custom print is available regardless of
whether E-signatures have been configured for the company or not.
In the Attachments Review tab:

» The E-Signature status in the Review window is set as recalled.

» For each selected attachment with E-Signhature status as complete, or not started, the
system ignores the recall request.
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The Review window (similar to the Attachments tab for BP Upper form, or detail form) displays
the Send for E-Signature and Recall E-Sign Request actions by way of the:

» Gear menu ()

» Right-click
The right-click options will be visible based on the E-Sign Status of selected attachments.
Use the right-click options to send, or recall, multiple attachments for E-signatures. The
Recall E-Sign Request option is available only to the:

» E-Signature request sender
» Document Owner

Note: Other users will not be able to view or take action even if all other
conditions are met.

E-Signature Log (Declining an E-Signature)

If a signee declines an E-signature request, then the E-Signature log captures the E-Signature
status as Declined. When the E-Signature Status = Declined, then the tooltip (triggered by

placing the pointer on the status), or the gear menus ( % ), displays the reason for decline.

E-Signature Node (E-Signhature request)

When you select an E-Signature request from the E-Signatures node, you can see the E-Sign
log in the right pane (E-Sign Log). This contains the message which was sent out at the time of
sending the E-Signature request and a log of all signature requests' statuses. When you expand
the Attachments tab for BP Upper form, or detail form, if a file has E-Signature requests
associated with it, the right pane displays the E-Sign Log tab, next to the preview tab.

Publish from BP to DM

If you attach a file in the DM to a BP record and send it for E-Signature from the BP record, then
the revised (signed) file will be published back into the DM at the same location from where the
original file was attached. This is irrespective of the publish path on the BP record.

The ability to re-publish DM Document from a BP record allows you to choose to republish
(move or copy) a revised DM attachment, if this option is selected in uDesigner then the signed
file will be published using the Publish Path.

Adding or Viewing a Map (Geocoding)

If the functionality is configured in uDesigner for a business process, you can add an interactive
map to a record. The location will be based on a property address, and/or longitude and latitude
(Geocoding). You can add or view maps from the upper form of these business process types:

» Line item
» Simple

> Text

» Document
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» Cost (classification generic)

Maps are supported on company, project, and shell-level BPs. You can also search for a map by
an address or longitude or latitude.

To add a map to a business process

1) Inthe BP form, click the location pin icon ( © ) next to the Latitude and Longitude fields.
The Latitude/Longitude picker window displays with a map that you can manipulate as
needed.

2) Do one of the following:

» Enter the address of the property to compute the latitude and longitude, and click the
Map It button.

» Enter the numbers for latitude and longitude in degrees, or in degrees, minutes, and
seconds, and click the Map It button.

» Click the map to compute latitude and longitude. A map pin displays the location of your
click.

3) Click Done when finished computing latitude and longitude. Latitude and longitude are
populated in the corresponding fields on the BP in decimal degrees.

4) If you click the pin icon again, the latitude and longitude values are displayed in the Latitude
Longitude picker window and are retained there until you calculate a new latitude and
longitude. A map pin on the map indicates the location of the property represented by the
current latitude and longitude displayed in the picker.

To view maps from the business process log
1) Navigate to a business process log.
2) Select one or more records.

3) Click View Record Location ( © ) from the top toolbar. If no records have been mapped,
this icon is not visible. A map opens displaying the various locations that are mapped,
indicated by map pins. If the locations indicated on the map are far apart, the map zooms to
the closest location.

4) Click a map pin for location details.
5) Click Close to close the map.

Note: If multiple records are selected that have the same latitude and
longitude, the map will show only one pin marker.

To view a map for a specific business process record

1) Navigate to a BP record and click View Record Location ( © ). If the BP has latitude and
longitude address details, a map opens displaying the property location, indicated by a map
pin.

2) Click the map pin for location details.

3) Click Close to close the map.
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Adding an Image

In some forms, you can add an image to your project or shell. For example, you can add an
image that shows progress on the project or shell information record, pictures of assets related
to a specific asset record, or a photo of an employee in the Resource Manager. You can add
images to attribute forms in shells, project or shells, companies, and business processes.

If the Image picker functionality has been added to your project or shell, forms with the
functionality display the image name and a virtual box that will hold the uploaded image.

Note: The image name is based on the data element name provided in
the design.

To add an image
1) Open a BP form.
2) Locate the Image section of the form from the main tab.

3) Select Browse, to search for a file from your computer, or Document Manager, to search
for a file from the Document Manager.

Valid image file types are:

» .JPg

» .jpeg
» .gif

» .png
» Ltif

You can change the image by replacing it with another uploaded image. Images appear on
the HTML or PDF formats of printed forms. They appear in print preview as well. The Image
picker can be added to all forms except for those in the Cost Manager, Generic Cost
Manager, Schedule Manager, and the Document Manager.

Note: The image appears online in the system, but it is not available for
printing. Also, images do not appear in UDRs or email notifications.

Adding or Updating a Hyperlink

In some forms, you can add a hyperlink to your project. For example, you can add a hyperlink to
equipment documentation, details on a resource, or external websites that contain information
pertinent to a BP record. You can add hyperlinks to attribute forms in shells, projects,
companies, and BPs.

If the Hyperlink picker functionality has been added to your project, forms with the functionality
display a hyperlink name, such as vendor website or internal web page.
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To add a hyperlink

1) Click the hyperlink area on the form (blue link & ).
2) Enter the hyperlink name and the Uniform Resource Locator (URL).

Only the URL is mandatory. If you enter the name and the URL, the hyperlink displays as the
name you entered. If you only enter the URL, the hyperlink displays as the URL.

3) Make sure that the URL adheres to accepted formats, such as starting with an approved
protocol, followed by ://, and then followed by a host name or domain name.

The system validates the specified URL based on the Uniform Resource Identifier (URI)
provided by the administrator for your organization, if applicable, and on current standards
for URLs.

Examples of HTTP and HTTPS URLs:
http://MyCompany.com
https://YourCompany.net

Examples of URLs that might include URIs authorized for use by your administrator:
ftp://lUserName:Password@MyCompany.edu
ftp://private.ftp-servers.sample.com/MyDirectory/MyFile.txt

Note: The URL should not reference the same domain that Unifier is
using for operation. If you attempt to use the same domain, a warning
message will result.

4) Click Done.

To update a hyperlink

1) Click the hyperlink area on the form (blue link & ).

2) Below the URL text box, click Clear to remove the existing hyperlink.
3) Enter a new hyperlink name and URL.

4) Click Done.

Viewing Referencing Records

For any business process with referencing records, the system can show you a Reference
Records window that displays a graph and a list of the records that the record you are viewing
refers to, as well as those records that refer to the record you are viewing. (To see the records,
you must have view permissions.)

For example, you might want to view all the change orders that refer to a particular purchase
order. For other examples, you could view:

» All the invoices that a commit business process refers to so that you can reconcile all the
invoices against the purchase order

» All the change order requests that are referred to by a specific change commit business
process in order to track the progress of a construction project

» All the lease payment requests that refer to a Master Lease, in order to view and reconcile
all payment records for a lease
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» All the base commits that are referred to by a vendor record in order to review payment
progress

» All the work order BPs refer to a Preventive Maintenance type BP in order to view all the
work orders for a Preventive Maintenance Book (PM Book).

Business process records can reference other records and be referenced to using the following
features:

» A BP picker on a business process record, including line items

» A BP line item picker on a business process record

» Auto-creation of a record through the workflow (S-Step)

» Auto-creation of a record through meeting specific criteria set up by your administrator
» A data picker

View a List of Referencing Records

The Reference and Linked Records section of the reference records window displays the
reference records and the linked records associated with the BP record (both from the Upper
form and Detail forms), but the graphical section of the reference records window does not
display the linked records.

The grid section of the reference window lists all the linked records associated with the line items
including the ones established by means of consolidation.

The record details of the consolidated line item are also displayed in the grid section, and you
will be able to open the record from the grid.

To view a list of referencing records
1) From the business process log, open the record.

2) Inthe right pane, click the right arrow until you see the Reference Records tab. The
Reference Records window opens.

The Reference Records window has two components, a graphical representation of the

referenced records and a list. The records shown on this window include records from across

shells.

The graphic displays:

» Records that the business process references (that is, references to other business
processes)

» Records that reference the business process (that is, other business processes that
reference the BP you are looking at)

The list displays:
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Records that the business process references (that is, references to other business
processes)

Records that reference the business process (that is, other business processes that
reference the BP you are looking at)

Records that have been linked to the business process via the Linked Records feature
(About Linking Business Process Records to other Business Process Records (on
page 174))

Line items that have been linked to the business process via the Linked Records feature.

Note: If the record does not reference any records, the only item in the
Reference Records log will be itself.

What you can do on the Reference Records Graphic window

With the Reference Records Graphic, you can:

4
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View high-level record information

When you first open the graphic, it displays the original parent record that you opened,
along with all child records that are directly attached to it. Child records are color coded
based on their BP type. If you hover over a record, the system will display the type of
record, record number, and record status. The direction of the connection is indicated by
a gray arrow, pointing from the parent record to the child record.

On the right pane is a log that displays all the visible referenced records, as well as linked
records and line items. Each parent record has a list of all connected child records
underneath, which can be collapsed or expanded by clicking the gray arrow next to the
record name. The icon in the first column indicates the type of connection that exists

between records. If it is a referenced record, a blue page icon [E is displayed. If it is a

linked record, a blue link icon ¢ is displayed. If it is a linked line item, a yellow link icon
is displayed.



4

Working with Business Processes

Rearrange records

You can rearrange records by clicking and dragging each record to a desired space in the
graphic window.

Note: You cannot click and drag multiple records at a time. Each record
must be rearranged individually.

Expand the graphic

You can expand the records in the graphic by clicking the Plus icon in the top left corner
of a record. All records that are connected to that record will appear with arrows
connected to them. If the expanded record is also connected to a record that is already
visible, an arrow will appear connecting the two. After it is expanded, the Plus icon will be
replaced with a Minus icon, which you can use to collapse the record. If there is no icon,
that means there are no more child records to that record.

Move the display (convenient for large graphics)

You can click and drag any open space in the graphic to move the display, using the
mouse wheel to zoom in and zoom out.

Filter visible items on the graphic

There are many ways to filter information on the graphic to focus on specific information.
As information is updated on the graphic, the log in the right pane is updated as well. The
Business Process drop-down menu lets you hide all records except for records of the
selected business process type. You can also change the Display of the graphic based
on the:

= Type of connection
=  Number of connected records

In the first Display drop-down menu, you can filter the graphic to view only linked
records, reference records, or both. In the second Display drop-down menu, you can
restrict the number of child records that can appear when expanding a record by setting
the value to 20, 50, 100, or 200.

View or edit a record (if you have permissions)

From the graphic, you can open a record by double-clicking it from the log or the graphic.
In addition, if you have permissions, you can edit and take action on the record the
same way you would by opening the record directly from a Unifier log. When you
finish the edits and close the form, the system will return to the Reference Graphic
window. The records you can edit must be at the same level as the focused record. If
the referenced record that you open from the graphic resides at another level (such as
in a different shell, project, or at the company level), you will not be able to edit it; it
will open in view mode only, regardless of your permissions.

Notes:

= If you make changes to the record (including referencing links, linked
records, title, status, and so on), the graphic and the reference list on
the right pane will not reflect these changes until you click the
Expand, Collapse, Reset, or Transfer Focus buttons.

= The edits and actions you take on the form from the Reference
Graphic window will behave in the same way they would if you
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opened the record from a log; that is, roll-ups will occur, workflow
actions and auto-creations will proceed, email notifications will be
sent, and so on.

= If you have only view permissions, regardless of where the record is
in the workflow, the system will display the view form from the End
step of the workflow.

» Print the graphic
Click the Print button to open the standard print window for your browser.

» Transfer the focus of the graphic to another record and its references
You can change the focus of the graphic to another record and display all of its
referencing records. The record you transfer to will change to blue to indicate that all
referencing records shown on the graphic are now connected to the new record. In
addition, the list on the right panel will change accordingly.

» Reset the graphic

To set the graphic back to its original state, click Reset. This will undo all display
changes, record expansions, and focus transfers.

Participating in a Workflow

Each step in the workflow is set up individually. Step-by-step, the administrator can define
responsibilities for users and groups through task assignments, completion policies and
resolving action settings, and email notification settings. Non-administrative users can complete
business process forms, select Workflow Actions, and assign task recipients. They can track
business process routing between steps and trace a record's path through the workflow.

Completion Policies and Resolving Actions

Your administrator sets a "completion policy" on each step in a workflow. This policy determines
when the step is complete and where the step proceeds from there. A step can be complete
under the conditions listed below.

» Single completion policy: Any single user can accept a task and complete it, and the record
will move forward to the next step.

» All-majority completion policy: All assignees to the task have responded to it and a majority
has agreed on the action that moves the record forward to the next step. If there is no clear
majority on the action, the system will use a resolving action to determine how the record
moves forward.

» All-consensus completion policy: All assignees to the task have responded to it and all
assignees have agreed on the action that moves the record forward to the next step. If there
iS no consensus on the action, the system will use a resolving action to determine how the
record moves forward.

A resolving action moves the step to either a following step, a previous step, or a conditional
step that essentially "re-addresses"” or "revisits" the task. This step must be completed before
the workflow can continue. The assignees on this resolving action step can include the original
task assignees and can also include new assignees.
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If there is only one action in the Workflow Actions drop-down list, the system defaults the
selection. As a result, the system updates the To and CC fields with the relevant users and
groups. When you click Send, if the list of users changes based on either an assignee filter in
the workflow setup or via conditional routing, the system displays a window informing you that
the list of users will change. After the list of users is changed, you must click Send again. The list
of assighees changes to reflect the change in the next step and will be displayed when you save
the workflow BP record.

Note: Clicking Send will not route the BP record if the conditional routing
is not resolved.

If the Admin sets up the Business Process policy, you can choose that a step be completed
without all assignees having to act on it, if the result can be determined without the assignee
action. This is to prevent unnecessary delays in waiting for all users to take action on the record
before moving it to next step.

If the Admin sets the Completion Policy for a step in a business process workflow setup as "All -
Majority" and checks the option "Advance workflow when next step is determined," then
during runtime, when a record for this business process reaches this step, as soon as the
majority of the step assignees take the same action at this step, the step will be completed and
the workflow moves to the selected step.

Note: One or more assignees on the step could choose to decline acting
on their tasks. In this case, the majority count is determined by
dismissing the count of users who declined the task.

Example

There are four assignees on a step. Two of the assignees take the same action. The third
assignee declines the task. As soon as the third assignee declines, because the majority
(two of the assignees) have taken the same action, the record will move to the next selected
step.

In addition, the "Workflow Progress" tab (in the BP log and within the BP record) gets updated
correctly (with the correct "Status" and "Action") for all the users who took action on the step. For
all users who did not act on the step:

» The "Status" gets updated as: Closed.
» The "Action" remains blank.

If the Admin sets the Completion Policy for a step in a business process workflow setup as "All -
Consensus," and checks the option "Advance workflow when next step is determined,"” then
during runtime:

When a record for this business process reaches this step, and:

» As soon as one assignee on the step takes the "Resolving action" as chosen in the BP setup
in the Admin mode, or

» As soon as two assignees on the step take two different actions on the step

Then, this step will be completed, and the workflow moves to the "Resolving action" step;
otherwise, if all the assignees take the same action (which might be different from the resolving
action), then the record moves to the step, as chosen by the assignees.
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The "Workflow Progress" tab (in the BP log and within the BP record) gets updated correctly
(with the correct "Status" and "Action") for all the users who took action on the step. For all users
who did not act on the step:

» The "Status" gets updated as: Closed.
» The "Action" remains blank.

For both options "All - Majority" and "All - Consensus" completion policies, if an assignee
accepts the task and has been working on a draft record, and while the assignee has been
working on a draft record a majority or consensus has been reached, then the draft will be
deleted, and the record moves to the next step.

Note: In case the assignee has who has worked on the draft had added
new line items, or edited existing line items, the changes will be retained
when the record moves to the next step.

Statuses

The statuses you see on this window are internal to the system and are used only to display the
status of the workflow step relative to the completion policy. These statuses are:

Status Description
Not Started The assignee has not accepted the task.
In Progress The assignee has accepted the task.

This status is used when the step has a
single completion policy and one of the
assignees accepted the task. This status
denotes those assignees who were also
assigned to the task, but because of the
single completion policy, the task was
locked and these assignees no longer
have access to it.

Locked

This status indicates that this user was
View Only cc'd on the task, but is not expected to
take action on the task.

This status is given to an assignee's action
if the task was finished and needed no
resolving action. At any step, a task can
have only one status of "Completed."

Completed

This status is given to an assignee's action
if the task was finished but triggered a
resolving action. The task will either return
Closed to a previous step, move forward to a next
step, or divert to a conditional step, which
will resolve the condition and move the
task forward in the workflow. The step the
action moves to for resolution will show a
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Status Description

status of "Not Started." The number of
times the task shows a "Closed" status
indicates the number of times the step has
been revisited.

Working with Tasks

The system helps you collaborate with your team members through business processes. Your
tasks are business processes that are in process and with which you are involved.

After you create and send a workflow business process, the system creates a task for each of
the assignees in the next step in the workflow and sends a message to each user that has been
Cc'd.

In general, you are assigned a task when you are part of a BP workflow, and you are requested,
or required, to take some sort of action.

The following tasks are not listed in your Tasks log:

» Tasks for view-only.
» Tasks for inactive Projects/Shells.

If you are designated as an assignee on a task, you will receive an email notification, and the
task will appear in your Tasks log.

Taking Action on your Task

To take action on your task, you can use the following sub-options of the Actions option:

» Action with Preview
» Action without Preview

For Action with Preview:

1) Goto your Tasks log and Ctrl+click the tasks that you want to modify.
2) Click the Actions drop-down list and select Action Preview.
The system opens the record that you have selected in a separate window.
3) Modify the record.
4) Click Save.
5) Click Close Window.

If your tasks have been accepted, the Action with Preview option will not be available.
For Action without Preview:

1) Goto your Tasks log and Ctrl+click the tasks that you want to modify.

2) Click the Actions drop-down list and select Action without Preview to open the Action
Without Preview window.

The Action Without Preview window is divided into two panes:
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Use the left pane to edit the Upper Form of your business process and perform workflow
action (Workflow Actions).

Use the Workflow Actions to send records to the next step in the workflow, after
completing the task, and assign record status such as pending, in-review, and so forth.
The system automatically selects the check box under the Update column when you type
into or modify a field. You can deselect it if you do not want to modify the field at this time.
The system updates the field values if you select the check box under the Update column
of that field.

- If you change the value of a field and select the check box under the Update column of
that field, the system will update the value of that field.

- If you erase the value of a field (blank) and select the check box under the Update
column of that field, the system erases the pre-existing value of that field.

Use the right pane to preview the status of the task (Action Status).

The Action Status indicates whether your update was a success or not (using a green
check-mark symbol or a red x symbol, respectively), and a message explaining why an
update has failed.

You can use Action without Preview to create multiple shells using the Project/Shell
Creation business process. The Action without Preview functionality in the Tasks log
supports data elements such as Shell Location and Shell Template pickers (existing in
the Upper Form) that are required for shell creation.

3) When finished, click Close. The system will update the tasks.

For more information, see Editing Business Process Records (on page 211).

Taking Action on Multiple Tasks at the Same Time

Use the Actions option to take similar actions for multiple tasks.

You can select multiple tasks (Ctrl+click), click Actions drop-down list, and perform the following
actions:

v v v v Vv

Accept

Undo Accept
Hide

Unhide All
Print

You can use the following options to modify multiple records:

» Action with Preview

4

4

To open multiple records (one record at a time) and modify the contents.

The Action with Preview option can be used when records belong to different business
processes and different workflow steps.

» Action without Preview
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To open multiple records in Action Without Preview window and modify the contents.
The Action Without Preview option can be used when records belong to the same
business process, records have the same workflow name, and records are on the same
workflow step.
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When tasks are updated through the Action Without Preview option (in the Tasks log),
the values of the Data Elements (DESs) that have "Reset" property will not be reset.

The following provides more details about modification of multiple records.

Taking similar actions for multiple tasks that belong to the same business process, and
the same step

1) Goto your Tasks log and Ctrl+click the tasks that you want to modify.

2) Click the Actions drop-down list and select Action without Preview to open the Action
Without Preview window.

The Action Without Preview window is divided into two panes:

4

Use the left pane to edit the Upper Form of your business process and perform workflow
action (Workflow Actions).

Use the Workflow Actions to send records to the next step in the workflow, after
completing the task, and assign record status such as pending, in-review, and so forth.
The system displays Master DE, value set DE, and the behavior set DEs (Required,
Disabled, Disabled and Clear). If the data element is disabled, it is based on the Master
DE and value set DE in the DDS configuration.
= The elements of a DDS, especially behavior set DEs, play a role on many of these
actions. This is due to Bulk Update retaining any change brought on by a behavior
set DE. For example, if the fields become Disabled and Clear based on the
values selected in the Master Data Element, the fields become disabled with no
values.
* When you select Disabled and Clear, other formula fields are re-evaluated.

= A similar reaction occurs when updating records, as the Update check box also
becomes disabled.

The system automatically selects the check box under the Update column when you type
into or modify a field. You can deselect it if you do not want to modify the field at this time.
The system updates the field values if you select the check box under the Update column
of that field.
- If you change the value of a field and select the check box under the Update column of
that field, the system will update the value of that field.
- If you erase the value of a field (blank) and select the check box under the Update
column of that field, the system erases the pre-existing value of that field.
Use the right pane to preview the status of the task (Action Status).

When working with multiple tasks, you (the assignee) can select multiple records of the
same business process and same step and perform the action in one place.

The Action Status indicates whether your update was a success or not (using a green
check-mark symbol or a red x symbol, respectively), and a message explaining why an
update has failed.

3) When finished, click Close. The system will update the tasks.
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Taking similar actions for multiple tasks that do not belong to the same business
process, and the same step

The Action without Preview option can be used to take bulk action on tasks that belong to
different business processes, or on the tasks that belong to the same business process and
workflow, but are on different steps in the workflow.

1)
2)

3)
4)
5)
6)

Go to your Tasks log and Ctrl+click the tasks that you want to modify.

Click the Actions drop-down list and select Action Without Preview.

The system opens each record that you have selected in a separate window.
Modify the record.

Click Save.

Click Close Window. The system opens the window of the next record.
Continue modifying the records, Save, and click Close Window until finished.

If your tasks have been accepted, the Action with Preview option will not be available.

Additional information about taking actions for multiple records

»

You can update a maximum of 200 records using Workflow update (Action Without
Preview window > Workflow Actions).

Only the Upper Form is modified during Workflow update (Action Without Preview window >
Workflow Actions).

The Workflow update (Action Without Preview window > Workflow Actions) is not supported
on tasks that are on the Initiation step.

When you send the record to the next step, the system performs validation for the required
fields.

At the company-level and project-level, when you are taking action on multiple tasks, you
must have Allow Bulk Edit permission for each task.

For bulk update, the fields are from both Upper Form and Details forms (drawn from
integration templates). Some business processes do not support integration. As a result, you
cannot take multiple actions on these business processes because integration is used in
multiple action.

For more information, see Editing Business Process Records (on page 211).

Accepting your Tasks

You must accept a task to complete it.

The best way to accept a task is from the Home workspace: Home workspace > Tasks. You
can also accept a task from the specific business process log, provided you have permission to
the log (Company Workspace and Project/Shell). See Accepting your Tasks (on page 196) for
details on how to access the Tasks node in the Company Workspace or Project/Shell.

Note: If the Project/Shell in which a business process resides becomes
View-Only, any in-process records will be placed on the View form of the
current step of the workflow. If the project or shell is re-activated, the
business processes will revert to the Action form.

To accept a task from the Home workspace:
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1) Go to Home workspace and click the Tasks node.

2) Hover over the record and click the gear menu ( % ).
3) Click Accept.

Alternatively, you can also click Actions and then click Accept. or use the Task Status (the
check-mark icon).

To accept a task from the specific business process log (Company Workspace and
Project/Shell):

1) Go to your business process and open the log from the Tasks node.
2) Hover over the record and click the gear menu (% ).

3) click Accept.

Alternatively, you can also click Actions and then click Accept. or use the Task Status (the
check-mark icon).

To accept multiple tasks (of the same BP and same workflow schema):

1) Go to Home workspace, or your business process, and open the log from the Tasks node.
2) Citrl+click to select the necessary tasks.
3) Click Actions and then click Accept.

Every task you complete will be deleted from the Tasks log (Tasks node). Those you do not
complete will remain on your Tasks log.

Additional information about accepting your tasks

Task Notifications

» If the task belongs to the Create step of a workflow, you will receive a message confirming
that the record was (or was not) created successfully.

» If you open a task from a project/shell that is on-hold, the system will notify you and delete
the task from the log.

Initiation Step

In general, if a business process has been auto-created and sent to an Initiation Step, you will
usually need to select a workflow schema to launch the business process into the workflow.
When you accept the task, the system displays a Select Workflow window, where you must
choose the workflow schema this business process should use. See Creating a Business
Process (BP) Record (on page 71) for more information.

The system does not display the Select Workflow window if:

» The BP is a non-workflow business process.
» There is only one workflow schema you can choose for this business process.

Undoing Accepting your Tasks
If you change your mind after accepting a task, you can use the Undo Accept option, if:

» You are the last person on the task distribution list and everyone else has declined the task.
» You are the only task recipient.
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The Undo Accept option restores the business process form, and data, back to the state it was
in just prior to accepting the task, even if you have made some modifications to it. This applies
only to additions or changes made between accepting the task and selecting Undo Accept.

Note: The Undo Accept is not available for Initiation Steps.

The Undo Accept will roll back the following to their previous state:

» Changes to Upper Form fields
» Auto-populated fields
» Changes to the action details (To and Cc fields)

Any new additions of the following are removed:

» Summary, detail, or imported line items
» Comments

» File attachments

» Linked records

These changes are not rolled back:

» Changes made to existing line items.

» Anything that is deleted, such as attachments, linked records, linked Mailbox, and line items,
cannot be restored. The exception is upper form fields, which will be restored to their
previous state.

» Transfer ownership.
» Mailbox messages sent through linked Mailbox.

To undo an accepted task from the Home workspace:
1) Go to Home workspace and click the Tasks node.
2) Hover over the record and click the gear menu (% ).

3) Click Undo Accept.

Alternatively, you can also click Actions and then click Undo Accept, or use the Task Status
(the check-mark icon).

To undo an accepted task from the specific business process log (Company Workspace and
Project/Shell):

1) Go to your business process and open the log from the Tasks node.
2) Hover over the record and click the gear menu (% ).

3) Click Undo Accept.

Alternatively, you can also click Actions and then click Undo Accept, or use the Task Status
(the check-mark icon).

To accept multiple tasks (of the same BP and same workflow schema):

1) Go to Home workspace, or your business process, and open the log from the Tasks node.
2) Citrl+click to select the necessary tasks.
3) Click Actions and then click Undo Accept.
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Declining a Task

Sometimes you have the option of declining a task. If you are the only person assigned to a step
in the workflow, or if the creator of the workflow has not granted permission to decline a task,
this is not an option.

To decline a task from the Home workspace:
1) Go to Home workspace and click the Tasks node.

2) Hover over the record and click the gear menu ( & ).
3) Click Decline.

To decline a task from the specific business process log (Company Workspace and
Project/Shell):

1) Go to your business process and open the log from the Tasks node.

2) Hover over the record and click the gear menu (& ).
3) Click Decline.

Note: You cannot decline multiple tasks.

Completing a Business Process Form

To complete a business process form

1) Review the form carefully. If you have the proper permissions, you can perform the following
functions, if the business process is set up for them or is of the proper type to accommodate
them.

» Make changes or additions in editable fields of the business process.

» Add, edit, or remove line items or summary line items (see Adding and Managing Line
Items (on page 122)).

» Add or view file attachments (see Working with File Attachments and Markups (on
page 151)).
» View or add general comments (see Adding and Managing Comments (on page 142)).

» Add or review graphic markups to an attached document (see Add Markups to a
Business Process Attachment (on page 164)).

» Provide a link to another completed BP form. Other participants will be able to click the
link and view the referenced BP form (see About Linking Business Process Records
to other Business Process Records (on page 174)).

2) Inthe Action Details area of the form, designate the next assignees (users and groups) who
will receive the next step in the workflow as a task. (See Assign users to the next step
(see "Assigning Users for the Next Step or Sending a Copy" on page 200)) You can
choose the next users to send the BP to if the BP has been set up this way. Some BPs have
a fixed workflow. If this is the last step in the workflow, this is not applicable.

You may also be able to designate the Task Due Date for the next assignees. (See
Modifying Step Due Date (on page 203).)
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3) When you have completed any necessary edits or additions, select an action or workflow
action from the Workflow Actions drop-down list. If there is only one possible workflow
action for a step, the action is auto-populated in the field. The action you take depends on
the task assigned. For example, if this is a review step, an action that you may be able to
take is "approve."

4) Click the Send button.

» If the workflow is not yet complete, the form will be forwarded to the next team members
in the workflow.

» If the workflow is complete (that is, your input was the last step of the workflow), the
record will appear as complete in the business process log.

Note: You can also save your work as a draft at any point. This is
recommended if you are going to leave your desk or have a lot of work
to do on it. There is no autosave. If you change your mind after making a
selection, click the Undo Action button, and then choose another action.
In Classic View, after you have accepted the task or initiated an action,
you can still review what you received prior to doing so without having to
undo. Click View > Received or the Click here to view latest content
button. The system displays another pop-up window of the original
record as you received it. Assign users to the next step (see
"Assigning Users for the Next Step or Sending a Copy" on page 200)

Assigning Users for the Next Step or Sending a Copy
Assigning users, and workflow routing, must be done after opening a record.

Depending upon the workflow configuration and your user permissions, you may select one or
more users or groups to whom the form will be sent as the next step in the workflow. The
assignee fields are:

» To: The users or groups that you choose will be assigned the next task in the workflow.
Team members listed will receive an email notification of the task. This can include users
designated as Editors on the task, as well as proxy users.

» Cc: These users and groups receive an email notification and a copy of the BP record in
their Message log. They can review the record but cannot take action on the workflow.

Depending on the workflow setup, you may also be able to set the due date for the next step.

Assigning Users for the Next Step

You can assign a user for the next step from the tasks log (Tasks functional node in Home
Workspace, Company Workspace, and Project/Shell).

1) Go to your business process and open the log.

2) Select the record, click the gear menu ( ¥ ), and click Open.

3) When you are finished editing the form, click Send to open the Workflow Action Details
window.
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In the To field, click the Select button to the right of the text box. The User and Group
Picker window opens. Alternatively, you can start typing in the text box for suggested users
based on your entry.

Select names from the Available Items list and click Add Selected (singular right arrow), or
Add All (double right arrow) if you would like to add everybody on the list.

Click Done when finished.

When the business process form is sent, each member will receive an email message regarding
their task assignment and a copy of the BP form in their Tasks log.

Note: If a task is sent to other users for review, it may be sent back to
the initial user for revision. In this case, if the "Include only previous
action takers" option is selected for the business process, and the user
that initiated the last step is no longer active, you will receive the
following error message:

"The system cannot send the record to the next step as step assignee is
no longer active. Do you want the system to send an email notification
about the error and appropriate action to the Administrator?"

If you select Yes, your email will be sent to the administrator or
administrative group specified in the Business Process setup.

The administrators will take appropriate action of reassigning the task to
an active user by navigating to Task Reassignment log.
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If you select No, the confirmation alert is dismissed and no further action
is taken.

In both the above cases, the To field in the workflow action details will
not be populated with any user or group from the creation or matching
step, and the workflow cannot progress until an administrator takes
action.

This error will also occur when records are sent through Bulk Action or
Email Action.

Sending a Copy of the Business Process Form
If you must send a copy of a business process form to another user:
1) Go to your business process and open the log.

2) Select the record, click the gear menu (% ), and click Open.
3) When you are finished editing the form, click Send to open the Workflow Action Details
window.

4) In the CC field, click the Select button to the right of the text box. The User and Group
Picker window opens. Alternatively, you can start typing in the text box for suggested users
based on your entry.

5) Select names from the Available Items list and click Add Selected (singular right arrow), or
Add All (double right arrow) if you would like to add everybody on the list.

6) Click Done when finished.
When the business process form is sent, each member will receive an email message and a
copy of the BP form in their Notifications log.

Note: The BP form may be set up to have pre-assigned Cc users. In this
case, if the Cc button is enabled, you can add additional Cc users. If not,
the BP is not set up to allow additional Cc users. You cannot remove
pre-assigned Cc users.

User Picker and Group Picker

With the introduction of profile picture, the User Picker, User Data Picker, and User and Group
Picker include the profile picture, before the User name.

User Picker

This picker has the list of users. For users who have uploaded their profile picture, their
picture will be displayed. If there are no pictures, then the system displays the initials of the
user's first and last names.

User Data Picker

This picker has the list of users. For users who have uploaded their profile picture, their
picture will be displayed. If there are not pictures, then the system displays the initials of the
user's first and last names.
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Depending on how the business process (BP) form is configured, the user data picker, in any
business process (BP) record, can be used to auto-populate the user attribute values of the
fields corresponding to the selected user in the BP form.

User Group Picker

This picker has Groups followed by Users. For users who have uploaded their profile picture,
their picture will be displayed. If there are not pictures, then the system displays the initials of
the user's first and last names.

View User Profile

The View User Profile window lets you see the profile for multiple users who are assigned to, or
cc'd in, workflow tasks. This window opens when you select a highlighted user name within a
form.

The left section of the View User Profile window lists the users, and the right section displays
the following for the user:

» Basic Information

» Additional Information

You can view the user attributes from both the company and the shell directories.

If the Apply values for the picker log from Project directory option is selected, the system
fetches the user attribute data from the project directory. The data that is displayed under the
project directory (User mode) can be fetched from the shell-level when the project directory
option is selected. When the user's name is launched from the shell, the project-level or
shell-level information is fetched as defined at the shell-level.

Modifying Step Due Date

If the step duration and workflow override are enabled on the business process, you can also set
the task due date for the next step.

To change the task due date

1) Inthe Due Date Details section, click the Calendar icon. The Task Due Dates window
opens.

2) Choose one of the following options:
» Set all task due dates as: Lets you set the same due date for all assignees.

» Set individual task due dates: Lets you assign different due dates for each assignee
one at a time.

3) Click the Calendar icon to set the due date. For the second option, click the date listed in the
Task Due Date column.

4) Select the month and year, and then click the date you want to select.
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Note: The workflow engine uses the company workday calendar.
Grayed-out dates are those that have been set as non-working days (for
example, weekends and holidays) by your company administrator. You
cannot select non-working days for a task due date.

Editing the Due Date (due_date) Field

In the Workflow Settings field in the Workflow Setup of a BP, if the option Override Workflow
Due Date field set as Yes, then you can edit the due date in the creation step.

In the Workflow Settings field in the Workflow Setup of a BP, if the option Override Workflow
Due Date field set as No, then you cannot edit the due date in the creation step.

Also, you cannot edit the due date if:

» The work has started.
» The work has moved to the next step (is in-flight) in the workflow process.

Adding Additional Assignee or Sending Additional Copy

The current step assignee can add assignees to the next step in the workflow. This is useful if
you want to send a copy of the record or add another assignee before you take action on it.

You can add additional assignees or copy users if:

» You have not yet accepted the task, and the form is still in view form. If you have already
accepted the task, you can reverse the action by clicking the menu icon (three horizontal
lines) and selecting Undo Accept.

» The business process workflow has been set up to allow adding assignees or allowing to Cc.
Adding Additional Assignee

You can add additional assignees or copy users from the tasks log (Tasks functional node of
Home Workspace, Company Workspace, and Project/Shell).

Note: Adding additional assignees must be done after opening a record.

To add an additional assignee to a task:

1) Go to your business process and open the log.
2) Select the record, click the gear menu ( ¥ ), and click Open.

3) Click the Menu Options ( =) and choose Add more assignees. The User/Group picker
window opens (to learn how to search and use the picker refer to Unifier General User
Guide). The list displays the list of users or groups that can be assigned, according to the
business process setup.

4) Follow the assign team members' procedure to select users or groups.
5) Click Done.
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The user or group will be added to the list of assignees. The record will appear in each new
user's Tasks log and applicable business process log, and users will receive an email informing
them of the task, depending on their email subscription preferences.

Sending Additional Copy of Business Process Form
To send a copy of a business process to additional users:
1) Go to your business process and open the log.

2) Select the record, click the gear menu (% ), and click Open.

3) Click the Menu Options ( =) and choose CC more users. The User/Group picker window
opens. The list displays the list of users or groups that can be copied according to the
business process setup.

4) Follow the assign team members procedure to select users or groups.
5) Click Done.

The user or group will be copied. This means that the record will appear in each new user's
Notifications log and applicable business process log, and the users will receive an email
informing them of the copy, depending on their email subscription preferences.

You can copy more users on the End step, if the following conditions are met:

» The signed in user is not a Step Editor, and
» The signed in user is not a Record Editor.

The restrictions for Record Editor and-or Step Editor are not applicable to creators. A creator
can add more users because the creator is the owner of the record. This ability remains whether
the creator belongs to the Record Editor group or the Step Editor group.

Completing Tasks via Email

You may receive BP-related email notifications that contain hyperlinks that represent actions in a
BP workflow.

Actions you can take via email are shown as hyperlinks and represent actions you can take in a
workflow step. When you click the hyperlink, an email reply is generated. Your reply text
becomes a general comment in the BP record, except in the case of Document Type business
processes; reply text is not attached for those business processes. Assignees need to be
pre-assigned on the workflow steps for the email workflow action to occur. Attachments can be
included in the workflow action replies if the BP is set up to include them. Email clients
supported for workflow actions via email include HTML and text. If you are using a text client for
your email, the possible actions are listed, but are static text (not hyperlinks). In that case, you
can reply to the email manually and provide the appropriate To, Subject, and body text. Your
subject should be the name of the action you want to take as shown in the email notification.

Your subject should be the name of the action you want to take as shown in the email
notification.

Tasks that are assigned to you are listed in your Tasks logs. The Tasks logs display business
process-related tasks in which you are being requested to participate. Refer to Unifier General
User Guide for details about the Tasks log.
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The following tasks may appear in your Tasks logs:

» You are part of a business process workflow and are requested or required to take some sort
of action.

» You are designated as the Initiation step assignee for an auto-created business process.
Validation for email task flow actions are as follows:

Email address must match that of the assignee

Valid Notification ID/Password (NID)

Active (Unifier) User

BP record has not moved or been terminated

Record has not already met completion policy
Assignees must be Preassigned at the destination step

v v v v v Vv

To respond to a workflow task directly from email

1) Open the email notification.
If Response via email has been enabled in the business process design, the email includes
action links. The email message also displays data from the business process form.

2) To take action, review the email, then click an action link. In an email program such as
Outlook, this will create a response email.

Note: (1) Do not change the subject line of the email. Changing the
subject line text will cause the email response to fail. (2) If you are using
a text client for your email, you can open a new email message, copy the
subject line of the natification, and paste it into the subject line of the
response email.

3) You can add text to the body of the email. This will create a General Comment on the
business process record.

Note: Email response text is not saved as General Comments for
Document Type business processes.

4) You can add file attachments to your email response.

If the business process has been set up to accept attachments, they will be added to the
record in the system. If the business process does not allow attachments, attachments you
add to the email response will be ignored. If a file exists on the record with the same name
as the file you are trying to send, your attachment will be ignored.

5) Send the email, which will send the action to Unifier.
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For all Workflow Business Processes where the steps are enabled for “Enable Response via
email,” the following Workflow processes are completed when you perform, or approve, a task
via email:

Capture of Workflow progress elements in the form:

» Taken By
» Action Name
» Taken On

Formula calculations on the form:

When the record progresses to the next step, the system evaluates the formulas on the form
that are associated to the Workflow.

Form level validations:

Form-level validations are applied. If there are any errors, it will not advance the Workflow to
the next step.

Additional form processing:

» Auto population (sum of line items)

» Dynamic Data Set (DDS) check: The system performs DDS checks prior to routing the
record to the next step when action is taken through Email.

Note: If the step where the action is being performed has a DDS
behavior set field which is required, and that field is empty, then the
record will not progress to the next step.

Reset Form: Data Elements (DESs) in the form that have the Data Entry as Reset are processed
when the record is progressed to the next step via email action.
Auto-Population for Behavior Set DEs

The data fields in a business process form can be updated through auto-population, including
those in a behavior set of a DDS. Auto-population can occur during the creation of a form or
during the selection of a picker value within a form. If the value of a Master Data Element clears
a previously entered value of a behavior set data element and disables it, then any fields
auto-populated from the behavior set data element are re-evaluated.

Similarly, any formulas dependent on the behavior set data element are re-evaluated. For
example, in an Upper or Detail form, when a behavior set DE changes, the auto-population
fields do not change. In the case of selecting a picker value, when the value of a picker changes,
the auto-population fields do change.

Additional Processing

Query and Summary DEs:

Query and summary-based DEs, in the subsequent forms of the Workflow, are populated
correctly when the record is progressed to the next step via email action.

Other post processing logic:
» Reverse auto population
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Roll-up to Cost sheet

Roll-ups to other sheets

Auto Creation - S-Step

Auto Creation - I-Step and so on

v v v Vv

About Email Notifications for Business Processes

Email notifications are designed and set up by the Unifier Administrator. To initiate this feature
for yourself, you must set up an option in your user preferences that specifies that you want to
receive these notifications.

Refer to Unifier General User Guide for information about selecting email subscription options.

After you make this specification, you will be notified whenever a business process to which you
have been assigned is created, modified, or closed.

In addition, if you are creating or editing a business process that has been set up for email
notifications, you can notify additional users or groups at your discretion.

Users who receive email notification (based on events triggered) will see the data elements
based on configured email notification elements which is across all view forms for Workflow BPs.
For Non-workflow BPs, the email notification received will show all the data elements based on
configured email natification elements set up across all upper forms.

Email Notifications for Workflow Business Processes

You may be notified by email when you have a new task, if you are late responding to an
assigned task, you are an editor on the task (in which case, you receive naotification each time a
draft is created), or if you were the creator of the business process and someone has taken
action on their task.

Depending on your company Unifier email notification setup, and your own user preferences,
you may receive such emails one at a time as the task is generated, or you may receive one
daily email digest summarizing all the day's email notifications (including non-business process
related notifications).

Note: Email notifications can be configured in your user preferences.

If you receive an email notification

You may receive BP-related email notifications for the following:
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You have a new task. A task can be generated if you must take action on a BP workflow
step. Click the hyperlink at the bottom of the email. When you click the link, you will be
directed to the Unifier sign in screen. After you sign in, the system will display the record,
where you can complete the form and send it to the next step.

You are late responding to an assigned task. The actions you can take are similar to when
you have a new task.

You are the owner or creator of the BP and someone has taken action on their task. This is a
notification only and no action is required.

You are an Editor on a task (you receive notification each time a draft is created).

You are designated as an active proxy user, and the user you are acting for has received a
task.

A BP workflow has been completed. This is a notification only and no action is required.
You must take action during a BP workflow.

Email Notifications for Non-Workflow Business Processes

Your company may require that non-workflow business processes be acknowledged when they
are created, modified, or closed (terminated).

Email notifications for non-workflow business processes include the fields from the business
process that were chosen to appear on the email. The notification also includes a link you can
click that will open the record for you to view.

When you click the hyperlink, you will be directed to the Unifier sign in screen. After you sign in,
the system will display the record, where you can complete the form and send it to the next step.

The email will display summary information, such as:

v v v v v Vv

What record was created

Which upper form fields have been modified

Comments that have been added to the BP or a line item

Line items that have been added, edited, or deleted

General comments that have been added to the record (excluding any hidden comments)
Attachments that have been added or removed

Managing Business Process Records

The following topics describe how to manage business process records.
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Transferring Ownership - Business Process Records

If you are a BP record owner or creator, you can transfer ownership at any time in the workflow
process, other than the creation step, or after its termination step. The new owner will have all
privileges of a BP owner, and the originator name on the BP form and the log will show the new
owner.

To transfer ownership within a BP form
1) Open the BP form.
2) Click the Menu Options (three horizontal bars).

3) Select Transfer Ownership. The Transfer Ownership window opens to display the User
Picker.

4) Click Select (&==) to the right of the text field, or type a User Name into the text box. If you
start typing, a list of suggested users will appear below.

5) If you clicked Select, click a user from the User Picker window and click Select.
6) Click Transfer when done.

To transfer ownership from a BP log
1) Open the BP log.

2) Hover over a record and click the gear menu ().

3) Select Transfer Ownership. The Transfer Ownership window opens to display the User
Picker.

4) Click Select (&==) to the right of the text field, or type a User Name into the text box. If you
start typing, a list of suggested users will appear below.

5) If you clicked Select, click a user from the User Picker window and click Select.
6) Click Transfer when done.

Alternatively, you can select Transfer Ownership in the Actions menu to complete the same
process.

Granting or Updating Record Permissions for Non-Workflow Business Processes

To grant or update permissions:

1) Create a BP record in the Company Data Manager, Company General, or project or shell
General log.

2) Select one or more BP records and click Actions > Permissions. You can also click the
gear menu ( &), and click Permissions to assign permissions to only one BP Record. The
Permissions window opens.

3) Inthe Permissions table, type the user or group hame in the Add box and select the user or
group to grant access.

4) By default, each listed user or group will be granted View permission, allowing them to open
the BP Record. To grant additional permissions, select the check boxes that correspond to
the user or group:

» All: User will have View, Edit, and Modify Permission.
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» Modify Permissions: Allows user to control the BP record's permission settings.

» Edit Data: User can import BP record information, save a snapshot, edit BP record
properties, and add columns.

» View: User can view the BP record.
5) Click Save, or click Save & Next to go to the next worksheet.

When editing one record at a time, click the left arrow to view the previous BP record or the
right arrow to view the next BP record.

After exiting the Permissions window, the Permissions tab will be refreshed with the updated
information.

Note: You must have permissions for specific business process logs to
create or view records. Contact your project or shell administrator if you
are having trouble accessing BPs or BP logs to which you need access.

Editing Business Process Records

When a workflow business process (BP) is in route, depending upon your permission settings,
you can add or edit information on the form. A non-workflow BP can be edited as needed, as
well.

You can be designated as either a step editor on a specific step in a workflow, or as a record
editor. As an editor, you must have at least the "View" permission to be able to view the record
in the log and access it for editing.

» Step editors cannot edit a workflow record until the task assignee accepts the task and
saves the draft.

» Edits made and saved by assignees are not viewable until the assignee sends the record on
to the next step; however, edits made and saved by record editors are viewable at any time.

» Edits performed on the end step of a workflow BP affect the record directly, as no draft
exists.

For details about editing your tasks records, see Taking Action on your Task.

Editing a BP Record for Editors

You can be designated as either an Editor on a specific step in a workflow, or as a Record
Editor. As an Editor, you must have at least view permission to be able to view the record in the
log and access it for editing.
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Notes:

= Step editors cannot edit a workflow record until the task assignee
accepts the task and saves the draft.

= Edits made and saved by assignees are not viewable until the
assignee sends the record on to the next step. However, edits made
and saved by record editors are viewable at any time.

= Edits performed by editors are not audited; however, changes made
by record editors are audited.

= Edits performed on the end step of a workflow business process
affect the record directly, as no draft exists.

Concurrent editors in a business process

While a workflow BP is on a step, or a non-workflow BP is in Edit mode, the system saves edits
to fields, but does not commit the changes. For example, if editor one revises fields 1 to 5 and
then saves the record, and editor two revises fields 6 to 10 and saves, the record retains all 10
edits. However, if editor two revises field 4, and saves the record after editor one saved the
record, the data from editor two overwrites editor one's revision.

Note: Non-workflow Cost BPs cannot be updated concurrently. If a
Non-workflow Cost BP record is updated through the following means,
and the record is being updated by a concurrent editor, there will be a
slight delay in the process because the update call will need to wait until
any previous transactions are completed.

= Upper form - updated via form view, bulk update, REST, RAP, Email
action, as a result of Autocreation

= Lineitems - created via form and grid views, CSV, REST,
lineitemcreator DE, consolidation, copy

= Lineitems - updated via Ul, REST, RAP, as a result of Autocreation
= Lineitems - deleted via Ul, REST

To edit a non-workflow BP that is complete, click to open the BP and click Edit.

Notes:

= |f the BP is in a terminal status and you click Submit, the system
disables the Edit button and the form can never be edited again.

= [f you update a record for which the current Status has been set to
Inactive, you must select a different Status to continue with the
update.

You can edit a workflow BP during the workflow process.
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Note: If a view form is used on a terminal step, further editing is not
possible.

You can add comments if you are not a task assignee, provided that you have the following
permissions for business process records:

> View

» Add General Comments

In this scenario:

» You only can add general comments when the business process record is in View mode.

» You will not be able to hide comments. The Hide Comment option is available for task
assignees who are working on an accepted task (an Action form associated with the
workflow step).

Editing a BP Record from Master Log - Business Processes Node

You can edit a Project/Shell BP record from the master log (Master Log - Business Processes
grouping node), if you:

» Are an active member of the project, shell, or sub-shell

» Have the appropriate permissions in the associated project or shell.

Note: The name of the Master Log - Business Processes grouping
node can be customized.

When you open a BP record from the master log, the record will open in either Edit or View
mode, depending on the user permissions associated with that record in the Project/Shell.

For editing workflow BP records:

» After you open a BP record from the master log, the Project/Shell permissions are in effect.

» You can accept a task and take action on the workflow BP record by opening the BP record
from the master log, if you are the assignee on the current workflow-step in the BP. If not,
the BP record is opened in View mode only.

You can add general comments if you are a cc user on a particular step.

You can add general comments provided that the current step has general comments option
enabled.

» If you are not an assignee on a particular step, you must have Bulk Edit permission on the
BP record, in the master log, to edit data elements on the record.

For editing non-workflow Bp records:
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» If you have Edit Data permissions for a non-workflow BP record, then you can open the
record from the master log and proceed to edit the BP record.

» If you are an Editor of a non-workflow BP record, then you can open the record from the
master log and proceed to edit the BP record.

To edit a BP record from the master log

1) Go to Home workspace.

2) Click Master Log - Business Processes grouping node.
3) Select the BP record that you want to edit.

4) Click the gear menu ( % ) and select Open to open the BP record.
5) When finished editing, click Save.

Editing Multiple BP Records (Bulk Edit)

If you have many projects or shells with several business processes in the same state, you can
edit/modify (update) multiple BP records (bulk edit) at once.

To edit/modify multiple BP (bulk edit) records through integration:

» An interface must have been defined.
» You must have permission to perform bulk edit (Allow Bulk Edit).

Notes:
= You can update a maximum of 200 records using bulk workflow
update.

= |tis recommended to add those fields to integration which can be
updated. Exclude fields such as formulas, and system fields such as
Record No, Creator, and Record Status in workflow BPs.

You can edit/modify multiple BP records, both the workflow and non-workflow, at the following
levels:

» Project

» Shell

» Company

You can edit/modify multiple BP records (bulk edit), both the workflow and non-workflow, from
the following grouping nodes:

» Company Logs

» Project/Shell Logs

Note: You cannot update the Bidders email addresses in bulk (bulk
update through Bulk edit) or within multiple records. You can only
change a Bidder's email address in a single record.

You can also update upper form data and line item records of multiple Simple and Line Item type
BP records from the Business Process Log node.
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To edit/modify multiple BP records (bulk edit), both the workflow and non-workflow, from
the Company Logs grouping node

1) Gotothe Company Workspace tab and switch to User mode.

2) In the left Navigator, expand the Company Logs grouping node.

3) Click the desired BP to open the BP log.

4) From the log, Ctrl+click to select the BP records that you want to edit.

5) Click Actions and click Bulk Edit to open the Bulk Edit window.

The window is divided into two panes. Use the left pane to edit the Upper Form of your
business process.

The system automatically selects the Update check box when you type into or modify a field.
You can deselect it if you do not want to modify the field at this time.

Use the right pane (Action Status) to preview the status of each record.
6) When finished, click Close.

To edit/modify multiple BP records (bulk edit), both the workflow and non-workflow, from
the Project/Shell Logs grouping node

1) Go to the project/shell tab and switch to User mode.
2) In the left Navigator, expand the Logs grouping node.
3) Click the desired BP to open the log.
4) From the log, Ctrl+click to select the BP records that you want to edit.
5) Click the desired BP to open the BP log.
6) From the log, Ctrl+click to select the BP records that you want to edit.
7) Click Actions and click Bulk Edit to open the Bulk Edit window.
a. Inthe left pane, edit the Upper Form of your business process.

The system automatically selects the Update check box when you type into or modify a
field. You can deselect the Update check box if you do not want to modify the field at this
time.

b. Inthe right pane, (Action Status), preview the status of each record.

Note: Bulk Edit ignores data elements with a formula. As a workaround,
add the desired data element that does not have a formula to the
integration form with the direction set as Both or Input. During bulk edit,
add the desired value to that DE. For more details on updating the
integration form, see the topic, Creating an Upper Interface, in the Online
Help.

8) When finished, click Close.

Additional information about editing/modifying multiple BP records (bulk edit)

The Bulk Edit option (for multiple BP records) lets you edit the fields from the Action Form
(Upper Form) of the current step in the workflow.
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In a non-workflow BP, you can use Bulk Edit to update the Record Status if the record has not
reached terminal status or the record is not terminated. The Bulk Edit window will only show
active statuses.

You cannot use the Bulk Edit option for multiple BP records to edit:

» Initiation Step (I-Step) records

» Fields in a dynamic data set

» Fields from line items

» System-defined fields, such as record number, status, or due date

Note: If the Record Status defined for any of the targeted business
processes been inactivated, an error is displayed, and those business
processes will not be updated.

The Bulk Edit option for multiple BP records is not available for the following BPs:

» Resource Booking BP
» Timesheet BP
» Single-record BP

Fields that are configured for auto-sequencing are not available for bulk edit because the values
for these fields are system-generated.

You cannot use the Bulk Edit option for single, or multiple, BP records to update a field that has
value uniqueness configured.

You can update a maximum of 200 records using Workflow update (Action Without Preview
window > Workflow Actions).

Only the Upper Form is modified during Workflow update (Action Without Preview window >
Workflow Actions).

The Workflow update (Action Without Preview window > Workflow Actions) is not supported on
tasks that are on the Initiation step.

When you send the record to the next step, the system performs validation for the required
fields.

At the company-level and project-level, when you are taking action on multiple tasks, you must
have Allow Bulk Edit permission for each task.

For bulk update, the fields are from both Upper Form and Details forms (drawn from integration
templates). Some business processes do not support integration. As a result, you cannot take
multiple actions on these business processes because integration is used in multiple action.

The system does not allow Bulk edit of Data Picker based on a query.
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Editing Multiple BP Records (Bulk Edit) from Master Log - Business Process Node

If you have the Allow Bulk Edit permission, you can select one or more business process
records from a master log (Master Log - Business Processes grouping node) and perform bulk
edits on those selected records.

Note: The name of the Master Log - Business Processes grouping
node can be customized.

You can select records across projects or shells to perform bulk edit.
The following Data Definitions cannot be modified using Bulk Edit in a Master Log:

You cannot modify the following data definitions when using the Bulk Edit option from a master
log.

» Image Picker

» Company Picker

» Group Name Picker
» User Picker

» Project Picker

» BP Creator

To edit multiple BP records (bulk edit) from the master log (availability based on
permission)

1) Go to Home workspace.

2) Click Master Log - Business Processes grouping node.

3) Select the BP record that you want to edit.

4) From the log, Ctrl+click to select the BP records that you want to edit.
5) Click Actions and click Bulk Edit to open the Bulk Edit window.

The window is divided into two panes. Use the left pane to edit the Upper Form of your
business process.

The system automatically selects the Update check box when you type into or modify a field.
You can deselect it if you do not want to modify the field at this time.

Use the right pane (Action Status) to preview the status of each record.
6) When finished, click Close.
7) Proceed with your edits, save, and close the window.

Additional information about editing/modifying multiple BP records (bulk edit)

The Bulk Edit option (for multiple BP records) lets you edit the fields from the Action Form
(Upper Form) of the current step in the workflow.

You cannot use the Bulk Edit option for multiple BP records to edit:

» Fields in a dynamic data set
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» Fields from line items
» System-defined fields, such as record number, status, or due date

Note: If the Record Status defined for any of the targeted business
processes been inactivated, an error is displayed, and those business
processes will not be updated.

The Bulk Edit option for multiple BP records is not available for the following BPs:

» Resource Booking BP
» Timesheet BP
» Single-record BP

Fields that are configured for auto-sequencing are not available for bulk edit because the values
for these fields are system-generated.

You cannot use the Bulk Edit option for single, or multiple, BP records to update a field that has
value uniqueness configured.

You can update a maximum of 200 records using Workflow update (Action Without Preview
window > Workflow Actions).

Only the Upper Form is modified during Workflow update (Action Without Preview window >
Workflow Actions).

The Workflow update (Action Without Preview window > Workflow Actions) is not supported on
tasks that are on the Initiation step.

When you send the record to the next step, the system performs validation for the required
fields.

At the company-level and project-level, when you are taking action on multiple tasks, you must
have Allow Bulk Edit permission for each task.

For bulk update, the fields are from both Upper Form and Details forms (drawn from integration
templates). Some business processes do not support integration. As a result, you cannot take
multiple actions on these business processes because integration is used in multiple action.

Exporting BP Records Using Bulk Update From Business Process Log Node

If you have the Allow Bulk Edit permission, you can select one or more business process
records from the Business Process Log grouping node and perform a bulk update on those
selected records.

A bulk update allows you to export multiple business process records and modify each record
distinctly in a Microsoft Excel spreadsheet (.xlsx) for the following types of business processes:

» Simple BPs(workflow and non-workflow)
» Generic Line Item BPs (workflow and non-workflow)
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Exclusions
The following BPs are excluded from Bulk Update:

» Special behavior BPs like Project / Shell Creation and Master Vendor list

» Line Item BPs that include the following pickers: Activity picker, Account Code picker, BPO,
BPO Line Item pickers, CBS Pickers, CMx Pickers, Fund picker, OBS pickers, WBS Pickers

» Vendor Business Process

Bulk Update Export Process
To export data using bulk update:

1) Switch to the User mode.

2) Inthe left Navigator, click Logs > Business Processes.

3) In the right pane, Ctrl+click to select multiple BPs you want to export and edit.

4) Depending on the type of business processes selected, choose the following options in the
menu bar:
» For Simple BPs, click Bulk Update > Export Data > Selected Records.

» For Line Item BPs, click Bulk Update > Export Data > Selected Records > Main Form
or Main Form and All Line Items.

Note:The main form data of the terminal records will be exported when
the terminal status record has Action form as an Edit form. To export
such terminal records, select Bulk Update, Export Data, Selected
Records, and then select Main Form.

5) Save the generated Microsoft Excel spreadsheet (.xlIsx) file in a desired folder location. For
more details, see Microsoft Excel Spreadsheet File Format For Bulk Update
Export/Import Process (on page 117).

By default, spreadsheets for business processes with only Main form data are named in the
format <BP Name>_MainForm.xlsx (for example, Warranty_MainForm.xIsx).

By default, spreadsheets for business processes with Main form data and line item data are
named in the format <BP Name>_MainForm_Lineltems.xIsx (for example,

Warranty MainForm_Lineltems.xIsx).

Importing BP Records Using Bulk Update From Business Process Log Node

If you have the Allow Bulk Edit permission, you can upload a batch of modified business
process records using a Microsoft Excel spreadsheet (.xIsx) from the Business Process Log
grouping node.

A bulk update allows you to import multiple business process records that have been distinctly
modified in a Microsoft Excel spreadsheet (.xIsx or .xIs) for the following types of business
processes:

» Simple BPs(workflow and non-workflow)
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» Generic Line Item BPs

Exclusions
The following BPs are excluded from Bulk Update:

» Special behavior BPs like Project / Shell Creation

» Line Item BPs that include the following pickers: Activity picker, Account Code picker, BPO
pcker, BPO Line Item pickers, CBS Pickers, CMx Pickers, Fund picker, OBS pickers, WBS
Pickers

» Vendor Business Process

Prerequisite

Modify business process records in the Microsoft Excel spreadsheet (.xIsx. or .xlIs) that adheres
to the Microsoft Excel Spreadsheet File Format For Bulk Update Export/Import Process.

To update line item data in your spreadsheet for an import:

1) Inthe Action column, select the Update option. Otherwise, by default, the line item will not
be updated when set to a Blank value.

2) Save the spreadsheet.

Bulk Update Import Process

After modifying business process records in a Microsoft Excel spreadsheet (.xIsx. or .xlIs), import
data using bulk update as follows:

1) Switch to the User mode.

2) Inthe left Navigator, click Logs > Business Processes.

3) Inthe right pane, click Bulk Update > Import Data.

4) In the Upload Microsoft Excel File dialog, navigate to the Microsoft Excel spreadsheet
(.xIsx) and click Upload.

5) Review status of the imported data in the email notification received.
» If the import process is Completed Successfully, you will receive a success message.

» If the import process is Completed with Errors, check the attached error file containing a
list of erroneous records.

Or

» Click Bulk Update > Import Data History Details to check for error details or update
failures of records or line item updates if any.

6) Correct the errors identified in the error file and reuse the error file to re-import the data. For
more details, see Reusing the Error File Spreadsheet For Bulk Update Import Process
(on page 224).

Notes:

= Attachments updates are not supported in the Excel import.

= A maximum of 50,000 records, including the column headers can be
imported per spreadsheet.

= Upper form errors need to be resolved before proceeding to discover
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and resolve any line item errors.

= Required fields must be entered in the Main Form tab of the Microsoft
Excel spreadsheet prior to a bulk edit import process.

= Line items that do not exist will be ignored by the system during bulk
import.

= If you modify the design to include pickers in the Business Process
Integration form for a business process that is already loaded in the
BP Log node in the User mode, you must reload the BP Log to
ensure the most recent changes in design are reflected.

Viewing Bulk Update Import Data History Details

If you have the Allow Bulk Edit permission, you can view the import data history details for the
files that you imported.

To view the import details history:

1) Switch to the User mode.
2) In the left Navigator, expand the Logs node and select Business Processes.
3) In the right pane, select Bulk Update menu, and then select Import Data History Details.
4) Review the following information for each imported spreadsheet:
» Input File: The file name of the Microsoft Excel file (.xIsx)
» Upload Date: The date on which the file was imported into the application.
» Start Date: The start date and time of the import process.
» Finish Date: The end date and time of the import process.
» Job Status: Displays the job status of each imported file as any of the following:
» Not Started: Indicates the import is yet to commence.
= In Progress: Indicates the import job is in process.

= Completed Successfully: Indicates all records and line item data have been
successfully updated.

= Completed with Errors: Indicates records were partially updated, or failed to
update at least one record. For more details, see Viewing Error Details of the
Bulk Update Import Process (on page 222).

= Aborted: Indicates the job could not progress due to system issues or server
failures.
» Error File: Displays the name of the file containing the list of erroneous records. For
more details, see Error File Spreadsheet Format of Bulk Update Import Process (on
page 118)

» Records Processed: The sum total of the BP records in the Main Form worksheet and
the Line Item worksheets, if any, in the spreadsheet.
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Viewing Error Details of the Bulk Update Import Process

The Import Data History Details window displays a log of the all files imported, and their
outcomes for a business process.

If the import process is successful, the Job Status indicates, Completed Successfully.

If the import process is Completed with Errors, you can either download the input file or the error
file to correct the data and re-import.

If the import process is Aborted, you can continue importing the remaining data.

Note: If you have the Allow Bulk Edit permission, you can view the
import data history details for the files you imported.

To view the outcome of the import process:

1)
2)
3)
4)

5)

6)

Switch to the User mode.
In the left Navigator, click Logs > Business Processes.
In the right pane, click Bulk Update > Import Data History Details.

If the import process is Completed with Errors, select that row to perform any of the following
actions:

» Download the input file using any of the following options:
= Click the % gear menu of the row and select Download Input File.

= Click & Download in the toolbar and select Input File.

Correct the data in the input file and re-import as outlined in Importing BP Records
Using Bulk Update From Business Process Log Node (on page 219).

» Download the error file using any of the following options:
= Click the % gear menu of the row and select Download Error File.

= Click & Download in the toolbar and select Error File.
Correct the data in the error file to re-import as outlined in Reusing the Error File
Spreadsheet For Bulk Update Import Process (on page 224).
» Click [3 View Error Details to review a list of erroneous records in the Import Error
Details of <filename> window.

If the import process is Aborted, click Re-import in the Job Status column of the import job
to continue importing the remaining records.

You can also perform any of the following actions:
» Click & Refresh to refresh the Import Data History Details window.
» Click Q Search to open the Search window.

» Click =2 Find on Page to search and locate a specific input file in the Import Data
History Details window.
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» Click & Print to print the list of entries displayed in the Import Data History Details
window as PDF, or export and save in any of the following file formats: .html, .csv, or
XlIsx.

Error File Spreadsheet Format of Bulk Update Import Process

When the Bulk Update Import process is Completed with Errors, an Error file is generated as a
Microsoft Excel spreadsheet (.xIs).

Use any of the following methods to download the error file:

»

Download the error file from the Import Data History Details window.
For more details, see Viewing Bulk Update Import Data History Details (on page 221).

Download the error file from the email notification you receive when the import process is
Completed with Errors.

The error file contains the following worksheets / tabs:

»

Instructions worksheet

The Instructions worksheet is generated automatically. Depending on the type of business
processes included in the spreadsheet, the Instructions worksheet describes how to use the
spreadsheet to resolve errors identified in BP records and line item data.

Main Form worksheet

The Main Form worksheet is generated automatically as the second worksheet in the
spreadsheet. It is recommended to not rename or reorder this worksheet. It contains a list of
erroneous records identified in the Main Form.

» Column A of the Main Form describes the error identified for each erroneous record.

Note: All line items associated with the erroneous record in the Main
Form will not be validated. Therefore, the error file may not show all
errors related to the line items for the erroneous record.

» The following columns/data elements are also read-only: Record Status, Creator,
Creation Date, Currency ID, Due Date, Status in WF, BP, Formula Data Elements.

» Data elements that are set to auto-populate from the sum of all line items data elements
from the Integration Validation Form.

» The line item tab order is identical to the order in the selected records.

» Custom date formats are honored in the spreadsheet.

» The name of the worksheet is translated according to the user's language preference.

Worksheet for each line item tab

Line item tabs with erroneous records are color-coded orange. Each Line Item tab worksheet

contains:

» The line item records and the data elements of each tab are listed in the same order as
displayed in the user interface.

» Column A in the relevant Line Item tab describes the error identified for each line item
record.
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» Each line item record is identified by read-only columns in the following order: Record ID,
Line Item ID, Record number, and Line No. These columns cannot be renamed,
reordered, duplicated, or removed from the file.

» The formula data elements and auto-populated data elements are read-only columns.
» Worksheet names do not support the following special characters: \/ ? * : [ or ]

Reusing the Error File Spreadsheet For Bulk Update Import Process

If the bulk update import process is Completed with Errors, an error file (.xls or .xIsx) is
generated with a list of erroneous records identified by the import process. You can resolve
these errors and reuse the error file to re-import the records.

Note: You should have Allow Bulk Edit permission, to import or
re-import BP records using a Microsoft Excel spreadsheet (.xIsx) from
the Business Process Log grouping node.

The generated error file adheres to Error File Spreadsheet Format of Bulk Update Import
Process (on page 118) by default.

To reuse the error file for re-import:

1) Inthe Main Form tab, resolve the errors identified for each BP record.

2) Inthe relevant Line Item tabs, if any, also resolve errors corresponding to the BP record in
the Main Form tab (step 1).

3) Inthe Action column, select the Update option for each record. Otherwise, by default, the
line item will not be updated when set to a Blank value.

4) After resolving all errors, delete Column A to clear all errors identified in the Main Form tab
and relevant Line Item tabs.

5) Save the modified error file to prepare for import.

6) Import the error file as described in Importing BP Records Using Bulk Update From
Business Process Log Node (on page 219).

Auditing Business Processes (Audit Log)

The business process (BP) Audit Log tab lists the actions that have been taken on a specific
BP record. The following table describes the events that are, or are not, captured in the Audit
Log tab.

Note: Unless noted otherwise, the following information applies to both
workflow and non-workflow BPs.
The following events are captured in the BP Audit Log:

» Workflow steps
When and to whom (To and Cc) each step was sent (workflow BPS)
» Record creation date (non-workflow BPs)
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» General comments, including changes to the Hidden Comment check box and an entry that
indicates whether a user deleted a comment

File comments

Linked Mailbox

Linked records

Add or manage Document-type BP folders: new, remove, rename, move
Add, remove, open, view, or download file attachments
Decline task

Transfer ownership

Add, modify, or delete a line item: detail or summary

File attachments to existing line items

Copied (cc) user views the record

Updates performed on any part of the BP using the Reverse Auto-Population feature
Update user web service calls

When user(s) are added or removed using REST API services
Bulk Update Import Data

Record print

The entries include:

» Printing from BP record

» Single & Bulk Printing from the BP log

» Single & Bulk Printing from the Task log

The log entries are:

» Event - Print > <Print Type>

» Action - Run Print

» User Name - User who ran the print

The print type can be PDF, HTM, or Custom. In case of custom print, the format in Event will
be Print > Custom > <Template : Format>

» Disabled and Clear

The Audit Log captures the number of clearing and disabling of data fields, based on the
Disabled and Clear behavior set option in a DDS.

VvV VvV vV vV vV vV vV vV VvV vV v v

The following events are not captured in the BP Audit Log:

» Actions undertaken at the creation step

» Accept task

» Undo accept task

» Add assignees or copy users between steps

The following events that occur on the Unifier Mobile App are captured in the BP Audit Log:

» Record creation
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» Record update
» Line Item addition
» Line Item update

Auditing of Task Reassignment

When a Company Admin re-assigns a task, the BP record Audit Log will have the following
entries:
» Date
Date and time stamp of the task reassignment
» Event
Task Reassignment
» Action
Task has been reassigned
» Field
Assignee
» Old Value
User Name of the previous assignee
» New Value
User Name of the new assignee
» User Name
Name of the administrator who did the task reassignment

Printing and Distributing BP Forms

At times, you may need to print copies of a Business Process form, such as an invoice or a
purchase order. You can save a copy of the form as a PDF file and print or email the file, print an
HTML view, or print from a Word file if a custom print layout has been created for the form.

Notes:

= You can print a form that is in view mode or in edit mode.

= The print output is based on your permissions to certain data in the
system. If you cannot see the hidden comments in a particular step
within a Workflow, the hidden details will not be printed and will not
be visible in the Custom Print.

Print a BP Form in Different Formats

When printing business process forms from PDF or HTML format, you can choose to include not
only the information on the form itself, but also associated information such as general
comments and information about file attachments. The print options are:

» Upper form data
» Workflow progress information (for business processes with a workflow)
» Line item list
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Line item data

General comments made to the record

Information about file attachments on the record or line items
Comments made to file attachments

v v v Vv

Note: Some fonts may not be supported. Ensure that you adjust your
language settings correctly (go to region format tab and review changing
language topics in the Help) in cases of printing a BP form or attaching a
pdf version of a BP form to an email when a workflow is routed.

If custom print layouts have been created for the business process, the form will print according
to the layout that you select.

Note: For PDF and HTML layouts, the ability to print hidden comments
will respect permissions: if you can see hidden comments, you can print
them. In custom print, hidden comments are not printed.

To preview and print a business process form:

Note: Workflow Progress section in Print options is driven by
permissions. If you can see workflow progress, you can print the
workflow progress.

1) Open the BP record that you want to print.

2) From the Menu Options ( =), hover over Print, then choose one of the following:
» HTML to view the form in the browser which can then be printed.

» PDF to open the form in Adobe Acrobat Reader, which can be saved or emailed as a
PDF file, or printed process, you are asked to save the changes to the form.

» Custom to select the Oracle Business Intelligence Publisher (Bl Publisher), Oracle
Analytics Publisher, Microsoft Word, and PDF custom print templates from the same
place as the current custom prints (Custom Format Print selection window).

Note: Even if you have not made any edits, you may be asked to save
changes. This can occur if the form includes fields that are
auto-populated or automatically updated, as these automatic functions
are considered to be changes.

3) The Print Options window opens.

This window displays the business process record information that can be printed; see the
table below. Select the check boxes for the information that you want to print. Only those
options that are applicable to that business process design will appear on the Print Options
window. For example, line items options are available for business process types that
support line items, the Task Details option appears only for workflow business processes.
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4) To select all the check boxes, click Select All. To deselect all, clear Select All.

Selecting or deselecting this check box will have no effect on any Workflow Progress options
you choose.

5) Click Print. The preview form opens in an HTML window, from which you can print.

If you chose PDF, the PDF file may automatically download to your system based on your
browser.

Print option What it prints

Selected by default. This prints the
information entered on the upper form.

Upper Form

Prints a log of the steps in a workflow,
showing the step name, the assignee(s) on
the step, the action that was taken on the
step and the completion date. You have
additional print options:

All Steps will include all the steps in the
workflow, whether or not they were visited
by users. The steps will be listed in order
Workflow Progress according to the workflow setup. All
assignees on each step will be listed in the
log, whether or not they acted on the step.

Visited Steps will include only those steps
that have been visited by users. Only the
assignees who acted on the steps will be
listed. You can display the steps sorted by
the completion date or the step name, in
ascending or descending order.

Selected by default. This prints line
information as it appears on the business
process form itself. This is applicable for
Line Item List business processes that support line
items.

Note: The number of line items determines
the time taken to generate the pdf.

The general comment text and create

General Comments details are printed.

File attachments to the record are listed
alphabetically by file name and include the
file title, issue date, revision number, and
file size. This is not applicable for
document type business processes, which
list file attachments in the line item section.

Record Attachments

Record Attachments > Comments Prints comments associated with file
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Print option What it prints

attachments to the record. Record
Attachments must also be selected to
select this option.

Line item data is displayed in order by line
item and grouped by tab if the business
process has multiple line item tabs. This
prints all line item data elements present
on the detail form and reflects the layout of
the detail form (for example, if the detail
form is two-column, the print data is
displayed in two columns).

Detail Form

Prints information about attachments to
Detail Form > Attachments each line item. Detail Form must also be
selected to select this option.

Prints comments associated with file
attachments to a line item. Detail Form and
Attachments must also be selected to
select this option.

Detail Form > Attachments > Comments

Bl Publisher/Oracle Analytics Publisher custom printin | Step BP records

In | step BP records, and where the record number does not exist for a record, if you print the BP
record using a Bl Publisher/Oracle Analytics Publisher custom print template, the print output will
be blank.

Note: You cannot print a Portal Enabled BP record in the Creation step.

Custom Format Print Options for BPs

Custom Format Print Window for a non-Workflow BP
The Custom Format Print window, for a non-Workflow BP, has two sections:

» Select a custom print template
» Select a template and format to print

Both sections facilitate custom print template and format selections.
Select a custom print template

Lists all the custom print templates existing for the non-workflow BP, including the custom print
templates created in the Custom Templates functional node and the custom print templates
created in the configuration of the non-workflow BP. For example, the list may include BI
Publisher/Oracle Analytics Publisher, Word, and PDF custom print templates.

If there are multiple custom print templates for the same non-workflow BP, all the published
templates are listed in this section.
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The "Select a template and format to print" is populated by the selection made in the "Select a
custom print template" section.

Select a template and format to print

»

If you select a Bl Publisher/Oracle Analytics Publisher custom print, then you can select the
desired template and format from the drop-down lists.

Template drop-down displays all the available templates for the selected format.

Format drop-down displays the available formats for the selected template.

If the custom print template was created using PDF or Word, the "Select a template and
format to print" is disabled.

Default template and format (non-Workflow)

»

If a Bl Publisher/Oracle Analytics Publisher print template is selected, the default values in
the drop-down lists are set based on the default in the custom print template.

When a Bl Publisher/Oracle Analytics Publisher print template is selected in the "Select a
custom print template" section, the template and format are populated based on the default
value selected at the time of designing the print template.

Custom Format Print Window for a Workflow BP

If there is only one custom print template, and it happens to be a Bl Publisher/Oracle Analytics
Publisher template, the print template is selected in the “Select a custom print template” section,
and the template and format are populated based on the default value selected at the time of
designing the print template.

The Custom Format Print window has three sections for a Workflow BP.

» Select a custom print template
» Select a template and format to print
» Select options for Workflow Progress

By default, when the Custom Format Print window is launched, all three sections are enabled
and the first template is selected. The options seen in the subsequent sections are based on the
selection made in the "Select a custom print template" section.

You can select options for workflow progress in the 'Select options for Workflow Progress"
section of the Custom Format Print window for PDF and Word templates, which are created at
the time of configuring the non-workflow BP.

If the selected custom print template is of a Bl Publisher/Oracle Analytics Publisher type, the
“Select options for Workflow Progress” section is disabled. This is because the custom print
template designers can always use the system provided Workflow views to include
workflow-related information in the template.

Default template and format (Workflow)

» When a Bl Publisher/Oracle Analytics Publisher print template is selected in the "Select a

custom print template" section, the "Select a template and format to print" section is
populated based on the default value selected at the time of designing the print template.
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» If there is only one custom print template and it is a Bl Publisher/Oracle Analytics Publisher
template, the print template is selected in the “Select a custom print template” section, and
the template and format are populated based on the default value selected at the time of
designing the print template.

Note: If your custom print is a draft business process record, the
modified record values will not be displayed in the Output of the BI
Publisher/Oracle Analytics Publisher print.

Custom Format Print Window for Shells

In addition to editing shells that you have permissions for, you can view all Custom Print
Templates and define them at the shell level. After you navigate to your system logs, you must
select a BP. After you choose an item from the list of available items in the BP, click the
Settings icon and select the Print - Custom option.

When you select Print - Custom, a new window is displayed where you can choose a Custom
Print Template from the dropdown. Upon choosing one of the available Custom Print Templates,
select Print.

Note: If you copy a shell that has an existing setup and the BPSetup
module is selected, the Custom Print Templates are also copied.

Print Using a Custom Layout

Custom printing can be used with templates created in Bl Publisher/Oracle Analytics Publisher,
Microsoft Word, and PDF format. Depending on the template used for custom print, you can
print the upper form, the current workflow step, comments, and attachments of the record. The
template may also allow printing of specific line items in their tabs. The printed output will list the
name of the tab with the line items following on separate lines.

To print a BP form with a custom print layout:

1) Open the business process record that you want to print.

2) From the Menu Options ( =), hover over Print, and then choose Custom to select the B
Publisher/Oracle Analytics Publisher, Microsoft Word, or PDF custom print templates from
the same place as the current custom prints (Custom Format Print selection window).

If you are editing the business process, you are asked to save the changes to the form.

Note: Even if you have not made any edits, you may be asked to save
changes. This can occur if the form includes fields that are
auto-populated or automatically updated, as these automatic functions
are considered to be changes.

3) Select a template and format.

4) Select Workflow progress options. For details on non-Workflow progress options, see
Printing a Configurable Manager Form in the Unifier Managers User Guide.

Workflow progress prints a log of the steps in a workflow, showing the:
Step name
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Assignee: on the step

Company: the assignee company
Status: of the step

Action: on the step

You have additional print options:

» All Steps will include all the steps in the workflow, whether or not they were visited by
users. The steps will be listed in order according to the workflow setup. All assignees on
each step will be listed in the log, whether or not they took action on the step.

» Visited Steps will include only those steps that have been visited by users. Only the
assignees who took action on the steps will be listed. You can print the selected steps
(including the current workflow step) sorted by completion date or step name, in
ascending or descending order.

5) Click Print. The File Download window opens.
6) Choose to Open or Save the file.
7) Print the file.

Send a PDF Copy of a BP Form via Mailbox
You can create and send a PDF copy of a business process record directly from your mailbox.

To send a PDF copy of a BP form using Mailbox
1) Open your inbox.
2) Double-click a mail item that is linked to the business process record you want to send.

If it is linked to a business process record, you will see a caption under the subject line that
reads, This mail and any future replies are linked to business process records.

3) Click the business process records link to open the Linked Business Process Records
window.

4) Double-click a record to open it.
5) Click the Menu Options ( =) in the corner, and select Email as Attachment. The message

window will open with a PDF file of the business process record attached below the subject
line.

6) Complete the message and send.

Auto-Populating BP Data Picker on BP Auto-Creation

When a source business process (BP) record has a BP creator that auto-creates another BP
record that has a BP Data Picker referencing the source BP record, the BP Data Picker values
will be auto-populated referencing the source BP record, even when the source BP record is in a
different shell.
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The auto-creation of the destination BP records (from source BP record) can be either of the
type:

» Record to Record or

» Line-item to Record

Both types support the BP Data Picker in destination record that will be auto-populated.

Note: The system ignores the queries that have been defined for the BP
Data Picker.

The source BP record in a Project/Shell can auto-create another BP record in the same
Project/Shell

As a result, when the source BP (BP A) record and the auto-created BP (BP B) record reside in
the same Project/Shell, then the BP Data Picker in the auto-created BP (BP B) record is
auto-populated with reference to the source BP (BP A) record, similar to all BP Pickers.

The source BP record in a Project/Shell can auto-create another BP record in different
Projects/Shells

As a result, when the source BP (BP A) record and the auto-created BP (BP B) record reside in
different Projects/Shells, then the BP Data Picker in the auto-created BP (BP B) record is
auto-populated with reference to the source BP (BP A) record.

Auto-Populating BP Line Item Data Picker on BP Auto-Creation
When a record is auto-created from a line item:

» If the created record has a BP Data Picker, it will be populated with a reference to the source
record. If the upper form also has the BP Line Item Data Picker, it will be populated with a
reference back to the line item on the source record.

» If the created record has a BP Data Picker on the detail form, the line items copied from the
source will have the picker populated with a reference to the source record. If the detail line
also has BP Line Item Data Picker, it will be updated with a reference to the detail line. You
can auto-populate and reverse auto-populate back to the source upper or detail form.

» BP Line item Data Picker displays the line item based on query conditions that are evaluated
similar to Data Picker in the auto-created record.

When a record is auto-created from another record upper form:

» If the created record has a BP Data Picker, it is populated with a reference to the source
record and any Line Item Data Picker on record is empty.

» If the created record has a BP Data Picker on the detail form, the Line Items copied from the
source will have the picker populated with a reference to the source record. If the detail line
also has BP Line Item Data Picker, it will be updated with a reference to the detail line. The
design can then auto-populate and reverse auto-populate back to the source upper or detail
form.

» BP Line Item Data Picker displays the Line Iltem based on query conditions that are
evaluated similar to Data Picker in the auto-created record.

When a line item is auto-created from source BP line item:
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» If the source record has a BP Line Item Data Picker, it is populated with a reference to the
auto-created line item, provided BP Data pickers refer to the source record.

Auto-population and Reverse Auto-Population of data elements, based on BP Line Iltem Data
Picker, is supported. A Reverse Auto-Population can be done from both the Upper and Detail
forms.

When you select a Line Item Data Picker without selecting a BP Data Picker, the system
displays a picker window without line items.

When you change the selection in a BP Data picker, if there is already a line item selected, the
system displays the message: You cannot change a BP Data picker that has line item(s)
associated with it.

Upon copying a record, the selected values for a BP Line Item Data Picker will be copied from
the source record.

Upon auto-creation of the record or line item, the value for the BP Line Item Data Picker (on the
destination record or line item) is retained from the source. The value of the BP Data Picker is
also retained on the destination from the source.

A data element that is based on a Line Item Data Picker data definition is supported as part of
HTML or PDF prints. The Display Element value is printed as part of HTML or PDF prints.

A Line Item Data Picker element is available as part of Custom Print schema so that you can
use it on Custom print XML file. At runtime the Display Element value will be printed.

Auto-Populating Record Due Date on BP Workflow Auto-Creation

To ensure auto-created destination BP workflow records display a record due date at run-time,
you can define either the Duration Element or Due Date Element during auto-creation setup.
This applies to source business process (BP) workflow records that have a BP Creator Element
to auto-create another BP record.

Except for S-step, the auto-created destination BP records (from source BP record) can be
either:

» Record to Record or

» Line-item to Record

The Due Date Element field displays those date picker elements that have been specified in the
upper forms or detail forms.

Depending on the entries made in the uDesigner forms, Auto-creation Setup, Unifier Admin, and
the source record in user mode, the Due Date field in the auto-created destination BP will be
populated as follows, only if the Due Date Element and BP Creator element have been
selected in the same form:
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» If the Record Due Date Element or Duration Element is not specified in the auto-creation
setup, and the Duration field is not setup in the Admin mode or selected in the user mode,
then the due date has to be entered manually in the auto-created BP record.

» If the Record Due Date Element or Duration Element is not specified in the auto-creation
setup, however, Duration is defined in the Admin mode, but it is not selected in, the source
record, then the due date is calculated and displayed based on the duration days.

» If the Due Date Element is specified in the auto-creation setup, the Duration is defined in
the Admin mode, and the source record has a date element, then the auto-created BP
displays the source record's Due Date Element.

» If the Due Date Element is specified in the auto-creation setup, the Duration is defined in
the Admin mode, but the Date Element is not specified in the source record, then the due
date is calculated and displayed based on the specified duration.

» If the Duration Element is specified in the auto-creation setup but Duration is not defined in
the Admin mode, and the Duration Element is not populated in the source record, then the
due date is calculated and displayed using the destination record's Duration Element.

Updates on Document Attributes for Business Processes

When a document gets published to the Document Manager (DM), the document attributes get
updated by matching DEs from the BP record. If the matching DEs on the source record get
updated during the life of the record, the corresponding DM attributes can get updated, if it has
been configured in uDesigner to do so.

If the Update attributes for already published documents option is enabled on a BP Upper
Form at a given step, the attributes of all record and line item published attachments will be
updated according to the matching DEs between the record and the DM attribute form. Also:

If the Update attributes for already published documents option is enabled at multiple steps,
the DM attributes gets updated at each such step.

For a Workflow type BP:

If the Update attributes for already published documents option is enabled on a current step,
the DM attributes get updated as the record is routed to next step.

If the user causing the record to move to next step does not have Modify Properties permission
on a document, the DM attributes get updated, if the Update attributes for already published
documents option is enabled.

If the end step has an edit form, the DM attributes get updated at each save of the record, if the
Update attributes for already published documents option is enabled.

For a non-Workflow type BP:

The attributes get updated when the record is Finish Edited, if the Update attributes for
already published documents option is enabled.
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If the user who edits the record does not have Modify Properties permission on a document,
the DM attributes get updated, if the Update attributes for already published documents
option is enabled.

For both Workflow and non-Workflow type BPs:

If the attribute on DM form is set to Formula or Auto-populate with a Constant Value, the
attributes get updated from the BP if there are matching DEs with the BP form; however, when
you manually open the Properties, and click OK, the Formula or Auto-populate with a
Constant Value on the DE gets recalculated and repopulated.

If a BP record is created by attaching file(s) from the DM directly, and the Update attributes for
already published documents option is enabled, the files are treated as a published
document(s) and their attributes get updated as the record progresses in workflow, or the record
is Finish Edited.

Note: If the Update attributes for already published documents

option is not enabled, there will be no update of DM attributes as a
record progresses in workflow, or the record is Finish Edited.
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Some business processes have special features and behaviors that make them operate
differently from most business processes in the system. These business processes and their
features are described in this section.

For information about internationalization and CSV files, refer to the Unifier General
Administration Guide.
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Schedule of Values (SOV) Sheets and Business Processes

This section discusses how to manage BP records, including searching for existing BPs,
transferring ownership, viewing BP properties, and viewing Schedule of Values (SOV) or funding
information from within a Cost type BP.

View an SOV sheet from the BP form

Commit (contract) or spend (invoice) BPs can be set up to automatically create a Schedule of
Values (SOV) sheet. These transactions can be easily accessed directly from the BP form. The
BP form remains active.

If the BP has been set up to automatically create an SOV sheet, an SOV button appears at the
top of the BP form after the SOV sheet has been created.

For more information about Schedule of Values (SOV) sheets, see Schedules of Values (SOV)
in the Unifier Managers User Guide.

To view the SOV sheet created from the Cost type BP:

1) Wait for the BP to reach terminal status.

2) Open the business process and click the Menu Options ( =).
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3) Click SOV to open the SOV sheet that corresponds to the transaction.
4) Close the SOV sheet to return to the BP form.

Create SOV breakdowns

You can add SOV breakdowns from this view. Breakdowns are only in use in the SOV sheet, not
the cost sheet. If another transaction exists for the CBS code, you will not be able to do a
breakdown.

To add CBS code breakdowns that can be used to create invoices:

1) Open the business process and click the Menu Options ( =).

2) Click SOV to open the SOV sheet that corresponds to the transaction.
3) Click a listed CBS code from the sheet. The CBS Detail window opens.
4) Go to the Breakdown tab in the right pane.

For more information about adding CBS breakdowns, see Adding Breakdowns to SOV sheet
by Importing in the Unifier Managers User Guide.

View, or edit, fund transaction details from the BP form

Commit (contract) or spend (invoice) BPs can be set up to consume or appropriate funds in the
project/shell funding sheet or commitment funding sheet. These transactions can be easily
accessed directly from the BP form.

If the BP form has been set up for funding (and is in the appropriate step, and you have funding
permissions), a Funding button will appear at the top of the BP form. This lets you perform a
fund assignment while routing and approving a BP, such as a payment. Access to this button
and fund information is dependent upon your Fund Manager permissions.

For more information, see the About business processes enabled for commitment funding
and About business processes enabled for funding topics in the Unifier Managers User
Guide.

Composite view of Base Commits and Change Commits

You can view a composite view of both Base Commits and Change commits. The SOV sheet is
used as a composite view, and the SOV sheet will be the composite of the PO and all added
lines from Change commits.

To support the line-item mode, the SOV sheet has a column called Ref that represents line item
numbers.

There are other fixed columns, and the columns will be dependent on the mode.

» Lineitem mode:

» The Ref column represents the line item numbers for both Commits and Change
Commits.

» The Description column shows the short description of the line item from the Commit.
» CBS mode:
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» The Ref column does not have any data. The breakdown items do not include a ref
number. The column width is four characters.

Note: For Base Commits Business Processes (BPs) with SOV type of
"Summary Payment Applications," a special behavior line item has been
provided to allow you to add further cost distribution details to the line
items. This option is accessible in the Standard detail tab of the
properties window and contains two options: Lump Sum and Cost Unit.
Click Add and select the appropriate option.

To view funding details from the Cost type BP:
1) Wait for the BP to reach terminal status.

2) Open the business process and click the Menu Options ( =).
3) Click Funding to open the Funding sheet that corresponds to the transaction.
4) Review the details of the transaction.

Note: This is the same window that you would see if you clicked on the
link corresponding to this transaction on the project or shell funding
sheet.

To reassign funding, click Fund Assignment. For more information, see About business
processes enabled for funding in the Unifier Managers User Guide.

Payment Application Business Processes

A Payment Application BP lets you track the payment information using the standard payment
application method, such as tracking retainage, stored materials, past payments, and so on.
Each Payment Application BP record references a particular Base Commits record. The line
items on the Payment Application BP will reflect the line items on the Base commits as well as
any associated Change Commits.

Payment Application BPs, and associated Base Commits and Change Commits, are designed in
uDesigner. For more information, refer to the Unifier uDesigner User Guide. Your Company
Administrator can include or remove SOV restrictions when setting up a Base Commit BP or a
negative Change Commit (negative change order) BP.

Payment Application Tasks and Performing Multiple Actions-Bulk Action

The Tasks node of the Payment Application lets you perform bulk action on Payment
Application records, when the system detects multiple payments, or negative change orders.

When you select multiple Payment Application BP records (or Summary Payment Application
BP records) and perform a workflow action (bulk action), the system (based on the "remove
SQV restrictions" selection on the Commit BP) updates all the records that you selected, and:
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» If you select the Action with Preview option (Tasks node > Actions), the system displays
messages related to payment applications and negative change commits, when applicable.

» If you select the Action without Preview option (Tasks node > Actions), the system does
not display messages related to payment applications and negative change commits, when
applicable.

For non-Workflow BP records, when the "Status" is updated through Bulk Edit, the system does
not display messages related to payment applications and negative change commits.

When the BP records are progressed from email notifications (when you perform a workflow
action through email notifications), the system does not display messages related to payment
applications and negative change commits.

Payment Application BP and Multiple Payments

If the Remove SOV restrictions option is selected in the Business Process Setup window
(General tab), then multiple Payment Application type BPs can be configured for a Project/Shell
and multiple Payment Application BP records can be routed, at any time, for a commit.

Note: You can go to the Base Commit Setup section for setting
information.

Example

First, the user creates the contract record CON-001 and sends the contact to a step that
creates Schedule of Values.

Then, the user creates a Payment Application BP record PA-001 and sends the BP record to
the next step for approval. At this point the BP record is in progress (in-flight).

Then, the user creates a second Payment Application BP record PA-002 and sends the BP
record to the next step for approval.

Then, the user tries to create a second Payment Application BP record for the same Contract
CON-001.

An Alerts icon ( A ) is displayed and when the user clicks the icon, information about
pending payments and negative change orders is presented.

The system does not block the creation of the second Payment Application BP record
PA-002 but informs the user that a Payment Application BP record is pending on the contact.

If the Remove SOV restrictions option is deselected in the Business Process Setup window
(General tab), then only one Payment Application type BP can be configured for a Project/Shell
and only one Payment Application BP record can be routed, at any time, for a commit.

After a Payment Application has reached the terminal step, if you open an in progress (in-flight)
BP record, the system notifies you that the SOV has been refreshed.

After the system refreshes, the system retrieves the latest information, from the SOV. At run
time, whenever you open a draft, or an in-flight, payment record and accept the SOV merge alert
the data element (which has the "Do not get latest SOV values when merging" option enabled)
will not get refreshed with the latest updated values from SOV.
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Before SOV merge, payment grid for data element 'Unit price/gallon’ which has 'Do not get latest
SOV values when merging' checked.

All the fields populated from the SOV will be updated based on the latest SOV.

All formula fields, in the Payment Application Detail Form, defined using fields from SOV, will be
re-evaluated.

Example

There are two Payment Applications P1 and P2. P1 has reached the terminal step. P2 is in
progress (in-flight).

User has not yet accepted the task. Upon accepting the task, the system will refresh the
SOV and inform user with an alert.

When the user changes to Payment Application BP, an alert icon appears on the window.

Click the Alerts icon ( A ) to see any pending payments, and negative change orders,
associated with the selected reference commit. The Alerts icon is available for both Workflow
and non-Workflow BPs and might appear after a selection for the contract record is made.

User has accepted the task, and SOV has changed because of another payment. When user
open this record, system will perform an SOV merge, and inform user with an alert.

If the user has left P2 open, and P1 has reached terminal status and P1 has impacted the
SOV used in P2, then when the record P2 is sent to the next step, system will refresh the
SOV and throw an alert to the user stating that the SOV has changed.

Payment Application BP and Negative Change Commits

If the Remove SOV restrictions option is selected in the Business Process Setup window of
the Base Commit (General tab), then multiple Payment Application type BPs and Negative
Change Commits can be configured for a Project/Shell.

At the time of creating the Payment Application record, upon selecting the reference commit, the
system will check for any existing negative change orders for the selected reference commit.
The system displays a message if there any negative change orders.

After the record has been created, subsequently, when you open Payment Application record,
the system checks to see if there are any pending payments, or negative change orders. If
detected, the system displays a message.

Payment Grid which has negative line items

When you open the Payment Application grid, the line items which will be modified because of a
pending Negative Change order will have a yellow alert in the Scheduled Value cell. You can
click the cell to view the details of the Change Order. The details include the BP name, BP
record number, Line Number, and the Amount fields.

Line items from negative Change orders which are in draft status will not be seen in the Payment
Application grid, but if a line item has been modified or removed from an existing record which is
in draft status, the line item from negative change order can be seen in the Payment Application

grid.

In case of Summary Payment Application, the alert will be seen in the Summary line, if the
summary line item amount is negative. Similar alert will be seen if the costed line item is
negative.
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The sort order in the window begins by Business Process, then by Record Number, then by Line
Number, and finally by Costed Line Number.

Creating negative change orders when the Payment Application is in progress (in-flight)

Example

First, the user creates the contract record CON-001 and sends the contact to a step that
creates Schedule of Values.

Then, the user creates a Payment Application BP record PA-001 and sends the BP record to
the next step for approval. At this point the BP record is in progress (in-flight).

Then, the user creates a Change Order (Change Commit) BP record to modify the
committed line with a line item with a negative amount (a Negative Change Order CC-001)
and sends it to the next step for approval.

The creation is successful.
Creating multiple negative change orders

Note: The following is applicable to Change Orders (Change Commits)
that point to the Base Commit that does not have any SOV restrictions.

Example

First, the user creates the contract record CON-001 and sends the contact to a step that
creates Schedule of Values.

Then, the user creates a Change Order (Change Commit) BP record to modify the
committed line with a line item with negative amount (a Negative Change Order CC-001) and
sends it to the next step for approval.

Then, the user creates another Negative Change Order for the same contract record
CON-001.

The creation is successful.

Enter Payment Application Line Item Information

Line items on the payment application have special functionality. Payment application line items
are created automatically from the line items on the associated base commit and any change
commits. The columns that appear on the grid (including formula columns) are part of the
business process detail form design.

To enter line item information on a payment application:

1) Inthe Standard tab of the payment application business process form, click Add. This
displays all the SOV lines with the selected Base Commit BP record in the upper form.

Notes:

= In a new payment record, when you navigate to the payment grid and
no line items are saved, the system will not calculate the sum of all
(SOV) line items for data elements in the upper form.

= If the Payment Applications business process has been configured to
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add all SOV lines, the Add button in the Payment Grid will be hidden.

= |f the Summary Payment Application business process has been
configured with Add only edited SOV Line Items, the Apply line
item value of Percentage Complete to Date to costed lines option
will be hidden.

Depending upon the design of the BPs, some fields may be auto-populated with data
from the base commit and change commit. For a field to auto-populate, the same data
element must be used on the base commit, change commit, and payment application.
Line items appear from the base commit and any change commits based on the statuses
of those business processes, as designed.

For classic Payment Applications BP, when the upper form has a DE which is configured
as “Auto-populate <sum of all lines>,” the system will calculate the sum of all SOV line
items. The system will not calculate the sum of all detail line items.

2) Enter details for the line items that must be paid. You can enter values in any editable field
on the grid.

3) When you have completed editing the Line Items window, click Save.

4

4

When the form is saved, lines that have payments are added to the grid.

If the Add only edited SOV Line Items option is enabled in uDesigner, then only the
edited SOV line items will be saved by the Summary Payment Application business
process.

If a payment must be made in a subsequent step, click Add again to re-invoke the SOV

lines screen. All lines become visible and any lines that were previously added open in
edit mode.

A pen icon appears in the second column to indicate which rows have been modified. When a
payment has been added and saved, the pen icon turns green. When the row is still being
edited, the pen icon is yellow.

To Remove an SOV line that you added to the grid, click the trash-can button on the toolbar.

The columns with decimal values preserve, or maintain, the decimal values specified in the data
element of the following business processes and SOV types:

» Schedule of Values (SOV) sheet: Payment Application and Summary Payment Applications
» Payment Application Line ltems
» Summary Payment Application Line Items

As a result, the system will not round the decimal value to two decimals, for the preceding DEs.
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Errors

The first column of the payment applications grid is marked by an (x) icon and indicates errors
within edited line items. An (X) icon appears in this column when rows have errors. To view
errors in the log, click Check Errors or click the (x) icon.

Payment Status

The second column of the payment applications grid is marked by a pen icon and indicates
payment status. A pen icon appears in this column to indicate which rows have been modified.
When a payment has been added and saved, the pen icon turns green. When the row is still
being edited, the pen icon is yellow.

To undo line item changes without closing the Line Items window

In the Line Items window, click the Cancel button. Any line item information that you have
entered or changed will be cleared, and the fields will revert to their original values.

SOV type Payment Application and SOV line items type Individual commit line items

Note: The following applies when the "Update Auto-populate on
payment application" option (in Options tab) is enabled for a Change
Order BP, in uDesigner.

When you create a Payment Application in your project (Payment Applications node), in the
Line Items tab of the Create New Payment Applications window:

a) The Description column and the Spend Category column are set to auto-populate from the
Base Commit and receive the latest updated values from the Change Order that references
this SOV line items.

b) The Change Order then routes the record to the terminal status.

c) The Description column and the Spend Category column are set to auto-populate from the
Base Commit and receive the latest updated values from the Change Order that references
this SOV line items.

When the auto-populated data elements are updated in referenced SOV line items (in the
Change Order) and routed to the approved step, new payment record elements that are set to
auto-populate from Base Commit will be updated with the latest values from the Change Order.
The new payment record elements will always get the values from the latest Change Order
whenever these values are updated in the payment record. Upon routing the payment record to
terminal status, it will further update the values in SOV line items.

Pending SOV type Payment Application, or SOV type Summary Payment Application, and
SOV line items type Individual commit line items
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Note: In the payment record, the values are auto-populated from the
Base Commit if the "Update Auto-populate on payment application”
option (in Options tab) is not enabled for a Change Order BP.

For a pending payment record, in the Line Items tab of the Payment Applications window:

a) The Description column and the Spend Category column are set to auto-populate from the
Base Commit and receive the latest updated values from the Change Order that references
this SOV line items.

b) The Change Order then routes the record to the terminal status.

c) The Description column and the Spend Category column are set to auto-populate from the
Base Commit and receive the latest updated values from the Change Order that references
this SOV line items.

When the auto-populated data elements are updated in referenced SOV line items (in the
Change Order) and route to approved step, the pending payment (after opening and accepting
the task) will receive an SOV alert, if there is an SOV merge. When you click OK, the
auto-populate data elements (from Base Commit) are updated with the latest Change Order in
the grid, along with the latest SOV line items values.

If you open a pending payment that is in an accepted state and navigate to the payment grid, all
the existing payment lines will receive the latest values for the auto-populated data elements
from the latest Change Order.

Summary Payment Applications behavior for Variable Unit Cost Lines

For the Variable Unit Cost line items, the Quantity this Period column is editable for both the
summary and costed lines. You can enter quantity at the summary and push that quantity to the
costed lines.

The Requested this Period amount will be calculated based on the Unit Price and Quantity this
Period for each costed line. In the summary line item, the Amount this Period is populated with
the sum of costed lines - unit price * Quantity this Period, and the request this period will be
calculated accordingly.

In the Payment Applications for the Variable Unit Cost line items, the Amount this Period for the
summary line will be calculated as sum of each costed line (uuu_unit_price * quantity this
period), if "Total the cost breakdown values to line item" is in the design. The Amount this Period
will be read-only for both the summary and the costed lines.

Amount this Period (uuu_spa_amt_tp)

This uuu_field DE will be calculated by the system in the summary line if you enter Quantity this
Period in the costed lines. The calculation of this field in summary line will be: uuu_spa_amt_tp =
sum of each costed line (uuu_unit_price * quantity this period). In the design, the "Total the cost
breakdown values to line item" must be selected. For costed lines, the uuu_spa_amt_tp DE
value will always zero (0).

The same applies when you import the payment line items for Variable Unit Cost line items,
using CSV or Restful services. The Amount this Period in summary line will always be the sum
of each costed line (uuu_unit_price * quantity this period). For the costed line items, the
uuu_spa_amt_tp DE value will be zero (0).
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The Requested this Period will be calculated based on the user-defined formula, for both the
summary and the costed line items, and % Complete to Date (for the summary and the costed
line items) is calculated based on the existing formula as: % complete to date =
(uuu_spa_prev_amt + (uuu_spa_qgty_tp * uuu_unit_price) + uuu_spa_amt_tp +
uuu_spa_other_tp + uuu_pa_mat_stored) / scheduled_value.

Note: The Percent Complete to Date field is read-only for the summary
Variable Unit Cost line item.

Percentage Complete to Date

In the Create New Payment application with Summary grid, you can edit the value of the
Percentage Complete to Date for the variable unit cost line items, when the Apply line item
value of Percentage Complete to Date to costed lines check box is selected--and can push
percentage down to the costed lines).

Note: In the Create New Payment application with Summary grid, the
value of the Percentage Complete to Date for the variable unit cost line
items is read-only if the Apply line item value of Percentage Complete
to Date to costed lines check box is selected.

In the Create New Payment application with Summary grid, based on the value of the
Percentage Complete to Date for the variable unit cost line items, the value of the Quantity
this Period will get calculated for costed lines, and the value of the Amount this Period will be
calculated for summary line.

View Payment Application Line Item History

When payment application records in view mode, a Line Item History button becomes
available. This provides a snapshot view of the line item grid as of the last entry.

Note: View mode refers to the non-editable version of the form. For
example, for workflow BPs, this is before clicking the Accept Task
button or after the form has gone through all the workflow steps and is
complete. For non-workflow BPs, this is after editing has been
completed.

To access line item history
1) Open a payment application record from the log. Be sure the record is in view mode.

2) Open the Menu Options ( =) and select Line Item History. The Line Items History window
opens, displaying the payment application line item grid, as view-only, with data entered to
date.
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Note: This option is also available in Classic view, labeled Line Item
History Classic.

By default, the first 100 line items are displayed on the page. If your payment application BP has
more than 100 line items, you can scroll through the other pages, or you can choose to display
up to 500 line items on the same page. Displaying more than 100 line items on the page may
take several seconds to load.

Export Line Item History

You can export the line item history of a payment application record to a CSV or Microsoft Excel
file.

To export payment application line item history information
1) Open a payment application record from the log. Be sure the record is in view mode.
2) Click the Line Item History button.

The Line Item History window opens.

Note: This option is also available in Classic view, labeled Line Item
History Classic.

3) Click the Print button and choose how to export (Print, Export To CSV, or Export To
Excel).

Depending on your browser, the file may download automatically to your computer or prompt
you to choose a location to save the file.

Notes:

= For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

= |f you export data from a business process (BP) record, sheet (such
as an Activity Sheet), or log (such as Company Funding Sheet Log)
to Excel, be aware that depending on how your negative values are
formatted, you might need to configure your columns in Excel to
match the correct data type (Number). Otherwise, the columns will
not be treated as numeric and will not sum as expected. One
supported format includes placing the negative sign between the
currency symbol and the amount (for example, $-1,000).

4) Click Save and specify the file name and location to which to save a copy of the CSV or
Excel file.

Save Payment Application in Draft Mode

You can save a payment application record in draft mode by clicking the Save button from the
toolbar.
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When you open the draft again to send, the system will check to see if there is any modification
done by other users. If the system identifies that there is modification to your payment
application, you will be asked to accept new changes before proceeding.

Draft Mode and SOV Synchronization

If you create a payment application record and save it in Draft mode, and your SOV changes
before you route the draft payment application, an error can result when you attempt to route the
record. The error Line Items must be validated before proceeding can result if the SOV has
changed while your payment application is in Draft mode.

To fix payment application BPs that are affected by changes to the SOV
1) Open the draft payment application record.

2) Click the Add button and click Detail Line Item to open the line item entry grid. Line items
that are affected by SOV changes are indicated with check marks.

3) Click OK. The line items are validated against the SOV.

View the Schedule of Values (SOV) Sheet

The Schedule of Values (SOV) for Payment Application functionality provides a way to assemble
information from the Base commits and Change commits (Commit), as well as the payment
history, in an SOV sheet. You can open the SOV sheet either from the Schedule of Values
(SOV) log, or from within a payment application record (the record must be in an editable mode).

When the base commit record is created and reaches a specified terminal status (for example,
Approved), the SOV sheet is automatically created, and line items display as rows. As change
commits are created and approved (or other specified status), they are added automatically to
the SOV sheet. As payment records are created, these also will affect the SOV.

Data that is displayed on the SOV sheet will depend on the columns that have been added to
the SOV structure.

The SOV displays the source information from the base commit and any change commits. The
source for each line can be one or more lines from one or more records.

Depending on the design of the associated business processes, the SOV may list each line
entry for the base commit and all change commits as separate line items, or it may group entries
with the same CBS code and display the total.

When you are working with the SOV sheets, in a Project/Shell, you can enter the item number
(Item # field) for each of the SOV lines:

» The system stores the SOV sheet based on the Item # column.
» When line items roll up to the SOV sheet from the Base Commit and Change Commit BP
records, then the system generates the values in the Item # field.

» The Item # for each SOV sheet starts with 000010 and this value is incremented by 10. So, if
there are 2 lines coming from the Base Commit, then the values seen are: 000010 and
000020.
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» Although the system generates these numbers, you can edit the numbers, which lets you
change the order of the SOV lines. To edit the values, double-click the field. Entries to this
field must be Numeric. No alphanumeric fields are allowed. Similarly, no other characters
such as punctuation marks, non-1ISO characters, negative sign, and so on, are permitted. For

the summary lines, you cannot enter the dot (period) "." character. Dots are reserved for
costed lines.

» If you edit an existing value, for example 000030, and enter 27, then the value seen in the
field will be 000027. The leading zeros are added by the system in order to align and help
sort all the values in the column.

The values entered should be in the range of 000000 to 999999.

The subsequent lines coming from the Change Commit (CC ) records (with reference to the
above mentioned Base Commit (BC) record) can be seen in the SOV sheet with increments
of 10.

If you make any changes to the Item # field, click Apply to save the values in the column and to
change the Sort order of the rows. The new sort order is maintained in the database and next
time when you open the SOV sheet, the sort order is displayed in the SOV sheet be based on
the last saved view.

For Payment Applications SOV and Summary Payment Applications SOV, the structure is
copied from the line item grid structure of the Payment Application BP.

When a Payment Application BP references a Base Commits of the Summary Payment
Applications SOV, the line items of the Payment Application BP will reflect the line items of the
Base Commits as well as any associated Change Commits.

In a Payment Application BP referring to the commits and the Summary Payment Applications
SOV type, depending on the BP setup, you can:

» Include only one Payment Application record, or

» Include multiple Payment Application records

See Payment Application Business Processes (on page 239) for details.

To open the Line Item window of a Payment Application BP form, click Add. The window
displays a list of line items from the Base Commits (and any Chance Commits), and the values
are populated if auto-population (from Base Commits and Change Commits) has been defined.

To view the associated SOV sheet from within the payment application BP
1) Inthe Navigator, click Logs > Payment Applications.

2) Select a Payment Application record and click Open (or double-click the record). The
Payment Application form opens.

3) Select SOV from the Menu Options drop-down menu (hamburger icon). The Schedule of
Values window opens.

Note: Ensure that the form is not in a view-only mode.
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Importing, Exporting, and Integration

You can use CSV import to create Payment Application Business Processes, or to add SOV line
items to an existing Business Process.

You can export payment application CSV templates at the log level (for header and line item
templates) and at the record level (for line item templates). You can then modify the templates
and import them to create records (at the log level) or to add line items to an existing record (at
the record level).

An integration interface must be defined to support CSV import. If you find that you cannot
perform the file import, see your Administrator. Also, new records can be created and line items
added using integration through Web Services. Integration through Web Services must be
coordinated with an Oracle Primavera representative.

The columns with decimal values preserve, or maintain, the decimal values specified in the data
element of the following business processes and SOV types:

» Schedule of Values (SOV) sheet: Payment Application and Summary Payment Applications
» Payment Application Line Items
» Summary Payment Application Line Items

As a result, the system will not round the decimal value to two decimals, for the preceding DEs.

Multiple Payment Applications and negative change orders (Change Commits) and CSV
import and Web Services

Previously, the system only allowed one Payment Application, or negative Change Commit
record, per SOV. You can now create multiple Payment Applications, or negative Change
Commit records, against the SOV. You can also create these types of records through CSV
import and Web Services.

Note: You can create only one record for each import.

Import New Payment Application Records

You can export a CSV template that includes the upper form and detail form fields as columns.
These fields include the header fields from the upper form and the line item SOV fields from the
detail form, including the detail line item fields defined in Integration. The Reference Number
field is exported as a column for payment application business processes that use individual line
items. The Reference number field is not exported as a column for payment application business
processes that use Group by CBS.

You can then modify the exported CSV template and import it to create the upper form header
and the detail form line items for the new business process.
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Note: The system lets you import Payment Application records and line
items by way of CSV and REST.

To export a copy of the payment application business process template

1)
2)

Navigate to the payment application business process log.

Click the Actions menu and select Export to CSV Template or Export to Microsoft Excel
Template.

Depending on your browser, the template will automatically be downloaded to your computer, or
you will be prompted to download it manually.

To modify the exported payment application business process template

1)
2)

3)

Open the exported CSV file or Excel file in Microsoft Excel.

Enter the business process information into the spreadsheet. Each upper form header record
must begin with an "H". Each line item must begin with a "D". For multiple tabs, you must
enter appropriate tab name in the Tab Name column.

Enter data into the required fields, as well as non-required fields as needed.

Important information:

4
4

v v v Vv

Data for formula-based columns is ignored.

If auto-populated data is provided, the system will import the value, and will not override the
imported values except for fields auto-populated by Base Commit, Change Commit, or from
SOV.

Any line items with the Amount equal to zero will not be imported.

SOV locking is enforced.

Use to add new business process records only; not to modify existing business processes.
For data to import correctly, you might have to change some of the cells in the CSV file to
Text type. For example, if you have a CBS code of 1-1, Microsoft Excel can interpret this
entry as a month-day combination and reformat it to Jan-1. In this case, your data import will
fail because this data is now an invalid CBS code.

If the Integration design for the business process includes a Description field for line items,
and the associated SOV sheet also contains a Description field, the description from the
SOV sheet is imported, and the line item description is not imported.

To import the payment application business process template

1)
2)
3)
4)
5)
6)

Navigate to the payment application business process log.

Click the Actions menu and hover over Import.

Select either Data From CSV File or Data From Microsoft Excel File.
Browse to select the file to import, then click Next.

Add any attachments to the import.

Click Upload when finished.

If there are any import errors, you can open the CSV file to view and correct the error. No
records are imported if any rows contain an import error.
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Import Payment Application Line Items into a BP

You can export a template that includes the detail form fields as columns for a specific business
process. These fields include the SOV data and detail line item fields defined in Integration. The
Reference Number field is exported as a column for payment application business processes
that use individual line items. The Reference number field is not exported as a column for
payment application business processes that use Group by CBS. If multiple tabs are designed
for the line items in the business process, the tab columns are included in the export. All the
data on the Standard tab is exported; no data on the other tabs is exported.

You can then modify the exported template and import it to create line items for the business
process. The exported template contains SOV record information.

Note: The system lets you import Payment Application records and line
items by way of CSV and REST.

The Payment Application of Summary Payment Application SOV type supports Record, Line
Item, and Cost Allocation creation through CSV integration.

If the payment line items have already been added in the Standard tab, importing of the line
items through CSV is not permitted.

When importing Summary Payment line items for Payment Applications BPs, the system uses
the values that the user provided for the auto-populate data elements, if the fields were editable
originally; otherwise, the system uses the values that are from Base Commit line items or
Change Commit line items.

To export the payment application line item template

If multiple tabs are designed for the line items in the business process, only the data in the
Standard tab is exported. For the other tabs, the tab name is included in the exported data for
reference, but no data in these tabs is exported.

1) Navigate to the payment application business process log.

2) Click Create to create a business process.

3) Select a Reference Base Commit for the business process. If you do not select a
Reference Base Commit, the exported template will not contain data. Data from all columns
in the Reference Base Commit is exported.

4) Open the Menu Options ( =) and hover over Export Line Item Template, then select CSV
or Microsoft Excel.

Depending on your browser, the file will be downloaded automatically, or you will be prompted to
download the file manually.

To modify the payment application line item template
1) Open the exported CSV or Excel file in Microsoft Excel. The SOV line items are listed.

2) Enter the line item information into the spreadsheet. Each line must begin with a "D". For
multiple tabs, you must enter appropriate tab name in the Tab Name column.

3) Enter data into the required fields, as well as non-required fields as needed.
Important information:
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Data for formula-based columns is ignored.

If auto-populated data is provided, then the system will import the value, and will not override
the imported values except for fields auto-populated by Base Commit, Change Commit, or
from SOV.

Any line items with the Amount equal to zero will not be imported.

SOV locking is enforced

Any line items that you import will replace the existing line items in the business process.
Use to add new lines only, not to modify existing lines

For data to import correctly, you might have to change some of the cells in the CSV file to
Text type. For example, if you have a CBS code of 1-1, then Microsoft Excel can interpret
this entry as a month-day combination and reformat it to Jan-1. In this case, your data import
will fail because this data is now an invalid CBS code.

If the Integration design for the business process includes a Description field for line items,
and the associated SOV sheet also contains a Description field, then the description from the
SOV sheet is imported, and the line item description is not imported.

To import the payment application line item template

1)
2)
3)
4)
5)
6)
7)

Note: The line items that you import will replace any existing line items.

Navigate to the Payment Application business process log.

Select a business process from the log.

Click the Actions menu and hover over Import.

Select either Data From CSV File or Data From Microsoft Excel File.
Browse to select the file to import, then click Next.

Add any attachments to the import.

Click Upload when finished.

If there are any import errors, you can open the CSV or Excel file to view and correct the
error. No records are imported if any rows contain an import error.

You can add line items with O (zero) value in the CSV or Excel template. In such scenario, after
you import your CSV or Excel template to the BP record, the BP record will have your added line
items with O (zero) value.

Example

You import a CSV or Excel template that has the following three line items to your BP record:
1-Amount = 1000

2-Amount = 0

3-Amount =0

After the import is complete, all three line items will be added to your BP record.
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Payment Application Grid Column Total

The following information is related to BP run-time for the Payment Applications and Summary
Payments Applications Business Processes (Standard tab), only. For Payment Applications and
Summary Payments Applications, based on the options set for the Total property for the Data
Elements (DEs) in uDesigner, when you add or modify the grid, the Total row displayed shows

the following values:
» Blank
The system displays the value as empty in the Total Column (that particular DE column).
» Sum of All Rows
The system displays the value as "Sum of All Rows" in the Total Column.

» Use Formula Definition
The system displays the value as "Formula Defined" in the Total Column. In other words, the
system calculates the formula by using the values from the Total row for the respective DEs.

If the formula was reset to Manual, the system resets the Total to "Sum of All Rows."
The system calculated the Total, for DEs with predefined formula, as follows:

» %Complete to Date (uuu_spa_per_comp)
» Custom formula
Based on the whether the property is enabled.
» System-defined formula
Based on whether the property is enabled.
» Amount This period (uuu_spa_amt_tp)
Based on whether the property is enabled. (Either Blank or Sum of All Rows)

Note: With version 23 and later, a Total row on a non-standard tab of a
line item grid is not displayed. For version 22 and earlier, the Total row
displays a 0.

Payment Application BP Record in Terminal Status

The data elements on the Upper Form that are set to receive the values from the Sum of All
Lines will not be re-evaluated if the Payment Application BP record is in Terminal status.

Payment Application BP Record in Non-Terminal Status (In-Flight)

An in-flight Payment Application BP record is a Payment application that is in progress. For
example, a Payment that has been in review status and now it is moving to the next step in the

workflow, which is approval.
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Note: A Payment that is in Draft status has been created, but it has not
been sent to the next step.

When a Contracts BP is configured to allow multiple payments (the Remove SOV Restriction
field check box is selected), the Upper Form data elements that are set to receive the values
from the Sum of All Lines fields will receive values from the latest SOV, including the existing
line item data.

When a Contracts BP is configured to not allow multiple payments (the Remove SOV
Restriction field check box is not selected), the Upper Form data elements that are set to
receive the values from the Sum of All Lines fields will receive values from the SOV at the time
of Payment record creation, including the existing line item data.

General Spends Business Processes

General spends business processes enable you to invoice at the CBS or breakdown level,
supporting multiple invoices per SOV. These business processes do not calculate retainage or
stored materials. General spends business processes are designed in uDesigner. For more
information, refer to the Unifier uDesigner User Guide or Unifier Help.

You can use CSV import to create general spends business processes or to add SOV line items
to existing business processes. You can export general spends business process templates at
the log level (for header and line item templates, with no data exported) and at the record level
(for line item templates with SOV line item data exported). You can modify the templates and
import them to create records (at the log level) or to add line items to an existing record (at the
record level).

An Integration interface must be defined to support CSV import. If you find that you cannot
perform the file import, see your Administrator.

Also, new records can be created and line items added using Integration through Web Services.
Integration through Web Services must be coordinated with an Oracle Primavera representative.

Import New General Spends Records

You can export a CSV template that includes the upper form and detail form fields as columns.
These fields include the header fields from the upper form and the line item SOV fields from the
detail form, including the detalil line item fields defined in Integration. These fields are always

exported in the template as well:
» Reference Number
» Description
» CBS Code
» Breakdown

You can then modify the exported template and import it to create the upper form header
information and the detail form line items for the new business process.
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To export a copy of the general spends business process template

1) Navigate to the General Spends business process log.

2) Click the Actions menu and select Export CSV Template or Export Microsoft Excel
Template.

Depending on your browser, the template will automatically be downloaded to your computer, or
you will be prompted to download it manually.

To modify the exported general spends business process template
1) Open the CSV or Excel file in Microsoft Excel.

2) Enter the business process information into the spreadsheet. Each upper form header record
must begin with an "H". Each line item must begin with a "D". Add a new "D" line for each
line item in the business process. For multiple tabs, you must enter appropriate tab name in
the Tab Name column.

3) Ensure that you enter the required values for the Amount, CBS Code, and Short Description
columns.

Notes:

Data for formula-based columns is ignored.

If auto-populated data is provided, the system will import the value,
and will not override the imported values except for fields
auto-populated by Base Commit, Change Commit, or from SOV.

= Any line items with the Amount equal to zero will not be imported.

= Use to add new business process records only, not to modify existing
business processes.

= For data to import correctly, you might have to change some of the
cells in the CSV file to Text type. For example, if you have a CBS
code of 1-1, Microsoft Excel can interpret this entry as a month-day
combination and reformat it to Jan-1. In this case, your data import
will fail because this data is now an invalid CBS code.

= [f the Integration design for the business process includes a
Description field for line items, and the associated SOV sheet also
contains a Description field, the description from the SOV sheet is
imported, and the line item description is not imported.

To import the general spends business process template

1) Navigate to the General Spends business process log.

2) Click the Actions menu and hover over Import.

3) Select either Data From CSV File or Data From Microsoft Excel File.
4) Browse to select the file to import, then click Next.

5) Add any attachments to the import.

6) Click Upload when finished.

If there are any import errors, you can open the CSV file to view and correct the error. No
records are imported if any rows contain an import error.
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Import General Spends Line Items into a Business Process

You can export a template that includes the detail form fields as columns for a specific business
process. These fields include the detail line item columns defined in Integration. These fields are
always exported in the template as well:

» Reference Number

» Description

» CBS Code

» Breakdown

You can then modify the amounts on the exported template and import it to create line items for
the business process. The exported template contains SOV record information.

To export the general spends line item template

If multiple tabs are designed for the line items in the business process, only the data in the
Standard tab is exported. For the other tabs, the tab name is included in the exported data for
reference, but no data in these tabs is exported. Data from all columns in the Reference Base
Commit is exported.

1) Navigate to the General Spends business process log.

2) Click Create to create a business process.

3) Select a Reference Base Commit for the business process. If you do not select a
Reference Base Commit, the exported template will not contain data. Data from all columns
in the Reference Base Commit is exported.

4) Open the Menu Options ( =) and hover over Export Line Item Template, then select CSV
or Microsoft Excel.

Depending on your browser, the file will be downloaded automatically, or you will be prompted to
download the file manually.

To modify the general spends line item template
1) Open the CSV or Excel file in Microsoft Excel. The SOV line item data is shown.

2) Enter the line item information into the spreadsheet. Each line item must begin with a "D".
For multiple tabs, you must enter appropriate tab name in the Tab Name column.

3) Enter required values for the Amount, CBS Code, and Short Description columns.

Notes:

= Data for formula-based columns is ignored.

= |f auto-populated data is provided, the system will import the value,
and will not override the imported values except for fields
auto-populated by Base Commit, Change Commit, or from SOV.

= Any line items with the Amount equal to zero will not be imported.

= Use the import to add new line items only, not to modify existing line
items.

= Any line items you import will be added after any existing line items.
= For data to import correctly, you might have to change some of the
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cells in the CSV file to Text type. For example, if you have a CBS
code of 1-1, Microsoft Excel can interpret this entry as a month-day
combination and reformat it to Jan-1. In this case, your data import
will fail because this data is now an invalid CBS code.

= |f the Integration design for the business process includes a
Description field for line items, and the associated SOV sheet also
contains a Description field, the description from the SOV sheet is
imported, and the line item description is not imported.

To import the general spends line item template

1) Navigate to the General Spends business process log.

2) Open a business process from the log.

3) Click the Actions menu and hover over Import.

4) Select either Data From CSV File or Data From Microsoft Excel File.
5) Browse to select the file to import, then click Next.

6) Add any attachments to the import.

7) Click Upload when finished.

If there are any import errors, you can open the CSV or Excel file to view and correct the
error. No records are imported if any rows contain an import error.

Lump Sum and Unit Cost

The Cost Line Item Type (uuu_cost_li_type) on the detail form is populated with Lump Sum or
Unit Cost based on the selection of the option that you have made at the time of adding line
items. When you click Add and select either Lump Sum, or Unit Cost, Line Items window opens.
The Line Items window has two sections: Upper form (Detail form that follows the uDesigner
Detail form design) and lower grid (fixed by system). The following explains all the fields in detail:

Line Item window toolbar

Save

Spelling
Attach

Upload Images
Delete

Line Item
Close window

v v v v vV v Vv

Line Item window fields
Add > Lump Sum (No added cost) - Upper form (General)

Short Description
Cost Line Item Type
Amount

4
4
4
» Role Effective Date
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Description
Spend Category
Work Package
Item Quantity
Unit of Measure
Item Unit Cost
Costed Amount

v v v vV v v Vv

Add > Lump Sum (Added cost) - Upper form (General)

Short Description
Cost Line Item Type
Amount

Description

Costed Quantity
Not Costed Quantity
Spend Category
Work Package

Item Quantity

Unit of Measure
Item Unit Cost
Costed Amount

Not Costed Amount

Add > Unit Cost (No added cost) - Upper form (General)

VvV VvV vV vV vV vV vV vV VvV VvV v v Vv

Short Description
Cost Line Item Type
Amount

Role Effective Date
Description

Costed Quantity
Not Costed Quantity
Spend Category
Work Package

Item Quantity

Unit of Measure
Item Unit Cost
Costed Amount

Not Costed Amount

Add > Unit Cost (Added cost) - Upper form (General)

» Short Description
» Cost Line Item Type
» Amount

VvV VvV vV vV vV vV vV vV VvV vV vV v v v
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Role Effective Date
Description

Costed Quantity
Not Costed Quantity
Spend Category
Work Package

Item Quantity

Unit of Measure
Item Unit Cost
Costed Amount

Not Costed Amount

VvV vV vV vV vV vV vV vV vV v v

Toolbar - Upper form (lower block)

» Add Cost

This option allows you to add cost distribution lines to the grid, within a line item. You can
add more than one cost lines by selecting multiple items from the CBS Picker window (Select
CBS Code). Selecting more than one CBS/CBS code results in added lines to the grid and
the Cost Code/Code Name fields are populated accordingly. You can edit the CBS/CBS
code by double-clicking the cell. The Add Cost option is available when the Allow Cost
Breakdown is enabled. Add Cost will be disabled when the record reaches terminal status.

» Remove Cost

This option allows you to remove cost distribution lines from the grid, within a line item. You
can select multiple lines and remove them collectively. The Remove Cost option is available
when the Allow Cost Breakdown is enabled. Remove Cost will be disabled when the record
reaches terminal status.

Note: When you remove a line item from the grid, it will impact the
calculations in the General section. If the line item is coming from an
SOV sheet, then deletion is not permitted on those lines.

» Copy Cost

This option allows you to select/copy one costed line item and create a new costed line item
using the selected/copied costed line item. You cannot select more than one costed line item
for copying. The Copy Cost option is available when the Allow Cost Breakdown is enabled.
Copy Cost will be disabled when the record reaches terminal status.

» Add Remaining

» When you select this option, the CBS Picker window (Select CBS Code) opens and
allows you to select multiple codes. You can allocate the remaining cost, or quantity, to
multiple codes.

» If you select Lump Sum as the cost line item type, you can use the Add Remaining option
for adding Not Costed Amount line, and the Amount field is auto-populated based on Not
Costed Amount. If the Costed Amount (total amount from all costed lines), on the
General section, is equal to the Line Item Amount, then the Add Remaining option will be
disabled.
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» If you select Unit Cost as the cost line item type, you can use the Add Remaining option
for adding Not Costed Quantity line, and the Quantity field is auto-populated based on
Not Costed Quantity. If the Costed Quantity (total quantity from all costed lines), on the
General section, is equal to the Line Item Quantity, then the Add Remaining option will be
disabled.

» The Add Remaining option is available when the Allow Cost Breakdown is enabled. Add
Remaining will be disabled when the record reaches terminal status.

Fields - Upper form (lower block)

You can make change within the editable or required cells of the following columns:

»

Cost Code

You can click the cell and select a Cost Code from a Cost Sheet of the same Shell.

Code Name

This is a read-only field. The value is auto-populated by the system according to the Cost
Code selection.

Short Description

The value is auto-populated from the line item Short Description field. You can modify the
default value.

Quantity

If the type of the line item is Unit Cost, you can edit the value of this field and enter the
costed quantity. If the type of the line item is Lump Sum, this field will not display.

Unit Cost

If the type of the line item is Unit Cost, the value of this field is read-only. The value is
auto-populated according to the unit price value that you entered in the upper form (General).
If no value was entered in the upper form (General), the default value of this field will be zero.
If the type of the line item is Lump Sum, this field will not display.

Amount

If the type of the line item is Unit Cost, this field is calculated by the system (Quantity * Unit
Cost). If the type of the line item is Lump Sum, you can edit the value of this field and enter
the costed amount.

Change Commits BP of Summary Payment Applications SOV type

The Change Commits BP of Summary Payment Applications SOV type, similar to the Base
Commits, you use Lump Sum and Unit Cost items to add new line items. In addition, you can
use the Modify Committed Line Item option (Add) to modify a reference commit line item that
exists in the Reference Base Commits record. When you select the Modify Committed Line Item
option (Add), the Commit Line Item Picker window opens, and the line items existing in the SOV
sheet.

Commit Line Item Picker window

You can select any summary line item from the Commit Line Item picker
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The following explains the fields in the Commit Line Item Picker window:

»

Ref

This column contains the reference number of the Change Commits Detail Line Item. The
summary row displays the reference number of the Detail Line Item, and the child row
displays the reference number of the Cost Distribution Line Item (costed line item) from the
parent line. For example, 1.1 is the costed line item for line item 1.

Cost Code

This column contains the CBS Code associated with each distribution line. For summary
rows (parent), the value for this column is blank.

Code Name

This column contains the CBS Code associated with the code. For summary rows, the value
for this column is blank.

Cost Type

This column contains the Cost Line Item type for the Summary rows. For child rows, the
value for this column is blank.

Description

This column contains the contents of the Short Description (short_desc) field in the Detalil
Line item. For summary rows (parent), this column contains the Short Description of the Line
Item. For distribution rows, this column shows the Short Description of each costed line item,
and based on the user input, the value might, or might not be, the same as the Short
Description of the Line Item.

Note: The names of the columns are based on the Summary Payment
Applications SOV sheet structure.

Cost Distribution Grid log columns

»

Cost Code

This field is both editable and required. You can click the cell and select a Cost Code from a
Cost Sheet of the same Shell. Similar to the Line Items, you can enter a Cost Code and the
same Cost Code will be available to select. You cannot change the Cost Code for existing
Line Items coming from SOV.

Code Name

This field is read-only, and the value is auto-populated by the system according to the Cost
Code that you have selected.

Short Description

This field is editable, and the default value is auto-populated according to the Short
Description (short_desc) field.

Current Quantity

This field is read-only and the value is auto-populated by the system if you have selected
Modify Reference Commit option, and the Cost Line Item type (uuu_cost_li_type) of the
selected Commit Line Item is Unit Cost.
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Note: If the conditions are not met, then the system auto-populates the
value as "Quantity,"” from the source commit distribution line item.

» Current Scheduled Value
This field is read-only, and the value is auto-populated by the system (regardless of the Cost
Line Item type (uuu_cost_li_type). The value of this field can be updated when modifying an
existing line is from an SOV sheet.

» Change Quantity

This field is read-only if the Cost Line Item type (uuu_cost_li_type) of the selected Commit
Line Item is Lump Sum. If the Cost Line Item type (uuu_cost_li_type) of the selected Commit
Line Item is Unit Cost, then you can edit this field and enter the costed quantity.

» Change Amount

If the Cost Line Item type (uuu_cost_li_type) of the selected Commit Line Item is Lump Sum,
you can edit this field and enter the costed amount. If the Cost Line Item type
(uuu_cost_li_type) of the selected Commit Line Item is Unit Cost, the value of this field is
calculated by the system as: Change Quantity * Unit Cost.

» New Schedule Value

This field is read-only, and the value is auto-populated by the system when modifying an
existing line is from an SOV sheet. The value of this field is calculated by the system as:
Current Scheduled Value + Change Amount.

CSV Integration

You can use a Comma Separated Values (CSV) file to save Cost Allocation data for Base
Commit and Change Commit of Summary Payment Application SOV type.

The Payment Application of Summary Payment Application SOV type supports Record, Line
Item, and Cost Allocation creation through CSV integration.

If the payment line items have already been added in the Standard tab, then importing of the
line items through CSV is not permitted.

The "CA" (Cost Allocation) row, in the CSV file, includes the following information about Cost
Allocation.

» Cost Code

» Short Description
» Quantity

» Amount

Note: Ensure that all Costed Line Item details are entered in the "CA"
row.
Multiple Cost Allocation Line Items can be added to the CSV file by way of multiple CA rows.

If your CSV template contains Cost Allocation details, but the design does not permit entering
the Cost breakdown information (that is, the option of Allow Cost Breakdown is unchecked),
importing the CSV file will fail and you will receive an error message.

Creating Lump Sum and entering Unit Cost details
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The "D" row, in the CSV file, includes the information about Summary Line Item. If the Cost
Line Item type is Unit Cost type, then you must enter the Unit Cost in the D row.

Based on the Cost Line Item type specified in the "D" row, the system will check for the
presence of required fields for the specified Cost Line Item type.
Change Commit: Adding Line Iltems to modify committed lines

The CSV template contains a "Reference" field that you can use for adding lines that have
already been committed from a reference commit. The system uses the value in the
"Reference" field to select a specific row in the committed lines (SOV).

Note: The availability of the "Reference” field depends on the design set in uDesigner. If this
field is not present in the Detail Form integration interface, then modification of committed
lines cannot take place.

The Costed Line Item of the Summary Line Item that needs to be updated will be identified
by the value in the "Reference" field and the Cost Code. The "Reference" column label is the
label set for "sovlinum" and will appear after the CA column.

After the record creation, all the Costed Line Items belonging to the selected Line Item (
Summary Line Item and child Line Item) will be added to the record.
Payment Application

For Payment Application of Summary Payment Application (SPA) SOV type, the "CA" row
will have the columns similar to the details row.

Unit Cost

The following additional informational texts are displayed in the exported CSV template:
» Cost Code

» Short Description

»  Quantity

» Unit Cost

» Amount

Enter the unit cost value either at "D" or "CA" row but not in both rows. Variable

You can enter the unit cost value either in the "D" row or in the "CA" row but not both. You can
create the variable unit cost lines by entering the unit cost in the "CA" row.

Importing the Lump Sum or Unit Cost line items remains as is. The Unit Cost, in the "CA" row is
ignored even if the Unit Cost column is seen in the "CA" row, and the cost line item type selected
is Lump Sum or Unit Cost.

When importing the line items for Lump Sum and Fixed Unit Cost line items, if the "CA" row has
values (based on the cost line item type mentioned in "D" row) the system will check the
presence of the required fields.

You can create both the Base Commit and the Change Commit records with the variable unit
cost line items. The "CA" row is populated with the variable rates for the Unit Cost column.

In the "D" row (Summary), if the uuu_li_cost_type value is entered as "Variable Unit Cost," and
you enter the unit cost for the "CA" rows, then the variable unit cost line items will be created
with uuu_li_cost_type, as the "Unit Cost."
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If you enter the unit cost value and select cost line item type as "Variable Unit Cost" at summary
row "D," you will see the message: Unit Cost is not allowed on summary line for variable unit
cost lines.

If the design does not permit cost breakdown (Allow Cost Breakdown is unchecked), and if the
CSV Template has cost allocation details, then you will see the message: Business Process
design does not allow cost allocation.

Change Commit Business Processes

Change commit business processes enable you to change the value of a base commit and to
also update the SOV created by the contract. This business process is also known as a change
order. Change commit business processes are designed in uDesigner. For more information,
refer to the Unifier uDesigner User Guide.

You can use CSV import to create change commit business processes or to add SOV line items
for an existing business process. You can export change commit business process templates at
the log level (for header and line item templates with no data exported) and at the record level
(for line item templates with SOV data exported). You can then modify the templates and import
them to create records (at the log level) or to add line items to an existing record (at the record
level).

An Integration interface must be defined to support CSV import. If you cannot import the file,
contact your Administrator.

Also, new records can be created and line items added using Integration through Web Services.
Integration through Web Services must be coordinated with Oracle Primavera Unifier Consulting
Services.

Import New Change Commit Records

You can export a CSV template that includes the upper form and detail form fields as columns.
These fields include the header fields from the upper form and the line item SOV fields from the
detail form, including the detalil line item fields defined in Integration.

You can modify the exported CSV template and import it to create the upper form header
information and the detail line items for the new business process.

To export a copy of the change commit business process template

1) Navigate to the change commit business process log.

2) Click the Actions menu and select Export CSV Template or Export Microsoft Excel
Template.

Depending on your browser, the template will automatically be downloaded to your computer, or
you will be prompted to download it manually.

To modify the exported change commit business process template
1) Open the exported CSV or Excel file in Microsoft Excel.
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2) Enter the business process information into the spreadsheet. Each upper form header record
must begin with an "H". Each line item must begin with a "D". For multiple tabs, you must
enter appropriate tab name in the Tab Name column.

3) Enter data into the required fields, as well as non-required fields as needed.

Notes:

Data for formula-based columns is ignored.

If auto-populated data is provided, the system will import the value,
and will not override the imported values except for fields
auto-populated by Base Commit, Change Commit, or from SOV.

= Any line items with the Amount equal to zero will not be imported.

= Use to add new business process records only; not to modify existing
business processes.

= All data created through the CSV import is rolled up to the cost sheet

= For data to import correctly, you might have to change some of the
cells in the CSV file to Text type. For example, if you have a CBS
code of 1-1, Microsoft Excel can interpret this entry as a month-day

combination and reformat it to Jan-1. In this case, your data import
will fail because this data is how an invalid CBS code.

To import the change commit business process template

1) Navigate to the change commit business process log.

2) Click the Actions menu and hover over Import.

3) Select either Data From CSV File or Data From Microsoft Excel File.
4) Browse to select the file to import, then click Next.

5) Add any attachments to the import.

6) Click Upload when finished.

If there are any import errors, you can open the CSV file to view and correct the error. No
records are imported if any rows contain an import error.

Import Change Commit Line ltems Into a BP

You can export a template that includes the detail form fields as columns for a specific business
process. These fields include the detail form line item fields defined in Integration.

You can then modify the exported template and import it to create line items for the business
process. The exported template contains SOV record information.
To export the change commit line item template

If multiple tabs are designed for the line items in the business process, only the data in the
Standard tab is exported. For the other tabs, the tab name is included in the exported data for
reference, but no data in these tabs is exported. Data from all columns in the Reference Base
Commit is exported.

1) Navigate to the change commit business process log.
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Click Create to create a business process.

Select a Reference Base Commit for the business process. If you do not select a
Reference Base Commit, the exported template will not contain data. Data from all columns
in the Reference Base Commit is exported.

Open the Menu Options ( =) and hover over Export Line Item Template, then select CSV
or Microsoft Excel.

Depending on your browser, the file will be downloaded automatically, or you will be prompted to
download the file manually.

To modify the change commit line item template

1)
2)

3)

Open the exported CSV or Excel file in Microsoft Excel. The SOV line items are listed.

Enter the line item information into the spreadsheet. Each line must begin with a "D". For
multiple tabs, you must enter appropriate tab name in the Tab Name column.

Enter data into the required fields, as well as non-required fields as needed.

Notes:

Data for formula-based columns is ignored.

If auto-populated data is provided, the system will import the value,
and will not override the imported values except for fields
auto-populated by Base Commit, Change Commit, or from SOV.

= Any line items with the Amount equal to zero will not be imported.

= Ensure that you are importing the records you want to import. Any line
items that you import will be added after any existing line items.

= Use to add new lines only, not to modify existing lines

= All data created through the CSV import is rolled up to the cost sheet

= For data to import correctly, you might have to change some of the
cells in the CSV file to Text type. For example, if you have a CBS
code of 1-1, Microsoft Excel can interpret this entry as a month-day

combination and reformat it to Jan-1. In this case, your data import
will fail because this data is nhow an invalid CBS code.

To import the change commit line item template

1)
2)
3)
4)
5)
6)
7)

Navigate to the change commit business process log.

Open a business process from the log.

Click the Actions menu and hover over Import.

Select either Data From CSV File or Data From Microsoft Excel File.
Browse to select the file to import, then click Next.

Add any attachments to the import.

Click Upload when finished.

If there are any import errors, you can open the CSV or Excel file to view and correct the
error. No records are imported if any rows contain an import error.
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Linked Elements for Changed Commit and General Spends SOV Types

The following data elements can be added as linked elements in Change Commit BPs and
General Spends BP of SOV Types:
» uuu_scheduled value
Displays the original scheduled value of a Base Commit BP or General Spends BP of SOV
type.
» uuu_commit_remaining_balance
Displays the remaining balance of a Base Commit BP or a General Spends BP of SOV type

Note: The above data elements can be added to published BP designs
also.

For more details regarding each element, refer to the Unifier Data Reference Guide.

SOV Summary Payment Applications Sheets and Business Processes

The Summary Payment Applications Schedule of Values (Summary Payment Applications SOV)
allows users to allocate cost to line items based on the line item type (Lump Sum or Unit Cost).
Use the Summary Payment Applications SOV type in association with Commit and Spends
Business Processes (BPs) that are designed for Summary Payment Applications SOV (SPA
SOV) type.

For a given Project/Shell, there can be multiple Payment Application Business Processes of
Summary Payment Applications SOV Type.

For Base Commits Business Processes (BPs) with SOV type of "Summary Payment
Applications," a special behavior line item has been provided to allow you to add further cost
distribution details to the line items.

Note: Cost allocation/distribution can be done only for line items that are
in the Standard tab of the Base Commits and Change Commits BPs of
SPA SOV type.

The Standard detail tab of the properties window contains two options:

» Lump Sum
» Cost Unit

Click Add and select the appropriate option. For more information, see the Cost Distribution
Grid log columns section in Lump Sum and Unit Cost.

The Summary Payment Applications sub-node will be available under the Schedule of
Values node only if a Base Commits or Change Commits of SOV type Summary Payment
Applications is deployed in uDesigner.

The Grid functionality is not supported for the Base Commits BP with SOV type of "Summary
Payment Applications."
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When a Base Commits BP with SOV type of "Summary Payment Applications" is configured to
auto-populate Data Elements on a Payment Application with values from the Base Commits, the
runtime auto-populate occurs for the:

» Summary lines

» Costed lines
The Audit log, at the record level, captures the Line Item as well as the Costed Line Item
changes (taking place through Web Services) for both Base Commits and Change Commits BPs
with SOV type of "Summary Payment Applications." In this case the Event field of the Audit Log
for the BP displays "Line Items: Costed Line Item." In other words, any updates that are made to

the Costed Line Items, through Update calls, will have the Event as “Costed Line Item” for
Costed Line Item changes.

Grid functionality is not supported for Change Commits BPs with SOV type of "Summary
Payment Applications."

Summary Payment Applications SOV sheet is created when the Base Commits BP reaches the
terminal step as set in uDesigner.

Note: If a BP has been set up in uDesigner to automatically create a
Summary Payment Applications SOV sheet upon the end step, the
following procedures are not applicable.

Adding Values to a Summary Payment Applications SOV Sheet

To create a Summary Payment Applications SOV sheet, manually, begin by allocating cost to
line items based on the line item type (Lump Sum or Unit Cost).

To allocate cost to line items based on the line item type (Lump Sum or Unit Cost), follow these
steps.

1) Open the Project/Shell, switch to User mode, and click Cost Manager > Schedule of
Values in the left Navigator.

2) Click to expand the Summary Payment Applications grouping node.

3) Select a Base Commit BP (SOV Base Record) that you want to allocate cost to.

4) In the left Navigator, expand the Logs grouping node.

5) Select the Base Commit BP that you want to allocate and click to open the log.

6) Select a record and from the toolbar click Open to open the Base Commit BP form. The
Base Commit BP must be Approved before you can allocate.

7) Click Edit from the toolbar and change the Status to Approved.

8) Add cost by clicking the Add button, located at the lower-left corner of the window, and
selecting your cost option (Lump Sum or Unit Cost).

9) Ensure that the Line Item fields have correct values (Add Cost, Remove Cost, and so on)
and when finished click Close Window.

10) Click Finish Editing from the toolbar and wait for the process to complete.
11) Go to the Base Commit BP under the Summary Payment Applications grouping node.
12) Find the SOV Base Record that you have added, select the record, and click Open.
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13) Inspect the fields to ensure that the record has been added.

Note: Some of the column headings are links. If you click these types of
column headings, you can view more details about the column.

14) When finished, click Close Window.

Summary Payment Applications SOV Sheet window

Use the toolbar to expand, collapse, find, split the screen, and export records.
Note: You can use the menu bar options as an alternative and perform
the same operations.

Expand

Allows you to view the Summary and the associated child rows.

Collapse

Allows you to view only the Summary rows. This will be the default view.

Find

Allows you to search the Summary Payment Applications SOV sheet for specific line items. Find
will be based on the columns and will have fields of Column, Value, and Search.

Split
Allows you to split the sheet into two sections.
Export

Allows you to export the entire summary sheet along with the costed lines (the line item
summary and the associated costed line items). The generated CSV is for information purposes
only.

Summary Payment Applications SOV sheet structure (columns)

The columns in the Summary Payment Applications SOV sheet window are based on the SOV

structure. The following is a list of the default columns:
> Ref.

» Cost Code

» Code Name

» Cost Line Item Type
» Description

To modify the columns, click File > Properties, to open the Properties window, and then click
the Options tab.

Note: The CBS Code and CBS Item fields are read-only and the values
are based on the Cost Sheet.

The rows display the summary lines and the associated child rows, within the summary lines.
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The grid displays the summary rows (Detail line item) with cost distributed rows, and the child
cost rows within a Detail line item appears under the row and indented. All the fields are
read-only and the currency is displayed on the right upper-corner of the grid.

The grid also has a Total field, which appears at the bottom of the sheet, that displays the sum
of all the lines.

Grid Support in Base Commit and Change Commit

You can enter line items using either a line-item entry form, or the Grid feature. For the Base
Commit and Change Commit, you can use the Grid feature to enter line items directly into the
item logs.

Note: The Grid feature is best used for short line items.

Grid Support for Base Commit
The toolbar for the Base Commit and Change Commit item logs has the following options:

Save

Attach

Linked Records
Expand
CollapseSplit
Find

Close Window

v v vV vV v v Vv

Other Grid functionalities
In the Grid, you can:

» Reverse auto-population

» Auto-population of other fields in the Grid based on the selection of certain fields

» Printing of Line Items (Line Items and Costed Line Items created through the Grid)
» Audit log

Additional Grid Toolbar Options

Upon selecting the Line Items tab of a Business Process record, the Form View is displayed by
default. In Form View, the view options are displayed in the toolbar alongside options like
Refresh, Print, Search, and Find on Page.

The Line Item list, along with line item Details, Attachments, and Linked Records, is displayed in
the right pane.

You can switch to Grid View by selecting the Grid View option in the toolbar. In Grid view, the
view options are displayed in the toolbar alongside Refresh, Print, Find on Page, and
Expand/Collapse. When a row or cell in the grid is edited, additional toolbar options are
available, including: Add, Cancel, Error Check, Save, Print, and Find on Page.

Note: In the Grid view of Line Item tabs, the additional options are

271



Business Processes User Guide

applicable to Pending records. Only the Refresh, Print, Find on Page,
and Expand/Collapse options are applicable to Approved records and
Terminated records.

Other Elements of Line Items and the Grid

The options of Attach and Linked Records are only available for Line Items. If you attempt to add
attachments or linked records to a Costed line, an error message is displayed. If a Costed Line
Item (Cost allocated Line Item which belongs to a Summary Line Item) is selected, then these
options are not available.

Before adding attachments or linked records to a line item, you must save the line item.

If a Costed Line Item and a Summary Line Item are selected, then you can upload the
attachments, or link records, to the Summary Line Item.

If multiple Summary Line Items are selected, and you click Attach, or Linked Records, the
system notifies you then an alert will be seen informing user that only one record needs to be
selected (this is existing elsewhere in the grid).

The search parameters, in the Find option, are based on the design of the Line Item list,
prepared in uDesigner.

Note: The search parameters are not for the Costed Line Items.

Any time you run a search, the Line Item that matches the search parameter is found. In addition
to the parent Line Item, the Costed Line Items belonging to that Line Item will be found.

The Grid rows can be expanded.

The Grid columns contain the Cost Allocation columns, and the fields designed in the Detall
Form, in uDesigner.

The sorting order is based on the order set in uDesigner. Line items are sorted first, followed by
Costed lines.

You can use the Split option to split the view into 2 sections.
By default, the order of the following columns will be fixed:

Row

Line No.
Attachment
Linked Record
Cost Line Item Type
Cost Code

Cost Name
Short description
Item Quantity
Item Unit Cost
Amount

VvV vV vV vV vV vV vV vV vV v v
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Subsequent columns appear in the order that was set in the Detail Form, during the design.
Note: The system uses the Row number to display an error messages.

The column names are based on the Data Element (DE) labels specified in the Data Structure
setup. Cost Code and Cost Name columns have fixed labels and cannot be changed.

The first column (Gear menu) provides the following options:

Insert Line Item
Insert Multiple Line Items
Insert Costed Line Items
Add Remaining
Copy
Paste
Remove
* |n the Remove gear menu, the following message is displayed when the action is

triggered: “Are you sure you want to remove the selected Line Items and all the
associated Costed Line Items?

v v v v v v Vv

Effect of uDesigner on Gear Menus

The options on the corresponding uDesigner Upper form affect the toolbar and Gear menus
when a line item and a Costed line are selected in the Grid view. The table below indicates the
effects of the uDesigner options.

uDesigner Upper form
options

Toolbar and Gear menus
seen at runtime when aline
item is selected

Gear menus seen at runtime
when a Costed line is
selected

Allow Add/Remove/Copy
line items option checked

Allow Cost Breakdown
unchecked

Toolbar
Add option is seen
Gear menus

Insert Line ltem with
submenu options of Lump
Sum and Unit Cost

Insert Multiple Line Items
with submenu options of
Lump Sum and Unit cost

Copy-To make an exact
copy of the line item

Remove-To remove a line
item

Gear menus
No actions in the gear

Allow Add/Remove/Copy
line items option unchecked

Allow Cost Breakdown
unchecked

Toolbar

Add option is not seen
Gear menus

No actions in the gear

Gear menus
No actions in the gear
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uDesigner Upper form
options

Toolbar and Gear menus
seen at runtime when aline

Gear menus seen at runtime
when a Costed line is

item is selected selected
Allow Add/Remove/Copy Toolbar Gear menus
line items option checked | Add option is seen No actions in the gear
Allow Modification of Line | Gear menus

Iltem checked with Allow
Cost Breakdown unchecked

Insert Line Item with
submenu options of Lump
Sum and Unit Cost

Insert Multiple Line Items
with submenu options of
Lump Sum and Unit cost

Copy-To make an exact
copy of the line item

Remove-To remove a line
item

Allow Add/Remove/Copy
line items option unchecked

Allow Modification of Line
ltem checked with Allow
Cost Breakdown unchecked

Toolbar

Add option is not seen
Gear menus

No actions in the gear

Gear menus
No actions in the gear

Allow Add/Remove/Copy
line items option unchecked

Allow Cost Breakdown
checked

Toolbar
Add option is not seen
Gear menus

Insert Costed Line ltems-To
add cost break down to a
line item

Add Remaining-To add a
costed line which will have
the Amount
field=Non-Costed Amount -
Costed Amount. This option
will not be seen when the
Costed Amount=Amount in
the Costed lines

Copy-To make an exact
copy of the line item

Remove-To remove a line
item and its costed lines

Gear menus

Insert Costed Line Items-To
add cost break down to a
line item

Copy-To make an exact
copy of the line item

Remove-To remove line
items

Allow Add/Remove/Copy
line items option checked

Allow Cost Breakdown
checked

Toolbar
Add option is seen
Gear menus

Gear menus

Insert Costed Line Items-To
add cost break down to a
line item
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uDesigner Upper form Toolbar and Gear menus Gear menus seen at runtime
options seen at runtime when aline |when a Costed line is
item is selected selected
Insert Line Item with Copy-To make an exact
submenu options of Lump | copy of the line item
Sum and Unit Cost Remove-To remove line

Insert Multiple Line Items items
with submenu options of
Lump Sum and Unit cost

Insert Costed Line Items-To
add cost break down to a
line item

Add Remaining-To add a
costed line which will have
the Amount
field=Non-Costed Amount -
Costed Amount. This option
will not be seen when the
Costed Amount=Amount in
the Costed lines

Copy-To make an exact
copy of the line item
Remove-To remove a line
item and its costed lines

Line Iltems in the Grid
When the Grid is launched for the very first time and no Line Items exist for the BP record:

A blank line (first line) is displayed in the Grid, by default, and the blank line is treated as a
Summary Line Item. The uuu_cost_li_type field will be set as “Lump Sum” for the Summary Line
ltems.

Note: The uuu_cost_li_type field cannot be blank. It can either be set as
"Lump Sum" or "Unit Cost."

If you click the Gear menu (in the first column) in the first line, these options will be available,
only:

» Insert Line Iltem
» Insert Multiple Line Items

All other options are disabled.

You can change the default value set in the uuu_cost_li_type field to "Unit Cost." The value
specified in this field governs whether the other fields can be edited.

When a new Line Item is inserted, the new Line Item will be a Summary Line Item.
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You can also add the Summary Line Item by selecting the “Insert Line Item” option from the
Gear menu. The “Insert Line Item” option only lets you add one Line Item.

You can add multiple Summary Line Items by selecting the “Insert Multiple Line Items” option.

If you insert a new row, based on key actions (tab, enter), then the inserted new row type will be
the same as the previous row.

The line number (1, 2, 3, 4, and so forth) are generated after you click Save.
The "Add Remaining" option is enabled for all Summary Line Items as long as the:

» "Total Amount" from the Costed Line Items is not = Line Item Amount, in case of Lump Sum
» "Quantity" from the Costed Line Items is not = Line Item Quantity, in case of Unit Cost

When you select the “Insert Multiple Line Items...” option, the Insert Multiple Line Items window
appears which allows you to determine the number of Line Items that you want to add.

The total amount row (at the bottom of the Grid) displays the Total Line Item Amount of all the
Summary Line Item rows.

Note: The added Line Items are all Summary Line Items and will be
populated with Lump Sum as the Cost Line Item Type.

Gear Menus for Summary Line Iltem

The following explains the functions of the Gear menus when you select the Summary Line ltem
and click the Gear menu (in the first column).

Option Enabled/ Disabled Description

Insert Line Item... Enabled If you highlight a Summary
Line Item and click this
option, then the system
inserts another Summary
Line Item row above the
highlighted row.

Insert Multiple Line Enabled If you highlight a Summary
Items... Line Item and click this
option, then the system
inserts multiple Summary

Line Items.
Insert Costed Line Enabled If you highlight a Summary
ltems... Line Item and click this

option, then, you can add
Costed Line Items below
the highlighted row.
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Option Enabled/ Disabled Description

Add Remaining... Enabled If you highlight a Summary
Line Item and click this
option, then the system
launches the CBS Picker
window.

When you select the CBS
code, the system adds a
Costed Line Item, with the
Short Description field
auto-populated from the
Short Description of the
Summary Line Item, and
the system calculates the
value in the Amount field as
Non Costed Amount -
Costed Amount.

The system inserts these
Line Items at the end of the
Costed Line Item for that
parent/Summary Line Item.

This option is disabled
when the Costed Amount =
Amount in the Costed lines.
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Option

Enabled/ Disabled

Description

Paste

Disabled
(until you perform a Copy)

If you highlight a blank row

and perform a Paste action,
then the system inserts the

Summary Line Item and the
Costed Line Item above the
highlighted Line Item.

You can also insert the
Summary Line Item and the
Costed Line Item between
Summary Line Item.

If you select a Summary
Line Item, the system
inserts the Summary Line
Item above the highlighted
row.

You cannot perform a Paste
action for more than one
Costed Line Item.

When you perform a Paste
action, the system updates
the number of each Line
Item, after you click Save.
When you click Save, the
newly pasted Summary
Line Items appear at the
end of the Line Item list.
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Option Enabled/ Disabled Description

Copy Enabled If you highlight a Summary
Line Item and click this
option, then you copy the
Summary Line Item and the
associated Costed Line
Items.

If you highlight a Summary
Line Item and a Costed Line
Item, from a set of Costed
Line Items, and click the
Gear menu > Copy, then
the Summary Line Item and
all the associated Costed
Line Items are copied.

Example

Line 1 has 1.1, 1.2, and 1.3.
You select Line 1 and click
copy.

When you paste, the
system inserts Line 1 along

with 1.1, 1.2, and 1.3 in the
Grid.

Remove Enabled If you highlight a Summary
Line Item and click this
option, then the Summary
Line Item and all the
associated Costed Line
Items are removed.

Adding and Managing Line Items in Grid View

Adding Line Iltems in Grid View

Upon selecting the Line Items tab of the record, you can add a Lump Sum item or a Unit Cost
item using the Add dropdown.

Fields seen in the grid are based on the detail form design. The editable field cells are bolded
while the read-only field cells are italicized. Row numbers for the line items are generated upon
saving the grid.

Adding Multiple Line Items in the Grid

After selecting to add multiple line items, a dialog box is displayed where you can specify the
number of added line items. When adding these line items, the total number of rows displayed
depends on the number indicated in the dialog box.
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The Cost Line Item Type for each line item is populated based on the selected sub-menu option.

Modifying Cost Line Item Types

When an alert window is displayed regarding a change of value for uuu_cost_li_type, the rules
are applied as listed below:

» If the line item has not been saved and the line item remains in entry mode, no error
message is displayed.
» If the summary line item has been saved, a confirmation message is displayed.
= This indicates that the field values for the Cost Line Item Type are reset.
» If the summary line item has Costed lines, a confirmation message is displayed.
= This indicates that the field values for both the line item and Costed line are reset.

» If you select, “Yes” in the alert window, system fields dependent on uuu_cost_li_type are
reset for both the line item and Costed line.

Note: If “Allow Cost Breakdown” is unchecked in uDesigner and Costed
lines exist as part of a previous step, then changing uuu_cost_li_type
modifies the Costed lines. This is applicable for Workflow Business
Processes.

Handling Errors in the Grid

The handling of errors in this updated grid is similar to other grids. All required field validation
errors are displayed with a red circle in their respective fields.

When you select Save or Error Check, form and system-level validations are performed. If any
rows on the grid contain errors, the Error Indicator column displays an error.

System-defined Fields for the Summary Line ltem
The following explains the function of the system-defined fields in the Summary Line Item.
Columns

» The first 10 columns will be fixed as Line No., attachment, link records, uuu_cost_li_type
field, Cost Code, Cost Name, Short Description, Item Quantity, Item Unit Cost, and Amount.

» Remaining columns will be as per the detail form design in uDesigner.
uuu_cost_li_type
The uuu_cost_li_type will be a drop down and will have the values of Lump Sum and Unit Cost.

This field is a required field and should be marked with an asterisk. This field cannot be blank
and by default will be set as Lump Sum.

The drop-down will have the values of Lump Sum and Unit Cost.
The editing of remaining fields in the grid will be dynamic in nature.
Meaning the uuu_cost_li_type will drive the editable and non-editable fields in the grid.

Note: After the selection has been made, this value should be grayed
out post shift of focus. This will be important since this field drives the
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behavior of other fields.

If the option selected is Lump Sum then:

» uuu_quantity: Disabled (Any auto population and formula definition on this field will not be
retained when the LI type is lump sum.)

» uuu_unit_price: Disabled (Any auto population and formula definition on this field will not be
retained when the LI type is lump sum.)

amount: Required.

Manual or Formula destination. User must type in the amount value. This DE could also be
set as formula in uDesigner. Runtime should retain the formula calculation.

If the option selected is Unit Cost then:

» uuu_gquantity: Required.
» Manual or Formula destination. User must type in the Quantity value. This DE could also be
set as formula in uDesigner. Runtime should retain the formula calculation.

uuu_unit_price: Required
Manual or Formula destination. User must type in the unit cost value. This DE could also be
set as formula in uDesigner. Runtime should retain the formula calculation.

» amount: Read-only, populated by formula as configured by user in uDesigner. At runtime this
field should always be calculated as uuu_quantity*uuu_unit_price

If the detail form design does not have the uuu_quantity and uuu_unit_price fields but user
selects the Unit Cost option for uuu_cost_li_type then upon shift of focus, an error should be
thrown alerting the user that the fields are missing. (Use existing alert currently being thrown
when user clicks unit cost option in the classic line item Unit Cost option).

Other System Elements in the Grid

uuu_costed_amt

Always read-only. This DE should show value as sum of ‘Amount’ from all costed lines.

(Note that when uuu_cost_li_type = Lump Sum, amount will be entered by user in the cost
allocation window. When uuu_cost_li_type = Unit Cost, amount will be calculated in the grid by
system as Unit Cost*Quantity. Either case, uuu_costed_amt in the summary line item will be
calculated as sum of ‘amount’ from all costed lines.)

This field will be displayed only at the summary line item level in the grid.
uuu_not_costed_amt

Always read-only, this DE should show value = (amount - uuu_costed_amount)
This field will be displayed only at the summary line item level in the grid.
uuu_costed_qty

Always read-only. This DE should show value as sum of ‘Quantity’ from all distributed cost child
lines.
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(Note that when uuu_costed_Ii_type = Lump Sum, this will be zero. When uuu_cost_li_type =
Unit Cost, Quantity will be entered by user in the Cost Allocation window. Either case,
uuu_costed_qty in the summary line item should calculate as sum of ‘Quantity' from all costed
lines.)

This field will be displayed only at the summary line item level in the grid.
uuu_not_costed_qty

Always read-only, this DE should show value = (uuu_quantity - uuu_costed_quantity). Note that
when uuu_cost_li_type = Lump Sum, this will calculate as zero.

This field will be displayed only at the summary line item level in the grid.
All other fields designed in the Detail form
User defined fields will be editable in the summary line item and not in the costed lines.

Costed Line Items in the Grid

The option of “Insert Costed Line Items...” allows you to add Costed Line Items for a Line Item.
Clicking this option will launch the CBS Picker window. Multiple CBS Codes can be selected.

The number of Costed Line Item inserted depends on the number of codes selected in the CBS
Picker window. After you insert the Costed Line Items, along with the CBS codes, you can edit
the rest of fields according to the Cost Line Iltem Type that these Costed Line Items belong to.

Line Numbers for the Costed Line Items follow the parent number (+ 1,2,3,4, and so on).

Example

If parent line item has a Line No. of 1, then the subsequent Costed Line Items have the
numbers of 1.1, 1.2, 1.3 and so forth.

Note: The Line Item numbers are generated after you click Save.

Both the Summary Line Item and the Costed Line Item are indented on the page. The Summary
Line Item has the option of Expand and Collapse.

The "Short Description” field is auto-populated from the Short Description field in the parent Line
Item.

If you insert a blank Line Item through a key action, and there are no rows after the inserted row
in the Grid, then the inserted row will be a Costed Line Item. If you want to change the next Line
Item to a Summary Line Item, then you must insert the Line item by clicking the Gear menu and
select the option “Insert Line Items...” The "Add Remaining" option is disabled for the Costed
Line Item.

Gear Menus for Costed Line ltem

The following explains the functions of the Gear menus when you select the Costed Line Item
and click the Gear menu (in the first column).
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Option Enabled/ Disabled Description

Insert Line Item... Disabled You cannot add a Summary
Line Item when a
hierarchical relationship
exists between the Costed
Line Item and a Summary

Line Item.
Insert Multiple Line Disabled You cannot add a Summary
Items... Line Item when a

hierarchical relationship
exists between the Costed
Line Item and a Summary

Line Item.
Insert Costed Line Enabled If you highlight a Costed
ltems... Line item and click this

option, then you can add
additional Costed Line
Items below the highlighted

row.
Add Remaining... Disabled You can only perform this
action for Summary Line
Items.
Paste Disabled You can only paste a

(until you perform a Copy) copied Summary Line Item.
If you copy a Costed Line
Item, for example 1.1, from
the parent line, for example
Line 1, then you can paste
the copied Costed Line Item
under the parent line.

After you paste, the new
Costed Line Item is inserted
below the selected Line
Item and renumbering of
the Costed Line Items takes
place automatically.

You can paste Costed Line
Iltems that have the same
source and destination.
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Option

Enabled/ Disabled

Description

Copy

Enabled

If you highlight a Costed
Line Item and click this
option, then the highlighted
Costed Line Item is copied.

You can copy multiple
Costed Line Items and
insert them below the
highlighted/selected Costed
Line Item. The Costed Line
Items copied must belong to
the same Summary Line
Item.

You cannot copy Costed
Line Items that belong to
different Summary Line
Items.

Remove

Enabled

If you highlight a Costed
Line Item and click this
option, then the Costed Line
Item will be removed.

System-defined Fields for the Costed Line Item

The following explains the function of the system-defined fields in the Costed Line Item.

Option Enabled/ Disabled Description
Cost Code Always Enabled regardless | The initial value that is
of the uuu_cost_li_type populated in this field is
value based on the selection that
you had made when you
clicked the "Insert Costed
Line Items ..." option.
You can modify the value
later.
Cost Name Disabled The value in this field

depends on the CBS Code
that you had selected.
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Option Enabled/ Disabled Description

Short Description Always enabled regardless | The initial value that is
of the uuu_cost_li_type populated in this field is
value based on value of the Short

Description field of the
Summary Line Item.

You can modify the value

later.
Item Quantity Enabled only when User will be allowed to enter
uuu_cost_li_type = Unit the quantity.
Price
Item Unit Price Disabled This field will get populated
based on the Item Unit
Price value in the Line Item.
Amount Enabled when: Amount will be editable
uuu_cost_li_type = Lump when uuu_cost_li_type =
Sum Lump Sum. Amount will be
Disabled when: derived as Item Quantity*
uuu_cost_li_type = Unit Item Unit Price when
Cost uuu_cost_li_type = Unit

Cost

Grid Support for Change Commit

Note: Except when noted, other functions of the Change Commit Grid
are similar to those for the Base Commit Grid.

The Grid for the Change Commit Business Processes of Summary Payment Application (SPA)
SOV type enables you to add:

» Lump Sum
» Unit Cost
» Modify Committed Lines

The first column (Gear menu) provides the following options:

Insert Line ltem

Insert Multiple Line Items
Insert Costed Line Items
Modify Committed Line Item
Add Remaining

Copy

Paste

Remove

v vV v vV VvV vV v Vv
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*= In the Remove gear menu, the following message is displayed when the action is
triggered: “Are you sure you want to remove the selected Line Items and all the
associated Costed Line ltems?"

Note: The "Modify Committed Line Item ..." option will be disabled when
you select a Costed Line Item.

When you click the "Modify Committed Line Item ..." option, the Commit Line Picker window
opens. Follow the prompts to select a Commit Line Item from SOV to insert in the Grid.

The columns in the Change Commit grid are similar to the Base Commit grid. Alongside Item
Quantity, Item Unit Cost, and Amount are the following new columns:

Error Indicator
Attachment

Linked Record

Cost Line Item Type
Cost Name

Short Description
Current Quantity

Current Scheduled Value
New Scheduled Value

Vv vV vV vV vV VvV v v Vv

The remainder of the columns display based on the form design established in uDesigner.

Total Amount Row

Similar to a Base Commit grid, a total amount row (at the bottom of the Grid) displays the Total
Line Item Amount of all the Summary Line Item rows.

Form Validations

All form level validations at the system and user-defined levels are done once the Save option is
selected in the toolbar.

For Lump Sum validations, the Costed Amount must be the same as the Line Item Amount for
the Cost Line Item Type.

For Unit Cost validations, the Costed Quantity must be the same as the Line Item Quantity for
the Cost Line Item Type.

Selecting and Modifying Line ltems

You can use the "lItem Quantity" and "Amount" to enter "Change Quantity" and "Change
Amount" when modifying the Committed Line Items.

When you select "Modify Committed Line Item ..." option, the Committed Line Item Picker
window opens to allow you to select the Line Item that you want to modify. The behavior of a line
item selection is similar to the one seen when line items are added through selecting the Modify
Committed Line option in Form View. You can select any Summary Line Item, from this window.
After you select the Line Item, the following occurs:
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» The uuu_cost_li_type and uuu_unit_price fields, when Cost LI type = Unit Cost, are copied
from the reference Commit Line Item and transferred into the Change Commit Line Item as
read-only fields.

» The uuu_cost_li_type and uuu_unit_price fields are read-only and cannot be modified
because the fields are from the SOV sheet.

» The short_desc field is also copied from the reference Commit Line Item and transferred into
the Change Commit Line Item.

The following Costed Line Items, below the Commit Line Item, are copied into the Change
Commit Line Item:

» The currency field Scheduled Value
» The bi_item, bitemid, and short_desc fileds

Note: The fields mentioned above are copied from the source
distribution row and transferred into the destination distribution row.

If you select a Costed Line Item instead of a Summary Line Item, and you select Costed Line
Item from the Commit Line Item Picker window, then you will add the parent Line Item, along
with all the child distribution Line Items, into the Change Commit Line Item.

The short description field of the Change Commit Line Item updates the SOV sheet.

Gear Menus for Modify Committed Line Item > Summary Line ltem

The following explains the functions of the Gear menus when you select the Modify Committed
Line Item > Summary Line Item and click the Gear menu (in the first column).

Option Enabled/ Description

Disabled
Insert Line |Enabled If you highlight a Committed Summary Line Iltem and click
Item... this option, then the system inserts another Committed

Summary Line Item row above the highlighted row.

Insert Enabled If you highlight a Committed Summary Line Item and click
Multiple this option, then the system inserts multiple Committed
Line Summary Line Items.
ltems...
Modify Enabled If you highlight a Committed Summary Line Item and click
Committed this option, you will launch the Commit Line Item picker,
Line Item... and you can select the Summary Line Item for insertion.
Insert Enabled If you highlight a Committed Summary Line Item and click
Costed Line this option, then, you can add Costed Line Items below
Items... the highlighted row.

287



Business Processes User Guide

Option Enabled/ Description
Disabled

Add Enabled If you highlight a Committed Summary Line Item and click

Remaining this option, then the system launches the CBS Picker

window.

When you select the CBS code, the system adds a
Costed Line Item, with the Short Description field
auto-populated from the Short Description of the
Summary Line Item, and the system calculates the value
in the Amount field as Non Costed Amount - Costed
Amount.

This option is disabled when the Costed Amount =
Amount in the Costed lines.

Paste Disabled If you highlight a blank row and perform a Paste action,
(until you then the system inserts the Committed Summary Line
perform a Item and the Costed Line Item above the highlighted Line

Copy Enabled If you highlight a Committed Summary Line Item and click

this option, then you copy the Committed Summary Line
Item and the associated Costed Line ltems.
Remove Enabled If you highlight a Committed Summary Line Item and click

this option, then the Committed Summary Line Item and
all the associated Costed Line Items are removed.

Gear Menus for Modify Committed Line Item > Costed Line item

The following explains the functions of the Gear menus when you select the Modify Committed

Line Item > Costed Line Item and click the Gear menu (in the first column).

Option Enabled/ Description
Disabled

Insert Line |Disabled You cannot add a Summary Line Item when a

Item... hierarchical relationship exists between the Costed Line
Item and a Committed Summary Line Item.

Insert Disabled You cannot add a Summary Line Item when a

Multiple hierarchical relationship exists between the Costed Line

Line Item and a Committed Summary Line Item.

ltems...

Modify Disabled You cannot add a Committed Summary Line Item from

Committed an SOV sheet when a Costed Line Item is highlighted.

Line Item...
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Option Enabled/ Description
Disabled

Insert Enabled If you highlight a Costed Line item and click this option,

Costed Line then you can add additional Costed Line Items below the

Items... highlighted row.

Add Disabled You can only perform this action for Committed Summary

Remaining Line Items.

Paste Disabled You can paste a Costed Line Item within the Summary
(until you Line Item. For example, if you copy the Costed Line Item
perform a 1.1 from the parent Line 1, the copied Costed Line Item
Copy) can only be pasted under Line 1. Renumbering of the

Costed Line Items occurs automatically.
You can paste Costed Line Items that have the same
source and destination.

Copy Enabled If you highlight a Costed Line Item and click this option,

then the highlighted Costed Line Item is copied.

You can copy multiple Costed Line Iltems and insert them
below the highlighted/selected Costed Line Item.

The copied Costed Line Items must belong to the same
Summary Line Item.

You cannot copy Costed Line Items that belong to
different Summary Line Items.

Remove Enabled or Case 1: A new Costed Line Item that does not exist in the
Disabled SOV sheet:
depending on | if you highlight the Costed Line Item and click this option,
the case then Costed Line Item will be removed.

Case 2: The Costed Line Iltem exists in the SOV sheet:

This option is disabled if you select a Committed Costed
Line Item (the Costed Line Item exists in the SOV sheet).

Column Details Specific to Cost Allocation

The following provides the details specific to the Cost Allocation.

Log Column

Description

Cost Code

Required and editable within the Grid. You can select a Cost Code from
the Cost Code Sheet, within the same Shell, by clicking inside the cell.
Similar to the Line Items, you can enter a Cost Code in the cell and the
system provides the matching Cost Codes for you to choose from. You
cannot change the Cost Code of an existing Line Item that originates
from an SOV sheet.
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Log Column | Description

Code Name |Read-only. The value in this field is auto-populated by the system
according to the Cost Code that you have selected.

Short Editable. The default value in this field is auto-populated by the system

Description according to the Line Item "short_desc" field. You can update/modify
the default value.

Current Read-only. You can see the column and the values if 1) You select the

Quantity Modify Reference Commit option and 2) The Commit Line Item = Unit
Cost in the Cost Line Item type: uuu_cost_li_type. If the two conditions
are satisfied, then the system auto-populates the value in this column
as "Quantity" (from the source Commit distribution line).

Current Read-only. The system displays this column and populates the value

Scheduled (regardless of the uuu_cost_li_type). The value in this column is only

Value populated when you modify an existing Line Item from the SOV sheet.

Item Quantity

Read-only if uuu_Cost_li_type = Lump Sum. Editable if

(Change uuu_cost_li_type = Unit Cost. You can enter the Costed Quantity.

Quantity)

Amount Editable if uuu_cost_li_type = Lump Sum. You can enter the Costed

(Change Amount. The system calculates the value as "Change Quantity * Unit

Amount) Cost" if uuu_cost_li_type = Unit Cost. The value of the Unit Cost must
be according to the Detail Form (uuu_unit_price). If DE is missing, the
value will be zero.

New Read-only. This column is only populated when you modify an existing

Schedule Line Item from the SOV sheet. The value is calculated by the system as

Value "Current Schedule Value + Change Amount".

Summary Payment Application Grid Column Total

» Blank

Unifier displays the value as empty in the Total Column (that particular DE column).
» Sum of All Rows
Unifier displays the value as "Sum of All Rows" in the Total Column.

Use Formula Definition

Unifier displays the value as "Formula Defined" in the Total Column. In other words, Unifier
calculates the formula by using the values from the Total row for the respective DEs.

If the formula was reset to Manual, then Unifier resets the Total to "Sum of All Rows."
Unifier calculated the Total, for DEs with predefined formula, as follows:

» %Complete to Date (uuu_spa_per_comp)
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» Custom formula
Based on the property selected in uDesigner.
» System-defined formula
Based on the property selected in uDesigner.
» Amount This period (uuu_spa_amt_tp)

Based on the property selected in uDesigner. (Either Blank or Sum of All Rows)

Note: With version 23 and later, a Total row on a non-standard tab of a
line item grid is not displayed. For version 22 and earlier, the Total row
displays a 0.

SOV Summary Payment Application Business Process

In a new payment record, when you navigate to the payment grid and no line items are saved,
the system will not calculate the sum of all (SOV) line items for data elements in the upper form.

View Mode
In View Mode, you can use the toolbar to Reload, Print, Find, Collapse, and Expand.

Field Description

Add Lets you add lines. When you click Add, a
confirmation dialog will be displayed. After
lines have been added, the Add button will
be hidden.

Note: After lines have been added
manually, the payment lines cannot be
added through CSV import.

Import Lets you import lines. After lines have
been added, the Import button will be
hidden.

Reload Lets you reload line items.

Print Lets you print or export the entire summary

sheet along with the costed lines (the line
item summary and the associated costed
line items). The sheet can be exported to
CSV or Excel. The generated CSV or
Excel sheet is for information purpose
only.
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Field Description

Find on Page Lets you find items on the displayed page.
When you click this option, the system
inserts a row that lets you enter filter
parameters.

Collapse Lets you view only the Summary rows.

Expand Lets you view the Summary and the

associated child rows. This will be the
default view.

Summary Payment Applications SOV
structure (columns)

The grid columns seen in the classic
payment application will be as per the
detail form design specified in uDesigner.

The grid also has a Total field, which
appears at the bottom of the sheet, that
displays the sum of all the lines.

Edit Mode

In Edit Mode, you can use the toolbar to Cancel, Error Check, Save, Find, Collapse, and
Expand. Additionally, a check box option of Apply line item value of Percentage Complete to

Date to Costed Lines will be visible on the right.

Field

Description

Cancel

Allows you to exit Edit Mode.

Error Check

Allows you to check the sheet for errors.

Save Allows you to save any changes made to
the sheet in Edit Mode.

Collapse Allows you to view only the Summary
rows.

Expand Allows you to view the Summary and the

associated child rows. This will be the
default view.

Locking of the Grid

In View and Edit mode, the system will automatically lock the grid after the first 5 columns. To
lock another column while viewing or editing data, you can drag the column from the unlocked

part of the sheet into the locked part of the sheet. This layout will not be saved into the

database.
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Total Mismatch Indicator

When the line item field value does not match the sum of costed line values, the line item cell
displays a small red triangle to indicate that the totals do not match. When you click the small
triangle, the system displays an information text and informs you of the differences. This is
applicable only for the line item.

Multiple Payment Applications

If SOV restrictions are removed and multiple Payment Applications are detected, an Alerts icon
will be displayed in the upper right corner of the window. When you hover over the icon,
information about pending payments is presented.

Negative Change Orders

When the Payment Application grid is opened, the line items that will be modified because of a
pending Negative Change order will have an Alerts icon in the Scheduled Value cell. You can
click the cell to view the details of the Change order. The Pending Change Orders with negative
amounts screen will be displayed. The screen will include columns for the Business Process
name, Record Number, Line Number, and Amount.

Updating Change Orders

When a change order that refers to the line item from SOV contains data about the change
quantity (uuu_quantity) is created, and the quantity gets updated in the SOV sheet, the system
will update the quantity changed (uuu_quantity) to the inflight payment record after SOV merge.

Import New Summary Payment Application Records

You can export a CSV or Excel template that includes the upper form and detail form fields as
columns. These fields include the header fields from the upper form and the line item SOV fields
from the detail form, including the detail line item fields defined in Integration.

You can modify the exported CSV or Excel template and import it to create the upper form
header information and the detail line items for the new business process.

To export a copy of the summary payment application business process template

1) Navigate to the summary payment application business process log.

2) Click the Actions menu and select Export CSV Template or Export Microsoft Excel
Template.

Depending on your browser, the template will automatically be downloaded to your computer, or
you will be prompted to download it manually.

To modify the exported summary payment application business process template
1) Open the exported CSV or Excel file in Microsoft Excel.

2) Enter the business process information into the spreadsheet. Each upper form header record
must begin with an "H". Each line item must begin with a "D". For multiple tabs, you must
enter appropriate tab name in the Tab Name column.

3) Enter data into the required fields, as well as non-required fields as needed.
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Notes:

= Data for formula-based columns is ignored.

= [f auto-populated data is provided, the system will import the value,
and will not override the imported values except for fields
auto-populated by Base Commit, Change Commit, or from SOV.

Any line items with the Amount equal to zero will not be imported.

Use to add new business process records only; not to modify existing
business processes.

For data to import correctly, you might have to change some of the
cells in the CSV file to Text type. For example, if you have a CBS
code of 1-1, Microsoft Excel can interpret this entry as a month-day
combination and reformat it to Jan-1. In this case, your data import
will fail because this data is now an invalid CBS code.

To import the summary payment application business process template
1) Navigate to the summary payment application business process log.

2) Click the Actions menu and hover over Import.

3) Select either Data From CSV File or Data From Microsoft Excel File.
4) Browse to select the file to import, then click Next.

5) Add any attachments to the import.

6) Click Upload when finished.

If there are any import errors, you can open the CSV file to view and correct the error. No
records are imported if any rows contain an import error.

Note: If the Add Only SOV edited line items option is selected in
uDesigner, only the edited line items will be saved when the summary
payment application template is imported through CSV, Excel, or
RESTful services.

Adding Partial Line Iltems by way of CSV or Excel import or RESTful web services

When you add partial line items by way of CSV-Excel import or RESTful web services to the
Summary Payment Applications BP, the system will add all of the other existing SOV lines,
along with the line items provided in the CSV-Excel template or RESTful web services input
request.

When you are scheduling payments by creating the payment line items by way of CSV or Excel
import or RESTful web services, you can add all of the payment line items to the grid to prevent
data discrepancy in the Schedule of Value (SOV). To be able to prevent data discrepancy in the
SOV when the payment record is approved, you can view all of the SOV line items that have
been added to the payment grid (Standard tab):

» When partial line items have been included in the CSV or Excel import or RESTful web
services request.

» When the record is created by way of CSV or Excel import or RESTful web services request.
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» When the record is created by way of RESTful web services request (CreateBP Record)
and partial line items that have been included in the input request.

» When the record is updated by way of RESTful web services request (UpdateBPRecord)
and partial line items that have been included in the input request, provided that there were
no other line items added to the payment grid.

When you creating new payment applications, in the Payment Iltems tab, and you are exporting
the record CSV or Excel template (or line item CSV or Excel template):

» If the payment record is created by way of line items or patrial line items (using input from
the CSV or Excel template), then all of the existing SOV lines will be added to the payment
grid along with imported line items if importing is successful.

» If the payment record is created without line items or partial line items (not using input from
the CSV or Excel template), then the system will not add any line items or partial line items
to the payment grid.

» If the payment record is created by way of adding all of the payment line items (using input
from the CSV or Excel template), the all of the line items will be added to payment grid, when
the import is successful.

Oracle recommends that you should set the DD value as default, or define the auto-population,
when the payment detail form has "required" string DEs, such as a short description. If the
required” string DE does not include any value, then the CSV or Excel import or RESTful web
services request will fail because the system will add all of the existing line items from SOV into
the payment grid. In this scenario, the system will generate an error email for record creation, or
the system will generate an error message, in the imported CSV template, for line item creation.

The system will validate when you add payment line items (by way of CSV or Excel import or
RESTful web services request) to the SOV line items even if partial line items have been added,
previously.

Note: The existing process will remain as is for CSV or Excel import or
RESTful web services request of line items in non-standard tabs, within
the Summary Payment Applications SOV BPs.

When you export the record, or line item, CSV or Excel template, the template will display the
following information: "The system will add existing SOV lines into the payment
grid when importing partial line items."

Import Summary Payment Application Line Items Into a BP

You can export a template that includes the detail form fields as columns for a specific business
process. These fields include the detail form line item fields defined in Integration.

You can then modify the exported template and import it to create new line items for the
business process. The exported template contains SOV record information.

When importing Summary Payment line items for Payment Applications BPs, the system uses
the values that the user provided for the auto-populate data elements, if the fields were editable
originally; otherwise, the system uses the values that are from Base Commit line items or
Change Commit line items.
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To export the summary payment application line item template

If multiple tabs are designed for the line items in the business process, only the data in the
Standard tab is exported. For the other tabs, the tab name is included in the exported data for
reference, but no data in these tabs is exported. Data from all columns in the Reference Base
Commit is exported.

1)
2)
3)

4)

Navigate to the summary payment application business process log.
Click Create to create a new business process.

Select a Reference Base Commit for the business process. If you do not select a
Reference Base Commit, the exported template will not contain data. Data from all columns
in the Reference Base Commit is exported.

Open the Menu Options ( =) and hover over Export Line Item Template, then select CSV
or Microsoft Excel.

Depending on your browser, the file will be downloaded automatically, or you will be prompted to
download the file manually.

To modify the summary payment application line item template

1)
2)

3)

Open the exported CSV or Excel file in Microsoft Excel. The SOV line items are listed.

Enter the line item information into the spreadsheet. Each line must begin with a "D". For
multiple tabs, you must enter appropriate tab name in the Tab Name column.

Enter data into the required fields, as well as non-required fields as needed.

Notes:

= Data for formula-based columns is ignored.

= [f auto-populated data is provided, the system will import the value,
and will not override the imported values except for fields
auto-populated by Base Commit, Change Commit, or from SOV.

= Any line items with the Amount equal to zero will not be imported.

= Ensure that you are importing the records you want to import. Any line
items that you import will be added after any existing line items.

= Use to add new lines only, not to modify existing lines
= All data created through the CSV import is rolled up to the cost sheet

= For data to import correctly, you might have to change some of the
cells in the CSV file to Text type. For example, if you have a CBS
code of 1-1, Microsoft Excel can interpret this entry as a month-day
combination and reformat it to Jan-1. In this case, your data import
will fail because this data is now an invalid CBS code.

To import the summary payment application line item template

1)
2)
3)
4)

Navigate to the summary payment application business process log.
Open a business process from the log.

Click the Actions menu and hover over Import.

Select either Data From CSV File or Data From Microsoft Excel File.
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5) Browse to select the file to import, then click Next.
6) Add any attachments to the import.
7) Click Upload when finished.

If there are any import errors, you can open the CSV or Excel file to view and correct the
error. No records are imported if any rows contain an import error.

Adding Partial Line Iltems by way of CSV or Excel import or RESTful web services

When you add partial line items by way of CSV-Excel import or RESTful web services to the
Summary Payment Applications BP, the system will add all of the other existing SOV lines,
along with the line items provided in the CSV-Excel template or RESTful web services input
request.

When you are scheduling payments by creating the payment line items by way of CSV or Excel
import or RESTful web services, you can add all of the payment line items to the grid to prevent
data discrepancy in the Schedule of Value (SOV). To be able to prevent data discrepancy in the
SOV when the payment record is approved, you can view all of the SOV line items that have
been added to the payment grid (Standard tab):

» When partial line items have been included in the CSV or Excel import or RESTful web
services request.
When the record is created by way of CSV or Excel import or RESTful web services request.
When the record is created by way of RESTful web services request (CreateBP Record)
and partial line items that have been included in the input request.

» When the record is updated by way of RESTful web services request (UpdateBPRecord)
and partial line items that have been included in the input request, provided that there were
no other line items added to the payment grid.

When you creating new payment applications, in the Payment Items tab, and you are exporting
the record CSV or Excel template (or line item CSV or Excel template):

» If the payment record is created by way of line items or patrial line items (using input from
the CSV or Excel template), then all of the existing SOV lines will be added to the payment
grid along with imported line items if importing is successful.

» If the payment record is created without line items or partial line items (not using input from
the CSV or Excel template), then the system will not add any line items or partial line items
to the payment grid.

» If the payment record is created by way of adding all of the payment line items (using input
from the CSV or Excel template), the all of the line items will be added to payment grid, when
the import is successful.

Oracle recommends that you should set the DD value as default, or define the auto-population,
when the payment detail form has "required" string DEs, such as a short description. If the
required” string DE does not include any value, then the CSV or Excel import or RESTful web
services request will fail because the system will add all of the existing line items from SOV into
the payment grid. In this scenario, the system will generate an error email for record creation, or
the system will generate an error message, in the imported CSV template, for line item creation.

The system will validate when you add payment line items (by way of CSV or Excel import or
RESTful web services request) to the SOV line items even if partial line items have been added,
previously.
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Note: The existing process will remain as is for CSV or Excel import or
RESTful web services request of line items in non-standard tabs, within
the Summary Payment Applications SOV BPs.

When you export the record, or line item, CSV or Excel template, the template will display the
following information: "The system will add existing SOV lines into the payment
grid when importing partial line i1tems."

Overpayment in Summary Payment Applications SOV

The Data Element (DE) uuu_spa_per_comp (Percentage Complete to Date) is mandatory on the
detail form of a Summary Payment Applications type Payment Application business process.

You can enter values in the detail form (grid) (for uuu_spa_per_comp (Percentage Complete to
Date)) that is above 100 percent.

In the Summary Payment Application SOV structure, you can add a column with Datasource =
Commits Remaining Balance.

If the Commits Remaining Balance column has not been added to the SOV structure, you will
have the ability to overpay (assign a payment amount that exceeds the remaining balance and
the uuu_spa_per_comp value exceeds 100%).

If the Commits Remaining Balance column has been added to the SOV structure, you will not
have the ability to overpay (you will not be allowed to assign a payment amount that exceeds the
remaining balance or to make the uuu_spa_per_comp greater than 100), and the system
displays a detailed message notifying you that the payment amount exceeds the remaining
reference commit balance.

Base Commit SOV Type

Create New Base Contract Summary Payment Application

Based on the upper form properties, designed in uDesigner, if the add, copy, and remove
lineitems options are checked, then you can select Add and create a line item from the
Standard tab, in the Create New Base Contract Summary Pay App window. The following
options will be made available when you click Add:

» Lump Sum

Enables you to create line items with lump sum amount defined at the summary line item and
at the cost breakdown level.

When you select Lump Sum, the summary line item and cost breakdown creation are set.
The amount data element in the summary line item will be editable and any formulas defined
on the amount data element will be retained. The uuu_quantity and uuu_unit_price will be
disabled. The cost line item type for this type of line item will be lump sum. For the lump sum
cost breakdowns, the uuu_amount data element will be editable. You can add the cost
breakdowns with the amounts when the "allow cost breakdown" is configured, in uDesigner.

» Unit Cost
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Enables you to create line items with fixed unit rate defined at summary line item and cost
breakdowns that were added. The system will use the same unit rate to calculate the line
item amount.

When you select Unit Cost, the summary line item will have uuu_quantity and
uuu_unit_price data elements as editable fields. The summary line item can be set as
formula, in uDesigner. The Amount field will be read-only and always calculated based on
the formula configured in uDesigner.

When adding cost break downs, you can enter the CBS Code, a short description, and the
uuu_quantity data element. The uuu_unit_price, for each break own line, will be read-only
and is populated with the value from summary line. The Amount field, for each cost
breakdown, will be calculated based on the formula: quantity * unit price. The Cost Line Item
Type will be displayed as Unit Cost in the line item.

» Variable Unit Cost

Enables you to define a variable unit rate at cost breakdowns. The line item amount is
calculated based on the variable unit rate.

When you select Variable Unit Cost, the summary line item will have the uuu_quantity and
amount data elements editable, but the uuu_unit_price data element will be disabled and
read-only. The Cost Line Item Type will be displayed as Variable Unit Cost in the line item.
The following describes the data elements on the summary line item when the Variable Unit
Cost is selected:

uuu_quantity

The uuu_guantity is an editable and required field. It can be set for either a manual or
formula destination. The uuu_quantity DE can be set as formula, or it can be set as
auto-populate, in uDesigner. The auto-population or formula will work in user mode (at
runtime).

uuu_unit_price
The uuu_unit_price is a disabled field. The formula or auto-populate design does not work
for the Variable Unit Cost line item.

amount

The amount is an editable and required field. It can be set for either a manual or formula
destination. The amount DE can be set as auto-populate, in uDesigner. The
auto-population or formula will work in user mode (at runtime).

In the Variable Unit Cost, the data element uuu_costed_amount (in the upper section of the
line item) will be calculated as sum of the amount (from all cost breakdowns). The
uuu_non_costed amount will be calculated as (amount - uuu_costed_amount). The amount,
in this case, is the line item amount. Similarly, the data element uuu_costed_quantity (in the
line item) will be calculated as sum of quantity entered in all cost breakdown. In the
uuu_non_costed_quantity DE, the data element uuu_costed_quantity, will be calculated as:
uuu_quantity - uuu_costed_quantity.

Regardless of the Line Item type, the right pane displays the Line Item and Cost Breakdown
options.
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Note: The availability of the Cost Breakdown options of Add Cost and
Add Remaining is per uDesigner design. If the Business Process form
does not permit cost breakdown, then these options will not be available.

» Cancel

» Save

» Save & Add New

When you click the Save & Add New option, the Line Item type displayed will be based on the

last cost line item type selected. As a result, if you click Add > Lump Sum and then save the Line
Item and continue to click Save & Add New, then the new Line Item will be of Lump Sum type.

On the right pane:
The Line Item option contains fields that have been designed in uDesigner, and the fields are
similar to those in other Business Processes with the Standard user interface.

The Cost Breakdown option enables you to open a grid that contains fields related to the
Cost Line Item type such as the number, cost code, and so on.

Use the Add Cost and Add Remaining toolbar options to add your cost or the remainder of
the cost.

The "Not Costed Amount" (for Lump Sum) and "Not Costed Quantity" (for Unit Cost) options
are also available.

Cost Breakdown option (Adding costed lines)

When you click the plus (+) icon, the system launches the CBS picker, and you can select
one or more codes and add the codes to the grid.

The gear menu is available when you select a single line item or multiple line items, and it
allows you to copy or remove an item.

Note: You can copy multiple costed lines by selecting multiple line items,
click the gear menu, and click Copy.

Errors

In case of errors in Line Items, the system displays a detailed report inline (Error Location
and Description). The system displays all form level validation errors and required field errors
at the record level error location.

In case of errors in Cost Breakdown, the system populates an error column that contains the
error indication followed by a message.

Add Cost

In the Line Item Details tab, the Cost BreakDown tab, the add cost(+) option will be enabled if in
the upper form properties the Allow Cost Breakdown option is selected in uDesigner.

When you select the add cost option, in the Cost BreakDown tab, the CBS picker will be shown
S0 you can select a single or multiple CBS codes to add their breakdowns. In the cost
breakdown line:

Cost Code and Code Name
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The Cost Code is editable and the default value will be populated from selected code in
the CBS picker. You can double-click and modify the cost code. The Code Name is
read-only and populated by cost code selection.

Short Description

The Short Description is editable. By default, the Short Description data element is
populated from the value of the summary line item short_desc field. You can edit and
modify the field.

uuu_unit_price and uuu_quantity

The uuu_unit_price and uuu_quantity DEs are editable and available for you to enter the
values.

uuu_amount
The uuu_amount, in cost breakdown, will be calculated as uuu_unit_price * uuu_quantity.
Not Costed Quantity and Non Costed Amount

The Not Costed Quantity and Non Costed Amount will be calculated and displayed on the
top of the costed lines.

Total Amount
The Total Amount for all costed lines is displayed.
uuu_costed_amount and uuu_costed _quantity
The uuu_costed_amount and uuu_costed_quantity, in the summary line item, will be
calculated as the sum of amount and quantity from the costed lines.
Remove Cost

You can remove one or more cost breakdowns by using the Remove option (gear menu).
When the selected cost breakdowns are removed, the total amount of the costed lines will be
updated. The uuu_non_costed_amount and uuu_non_costed_quantity will be recalculated
accordingly.

Copy Cost

You can copy one or more cost breakdowns by using the Copy option (gear menu). For
copied costed lines, besides the CBS code, the quantity unit cost and the amount will be
copied.

Adding Variable Unit Cost lines by using the grid
You can add Variable Unit Cost line items in the grid view. Click Insert Line Item and select

the Variable Unit Cost option (similar to the form view). When you click the Insert Line Item,
the following options will be available, based on the form properties

» Lump Sum
» Unit Cost
» Variable Unit Cost

The Cost Line Item Type is set as "Variable Unit Cost" in the line item, when the Variable
Unit Cost option is selected.
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The behavior of data elements uuu_quantity, uuu_unit_price and amount in the Variable Unit
Cost lines will be similar to the cost lines created from the form view. The uuu_unit_price DE,
in the cost breakdowns, will be editable, and you can specify the variable rates for each
costed line. The amount for each cost breakdown will be calculated based on the unit rate

specified. Accordingly, both the uuu_costed_amount DE and uuu_noncosted_amount DE will
be calculated.

In unit cost lines, the uuu_unit_price DE will be editable only on the summary line and
read-only in cost breakdowns.

After the base contract record, which has the line items of both fixed and variable unit cost,
reaches the terminal step, the SOV will be created. The variable unit rates provided in the cost
breakdowns will be rolled up to SOV along with quantity and amount.

The following table explains how the line item consolidation of the Variable Unit Cost lines
takes place:
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Source Business Destination Business | Expected Results What If Scenarios
Process Process
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Generic Cost BP of
CBS type and
Non-SPA BP with
the line items having
cost (Non-SPA)
selected as variable
unit cost type.

Change Commit BP

Summary Payment
Applications SOV
BP (SPA commits)

Copy the line item
from the source. In
the destination
record, the summary
line item will be
created and cost line
item type is
populated as
variable unit cost
type.

Cost breakdown will
be created if the
source line item has
CBS Code defined.

If the source BP is a
CBS cost type, and
the line items are
consolidated from
the standard source,
then both the
summary and the
costed line items will
be created and data
will be populated as
follows:

» The summary
line item will
have both the
uuu_quantity
and the amount
populated. In this
case, the
uuu_unit _pri
ce will be
disabled and no
value should be
populated from
the source.

» The cost
breakdown will
have the CBS
Code,
description,
uuu_gquantity,
uuu_unit _pri
ce, and the
amount
populated.

If the line items are
consolidated from
the non-standard tab
and CBS Code is
not part of the
source line item,
then only the
summary line item
will be created with
uuu_quantity and
the amount
populated.

If the source BP is a
line item type, then
only the summary
line item will be
copied into the
destination.

The summary line
item will have both
the uuu_quantity
and the amount
populated. In this
case, the
uuu_unit_price
will be disabled and
no value should be
populated from the
source.
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SPA commits and
change commits
type BPs with
variable unit cost
line items.

Generic Cost BP of
CBS type and Line
item type BP with
the line items having
cost line item type
selected as variable
unit cost type.

Only the summary
line item will be
copied.

If the destination BP
is a CBS cost type,
then the
consolidation will fail
because the
summary line item
will not have CBS
codes.

If the destination BP
is a line item type,
then using the line
item consolidation
line items will be
copied if all of the
required fields have
values defined. In
this case, the short
description and the
amount are copied
in to the destination
line item, if it exists.

SPA commits and
change commits
type BPs with
variable unit cost
line items.

SPA commits and
change commits
type BPs with
variable unit cost
line items.

Both the summary
line item and thecost
breakdowns will be
copied in to the
destination.

New summary line
items will be created
(with all of their cost
break downs) in the
destination record.

Linked Elements for All SOV Types Except Summary Payment SOV Type

If you set up Base Commit BPs with the following options:

» Select Sub-Type as Line Items with CBS Code
» Enable Create SOV
» Select any SOV Type except Summary payment SOV type

the following data elements can be added as linked elements:

» uuu_scheduled_value
Displays the original scheduled value of a Base Commit BP or General Spends BP of SOV

type.

» uuu_commit_remaining_balance
Displays the remaining balance of a Base Commit BP or a General Spends BP of SOV type

Note: The above data elements can be added to published BP designs

also.

For more details regarding each element, refer to the Unifier Data Reference Guide.

305



Business Processes User Guide

Change Commit Summary Payment Application SOV Type

Create New Change Order with Summary Payment Application

Based on the upper form properties, designed in uDesigner, if the add, copy, and remove line
items options are checked, then you can select Add and create a line item from the Standard
tab, in the Create New Change Order with Summary Pay App business process window. The
following options will be made available when you click Add and when a referenced Base
Commit has "Allow Variable Unit Cost in Cost Breakdown" is selected in uDesigner:

» Lump Sum

» Unit Cost

» Variable Unit Cost

» Modify Committed Line Item

For Summary Payment Application SOV type business processes, the Amount field can be
either editable or read-only based on the following conditions:

» If you add a Lump Sum type line item to a BP, then the system will ignore the existing
formula of the Amount field.

» If you add a Unit Cost type line item to a BP, then the system will retain the existing formula
of the Amount field.

The cost breakdown of Lump Sum and Unit Cost is similar to the Base Commit Summary
Payment Application SOV type BP (cost), explained in the previous section.

The summary and costed line item behavior for the first three options selected will be similar to
Base Commit Summary Payment Application SOV type Business Process records with check
box selected in uDesigner.

For the Variable Unit Cost line items, you are allowed to enter the uuu_unit_price for each cost
breakdown. The amount will be calculated based on the unit rate and the quantity entered. The
summary line item will have the uuu_unit_price disabled.

When you select the Modify Committed Line Item option, the Commit Line Item Picker
window will be displayed. This window enables you to select and modify any line item from the
picker. The cost line item type for the unit cost lines will be the Unit Cost; whereas, for the
variable unit cost lines, the cost line item type will be the Variable Unit Cost.

When you click Save & Add New option, the system displays the Line Item type based on the
last cost line item type that was selected. As a result, if you click Add > Lump Sum and then
saved the Line Item and continue to click Save & Add new, then the new Line Item will be of
Lump Sum type.

When you click Modify Committed Line Item option, and then click Save & Add new, the
system launches the SOV picker.

Commit Line Item Picker
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Note: The fields displayed vary based on the line item selected from the
Commit Line Item Picker

The Cost Break down field, when you select a committed line:

» Committed line = Lump Sum, then the field seen will be "Not Costed Amount."
» Committed line = Unit Cost, then the field seen will be "Not Costed Quantity."

The grid columns are always dependent on line item creation.
Note: Grouping of line items through CSV is not supported for SPA BPs.

When you select the line item of type "Variable Unit Cost," the data element uuu_cost_li_type is
copied over from the reference commit line item into the Change Commit line item and will be
set as read-only.

The uuu_quantity and amount data elements, in the summary line item are editable. The
uuu_unit price DE will be disabled for the summary line item.

If the selected line item has variable unit rates at costed lines, then an additional column
(uuu_unit_price) will be seen in cost breakdowns that is copied over from the SOV.

The following columns will be in cost breakdowns in the Commit Line Item Picker, for the costed
lines that are copied from SOV:

Cost Code

The Cost Code is a read-only field, and the value gets populated from the Commit Line Item
Picker (for the SOV referenced lines). For the new costed lines, the Cost Code field can be
edited, and it can pick from the CBS picker.

Code Name

The Code Name is a read-only field, and the value gets populated from the Cost Code
selection.

Short Description

The Short Description is an editable field. By default, the value for this data element gets
populated from the summary line item short_desc field.

Current Quantity

The Current Quantity column is read-only, and the value for the existing lines will be copied
from the selected commit record. For the new costed lines that are added, this column will be
empty and read-only.

Unit Cost

The Unit Cost column is read-only, and it displays the uuu_unit_price value that is coming
from the selected commit record. For new costed lines added, this column will be
empty and editable.

Current Scheduled Value

The Current Scheduled Value column is read-only, and it gets populated with the
scheduled value from the SOV for the existing costed lines. For the new costed lines,
this column will be 0 and will be read-only.
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Change Quantity

The Change Quantity column is editable and you can enter the values for existing and
new costed lines.

Change Amount

The Change Amount column is read-only, and the value is populated based on the
calculation: Change Quantity * Current Unit Cost.

New Scheduled Value
The New Scheduled Value column is read-only, and the value gets calculated as: Current
Scheduled Value + Change Amount.
In the Commit Line Item Picker, you can:

» Add new costed lines
» Copy existing costed lines
» Remove newly added costed lines
The In the Commit Line Item Picker toolbar options that are available in the Cost Breakdown tab
(for the Commit Line Item) are:
Add Cost

When you select this option, the CBS picker is displayed so you can select single or
multiple CBS codes in order to add the breakdowns. In the cost breakdown line, the
following columns are displayed:

Cost Code

Editable field with value populated from the selected code, in the CBS picker. You can
double-click the field and modify the value.

Code Name

Read-only field with value populated from the selected cost code.
Short Description

Editable field with value populated from the summary line item short_desc field.
Current Quantity

For the new costed lines added, the Current Quantity column value will be empty and
read-only.

Unit Cost
For the new costed lines added, the Unit Cost column value will be empty and read-only.
Current Scheduled Value

For the new costed lines added, the Unit Cost column value will be 0 and cannot be
edited.

Change Quantity
This column is editable and you can enter the values for new costed lines.
Change Amount

This column is read-only and the value is populated based on calculation: Change
Quantity * Current Unit Cost.

New Scheduled Value
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This column is read-only and is calculated as: Current Scheduled Value + Change
Amount.

The gear menu options available for the costed lines are as follows:
Note: You cannot remove the existing line items that are coming from the SOV.

Copy

If you select an existing line item and click Copy, then you will copy the costed line item. THe
current scheduled value will not be copied. Only the unit cost and change gquantity columns
are editable. The new scheduled value will be calculated based on the: change amount +
current scheduled value.

You can copy multiple costed line items at the same time. All these line items must belong to
the same summary line item.

You cannot pick costed lines from different summary line items.
Remove

If you select a new costed line item, then by clicking this option you will remove the
costed line item.

For the committed costed line item (line items coming from the SOV), the Remove option
is not available.

After the Change Commit record is routed to the terminal step, the SOV will be updated with
both the modified quantity and the new scheduled value, for costed lines that exist in the SOV .

The variable unit rates that are provided in the cost breakdowns will be rolled up to the SOV,
along with the quantity and amount for new lines.

Totaling Cost Breakdown Values

This section explains the following topics:

Note: The following applies when the "Total the Cost Breakdown
values to the line item" option is checked in the form. Go to uDesigner
grouping node > Business Processes > Payment Applications >
Upper Forms > Properties > General tab > Line Items block.

» Totaling Cost Breakdown to the Line Item
Totaling cost breakdown values to the line item
» Totaling Line Item in Payment Application
Totaling the line in the Payment grid of Payment Application
» Totaling Line Item in Summary Payment Application
Totaling the line in the Payment grid of the Summary Payment Application
» Line Item and Sum of Costed Line
When the line item field value does not match the sum of costed line values
Summary Line item
Summary Row Totals
»  Summary total
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» Line item total

Totaling Cost Breakdown to the Line Iltem
The totaling cost breakdown to the line item can be done for:

» Line items with editable numeric data element columns (line item and costed lines)
» Line items with editable numeric data element columns (line item and costed lines)
» Line items with cells that are based on formula
» Line items with cells that are percentages

The following explains each option.

Line items with editable numeric data element columns (line item and costed lines)

You can see the sum of all the costed line item values after entering the pertinent values in the
editable fields (line item and costed lines). That is, when you enter values in the costed line
items, the system sums up those values and displays the resulting value in the corresponding
cell of the line item.

Example

Contracts with Cost Break down

Enter the costed line item information in the “Other Amount this Period” field. After you click
elsewhere, the system displays the sum total of the costed line item values in the "Other
Amount this Period" field of the line item.

Line items with editable numeric data element columns (line item and costed lines)

If the fields are read-only, then there are not summations.

Line items with cells that are based on formula

When the line item cell has a formula definition, then the sum (roll up) for the cell in the line item
is not generated from the costed line items. The calculation for this cell is based on the line item
values.

Example

"Completed and Stored to Date" is a formula field = Total Previous Payments
<uuu_spa_prev_amt> + Requested this Period <spz_total_tp> + Stored Materials Amount
<uuu_spa_mat_stored>. As a result, the cell value for "Completed and Stored to Date" in the
line item = Total Previous Payments <uuu_spa_prev_amt> + Requested this Period
<spz_total_tp> + Stored Materials Amount <uuu_spa_mat_stored>.

During runtime, the system Data Element (DE) uuu_spa_prev_amt, on a Summary Payment
Applications detail form, is calculated by the system as the sum of following (from SOV):

» The uuu_spa_prev_amt, and
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» The data element selected in udesigner option "Total Previous Payments = Total Previous
Payments + ..."

By default, uDesigner selects the "Amount” field from the system detail form in this option and
the formula for uuu_spa_prev_amt equals the sum of:

» The uuu_spa_prev_amt from SOV, and
» The amount from the SOV.

If the user selects some other option in uDesigner, for example, the data element "Amount
Requested this Period," then the formula for this field would become:

» The uuu_spa_prev_amt from SOV, and
» The amount Requested This Period from SOV

Line items with cells that are percentages

System-defined uuu fields and user-defined custom formula fields, which are treated as
percentages field and set as formulas, do not sum up the values from the costed lines to the line
item.

Totaling Line Item in Payment Application

The Total row, at the bottom of grid, displays the total for payment lines (costed line items) when
the values are:

» Manually entered
» Formula based
» Percentages

In the total Row, all the numeric columns display the total of the Summary Line items.
Note: With version 23 and later, a Total row on a non-standard tab of a

line item grid is not displayed. For version 22 and earlier, the Total row
displays a 0.

Totaling Line Iltem in Summary Payment Application

In the Total Row, the manual data element columns display the total of the Summary line item
values.

The calculation in the Total Row is applicable for both Payment Application and Summary
Payment Application.

Note: With version 23 and later, a Total row on a non-standard tab of a
line item grid is not displayed. For version 22 and earlier, the Total row
displays a 0.
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Line Item and Sum of Costed Line
When the line item field value does not match the sum of costed line values:

For fields that are editable, the line item cell displays a small triangle to indicate that the totals do
not match.

Note: The small triangle is displayed based on the selection that has
been made in the Upper Form option "Costed line item total must be
equal to the line item total". If the check box for Costed line item total
must be equal to the line item total is unchecked, then the red triangle
does not display. If the check box for Costed line item total must be
equal to the line item total is checked, then the Data Element is
configured to show the Summary Total as Sum of All Rows (there is a
total mismatch), and the red triangle is displayed.

When the user clicks the small triangle, the system displays an information text and informs the
user about the differences. This is applicable only for the line item.

Note: The alert is not displayed for uuu_spa_per_comp field because
the field values of costed lines and summary lines will always have a
discrepancy.

Summary Line Item
The (Summary) Line item row is gray when the line is not editable.
The (Summary) Line item row is editable if the row is displayed:

» In bold font.
» With thick borders.

To be able to modify Line Items, you must select the "Allow Modification of Line Items option
in the Creation step.

You can define whether or not you want the value of the Data Element (DE)
uuu_spa_per_comp (from summary row) to apply to all costed lines (in a summary Payment
Application grid) automatically. This enables you to avoid filling each costed line value manually
and have a better user experience.

If the Allow viewing of Costed line items and Allow Modification of line item options are
selected (checked) in the Upper Form of a Payment Application type BP (which references a
Base Commit of SOV Type = Summary Payment Applications) in uDesigner, the runtime SPA
grid provides a check box option labeled Apply line item value of <label of DE
uuu_spa_per_comp>to costed lines (in the upper-right corner of the grid) to enable you to
apply the line item value to costed lines.
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When you select the check box option labeled Apply line item value of <label of DE
uuu_spa_per_comp>to costed lines, the system copies the value of the data element
uuu_spa_per_comp (from the summary lines) into the corresponding costed lines. The
subsequent impact on fields uuu_spa_amt_tp / uuu_spa_qty_tp in the costed lines is similar to
just as if you made a manual edit of uuu_spa_per_comp in the costed lines to trigger the update
of these fields.

To proceed, select the Apply line item value of <label of DE uuu_spa_per_comp>to costed
lines option (at the upper-right corner of the detail form). This selection impacts only those lines
that are edited after checking the box, and the existing, or edited, lines will remain as they were.

If the Apply line item value of Percentage Complete to Date to costed Lines option is
selected (checked), the system performs all the form-level validations, for the Costed line items,
after saving the line items (clicking Save).

The following scenarios explain the behavior, when you edit a line item, or costed rows, after
checking the box.

Scenario 1
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Scenario 1-a

The uuu_spa_per_comp is editable and
the Apply line item value of 'Percentage
Complete to Date' to costed lines
options is selected (checked) when the
user enters a value for field
uuu_spa_per_com in the summary row:

a) The corresponding uuu_spa_amt_tp
or uuu_spa_qty_tp (depending on
whether it is a Lump sum or Unit Cost
type line item) in the summary row
should get back-calculated as per the
new value of uuu_spa_per_com.

b) All child costed lines should get
auto-populated with the same value as
the summary cell for
uuu_spa_per_com.

c) The fields uuu_spa_amt_tp or
uuu_spa_qty_tp for all costed lines
get back-calculated according to the
newly populated value of
uuu_spa_per_com.

In this case, the system stops at
back-calculating the costed row values
for uuu_spa_amt_tp or
uuu_spa_qty_ tp and does not roll
the values into the line item value again
(even if the option Total the Cost
Breakdown values to the line item is
checked). Here, if the back-calculated
values of uuu_spa_amt_tp or
uuu_spa_qty_tp total to a penny off
from the line item cell value, the system
adjusts that penny in the last costed
line.
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Scenario 1-b The uuu_spa_per_comp is editable and
the Apply line item value of 'Percentage
Complete to Date' to costed lines
options is selected (checked) when the
user enters a value in the summary cell for
fields uuu_spa_amt_tp or
uuu_spa_qty_tp, depending on whether
it is a Lump sum or Unit Cost type line
item:

a) The summary row field
uuu_spa_per_com is calculated by
the system.

b) At the same time, all child costed lines
get auto-populated with the same
value as the summary cell for
uuu_spa_per_com.

c) The fields uuu_spa_amt_tp or
uuu_spa_qty_tp (depending on
whether it is a Lump sum or Unit Cost
type line item) for all costed lines get
back-calculated according to the newly
populated value of
uuu_spa_per_com.

In this case, the system stops at
back-calculating the costed row values
for uuu_spa_amt_tp or
uuu_spa_qty_tp and does not roll
the values into the line item value again
(even if the option Total the Cost
Breakdown values to the line item is
checked). Here, if the back-calculated
values of uuu_spa_amt_tp or
uuu_spa_qty_tp total to a penny off
from the line item cell value, the system
adjusts that penny in the last costed
line.

315



Business Processes User Guide

Scenario 1-c The uuu_spa_per_comp is editable and
the Apply line item value of 'Percentage
Complete to Date' to costed lines
options is selected (checked) when the
user enters a value in the summary cell for
a field that impacts calculation of
uuu_spa_per_comp (such as
uuu_spa_mat_stored or
uuu_spa_other_tp):

a) The summary row field
uuu_spa_per_com get calculated by
the system.

b) At the same time, all child costed lines
get auto-populated with the same
value as the summary cell for
uuu_spa_per_com.

c) The fields uuu_spa_amt_tp or
uuu_spa_qty_tp (depending on
whether it is a Lump sum or Unit Cost
type line item) for all costed lines get
back-calculated according to the newly
populated value of
uuu_spa_per_com.

In this case, the system stops at
back-calculating the costed row values
for uuu_spa_amt_tp or
uuu_spa_qty_tp and does not roll
the values into the line item value again
(even if the option Total the Cost
Breakdown values to the line item is
checked). Here, if the back-calculated
values of uuu_spa_amt_tp or
uuu_spa_qty_tp total to a penny off
from the line item cell value, the
system adjusts that penny in the last
costed line.

Scenario 2

In this scenario, the uuu_spa_per_comp field is read-only, but any of the other fields that impact
its calculation (uuu_spa_amt_tp, uuu_spa_qty_tp, uuu_spa_mat_stored, or
uuu_spa_other_tp) are editable, and the option Apply line item value of <label of DE
uuu_spa_per_com>to costed lines is checked. In such scenario:
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Scenario 2-a

If the user modifies the summary cell value
for any of the editable fields, the behavior
will be similar to Scenario 1-b and
Scenario 1-c, above.
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Scenario 2-b

If the user modifies the costed row value
for any of the editable fields (existing
functionality), then the corresponding
costed row value of uuu_spa_per_com
gets calculated by system. This does not
result in roll up, or impact, the summary
cell value of uuu_spa_per_com, even if
the option Total the Cost Breakdown
values to the line item is checked.

You can select (check) the Apply line
item value of <label of DE
uuu_spa_per_com>to costed lines
option and the proceed to deselect
(uncheck) it. Deselecting the option does
not revert any of the changes that you had
made when the option was selected, but it
impacts the future operation and the
subsequent summary value changes for
uuu_spa_per_com will not automatically
copy into the costed lines.

If you make manual changes (after
deselecting the option), then select the
option again:

» The manual changes that you had
made remain as they were.

» The roll-down behavior from summary
to costed rows occurs for all the
subsequent summary row changes.

If you select (check) the Apply line item
value of <label of DE
uuu_spa_per_com>to costed lines
option, the system lets you only push the
values down from the line items to the
costed row (for uuu_spa_per_com).

Even if the option Total the Cost
Breakdown values to the line item is
enabled, the system does not allow roll-up
from the costed rows to line item for the
following Data Elements:

» uuu_spa_per_com
» uuu_spa_amt_tp
» uuu_spa_qty_tp
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Summary Row Totals

The costed lines can be defined to rollup to their summary line items as "Sum of all rows" by
using the form option "Total the Cost Breakdown values to the line item" in uDesigner (for a
Payment Application BP which has reference to a Contract type BP of SOV Type: "Summary
Payment Applications").

Similar to the "Totals: for fields on a Summary Payment Application detail form, you can define:

» The fields from costed lines sum up to the summary line item.
» The fields from costed lines do no sum up to the summary line item.

The values in summary line item fields populate as defined in uDesigner (Manual, Formula, or
Auto-populate).

The following sub-sections provide details about when the option Total the Cost Breakdown
values to the line item is checked (Summary Row Totals), or is not checked (Line Item Total),
in uDesigner.

Summary Total

During runtime, if the uDesigner upper form option "Total the Cost Breakdown values to the line
item" is checked, then the Summary row values in Payment Applications grid displays per
"Summary Total' option, selected by the user in detail form. The following table "Summary Total"
provides details:

Costed Row Data Element Costed Row Data Element Summary Row Value
Settings in uDesigner Settings in uDesigner
Data Entry / Access Summary Total

Manual / Editable/Editable |As Defined Editable. The value shows
Required as 0 or $0.00, per Data
Element (DE) Data
Definition (DD). The user
can double-click into the cell
and enter any value as per
the DE Data Definition**. If
the user deletes the value in
the cell, it reverts to O (zero)
or $0.00, whichever
applicable.

Manual / Editable/Editable | Sum of All Rows Editable. The value shows
Required sum of all costed lines. The
user can double-click into
the cell and enter any other
value, per the DE Data
Definition**. If the user
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Costed Row Data Element
Settings in uDesigner
Data Entry / Access

Costed Row Data Element
Settings in uDesigner
Summary Total

Summary Row Value

deletes the value in the cell,
it reverts to O (zero) or
$0.00, whichever
applicable.

Manual / Read-Only

As Defined

Read-Only. Value: O (zero)
or $0.00

Manual / Read-Only

Sum of All Rows

Read-Only. Value: Sum of
all costed lines

Formula (Always
Read-Only)

As Defined

Read-Only. Value:
Calculated according to the
formula defined for the DE.
Note: If the DE is set as
Formula, the option As
Defined is selected for the
Summary Total.

Formula (Always
Read-Only)

Sum of All Rows

Read-Only. Value: Sum of
all costed lines

Auto-populate /
Editable/Editable Required

As Defined

Editable. The value shows
the auto-populated value,
per definition. The user can
double-click into the cell
and enter any value as per
the DE Data Definition**. If
the user deletes the value in
the cell, it reverts to O (zero)
or $0.00, whichever
applicable.

Auto-populate /
Editable/Editable Required

Sum of All Rows

Editable. The value shows
sum of all costed lines. The
user can double-click into
the cell and enter any value
as per the DE Data
Definition**. If the user
deletes the value in the cell,
it reverts to O (zero) or
$0.00, whichever
applicable.

Auto-populate / Read-Only

As Defined

Read-Only. Value: The
auto-populated value, per
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Costed Row Data Element
Settings in uDesigner
Data Entry / Access

Costed Row Data Element
Settings in uDesigner
Summary Total

Summary Row Value

definition

Auto-populate / Read-Only

Sum of All Rows

Read-Only. Value: Sum of

all costed lines

** |f there is a total mismatch, then a red triangle symbol appears in the cell and when you click
the red triangle symbol the cell displays the difference.

During runtime, the following DEs (summary row total value fields) are exception to the above
settings:

» scheduled value

» uuu_spa_prev_amt

» uuu_spa_per_comp

The uDesigner properties for the fields above are set as "Manual," but the system calculates the
value of these fields as a system-calculated hard-coded formula.

» The summary cells for these three fields are calculated per system-defined hard-coded
formula for each line.

» The fields are Read-Only, Editable, or Required per uDesigner setting.
» If Editable, or Required, then you can double-click into the cell and enter any other value,
per the DE Data Definition.

» If there is a total mismatch, then a red triangle symbol appears in the cell and when you
click the red triangle symbol the cell displays the difference.

Line Item Total

If the uDesigner option "Total the Cost Breakdown values to the line item" is unchecked, even if
the "Summary Total" option has been defined in detail form, the costed lines do not roll up to the
summary rows in any of the forms. The following table lists additional scenarios:

Item Check box Check box Summary Total |Expected
"Total the Cost |"Costed Amount |definition fora |behavior of
Breakdown must be equal to |numeric Data corresponding
values in the the line item Element on the |summary cell
lineitem"” in the |total" in the BP |BP detail form during runtime
BP upper form upper form

1 Unchecked Unchecked As Defined Blank,
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Item

Check box
"Total the Cost
Breakdown
values in the
line item" in the
BP upper form

Check box
"Costed Amount
must be equal to
the line item
total" in the BP
upper form

Summary Total
definition for a

numeric Data

Element on the

BP detail form

Expected
behavior of
corresponding
summary cell
during runtime

editable/require
d/read-only, per
definition.

Unchecked

Unchecked

Sum of All
Rows

Blank,
editable/require
d/read-only, per
definition.

Unchecked

Checked

As Defined

Blank,
editable/require
d/read-only, per
definition.

Unchecked

Checked

Sum of All
Rows

Blank,
editable/require
d/read-only, per
definition.

Checked

Unchecked

As Defined

If the DE is set
to "Manual," the
summary cell is
0 (zero). The
field is
editable/require
d/read-only, per
definition. If the
field is
editable/require
d, you can
change the
value.

Checked

Unchecked

As Defined

If the DE is set
to "Formula,"
the summary
cell is calculated
per formula.
The field is
read-only.
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Item Check box Check box Summary Total |Expected
"Total the Cost |"Costed Amount |definition fora |behavior of
Breakdown must be equal to |numeric Data corresponding
values in the the line item Element on the |summary cell

line item" in the |total" in the BP |BP detail form during runtime
BP upper form upper form

5 Checked Unchecked As Defined If the DE is set
to
"Auto-populate,
the summary
cell shows the
auto-populated
value. The field
is
editable/require
d/read-only, per
definition. If the
field is
editable/require
d, you can
change the
value.

6 Checked Unchecked Sum of All The summary
Rows cell is populated
by the system
as sum of all
rows. This field
is
editable/require
d/read-only, per
definition.

7 Checked Checked As Defined If the DE is set
to "Manual," the
summary cell is
0 (zero). The
field is
editable/require
d/read-only, per
definition. If the
field is
editable/require
d, you can
change the
value.

Note: This
behavior
overrides the
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Item

Check box
"Total the Cost
Breakdown
values in the
line item" in the
BP upper form

Check box
"Costed Amount
must be equal to
the line item
total" in the BP
upper form

Summary Total
definition for a
numeric Data

Element on the
BP detail form

Expected
behavior of
corresponding
summary cell
during runtime

check box
"Costed Amount
must be equal
to the line item
total" and must
be allowed.

Checked

Checked

As Defined

If the DE is set
to "Formula,"
the summary
cell is calculated
per formula.
The field is
read-only.

Note: This
behavior
overrides the
check box
"Costed Amount
must be equal
to the line item
total" and must
be allowed.

Checked

Checked

As Defined

If the DE is set
to
"Auto-populate,”
the summary
cell shows the
auto-populated
value. The field
is
editable/require
d/read-only, per
definition. If the
field is
editable/require
d, you can
change the
value.

Note: This
behavior
overrides the
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Item Check box Check box Summary Total |Expected
"Total the Cost |"Costed Amount |definition fora |behavior of
Breakdown must be equal to |numeric Data corresponding
values in the the line item Element on the |summary cell

line item" in the |total" in the BP |BP detail form during runtime
BP upper form upper form

check box
"Costed Amount
must be equal
to the line item
total" and must
be allowed.

8 Checked Checked Sum of All The summary
Rows cell is populated
by the system
as sum of all
rows. The field
is
editable/require
d/read-only, per
definition. The
system applies
the check box
"Costed Amount
must be equal
to the line item
total" and
prevents if you
manually
change the
value to
something other
than sum of all
rows.

Request for Bid (RFB) Business Processes

The Request for Bid (RFB) feature allows companies to invite bids from vendors and suppliers.
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Note: The system lets your company designate only one Vendors
business process as the RFB master vendor list (master vendor
BP/vendor master BP).

The bid invitation can be addressed to a specific set of vendors or can be opened to the public.
The bidders are provided with a simple Unifier interface that does not require special training to
use. Bidders receive email notifying them that they have received a bid invitation so they can log
on to the system and submit their bids.

The bidder portal enables the bidder to use the Announcement icon ( ® ) to view
announcements by the owner company. The Bidder Business Process log (Bidder BP log)
enables the bidder to view all requests, their titles, due date, and status.

The Bidder BP log has the following options:

> View
» Active
» All
Refresh: To refresh the log items.
Print: To print the log contents.
Search
» Status with values of All, Open and Closed
» Search parameters based on Bidder log setting
Find on Page: To find content on the visible page.
Help: To view help options.

The gear menu ( ¥ ), in front of each record, is context sensitive and provides the following
conditions and corresponding options:

Condition Options

Bid has been received and no submissions | Open - Opens the requestor's form
have been made Create - Will open the bid form

Bid has been submitted Open - Opens the requestor's form

View Submission

Withdraw Submission - Confirmation
asking user to confirm action. After a
successful withdrawal, an alert will be seen
Note: After a bid has been withdrawn,
options seen will be: Open

Bid has been closed View Submission - This will open the
submitted bid

Double-clicking the record will open the
submitted bid form.

The preview pane, on the right side, contains:
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» The form content, based on the current state of the record.
» If the bid is active (just received a RFB or submitted a bid), then the requestor form is
displayed.
» If the bid is closed, then the content of the submitted bid is displayed.
» The Attachments tab is displayed.

The Mailbox provides a preview of a selected email, in the right pane. The Mailbox has an Inbox
and a Sent Items section. The Inbox lets bidders view all the mails received from Unifier.

The RFB type BP supports the Grid feature when the RFB design includes the subtype: Line
Item with CBS Code. The Grid feature is available both in the Requestor and Bidder sides,
within the Line Item tab.

Request for Bid (RFB) Type Business Process Form (Private)

If you have been invited for a private bid, you receive an RFB business process form that is not
configured for public bidding. In such case, the upper form and detail form contain the following
elements:

1) Go to the project/shell tab and switch to User mode.

2) Inthe left Navigator, click Logs and open an RFB BP.

3) Open a record.

The record details screen opens with the following elements:

» Send

» Save

» Menu Options

» Tabs

» General

» Line ltem

» Winning Contract

» Proposal Management

The Menu Options enables you to perform the following actions:

» Print
To print the form (HTML, PDF, Custom)
» Reload
To reload the information presented.
» Review
To preview an attachment.
Terminate Record
Transfer Ownership
Undo Accept Task
Help
To access the BP help and User Productivity Kit

v v v Vv
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» Close

Tabs (RFB Creation Form)
On the left pane, the RFB Creation Form tab contains the following field blocks:

» General
» Details
» Calculation

On the right pane, the RFB Creation Form tab contains the following tabs:

» Attachments

» Comments

» Linked Records

» Linked Mail

» Workflow Progress
» Audit Log

» Reference Records

Tabs (RFB Line Item List)
On the left pane, the RFB Line Item List tab contains the following toolbar options:

Form View
Grid View
Add

Actions
Refresh

Print

Search

Find on Page

v vV vV vV vV vV v Vv

On the left pane, the RFB Line Item List tab contains the following columns:

No.

Attachments

Linked Records

WBS Code

Short Description

Line Item Last Update Date
Item Quantity

Iltem Unit Cost

Unit of Measure

Amount

vV vV vV vV vV vV vV v v v

The Total Amount is displayed at the bottom of the left pane.
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On the right pane, the RFB Line Item List tab contains the following tabs:

» Line Item Details
» Attachments
» Linked Records

When the RFB record is first completed, the Winning Contract tab will be visible.
On the left pane, the Winning Contract tab contains the following toolbar options:

» Form View

» Grid View

» Refresh

» Print

» Search

» Find on Page

On the left pane, the Winning Contract tab contains the following columns:

» No.

» Attachments

» Linked Records

» Short Description

When the bid is initiated, the Proposal Management tab will be visible.
On the left pane, the Proposal Management tab contains the following toolbar options:

» Add

» Send Invitation

» Actions

» Refresh

» Find on Page

On the left pane, the Proposal Management tab contains the following columns:

» Attachments
> Malil

Inviting to RFB

For public bidding, invitations are sent to the Vendors that you have selected from the Vendors
business process (a company-level BP). The Vendors BPs can be found in Company Logs >
User mode > Vendors BP.

To start the bidding process:

1) Goto your Project > User mode > Logs > Request for Bid.
2) Open the bid that you want to send.
3) Go tothe Proposal Management tab.
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If this is the first time you are sending an invitation, click Add to open the Add Vendors

window, select the applicable Vendors BPs, and move them from the Available block to the
Selected block. When all the applicable vendors have been selected, click Add. See Public
Bidding (on page 335) and Private or Non-Public Bidding (on page 336) for more details

about the options in the Proposal Management tab.
4) Select a vendor from the log.

If you are sending an invitation for the first time, click Send Invitation. Unifier sends two
emails:

I. An invitation email, which contains the Unifier Login URL.
2. A credential email, which contains the user name and password.

If a vendor who has received an invitation loses their password, the vendor can change their
password with the Forgot Password link on the Sign In page. For best results, bidders
should change the password at the first log in, and then sign in using the newly set
password.

The left section includes the general information about the requestor and the bid.
To modify the date, click the date icon, modify the date, and click Done.

The right panel includes the list of invitees to whom the invitations have been either sent out or
will be sent in future.

When you click Add, a new full-screen window overlay appears (similar to BP Picker) that lets
you select the list of vendors (from the Master Vendor List BP) that you want to add to the
invitees list.

Add vendors by selecting items from the Available list and moving them to the Selected list,
using the arrow buttons in the middle. Click Add when finished.
The gear menu ( % ) options in the left tab are:

» Open Vendor Details
» Remove
» Send Mail

Be aware that these options change depending on the Status of each invitation. For example,

Send Mail is not available for vendors whose Status is Not Invited and Remove is visible but only

functional for vendors whose Status is Not Invited.

Be aware that these options change depending on the Status of each invitation. For example,
Send Mail is not available for vendors whose Status is Not Invited.The right pane displays the
following tabs:
» Attachments
» Mail

For correspondence with internal team members.
For an RFB BP that is enabled for public bidding, if you click Send Invitation after the BP is

opened for public bidding, the system displays an overlay screen that lets you modify the due
date. Modifying the due date in public bidding is similar to the same feature in private bidding.
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Audit Log in Requestor BP (Private Bid and Public Bid)

The system audits all emails sent to the bidder (initial invitation, revised attachments, and so on)
and makes the information available in the Audit Log tab of the Requestor BP record. The
Audit Log captures the following events when an email is sent to a bidder:

» Adding new addendums
» Revising Addendums
» Removing Addendums or original attachments

In all the preceding cases, the event name will be Bidding. Furthermore:

» For adding addendums, the Action name will be "Send Addendum <Attachment name>."

» For Revising addendums, the Action name will be "Send Revised Addendum <Attachment
name>."

» When addendums or original attachments are removed, the Action name will be "Removed
Addendum <Attachment name>" or "Removed Original Attachment <Attachment name>."

» Also, the attachment name is displayed in the Audit Log entry.

Language, Time Zone, and Date Format for Vendors BP

While creating a Vendors BP, you have an option to set the language, date format, and time
zone specific to your bidders:

Note: The languages listed are the active languages selected by the
administrator in the Configuration - Internationalization log.

» Contact Language:
» Date Format:
» Time Zone:

Note: The DEs mentioned above must be included in the RFB master
vendor list BP (master vendor BP/vendor master BP) in uDesigner in
order to be selected by the user in runtime.

The notifications follow the preferences of the user who has been specified in Bid Management
Account field (Company Workplace > Admin mode > Company Workspace node > Open >
Bid Management Account), who is designated as the manager for all bidders, or the company
bid contact.

Selecting the above options enables the bidder to receive email notifications (also Unifier Bidder
Portal web page content and Bidder forms) in the bidder's language, date format, and time zone.

If the above options are not available, or not selected, the bidder receives email notifications
(also Unifier Bidder Portal web page content and Bidder forms) following the user preferences
whose name is indicated in the Bid Management Account field.

Note: If the RFB master vendor list BP (master vendor BP/vendor
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master BP) includes Date Format data element but no value is selected,
the system displays a default date format (for example, MM/DD/YYYY
HH:MM AM). The Company Administrator must set the respective
bidder's date format in the RFB master vendor list BP.

Unlike a standard user, a bidder user cannot change the preferences in the bidder portal. When
this option is clicked, the Preferences set forth in Vendor information record (for the vendor) will
be seen in view only mode.

Working with RFBs

The RFB business process has a reference process to a vendor list business process, which
contains the pool of vendors to whom the RFB will be sent. This vendor reference process will
populate the upper fields of the RFB at runtime. The system automatically launches this
reference process, when the RFB is activated.

After the RFB Business Process is active in the system, the bid procedure runs as follows:
You (the person who starts the bidding process and sends the invite):
1) Start the bid procedure by opening the RFB, filling in the form, and sending it for internal
review (if necessary).
2) When the internal review is complete, you:
a. Assemble the bid package and prepare the bid invitation for distribution.

b. Send out the bid invitations, along with a user name and password, so that the vendors
can log on to Unifier and submit their bids.

After the bid invitations have been sent, you must wait for the bid due date to pass.
The vendors:

1) When the vendors receive the bid invitation, they log on to Unifier and open the bid request.

2) (Optional) The vendors can request clarification of any questions or issues before submitting
the bid. (The vendors can use the Mailbox link on the bid request for this purpose.)

3) The vendors then submit their bids.
You (the person who started the bidding process and sent the invite):

1) When the due date for all bids is reached, you tabulate the bids for comparison.
2) Open discussions about the bids, if necessary.

3) Award the bid to a vendor and automatically generate a contract copying relevant details
from bid record into the contract.

4) Select a winning bid, after discussions with the members of your team.

In Unifier, you can create a contract from the winning bid (the bid that was selected from multiple
bids) automatically, and the contract that is generated automatically will have a copy of the data
from the winning bid (terms and negotiating amounts), if any. For more information, see Select
Winning Bid and Auto-create Contract.

Active bids in Bidder log

When you open the Attachments tab, the following blocks and sub-blocks will be present,
depending on the bid status:
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» Unpublished Attachments
» Addendums
» Published Attachments
» Original Attachments
All active bids can receive additional attachments, from the requestor. When the bidder opens or

views the bidding in the log, the new or additional attachments will be shown under the
Addendums block.

When a bid receives a new attachment, as addendums, the system sends a new email to all
bidders. The system sends a similar email when an existing bid attachment is removed.

Sending the Bid Request for Internal Review and Approval

For most companies, an internal review is necessary for the purpose of verifying the scope of
the project as well as other issues such as terms and conditions, architectural drawings, and
structural materials.

To send the Bid Request for internal review and approval:

1) Navigate to the RFB log, and click Create. The RFB BP form opens.
2) Complete the form.

3) After you submit the form for review, use the Workflow Actions list to send the RFB into the
workflow.

After the approval request reaches the middle of the workflow, you receive the completed BP
as a task in your Tasks log. When you open the form this time, you should see a Send
Invitation button on the toolbar of the Proposal Management tab, with which you can start
the bidding process.

After the bid request is approved, you can start the bidding process.

Starting the Bidding Process

After the RFB has completed the internal review and approval, you can start the bidding
process.

To start the bidding process:

1) Goto your Project > User mode > Logs > Requests for Bid.
2) Open the bid that you want to send.
3) Gotothe Proposal Management tab.

If this is the first time you are sending an invitation, click Add to open the Add Vendors
window, select the desired Vendors BPs, and move them from the Available block to the
Selected block. When all the desired vendors have been selected, click Add.

4) Select a vendor from the log.

If you are sending an invitation for the first time, click Send Invitation. The system sends two
emails:

I. An invitation email (contains the Unifier Login URL)
2. A credential email (contains the username and password).
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If a vendor who has already received an invitation loses their password, the vendor can
change their password with the Forgot Password link in the Sign In page. For best results,
bidders should change the password at the first log in, and then sign in to Unifier using the
newly set password.

The following provides additional information regarding the bidding process:

»

If you need, you can modify the bidding due date in the upper portion of the Proposal
Management tab.

The list of vendors you use to distribute the bid invitations can include your company's entire
list of vendors or a list of "approved vendors" specific for the project you are working on.
Your administrator can design a business process that filters the master list of vendors into a
sub-set of this list for your project. If such a sub-set of the vendor list has been created for
your project, this is the list of vendors you will see in the Bidders window, unless this is a
public bid. For public bids, the filtered vendor list will be ignored.

To see the approved list of vendors with more information, go to your project Logs grouping
node in the Navigator and click the business process that created the vendor list for your
project. The system will display the list of records in that business process. To see the
approved list, click the View filtered Records button on the toolbar.

Note: After you have sent out all the bid invitations, the system freezes
the RFB until the bid due date passes. After the due date passes, you
can compare the bids.

Filtering Bidders
During the BP run-time, the list of available bidders depends on the options set in uDesigner.

» When you do not select set additional filter for a bidder in the RFB BP, and you are in a

Shell, then:

If a Line Item type BP of sub-type, "Line item to filter Company BP record" exists and the
option of, "Use Master Vendor list filtered at Project level" is checked, then the list of vendors
will be filtered based on this existing functionality.

When you select set additional filter for bidder in the RFB BP and you are in a Shell, then:

A filtered list of potential bidders is listed which includes all those bidders referenced by the

BP Data Picker and the system ignores the Line Item type BP of sub-type, "Line item to filter
Company BP record.” To see the approved list of vendors with more information, go to your
project Logs grouping node in the Navigator and click the business process that created the
vendor list for your project and click the View filtered records button in the toolbar.

The BP Data Picker:

» Does not need to be populated in the RFB form.
» Value will always be ignored, and the system uses the query conditions on the Data Picker

to filter the list of vendors.

If no query conditions are defined for the BP Data Picker, then you will see the list of all vendors.
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In uDesigner, you can place the BP Data Picker, in the RFB BP, in a hidden block. If the BP
Data Picker is placed in the hidden block, you can filter the list of vendors through the defined
query conditions.

Public Bidding

For public bidding, invitations are sent to the Vendors that you have selected from the Vendors
business process (a company-level BP). The Vendors BPs can be found in Company Logs >
User mode > Vendors BP.

The option for public bidding is set in uDesigner: Company Workspace > Admin mode >
uDesigner; selected RFB Business Process > Open > General > Options tab: Allow public
bidding (no pre-defined bidders).

Public Bids: Requestor BP - Invite form
When you select the Invite option (from the menu icon), after the BP has been opened for public
bidding, the Invite overlay page opens. The following blocks are displayed on the Invite overlay
page:
» General
This block has the following fields:
» Title
» Requester Name
» Phone
» Due Date
» Email
» Invitation
This block has the following toolbar options:
» Add
To add invitee.
» Send
To send password.
This block has the following columns:
» First Name
» Last Name
» Company
» User Id
» Sent Date

The Invite overlay page has the following tabs (right pane):

» Attachments

Go to this tab to add additional attachments through using the Browse or Document
Manager options, similar to the Private or Non-Public Bidding (on page 336).
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All the attachments that have been added, from this form, are shown in the Addendums as
well as the Attachments tab of the Requestor form (Request for Bid), similar to the Private or
Non-Public Bidding (on page 336).

In the Requestor form (Request for Bid), Attachments tab, you can see the attachments that
have been added from the Proposal Management tab. After uploading a file to the
Attachments tab, the bidder is allowed to rename the file to ensure that meaningful names
are used within the proposal.

The new column, Addendums, can be seen under the Attachments tab in the BP log of the
RFB records. The additional attachments, added from the Invite form and sent to bidders,
are also shown under the Attachments tab in the BP log, but they will be listed as
Addendums.

The requestor can make changes to the attachments. Changes made to the Attachments
tab, before an invitation is sent out to the invitees, will be audited (Requests for Bid >
Request for Bid tab > Audit Log tab).

» Mail
Go to this tab to send email to the vendors, when the bidding is open (Send > Mail).

The emails that have been sent to the bidders are shown in the Mail tab, similar to the Private
or Non-Public Bidding (on page 336).

Private or Non-Public Bidding

For private non-public bidding, where you want to select who is invited to bid, the "Allow public
bidding (no pre-defined bidders)" option is deselected in uDesigner.

In the Proposal Management tab, click Add, select vendors, and click Add to send the
invitation to the Vendors.

Private Bids: Requestor BP

In an RFB, the Requestor can send an email to the bid-invitees from the Linked Mail tab. The
Requestor is also able to send emails from the Proposal Management tab. You can add
attachments in the Attachments tab, within the Proposal Management tab, while the bid is
open.

Note: On the Attachment tab, the attachments must be identified as
being added as addenda. This ensures that when the Bidder opens the
bid (or views the bid) from the log, the newly added attachments are
shown as addendums for the open bids.

The following explains each tab in detail.
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» Unpublished Attachments

The attachments added from the
Browse option are displayed under the
Unpublished Attachments. The
Unpublished Attachments has two
sections:

» Addendums

When the bid is still open, it lists all
the additional attachments that
have been added, using the
Browse option (the paper-clip icon)
in the invite form.

» Original Attachments

Lists attachments that have already
been sent as part of the bid
invitation (and are originally
attached to the Requestor form
(Request for Bid) through the
Browse option) but have not been
published, yet.

» Published Attachments

The attachments added from the
Document Manager option are
displayed under the Published
Attachments. The Published
Attachments has two sections:

» Addendums

When the bid is still open, it lists alll
the additional attachments that
have been added, using the
Document Manager option (the
paper-clip icon) in the invite form.

» Original Attachments

Lists attachments that have already
been sent as part of the bid
invitation (and are originally
attached to the Requestor form
through the Document Manager
option) but have been published.

The Attachments tab has two sections:
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There are two ways to add attachments
(click the paper-clip icon):

» Browse
» Document Manager

When you click to add an attachment, the
system displays the message: A1l the
invitees will receive the
addendums. Do you want to
continue?

» If you select Yes, you can add the
attachment.

» If you select No, the Upload File
window does not open.

Any attachment that gets added under the
Attachments tab will be shown in the
Requestor form (Attachments tab), as
Addendums.

You must send emails to all invitees
regarding any added, removed, or updated
attachments to the bids.

The gear menu ( &), for the items within
the Attachments tab, let you conduct the
following functions on each item:

» Revise: To revise the document
contents.

» Review: To review the document
contents.

» Download: To download the
document.

Remove: To remove the document.

Rename: To change the name of the
document.

When you select any of the gear menu
options, the system displays the message:
All the invitees will receive the
addendums. Do you want to
continue?

The Attachments tab log (grid) columns in
the Invite form and the Requestor form are
similar to any other BP form. The Upload
Date column (under the toolbar section
and to the right) lists the dates that each
attachment was uploaded.

Any Attachments that are added from the
Invite form as addendums are shown in
the Attachments tab of the Requestor form
(as addendums) after the form becomes
editable. The attachments that were added
as addendums can be identified under the
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The Mail tab: The Mail tab lists all emails sent to bid
invitees. When you select Send > Mail
from the Invite form, a new email window
will display which contains the following
columns, similar to the Linked Mail tab:

» Flag: Flagged mails can be identified
by using this column.

» Attachments: When attachments are
added to an email, then the
Attachment icon is seen.

» From: Shows the requestor name
(logged in username).

» To: Shows the selected bid invitees.
You can select one or more invitees,
and you can send emails while the bid
is open.

» Subject: Shows the subject of the
email that is sent.

» Date: Shows the date the email is sent.

The system adds the sent emails (from the
Invite form) to the Mail tab in the Invite
form, and the Linked Mail tab in the
Requestor form. The sent bid-invitations
are displayed in the Mail tab of the Invite
form.

Note: Emails must
be sent only
through the Invite
form. The Linked
Mail tab does not
let you send emails
to the bid-invitees.

The emails sent to the bid-invitees from
the Invite form are also shown in the
Linked Mail tab.

All the mails sent to bid invitees from the
Invite form should also be shown in
Linked Mail tab.

Bidders and Passwords

The bidders who have used the system before:
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Will not receive a new password when they create/submit a new bid.
Are expected to use the password they had used from the previous bid to log in to Unifier.

Can change their password. For more information, see Change Password in the Unifier
General User Guide.

Note: When you change your password, you will be logged out
automatically. Log in again with your new password.

Can use the "Forgot Password" process, if they have forgotten their password.
Receive an email from Unifier containing the new bid and the URL that they can use.

The new bidders who have not used the system before, receive an email from the system
inviting them to the bid followed by a second email that contains a user name and
system-generated password.

Comparing the Bids (Classic View)

After the bidding process ends (after the bid due date has passed), you can open a bid
tabulation to compare the bids you received. A default bid tabulation sheet is available in the
system, or your company may have a custom-designed bid tabulation sheet.

To compare bids
1) Open the Request for Bid (RFB) record.
2) Go to the Proposal Management tab.

After the bid is closed, upon selecting the bid, you can only view the information of the
invitation that was sent, along with the bids that have been received. The information within
the Invitation tab is read-only, and you (requestor) can only view the information about the
bid-invitees, the addendums sent, and the emails sent to the invitees.

3) From the list, select the vendors you want to compare and click Compare Classic.

The system tabulates the bids from the vendors you selected and displays a Compare
sheet. This sheet will look different, depending on whether you are using the default
comparison sheet supplied by the system, or a custom-designed comparison sheet created
by your company.

The default bid comparison sheet shows the bid amounts for each line item for which the
vendor submitted a bid.

The custom-designed bid comparison sheet shows the following:
» General bid information from each vendor who submitted a bid.

» Each line item from the RFB that the vendor has bid on. If the vendor adds line items of
their own to the bid, these line items will appear on the sheet as well.
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Comparing the Bids (Standard View)

After the bidding process ends (after the bid due date has passed), you can open a bid
tabulation to compare the bids you received. A default bid tabulation sheet is available in the
system, or your company may have a custom-designed bid tabulation sheet.

To compare bids
1) Open the Request for Bid (RFB) record.

2) Click the Proposal Management tab to view the bids you received. After the bid is closed,
upon selecting the bid, you can only view the information of the invitation that was sent,
along with the bids that have been received.

3) From the list, select the vendors you want to compare and click Compare. The Bids
Comparison window opens, showing the bids you selected. In the toolbar, check Star
Vendors Only to view the data of only shortlisted vendors. To compare the line item total
with reference to the selected proposal, select a proposal from the Compare with dropdown
list. The dropdown list includes all proposals selected for comparison.

4) Click Save or Cancel after making any edits.

Record Details tab

By default, the Bids Comparison sheet opens in the Record Details tab where you can view
requestor estimates and proposals in a multiform view.

Reorder bids by hovering the top of the bids and dragging them to the desired position.

Use the Bidder Qualification list to designate each bid as Qualified, Not Responsive -
Disqualified, or Not Responsible - Disqualified.

Hover the top of a bid to view a dropdown menu in which you can:

» Send Email
» Open Vendor Details
» Open Proposal

Line Iltems tab
To view the bid comparison in a grouped grid view, navigate to the Line Items tab.

The grid contains a Short Description column, a Requestor Estimates Column, and Vendor
Column Groups.

The Short Description column lists all lines entered by the requestor and additional lines
entered by each vendor. Additional lines display 0.00 for vendors who have not quoted.

The Requestor Estimates Column contains data elements selected for comparison for the
detail form. This column is fixed and cannot be sorted.

Each Vendor Column Group contains all data elements that have been included for
comparison from the detail form. The lowest amount per line item among all visible vendors in
the grid displays in green. The highest amount per line item among all visible vendors in the grid
displays in red.
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Select Winning Bid

To select the winning bid

1) Open the RFB record.

2) Go to the Proposal Management tab.
3) Select the bid to accept.

4) Click Award.

Note: If you click Yes to proceed, awarding the winning contract
removes all existing line items from the Winning Contract tab and
replaces them with the line items per the selected winning contract.

Requestor Upper Forms

The Bid Picker (Winning Bid) is available on any Requestor Upper Forms of an RFB type
Business Process as a second Detail tab (Winning Bid). The "Select Winning Bid" properties
window lets you select a bid, clear bid selections, and find bids.

» You cannot select a winning bid unless the bidding process has been completed.

» After the bidding process has been completed, you can select a bid and click Select. When
you select a bid as the winner, then:

» The winning bid picker displays the name of the company that has been selected (Company
Name).

If the Requestor form has the second Detail tab (Winning Bid), all the lines of the winning bid
form will be copied into the second Detail tab (Winning Bid). Lines are copied according to the
matching DEs from the Bidder Detail form and the Bid Comparison Sheet. If additional DEs have
been included in the Bid Comparison Sheet, the additional DEs will be copied into the second
Detail tab (Winning Bid) if the second Detail tab (Winning Bid) contains the matching DEs. The
DEs in the Bidder Detail form and the DEs in the Bid Comparison must match so you can copy
data.

For each copied line item, the value of the CBS Code (bitemlID), or a CBS Name (bi__item)
must be mapped from the corresponding line item in the standard tab Detail line item.

Example

Assume a standard tab that has 3 line items and each line item is associated with a CBS Code.
When bids are requested, these 3 line items will be copied into the Bidder Detail tab so that the
Bidder can bid on those 3 line items. The Bidder form (Bidder Detail tab) does not allow placing
bitemlID, bi_item DEs. As a result, the Bidder form line items will not display the CBS Code,
or the CBS Name.

When Bidder A adds 2 more line items to the Bidder form before submitting the bid. After all bids
have been submitted, the Bid Comparison Sheet column for Bidder A shows 5 line items (3 line
items from the Requestor standard tab, and the 2 line items that have been added by Bidder A,
manually).

If Bidder A is selected as winner, and the requestor adds more line items such as the negotiated
amount, price, quantity, and so forth, then the Bid Comparison Sheet, for the winner (Bidder A)
will have more information than originally included by Bidder A, when Bidder A submitted the bid.
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Note: The additional line items that the requestor has added must be
captured in the "Bid Comparison Sheet" by the requestor by way of
adding corresponding DEs in uDesigner (uDesigner > RFB Business
Process > Bid Comparison Sheet > Detalil).

All line items, within the second Detail tab (Winning Bid) must be valid before an RFB record can
be successfully routed to next step. If you change the value of a "Winning Bid" picker on the
Requestor Upper form, the existing line items in the tab (<winning bid tab name>) will be
removed and the system sends a confirmation request. If you confirm the change, the Winning
Bid selector displays the new value and all the line items from the second Detail tab (Winning
Bid) will be deleted.

If you use the Clear option in the winning bid selector window, the existing line items in the tab
(<winning bid tab name>) will be removed and the system sends a confirmation request. If you
confirm the change, the confirmation window and the winning bid selector window will close, the
winning bid selector value will be cleared, and all line items from second Detail tab (Winning Bid)
will be deleted, including line items add manually.

The system saves the following information to the database, each time you make a winning bid
selection:

» Winning Bid picker value
» Winning Bid Detail tab line items
» Any DEs on Requestor Upper form which are set to auto-populate from winning bid picker

As a result, if you select a winning bid and perform an Undo Accept Task, then:

» Winning bid will stay as selected

» Winning bid tab Detail line items will persist and not revert

» Fields that receive AP from winning bid will be persisted and will not revert
» Other DEs will be reverted back as per existing functionality

Note: If the winning bid picker is blank, but the Winning Bid Detail tab
has line items that have been manually added, then the manually added
line item will be removed when you perform an Undo Accept Task.

If you close a form window without saving the form:

» Winning bid Picker, auto-populated fields, and the winning bid Detail tab line items will still be
saved as records

» Other fields will not be saved (as per existing functionality)
To clear the winning bid related information, you can do one of the following:

» Clear, or reselect, the winning bid Detail tab to its previous value before performing Undo
Accept Task

or
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» If you performed Undo Accept Task, then click Accept Task, and reselect, or deselect the
winning bid picker.

If there is more than one assignee on a step:

» When user 2 tries to select the winning bid, if user 1 has already done a selection, then user
2 will receive an alert notifying user 2 that some of the line items have already been saved to
the winning bid tab (<winning bid tab name>) and the action taken by user 2 will remove all
those lines and recreate lines as per new information in the DE (<label of DE
uuu_rfb_winning_bid>) selection.

» New line items will be created in the winning bid Detail tab as per user 2's response.

The special runtime behavior of the winning bid Detail tab is connected to the winning bid
selector DE (uuu_rfb_winning_bid). You can select not to place the winning bid selector DE
(uuu_rfb_winning_bid) on the form and still use the winning bid Detail tab by naming it
something else. The winning bid Detail tab will behave like any other non-standard detail tab in
such a scenario.

Also, similar to other Detail tabs in Business Processes, you can delete line items from the
winning bid Detail tab if it is configured as such.
Additional information about selecting winning bid

To keep winning bid details hidden from the bidder, if a user signs in as a "Bidder," the requestor
Winning Bid Detail tab will remain hidden.

If you select a bid using the winning bid selector on RFB Upper form, the winning bid will be
highlighted in the following window:

» Select Winning Bid: By way of displaying the selected bid in bold typeface.
» Show: By way of displaying the "Winning Bid" column.
» Compare: By way of displaying the selected bid in bold typeface.

Note: The DE of DD = Bid Picker will not be available for bulk editing or
bulk action.
When you copy an RFB record to create an RFB record, note that:

» Not all the line items in the winning bid Detail tab are going to be copied.
» The picker "Winner Bid" will not be copied.
» DEs will be copied, similar to the standard copy behavior for records in the system.

Auto-create Contract

When an additional Detail tab (for the Requestor section of all RFB type Business Process
forms) is available, you can use the second Detail tab (non-standard tab) to record the lines of
the winning bid, as the user copies the data from the Bid Comparison Sheet.

In general, the Bid Comparison Sheet, for a preferred bidder, contains more information than
the information submitted by the bidder.

The second Detail tab is similar to that of any other non-standard Detail tab on any other
Cost-type BP which allows multiple tabs.
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To be able to use this feature, the following conditions must exist:

» The "uuu_rfb_winning_bid" data element must be included in the RFB requestor form.
» At least one bidding process must be completed.

After these conditions are met, you can select the winning bid.

The Result window displays all the completed bids. You can select one bid as the winning bid
and after selecting that bid the system copies all the lines of the winning bid onto the Winning
Bid tab.

The system copies the lines base on the matching data elements available on the:

» Bidder detail form
» Bid Comparison Sheet

The destination record is created by auto-creation and selecting a Winning Bid is not a must for
successful auto-creation.

The BP Creator is available after all the mapping to the second Detail tab (Winning Bid) is
complete. If the BP Creator is configured to auto-create a CBS Cost type Business Process, but
the source Bidder Detail form did not contain a CBS picker (bitemid), the auto-creation will fail.
To correct this error, you must correct the data (for example, selecting the CBS code before
routing it to the next step), manually.

Note: The value of bitemid cannot be copied over when a record is
auto-created from a Summary Base Commit to a non-Summary Base
Commit.

What the Vendor Does

Use the instructions in this section to familiarize vendors with the Unifier interface so they can
submit bids.

When a bidder is invited to bid for the first time, the system sends two emails simultaneously:
» Invitation email, which contains the URL to log on to Unifier.
» Credential email, which contains the username and system-generated password.

Note: For best results, a bidder should change their password at the first
log in, and then sign in using the newly set password.

About the Bid Due Date Time

Be aware that the due date and time for the bid reflect the time of the server on which Unifier is
running. (Unifier servers operate on Pacific Standard Time.)
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To signin

If you received a bid invitation, you should also have received an email containing a link to
Unifier, a user name, and a password.

1)
2)

To
1)

2)

3)

4)
5)

6)

Open the bid invitation, and click the link provided.
At the login screen, enter the user name and password provided in the email.
The Unifier home screen opens.

submit a bid

In the left Navigator, click Request for Bid/Bids (or Request for Bid Private/Bids if you
have been invited for a private bid). A bid log appears on the right pane showing a list of
open bids you have been invited to submit.

By default, the system displays only open bids. If you want to see all the bids you have been
invited to submit, use the View menu. Click the arrow and choose All from the list. The
system will display all your bids, past and present.

In the Request for Bid log, double-click the name of the RFB you have received. The
Request for Bid form opens.

Before you submit the bid, you can communicate with the requestor about any questions or
issues that need clarification. The Request for Bid form provides a link to a Unifier Mailbox
feature. To send a communication:

a. Click the Linked Mail tab at the top of the window. The Linked Mail tab shows a
chronological list of any existing communications.

b. Click Add > New Mail. An email-type form opens, where you can send a communication
to the requestor.

To participate in the bid, you must accept the request for bid using the Accept button in the
upper-right corner.

Fill in the upper-form fields that are required.

Go to the Line Item List tab and add line items to the form through one of the following
methods:

a. Click the Add button. Then, in the right pane, fill in the fields on the Line Item Details tab
and click Save or Save & Add New. The line item detail you entered appears in the log
on the left pane.

b. Use the Export button to export a CSV or Excel template of the line item form to be
opened in a separate application that reads CSV or Excel files. After the correct
information has been added to the CSV or Excel file, use the Import button to create line
items based on the data in the CSV or Excel file. For more information about this
process, see Importing Line Items to a Request for Bid.

(Optional) To add an attachment to the bid, open the Attachments tab in the right pane and

click Attach Files > Browse. A file upload window opens.

a. Within this window, click Browse to search your system for files to attach. Alternatively,
you can drag and drop files into the window.

b. Navigate to the file you want to attach and select it. Then click Open. The file name
appears in the list

c. Click the Upload button. After the file has been uploaded, the window will close
automatically.
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On the Request for Bid form, Unifier indicates the attachment in the lower-left corner of
the window. You can click Attachments to verify that the attachment is correct, or
rename or remove an attachment.

7) Click Submit Proposal to finalize the bid, or Save to save changes to the bid.
The following rules apply when a bidder accesses new forms:
» If the Requestor has created the bid request in Classic view, the bidder will be able to

perform all subsequent actions (such as View the request/Create Bids in Classic view).

» If the Requestor has created the bid request in Standard view, the bidder will be able to
perform all subsequent actions (such as View the request/Create Bids in Standard view).

» After the bid is submitted and the due date is passed, Unifier opens the RFB form in
Standard view.

To withdraw a bid

1) Sign in to Unifier.

2) In the left Navigator, click Request for Bid/Bids (or Request for Bid Private/Bids, if you
were invited for a private bid). A bid log appears on the right pane.

3) In the log, double-click the name of the RFB you received. The Request for Bid form opens.

4) Click the Withdraw button in the upper-right corner of the window.

To view or print the bid after submitting it

1) Sign in to Unifier.

2) In the left Navigator, click Request for Bid/Bids (or Request for Bid Private/Bids, if you
were invited for a private bid). A bid log appears on the right pane.

3) Inthe log, select the bid record that you want to view or print.
4) Click the Print button and select one of the following:

»  Print

» Export To CSV

» Export To Excel

Importing Line Iltems to a Request for Bid

You can export a template for CSV or Excel that includes the line item detail form fields as
columns for the Request for Bid business process. These fields include the detail form line item
fields defined in Integration.

You can then modify the exported template and import it to create line items for the RFB.

Note: In order to import or export line item templates, you must first
accept the bid.

To export the request for bid line item template

1) Navigate to the Request for Bid business process log.
2) Open a bid from the log.

3) Gotothe Line Item List tab.

4) Click Export and select one of the following options:
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» Export Line Iltem Template in CSV

» Export All Line Items in CSV

» Export Line Item Template in Microsoft Excel
» Export All Line Items in Microsoft Excel

Depending on your browser, the file will be downloaded automatically, or you will be prompted to
download the file manually.

To modify the request for bid line item template

1)
2)

3)

Open the exported CSV or Excel file in Microsoft Excel. The line item columns are listed.

Enter the line item information into the spreadsheet. Each line must begin with a "D". For
multiple tabs, you must enter appropriate tab name in the Tab Name column.

Enter data into the required fields, as well as non-required fields as needed.

Notes:

= Data for formula-based columns is ignored.
= Any line items with the Amount equal to zero will not be imported.

= Ensure that you are importing the records you want to import. Any line
items that you import will be added after any existing line items.

= Use to add new lines only, not to modify existing lines

= All data created through the CSV or Excel import is rolled up to the
cost sheet

= For data to import correctly, you might have to change some of the
cells in the CSV or Excel file to Text type. For example, if you have a
CBS code of 1-1, Microsoft Excel can interpret this entry as a
month-day combination and reformat it to Jan-1. In this case, your
data import will fail because this data is now an invalid CBS code.

= Image picker data elements will not be shown in the CSV or Excel
template.

To import the request for bid line item template

1)
2)
3)
4)

5)
6)
7)

Navigate to the Request for Bid business process log.
Open a bid from the log.

Go to the Line Item List tab.

Click Export and select one of the following options:

» Data From CSV File

» Data From Excel File

Browse to select the file to import, then click Next.
Add any attachments to the import.

Click Upload when finished.

If there are any import errors, you can open the CSV or Excel file to view and correct the
error. No records are imported if any rows contain an import error.
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Changing Vendor Email Address

You can change the bidder email in the RFB Vendors BP > Line Item Type Vendor > Bidder
Email.

If you accept the change (click Finish Editing or Save > Yes), then the system updates the
vendor record, with the new email address.

» If there are active bids for the vendor, the system sends an email to the vendor with their
username and password.

» If there are no active bids, the system changes the email address, but the system does not
send an email to the vendor.

Unifier deactivates the old email address.
If you change the vendor's email to an email that exists in the system, the following message
will be displayed: Existing email or username cannot be used.

If you do not accept the change (click Finish > No), the system reverts to the original email
address.

To change the vendor email address through integration, Reverse Auto-population (RAP),
or Bulk Edit

If you update the vendor's email address on the vendor record by way of integration, Reverse
Auto-population (RAP), or Bulk Edit, the system updates the record with the new email address
and sends an email to the vendor, if the bids are active.

Note: The system does not send an email to the vendor if the bids are
inactive.

Exporting Record Details and Line Iltems from Bid Comparison Sheet

A project manager can share information about bids that have been submitted by multiple
vendors with the rest of the project team members by way of the Bid Comparison module and
through exporting the Bid Comparison sheet data (record details and line items details) based
on certain parameters.

The following explains the process of exporting the Bid Comparison sheet data based on certain
parameters:

1) Go to your <shell> (User mode).

2) From the left Navigator, click Logs and open a RFB BP.

3) Inthe Requests for Bid log, select and open a record.

4) In the record window, go to the Proposal Management tab.

5) From the left pane, select the records you want to compare and click Compare, opening the
Compare window. By default, the Record Details tab is active which shows the details of
the bid comparison. The other tab on the Compare window is the Line Items tab.

6) Inthe Record Details tab, click the Export icon to enable Unifier to generate the export file
(The Excel file "Compare_Export - ....xIsx" shown in your browser's download log).
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7) After the Excel file is generated, open the file, or the exported comparison sheet file. Notice
that the file hast to worksheets: Record Details and Line Items. These two worksheets
correspond to the Record Details tab and the Line Items tab, on the Compare window,
respectively. The coloring scheme used within the columns of each tab is also maintained in
the columns of the corresponding worksheets of the export sheet.

The Records Details worksheet contains the following informational text:

This file contains the proposals received for - <Record No>: <Record
Title>

The content of this file i1s for information purpose only and cannot be
used to Import data into the system.

The upper form data has been exported into the Record Details worksheet.
The line item data has been exported into the Line Items worksheet.

Proposals for the following Vendors have been exported along with the
Requestor Estimates.

<Vendor 1, Vendor 2...>

The record details are displayed in columns. The Requestor Estimates column is locked, by
default. The color format, as mentioned, is according to the color format of the sheet. The text in
each cell is wrapped and can be displayed in multiple lines when the size exceeds the column
width. The rest of the columns show the vendors (for example, the vendors according to the
selection of the Star Vendors Only field at the time of export).

In the Line Items worksheet, the Requestor Estimates column is locked, by default. The color
format, as mentioned, is according to the color format of the sheet. The rest of the columns show
the vendors (for example, the vendors according to the selection of the Star Vendors Only field
at the time of export).

When you are on the Compare window, you can select the Star Vendors Only option before
exporting the data and compare the requestor estimates with bids submitted by only the star
vendors in the comparison sheet.

In general, on the Compare window, you can conduct a combination of comparisons by
selecting or not selecting the Attachments Only or the Star Vendors Only options and
selecting various bids (under the Compare With drop-down field). The Sort icon (on the
upper-right corner) enables you to sort the bids displayed on the on the Compare window.

Again, all of the selections or views set in the Compare window will be reflected on the
generated export file.

Lease Business Processes

Lease business processes (BPs) are a Cost type BP. You can use the Lease BP at the
project/shell level to set up and manage real estate leases and view the expected Payment
Schedule (regular as well as straight line) using the lease data from the BP. You can set up a
Lease BP if you are the landlord (lessor), or if you are the tenant (lessee). You can use it for new
leases you have just contracted, or existing leases. The Lease BP lets you track incoming or
outgoing payments, and you can use the Generic Cost Manager to roll up the amounts.
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Lease BPs are typically used to auto-create invoices (if you are the landlord) or payment
requests (if you are the lessee). These auto-created business processes are designed and set
up by your administrator. For more information, see Auto-create an Invoice or Payment
Request from a Lease Business Process (on page 360).

Lease BPs can be workflow or non-workflow cost business processes. If they are workflow
business processes, you can route them like other workflow business processes.

Notes:

= Lease BPs cannot be defined at the Company level and do not
support CBS functions.

= By design, the Line Item Details in the Lease BP cannot be
auto-created.

Leases can be designed with fields that you can use in line items to perform lease data
calculations. These calculations generate lease payment schedules. For example, you could
add lines items for rent, cost of maintenance, or taxes to a lease. The data in these line items is
data that you enter, or data that is populated based on calculations.

On Leases, you can:

» View expected payments for the lifetime of the lease using the Regular Payment Schedule
and Straight Line Schedule reports

» Disable the auto-creation of related BPs, or re-enable these auto-created BPs as needed
» Create Payment Schedules (regular and straight line)
» Create shapshots of the lease for historical purposes

In addition to typical behavior, the Lease BP supports:

» Consolidation from other Cost BPs

Snapshot creation

Auto-creation

Auto generation of Regular and Straight Line Payment schedules
Integration methods for creating upper form as well as line items of all tabs
Multiple tabs for line items (up to 8 tabs)

An allocation template to divide lease payments into different amounts for multiple tenants in
a building.

4
4
4
4
4
4

Lease BP Payment Schedule

Changes to Lease Payment Terms will be always applied on future payment schedules, starting
from the first payment of the next term, depending on the term type and length. The change in
escalation rate or value can happen in two ways:

» Line Item: Change the escalation value or switch the Index Rate picker record on the line
item.

» Index Rate BP: Change the rate value on the source Index Rate BP record in the Company
workspace.

Lease (Payment Setup) Details
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Field Example
Start date 03/01/2021
End date 02/01/2027
Payment Frequency Monthly
Initial Amount $1,000.00
Payment Due Day 1
Latest Payment Due Day 1
Payment Notice Lead Time 10
Escalation Method Index Rate
Escalation Frequency Term Type Yearly
Escalation Frequency Term Length 1
Lease Payment Schedule
Start Date |End Date Due Date Payment Amount Amount Yearly
Type (with initial |(with new |escalation
Index Rate |Index Rate
10) 20,

switched

on 27th

Nov, 2023)
03/01/2021 {03/31/2021 | 03/01/2021 |GTO $1,000.00 [$1,000.00 |Start of

Lease

04/01/2021 | 04/30/2021 | 04/01/2021 |GTO $1,000.00 |$1,000.00
05/01/2021 | 05/31/2021 | 05/01/2021 |GTO $1,000.00 |$1,000.00
06/01/2021 | 06/30/2021 | 06/01/2021 |GTO $1,000.00 |$1,000.00
07/01/2021 |07/31/2021 |07/01/2021 |GTO $1,000.00 |$1,000.00
08/01/2021 | 08/31/2021 | 08/01/2021 |GTO $1,000.00 |$1,000.00
09/01/2021 | 09/30/2021 | 09/01/2021 |GTO $1,000.00 |$1,000.00
10/01/2021|10/31/2021 |10/01/2021 |GTO $1,000.00 |$1,000.00
11/01/2021|11/30/2021 |11/01/2021 |GTO $1,000.00 |$1,000.00
12/01/2021|12/31/2021 |12/01/2021 |GTO $1,000.00 |$1,000.00
01/01/2022 |01/31/2022 | 01/01/2022 |GTO $1,000.00 |$1,000.00
02/01/2022 | 02/28/2022 | 02/01/2022 |GTO $1,000.00 |$1,000.00
03/01/2022 | 03/31/2022 | 03/01/2022 |GTO $1,100.00 [$1,100.00 |Firstyear
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Start Date |End Date Due Date Payment Amount Amount Yearly
Type (with initial | (with new |escalation
Index Rate |Index Rate
10) 20,
switched
on 27th
Nov, 2023)
04/01/2022 | 04/30/2022 | 04/01/2022 |GTO $1,100.00 [%$1,100.00
05/01/2022 | 05/31/2022 | 05/01/2022 | GTO $1,100.00 [%$1,100.00
06/01/2022 | 06/30/2022 | 06/01/2022 | GTO $1,100.00 [%$1,100.00
07/01/2022|07/31/2022 |07/01/2022 | GTO $1,100.00 [%$1,100.00
08/01/2022|08/31/2022 | 08/01/2022 |GTO $1,100.00 [%$1,100.00
09/01/2022 | 09/30/2022 | 09/01/2022 |GTO $1,100.00 [%$1,100.00
10/01/2022 {10/31/2022 | 10/01/2022 |GTO $1,100.00 [%$1,100.00
11/01/2022 {11/30/2022 | 11/01/2022 |GTO $1,100.00 [%$1,100.00
12/01/2022 (12/31/2022 |12/01/2022 |GTO $1,100.00 [%$1,100.00
01/01/2023|01/31/2023|01/01/2023 |GTO $1,100.00 [%$1,100.00
02/01/2023|02/28/2023|02/01/2023 |GTO $1,100.00 [%$1,100.00
Second
year
escalation
04/01/2023|04/30/2023 | 04/01/2023 |GTO $1,210.00 [%$1,210.00
05/01/2023|05/31/2023 |05/01/2023 |GTO $1,210.00 [%$1,210.00
06/01/2023|06/30/2023 |06/01/2023 |GTO $1,210.00 [%$1,210.00
07/01/2023|07/31/2023|07/01/2023 |GTO $1,210.00 [%$1,210.00
08/01/2023|08/31/2023|08/01/2023 |GTO $1,210.00 [%$1,210.00
09/01/2023|09/30/2023 |09/01/2023 |GTO $1,210.00 [%$1,210.00
10/01/2023 {10/31/2023|{10/01/2023 |GTO $1,210.00 [%$1,210.00

12/01/2023

12/31/2023

12/01/2023

GTO

$1,210.00

$1,210.00
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Start Date |End Date Due Date Payment Amount Amount Yearly
Type (with initial |(with new |escalation
Index Rate |Index Rate
10) 20,
switched
on 27th
Nov, 2023)
01/01/2024|01/31/2024|01/01/2024 |GTO $1,210.00 [%$1,210.00
02/01/2024 |02/29/2024 | 02/01/2024 | GTO $1,210.00 [%$1,210.00
03/01/2024 | 03/31/2024 | 03/01/2024 | GTO $1,331.00 ($1,452.00 |Third year
escalation
04/01/2024 | 04/30/2024 | 04/01/2024 | GTO $1,331.00 |$1,452.00
05/01/2024 | 05/31/2024 | 05/01/2024 | GTO $1,331.00 |%$1,452.00
06/01/2024 | 06/30/2024 | 06/01/2024 | GTO $1,331.00 |%$1,452.00
07/01/2024|07/31/2024|07/01/2024 |GTO $1,331.00 [$1,452.00
08/01/2024 |08/31/2024 | 08/01/2024 |GTO $1,331.00 [$1,452.00
09/01/2024 | 09/30/2024 |1 09/01/2024 | GTO $1,331.00 |%$1,452.00
10/01/2024 {10/31/2024 | 10/01/2024 |GTO $1,331.00 |%$1,452.00
11/01/2024 {11/30/2024 |11/01/2024 |GTO $1,331.00 [$1,452.00
12/01/2024 (12/31/2024 112/01/2024 |GTO $1,331.00 [$1,452.00
01/01/2025|01/31/2025|01/01/2025 |GTO $1,331.00 [$1,452.00
02/01/2025|02/28/2025 | 02/01/2025 |GTO $1,331.00 |%$1,452.00
03/01/2025 | 03/31/2025 | 03/01/2025 |GTO $1,464.10 |$1,742.40 |Fourth
year
escalation
04/01/2025 | 04/30/2025 | 04/01/2025 |GTO $1,464.10 [$1,742.40
05/01/2025 | 05/31/2025 | 05/01/2025 |GTO $1,464.10 |$1,742.40
06/01/2025 | 06/30/2025 | 06/01/2025 |GTO $1,464.10 [$1,742.40
07/01/2025|07/31/2025|07/01/2025 |GTO $1,464.10 [$1,742.40
08/01/2025|08/31/2025 | 08/01/2025 |GTO $1,464.10 |$1,742.40
09/01/2025 | 09/30/2025 | 09/01/2025 |GTO $1,464.10 [$1,742.40
10/01/2025 {10/31/2025 |10/01/2025 |GTO $1,464.10 |$1,742.40
11/01/2025 (11/30/2025|11/01/2025 |GTO $1,464.10 [$1,742.40
12/01/2025 (12/31/2025|12/01/2025 |GTO $1,464.10 [$1,742.40
01/01/2026 |01/31/2026 |01/01/2026 | GTO $1,464.10 [$1,742.40
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Start Date |End Date Due Date Payment Amount Amount Yearly
Type (with initial |(with new |escalation
Index Rate |Index Rate
10) 20,
switched
on 27th
Nov, 2023)
02/01/2026 | 02/28/2026 | 02/01/2026 | GTO $1,464.10 |$1,742.40
03/01/2026 |03/31/2026 | 03/01/2026 |GTO $1,610.51 |$2,090.88 |Fifth year
escalation
04/01/2026 | 04/30/2026 | 04/01/2026 | GTO $1,610.51 |$2,090.88
05/01/2026 | 05/31/2026 | 05/01/2026 | GTO $1,610.51 |$2,090.88
06/01/2026 | 06/30/2026 | 06/01/2026 | GTO $1,610.51 |$2,090.88
07/01/2026 |07/31/2026 | 07/01/2026 | GTO $1,610.51 |$2,090.88
08/01/2026 | 08/31/2026 | 08/01/2026 | GTO $1,610.51 |$2,090.88
09/01/2026 | 09/30/2026 | 09/01/2026 | GTO $1,610.51 |$2,090.88
10/01/2026 | 10/31/2026 | 10/01/2026 | GTO $1,610.51 |$2,090.88
11/01/2026 {11/30/2026 | 11/01/2026 | GTO $1,610.51 |$2,090.88
12/01/2026{12/31/2026 | 12/01/2026 | GTO $1,610.51 |$2,090.88
01/01/2027 |01/31/2027 | 01/01/2027 |GTO $1,610.51 |$2,090.88
02/01/2027 | 02/28/2027 | 02/01/2027 |GTO $1,610.51 |$2,090.88

Lease Business Process Terminology

Lease: An agreement whereby the owner of real property (the landlord or lessor) gives the right
of possession to another (the tenant or lessee) for a specified period of time (the terms of the
lease) and for a specified consideration (the rent or lease payments).

Straight line: The straight-line method implies that the cash flows in the form of fixed lease
payments over the lease term are aggregated and divided by the lease term to arrive at the
monthly income or expense. This results in an equal impact in the income statement in each
reporting period irrespective of the fact that cash flows differ.

Escalation: A clause in a lease which provides for the rent to be increased to reflect changes in
expenses paid by the landlord such as real estate taxes, or operating costs. An escalation can
be accomplished by several means such as fixed periodic increases, increases tied to the
Consumer Price Index, or adjustments based on changes in expenses paid by the landlord in
relation to a dollar or base year reference.

In addition to the terminology above, you can find more information about the special fields that
can be used on Lease business processes in the Unifier Data Reference Guide.
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Lease Business Process Use Cases

The following are examples of how you can the Lease BP to manage leases.

Various Payment Terms for the Same Lease

You start a lease on December 1, 2003 with a commencement date of April 1, 2004 and a
termination date of March 28, 2005.

Payment Term 1: A term of $4,000 per month for rent begins on April 1, 2004 and ends on
March 28, 2005. The due day is 1.

Payment Term 2: A term of $300 per month for common area maintenance (CAM) starts on
April 1, 2004 and ends on March 28, 2005. The due day is 1.

Payment Term 3: A semi-annual term of $500 for taxes begins on September 1, 2004 and
ends on March 28, 2005. The due day is 1.

Different Payment Allocations for Multiple Tenants

For accounting purposes, the rent for a building is to be charged back to departments, based on
each department's space usage. The Marketing Department uses 60% of the space and IT uses
40% of the space. If the total rent for the building is $5000 per month, then Marketing would be
charged $3000 and IT would be charged $2000 per month.

Semi-annual Lease Terms with Proration

The lease term start date is February 15, 2002, the end date is January 1, 2003. The frequency
is semi-annual, and the amount is $1,000 per term. The Proration Rule accounts for the date
difference in days, with the end date included.

Handling Rent Pre-payments

The lease term start date is January 1, 2003, the end date is June 30, 2003. The frequency is
monthly, and the amount is $6,000 per month. The due day is 1. The pre-payments are the first
and last month's rent.

Straight Lining with Quarterly Payments
The lease begins mid-month on 15 January, 2002 and ends mid-month on 14 January, 2003.

Rent for the first quarter is $100
Rent for the second quarter is $200
Rent for the third quarter is $300
Rent for the fourth quarter is $400
Rent for the fifth quarter is $500

The rent abatement of $10 is given only in the first month. The rent is scheduled to be paid in full
at the beginning of each month.

v v v v Vv

Note: Information about Straight-line Payment Adjustments: Straight-line
payments can be modified if the business process design includes
special data elements (fields). These fields can override the start and
end dates of a lease, add or subtract days from the lease term, or add or
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subtract specific dollar amounts to the lease amount.These adjustment
fields do not change the line item dates or amounts. The system takes
these adjustments into consideration when it calculates the straight-line
payments after you click Save or Submit. When you open the form in
view mode, you will see the adjustments reflected on the Payment
Schedule you open from the Payment Schedule button on the toolbar.

Straight Lining with Monthly Payments

The terms are a 12-month lease, with the first month rent-free. The rent is $1000 per month.
Real estate rules (FASB 13) require that this rent be normalized (or straight-lined) across the
entire lease term.

Lease Term of 20 Years with Escalation

The base, or primary, lease term is 20 years. During the base lease term, the monthly lease
payment is $10,000 for the first 10 years and $12,000 for the next 10 years.

Note: Payment Schedule calculations for Lease base frequencies and
Escalation frequencies will differ slightly depending on the frequency
used. For example, a 10 year lease escalating each year will differ
slightly from a lease escalating every 52 weeks (as opposed to a lease
escalating every 365 days). Over a 10 year period, if the lease
calculation is done in days, there can be years with more than 365 days.
Also, if the calculation done in weeks, 52 weeks might be a day or two
short of a full year depending on the year used.

Escalation Based on Index Rate

Set lease payments to increase based on the Consumer Price Index of a country. This
escalation method allows lessors to increase the rent by aligning it with inflation and without
going into an agreement using a pre-determined % escalation. On the Lease Business Process,
you can specify the index rate to use, the payment schedules are updated whenever the index
rate is changed.

Create and Manage Lease Business Processes

To create a Lease business process record
1) Navigate to the Lease business process log.
2) Inthe Lease BP log, click Create. The Lease form opens.

3) Complete the Lease business process record. Add the basic lease information to the upper
form, including the lease name, number, class of lease, and other details. Add the routing
information for the workflow if the BP is a workflow BP.

4) On the detail form, add the payment terms in the Payment Setup tab. Click the Add button to
add a line item for each aspect of the lease for which you want to create a payment
schedule. For example, you can add individual line items for rent, maintenance costs, and
taxes.

5) Click Save.
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To edit aline item

As long as the Lease BP form is still a Draft, you can edit a line item at any time. Open the grid
by clicking the Add button. The Line Items window opens. Enter the payment general setup,
payment trigger dates setup, straight line settings, payment escalation setup, and the cost
account setup. Make changes and click Save.

To remove a line item
In the Lease BP form, select the line item to remove and click the Remove button.

If you have created an allocation template, you can link the record to it. See Create and Use an
Allocation Template (Classic view) (on page 358).

Create and Use an Allocation Template (Classic view)

If the rent you charge (or pay) should be pro-rated for different tenants in a building, you can
create an allocation template and assign it to a Lease BP. The template will designate a
breakdown of the costs for each tenant and the system will use this breakdown to create the
payment calculations.

For example, for accounting purposes, the rent for a building is to be charged back to
departments, based on each department's space usage. The Marketing Department uses 60%
of the space and IT uses 40% of the space. If the total rent for the building is $5000 per month,
then Marketing would be charged $3000 and IT would be charged $2000 per month.

To create an allocation template
1) Open the Lease BP you want to create the template for.

2) Click the Menu Options ( = )and select Allocation. The Allocation Templates window
opens.

3) Click the New button. The Add/Edit Allocation Details window opens.
4) Use the information in the first table below to complete the top three fields in this window.

5) Click the Add button. The system enters a row number and opens an editable text box in the
Description field.

6) Use the information in the second table below to add rows to the allocation template.
7) To add more rows to the allocation template, repeat steps 5 and 6.
8) Click OK.

In this field: Do this:

Enter a name for the allocation template.
This name will appear on the list of
allocation templates you can select for the
record or line item you create.

Allocation Name

Click the arrow and select the payment

Payment Type type that should be used for the
allocations.
Allocation Type Select the type of allocation to use for the

358



Working with Business Processes

pro-ration.

» Percent will pro-rate the lease
according to the percentage you
specify (see Allocation Value).

» Fixed will allocate a fixed cost to each
tenant.

» Area will pro-rate the lease according
to the square footage each tenant
occupies (see Allocation Value).

In this field: Do this:
Enter a name to identify the allocation,
Description such as "Sales Dept" or "Uptown
Restaurant”.

Enter the value of the Allocation Type.

» For Percent, enter the percentage of
the lease that should be paid by the
tenant. If you specify percent, the

: values in all these fields must add up

Allocation Value t0 100%.

» For Fixed, enter the lease amount that
should be paid by the tenant.

» For Area, enter the square footage for
which the tenant is paying.

From the picker that opens, select the cost

Cost Code code for the allocation.

To link an allocation template to a lease business process

1) Open the Lease business process record to which you want to link the template.

2) Click the Menu Options ( =) and select Allocation. The Allocation Templates window
opens.

3) Select the template you want and click Open.

View or Export Payment Schedule

The Lease BP creates the Regular Payment Schedule and the Straight Line Schedule to allow
you to view your future lease payments.

The lease payment schedule is generated automatically after you add or change a line item for
the Lease BP. The schedule is time stamped, and is overwritten each time you add or modify a
line item. You can capture a particular schedule by exporting it to a PDF file.
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To view or export payment schedule

1) Open a Lease BP record from the log.

2) On the toolbar, click the Payment Schedules button and choose Regular or Straight Line.
The payment schedule window opens.
The schedule shows currency amounts to two decimal places (for example, $3120.33).
The Regular Payment Schedule lists the lease payments as calculated using Frequency,
Start Date, and End Date.
The Straight Line Schedule lists the lease payments averaged over all of the line items of the
payment terms for the lease over the life of the lease. You can specify which line items that
you want to include in the Straight Line Schedule by clicking the Straight Line radio button on
the detail form of each line item to Yes for each item you want listed in the schedule.

3) Click the Export button to save all of the schedule rows or selected rows to a PDF file. Click
Save to create the PDF file of the schedule.

4) Click the Close Window button when you are done viewing the schedule.

Auto-create an Invoice or Payment Request from a Lease Business Process

Lease business processes are typically used to auto-create invoices (if you are the landlord) or
payment requests (if you are the lessee). For example, a lease business process with a payment
schedule can use auto-creation to generate payment request records at appropriate days in
advance of the payment due date to be routed for approval.

Note: You receive a single auto-created line item based on the defined
grouping criteria.

For cost purposes, these invoices/payment requests do not roll up amounts to the Cost Sheet.
To roll up these amounts, the invoice/payment request should, in turn, auto-create another
business process for the purpose of rolling up the amount(s) to the Cost Sheet.

Lease
Business
Process

Ato-crestes a Payment
Request business process

Payment The amount(s] on a Payment Fequest
Request BP weill not ol L to the Cost Sheet.

Auto-crestes another business
process containing the amaount(s).

¥

"Payments" BP Folls up amount(s)] ——s) Cost Sheet
{or other name} o Cost Shest,

360



Working with Business Processes

Allocation Templates: Whenever a Lease BP auto-creates an invoice or payment request, the
system will check for an allocation template. If one is linked to the Lease BP, the system will
copy it to the invoice or payment request, and use it to calculate the payments. Each allocation
will appear as a separate line item under the Standard tab of the invoice or payment request.

Take a Snapshot of a Lease (Classic view)

Use the lease snapshot feature to create a historical picture of the lease that you can preserve
before the lease is amended or otherwise modified. The shapshot can be created automatically
when the Lease BP reaches a certain status, or you can create it manually whenever necessary.
Automatic snapshot creation is set up in uDesigner.

To save an automatically created snapshot

1) When the status of the Lease BP changes and a snapshot is created automatically, you
receive a message.

Enter a title for the snapshot (if you want to overwrite the default title), and an optional
description.

2) Click OK. The snapshot is saved in the system.

To create a snapshot manually

1) While in the Lease BP, open the Menu Options ( =) and select Create Snapshot. The
Create new snapshot window opens.

2) Enter a title for the snapshot (if you want to overwrite the default title), and an optional
description.

3) Click OK. The snapshot is saved in the system.

To view and manage snapshots

1) While in the Lease BP, open the Menu Options ( =) and select Snapshots. The
Snapshots window opens.

The snapshots are listed in the window. Manually created snapshots display Yes under the
User Created column; system created snapshots display No.

2) To save the snapshot as a PDF file, select a snapshot from the list and click Open.

Depending on your browser, the file may automatically be downloaded, or you will be
prompted to download the file manually.

3) To view snapshot properties and change the title or description of the snapshot, select a
shapshot from the list and click Properties.

4) To delete a snapshot, select a snapshot from the list and click Delete.
5) Click Close when you a done viewing snapshots.

Take a Snapshot of a Lease (Standard View)

Use the lease snapshot feature to create a historical picture of the lease that you can preserve
before the lease is amended or otherwise modified. The snapshot can be created automatically
when the Lease BP reaches a certain status, or you can create it manually whenever necessary.
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To take a snapshot of a lease
1) Open the Lease in Edit mode.
2) Click More Actions and select Create Snapshot. The Create Snapshot window will open.
3) Inthe Create Snapshot window:
a. Enter a Title for the snapshot.
b. (Optionally) Enter a Description for the snapshot.
c. Click Create.
4) In the notification message confirming the snapshot has been successfully created, click OK.

To view the snapshots for a lease, open the lease in view mode, click More Actions, and then
select Snapshots. To open a shapshot, click its title to download the .pdf file of the snapshot.

Calculating Net Present Value (NPV)

If the data elements corresponding to the Net Present Value (NPV) are included in Lease BP
design, then the following information will be available:

Annual discount rate NPV Amount Comments

The NPV amount for each
payment setup will be
calculated individually using
the discount rate present on
Detail Form Detail Form the respective setup.

The calculated amount will
then be populated into the
NPV present on each
payment setup respectively.

The NPV amount for each
payment setup will be
calculated individually using
the discount rate present on
Detail Form Upper Form the respective payment
setup.

The summarized NPV
amount will be populated on
the upper form.

The NPV amount for each
payment setup will be
calculated using the
discount rate present on
Upper Form Detail Form upper form.

The calculated amount will
then be populated into the
NPV present on each
payment setup respectively.
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The NPV amount for each
payment setup will be
calculated using the
discount rate present on the
upper form and the
summarized amount will be
populated on the upper
form.

Upper Form Upper Form

The NPV amount for each
payment setup will be
calculated using the
discount rate present on the
each setup.

If the rate is not present on
the payment setup, the
system will use the rate
present on the upper form.

The summarized amount
will then be populated on
the upper form.

Upper Form, Detail Form Upper Form

The NPV amount for each
payment setup will be
calculated using the
discount rate present on the
payment setup.

If the rate is not present on
Upper Form, Detail Form Detail Form the payment setup, the
system will use the rate
present on the upper form.

Calculated NPV amount for
each payment setup will be
populated in the respective
form.

The NPV amount for each
payment setup will be
calculated individually using
the discount rate present on
the payment setup.

The NPV for each payment
setup will be populated in
the respective form. Also,
the summarized amount will
populated in the upper form.

Detail Form Upper Form, Detail Form

The NPV amount for each

Upper Form Upper Form, Detail Form .
PP PP payment setup will be
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calculated using the
discount rate present on the
upper form.

The NPV for each payment
setup will be populated in
the respective form.

Also, the summarized
amount will populated in the
upper form.

If you have added the following data elements, then you will be able to calculate the Net Present
Value (NPV):

» Annual discount rate

» NPV Amount

» Include in Net Present Value

The NPV calculation will be triggered after the following events:
» Finish editing
» Index rate change (at the end of the day)
» Index rate change through user interface (UI) or Integration.
» Reverse Auto-population of the base lease record.

After you finish editing, the system refreshes values in the Regular Line Schedule and Straight
Line Schedules.

For a Workflow BP, the system calculates the NPV value when Payment Schedule is refreshed.
This feature applies to the Line Item updates, as well.

The system checks changes in the following values, daily:

» Index rate
» Payment schedules
» Discount rate

If there are any changes in the values of the fields above, then the system triggers NPV
recalculation based on the updated values.

Reservation Business Process

Some objects in the system can be reserved for use. For example, you could reserve a piece of
equipment that needs to be used at a project site for three weeks.

You can reserve the following objects:

Assets
Document Manager records
Configurable manager objects

The object of a line item or simple type business processes (both workflow and
non-workflow)

4
»
»
»
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When these objects (assets, shells, spaces, and so on) are designed, they can be "calendar
enabled,” which means that the business process form for these objects will show a calendar
option, and the object will be available for reservation.

In conjunction with these calendar-enabled objects, the system provides a reservation type
business process which you can use to reserve these objects. A reservation BP is considered a
type of cost BP in that it integrates with the Cost Manager to use cost codes at the company and
project/shell level.

There are two ways to make a reservation:

1) Using a reservation business process

By using a reservation business process (that has been designed and configured for your
use), you can specify the date and time of the reservation. Depending on its design, this
business process can also:

» Display availability and identify scheduling conflicts
» Denote the reservation as "tentative" or "confirmed"
» Gather cost information

» Specify additional details, such as the number of attendees, A/V requirements, food
catering, and so on

» Show the reservation as a recurring event.
» Trigger another business process, such as a work order.
2) Using a quick calendar

By using the quick calendar option that is available on any business process (that was
designed to be calendar-enabled), you can open the calendar and enter the parameters for
your reservation.

Using a Reservation Business Process

The reservation business process is similar to any other business process. You need to fill in the
upper form fields as necessary, and add line items for detail information about the reservation.

The upper form of the reservation business process should include From Date and To Date
fields which you need to complete, and should also include one or more data pickers, where you
choose the object or objects that you want to reserve. In the example above, the room and
projector fields are the data pickers from which you can select multiple objects to reserve for this
event.

The reservation business process can be designed to include additional information about this
reservation, such as food catering for the event.

The reservation business process has two special features:

» Schedules

» Enables you to open the Schedules window and view the reservation schedule for the
objects you are reserving with this reservation BP.

» Is useful for comparing the availability of multiple objects being booked for the same
event, and to resolve conflicts or identify openings in the schedule.

» Recurrence
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» Enables you to specify how often this reservation should be created. When you use this
options, the system continues to automatically reserve the object according to the
specifications you select with this feature.

The following describes the reservation business process log (Standard View):

From your project, go to your reservation BP and click to open the reservation BP log. On the left
pane, a set of toolbar options and a list of records, if available, are displayed. On the right pane,
the following tabs explain more information about each item on the list:

» Record Details tab

» Workflow Progress tab

» Attachments tab

The following explains the toolbar options of the reservation BP log:

Create Enables you to create a new reservation
BP. From the Requester Information
block, you can click the Space data picker
field to open the Usable Space
Reservation window which contains a
calendar that enables you to determine the
duration of the reservation.

Actions Enables you to conduct the following on a
selected record, or multiple records:

Import

Export CSV Template

Export Microsoft Excel Template
Create From Template

Bulk Edit

Print

Transfer Ownership

Terminate Record

v vV vV vV vV vV v Vv

View The View data picker enables you to
arrange the list of records listed, as
follows:

» Records Created by Me

» Records Received by Me

» Records Created and Received by
Me

» Records from My Company

In addition, the View data picker enables
you to:

» Create New View
» Manage Views
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Edit View To edit, or customize, the view of the log.

Refresh To refresh the data displayed on the log.

Print To print a record.

Search To search for a record.

Find on Page To find a record based on a column
heading.

Help To access documentation.

The following explains the columns on the reservation BP log:

Record Duration Status (Calendar icon)
Attachments (Paper clip icon)
Record Number

Reservation name

Space

From Date

To Date

Amount

Status

Creation Date

Creator

VvV VvV vV vV vV vV vV vV v v Vv

For each item on the list, the gear menu enables you to perform the following:

Open

Copy with Attachments
Copy without Attachments
Print

Transfer Ownership
Terminate Record

v v v v v Vv

Using the Schedules Feature
The Schedules feature is most useful for resolving scheduling conflicts.

When you open a reservation BP record, the BP record page that opens contains the following
menu options (on the upper-right corner):

Send Enables you to send the BP to the next
step.

Save Enables you to save any changes that you
have made.
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Menu Options drop-down (the three
horizontal line icon)

Enables you to complete, set up, or access
any of the following operations:
Cancel Reservation
Export Line Item Template
Print
» HTML
» PDF
» Custom
Recurrence
Reload
Review
» Review
» AutoVue Review
» Schedules (See below for more
details)
Transfer Ownerships
Undo Accept Task
Help

4
>
>
» Close

When you open a reservation BP record, the BP record page that opens contains the following

tabs:

» <BP name> Reservation Details tab
This tab enables you to see the details of the BP and access the following tabs for the record

that you had selected:
» Attachments
» Comments
» Linked Records
» Lined Mail
»  Workflow Progress
» Audit Log
» Reference Records
» Reservation Charges tab

This tab enables you to view and work with all the charges related to your selected record.

When open a record and click Schedules (the Menu Options drop-down (the three horizontal line

icon) > Schedules), a new window opens which contains the following tabs:

» Schedule

This tab enables you to set the schedule for the reservation. You can see and set the

reservation period and see any conflicts.

» Recurrence
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This tab enables you to set the frequency and range of the reservation. For more information,
see Making a Recurring Reservation.

Making a Recurring Reservation

The reservation business process includes a "recurrence” feature, where you can specify how
often this reservation should be created. The system will continue to automatically reserve the
object according to the specifications you select with this feature.

To make a recurring reservation (Standard View)

When open a record and click Schedules (the Menu Options drop-down (the three horizontal line
icon) > Schedules), a new window opens which contains the following tabs:

» Schedule
This tab enables you to set the schedule for the reservation. You can see and set the
reservation period and see any conflicts.

» Recurrence
This tab enables you to set the frequency and range of the reservation.
Recurrence Daily
In the Recurrence tab, when the "Recurrence On" check box is selected, the Frequency and
Range of Recurrence sections will be displayed.
In case the check box is deselected, the two sections are not displayed.
In case of an existing recurrence, if the check box is deselected, all recurrences will be
removed when you click Save. The interaction is the same as that occurs on clicking
'Remove Recurrence' button in existing screen.
Recurrence Weekly
In case of an existing recurrence, if the check box is deselected, and then it is checked again
(without clicking Save), the values present for the frequency and range of recurrence
sections will remain the same, as before.

Auto-Creating Another Business Process From the Reservation

If the reservation business process is designed to do so, it can automatically create one or more
new business processes. For example, for a room reservation, the Reservation business
process could auto-create a work order for catering two days before the event, and auto-create
an "action item" follow-up business process that would go to all attendees eight hours after the
event. In order to trigger the auto-creation, the form (either the upper form, or a line item form)
will contain fields you must fill in.

If a reservation business process is designed to auto-create another business process, the fields
you need to fill in are as follows:

In this field: Do this:
Specify whether the system should
Before/After auto-create the business process Before

or After the reservation event.

Specify the number of days before/after

Time (Days
(Days) the event this business process should be
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created. For example, the Work Order in
the illustration should be created 2 days
after the event.

Specify the number of hours before/after
the event this business process should be
Time (Hrs) created. For example, the Work Order in
the illustration should be created 8 hours
after the event.

Specify the number of minutes before/after
the event this business process should be
Time (Min) created. For example, the Work Order in
the illustration should be created 30
minutes after the event.

This is a read-only field. Initially, it will
display the date of the reservation. When
you fill in the Time fields, the system will
recalculate the trigger date according to
the values you entered and display it in
this field.

Trigger Date

Auto-creation and recurring reservations: For auto-creation on a recurring reservation, the
system re-evaluates the trigger date for each recurrence. The Reservation business process will
show a hyperlink to only the last record created; however, you can see all the records created by
opening the View References window. You cannot manually auto-create a business process for
a recurring reservation.

How the Data Pickers Work on a Reservation Business Process

The data pickers designed for Reservation business processes differ from most other data
pickers in that they are very interactive: You can check availability and change reservation dates
and times from the picker itself.
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Note: This works best if you are reserving a single object, such as a
room. If you are reserving multiple objects for the event, any time you
change the date or timeframe for any one of the objects, the system will
reflect that change for all the objects, and you are likely to encounter
scheduling conflicts this way. To change the dates or time frames of
multiple objects on a reservation, use the Schedules feature.

The data pickers for reservable objects show the object in a schedule-like window:

To select areservable object from the picker

Double-click the object you would like to reserve on the leftmost column.

To change areservation time on the picker

At the top of the data picker window, the Reservation From and To fields show the timeframe
you specified in the From Date and To Date fields on the Reservation form. This timeframe is
also denoted by the green and red lines on the schedule. If the object shows a reservation
conflict at that time, you can change the timeframe on the picker before you select the object.

To change the timeframe, drag the green and red lines to the timeframe you want. The system
will change the Reservation From/To fields at the bottom of the window to reflect your change.
When you click the Open button to select the object to reserve, the system will update the
Reservation record with the new time.
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Using Quick Calendar Entry on a Business Process

The Quick Calendar is available on any business process that was designed to include the
calendar feature (calendar-enabled). From the business process record, you can open the
calendar and enter a reservation.

Any entry you make on the calendar will update the record.

Note: The calendar does not show draft or terminated records.

To make a reservation using a Quick Calendar Entry
1) From the log, open the business process record.
2) On the toolbar, click the Calendar button. The Calendar window opens.

By default, the calendar opens in the "Month" view. You can change this to a day or week
view if you want using the tabs at the top of the calendar. If there are more reservations than
are visible on any day, click the down arrow at the bottom of the day cell to see the rest of
the reservations.

The calendar shows confirmed and tentative reservations in color. The current day is
highlighted blue.

3) Click the day you want to make the reservation for. If you are using the Day view of the
calendar, click the beginning hour for the reservation.

The system displays a reservation window.
4) Fill in the Name, From, and To fields.
5) Inthe Status field, specify whether this reservation is tentative or confirmed.
6) Click Create Event.

The system adds the reservation to the calendar.

To view all reserved objects in a log

If you want to see all the reserved objects in a log, click the Calendar button above the log. The
system displays a calendar showing all the reserved objects from that log. The Calendar button
will not appear above the log unless there are calendar-enabled objects in the log.

To view and edit a reservation
1) Open the record of the business process that is reservable and click the Calendar button.
2) On the calendar, click the reservation bar. The system displays a summary details window.

3) To see or edit reservation details, click the details link. The system displays the reservation
window.

4) Edit the details, if necessary, and click Update Event.
5) To delete the reservation, click the delete link.

To print a calendar

1) Open the record of the business process that is reservable and click the Calendar button.

2) On the calendar, click the printer icon in the upper-left corner. The system opens the
Calendar Print Preview window.
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3) Click the Print button. The system displays the Print window, where you can choose the
printer and other options.

4) Click the Print button.

Canceling a Reservation

To cancel areservation

1) Open the reservation business process you want to cancel.

2) From the drop-down menu ( =) choose Cancel Reservation. The system displays a
Cancel Reservation window.

On this window, the system tells you exactly what will be removed from the calendars, and
provides an area for notes on the cancelation. It shows:

» Any business processes this reservation auto-creates. These will also be canceled.

» All the objects associated with this reservation that will be canceled. In the example
above, the room is being canceled as well as the projector that was reserved for the
room.

» Additional details about the reserved object being canceled. You can access these by
clicking the hyperlinked ID next to the name of the reserved object.

3) Inthe Cancelation Notes area, enter any applicable notes.
4) Click Done.
Entering Values in Fields

This topic provides information about entering data in fields.

Field Entering Data

Date Picker When entering a date in the Date or Date
Only pickers, the "Today" and "Now"
options are not available.

Date Only Picker When entering a date in the Date or Date
Only pickers, the "Today" and "Now"
options are not available.

Drop-down (Pull Down) The quick search does not have a search
bar, and by default, the cursor is placed at
the end of 'Search.' The label must be
cleared before entering value.
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Interface

The Primavera Unifier has been undergoing significant changes in the overall user interaction in
the Business Process forms, various Logs, Cost Sheet, and so on. These changes were focused
on the user interface (Ul) and few structural changes related to the user interaction. These
changes have been rolled-out in early 2018, in phases. In November of 2019, the Classic View
of the business process forms, managers attributes, and shell dashboards have been replaced
with the Standard View (the new view). There are also other functional improvements as a result
of the Ul improvements such as type-ahead, auto-fill in pickers, tool-tips, and so on. Those
improvements have been covered in pertinent user documents.

Note: The images marked "New View" does not show the latest Ul, but it
does show the latest UX as of this publication.

The redesigned business process user interface allows you to:
View, edit, and manage all relevant details within a single form.

Access record details with limited pop-up and clicks.

See only relevant, context-sensitive menu, and toolbar functions.

Use the enhanced form layout to navigate, expand, and collapse field blocks.
Create, enter, and update record data and line items in one place.

Navigate easily between tabs to complete the main and line item forms.

Add and view attachments in one place.

Route workflows with minimized alerts and errors.

Use enhanced field interaction in text boxes, pickers and data pickers.

v vV v vV VvV vV v Vv

Note: This updated version does not impact the fundamental ways in
which a business process, manager attributes, or shell dashboards are
created in the new User Interface.

The following describes the business process types that are not supported in the new User
Interface and will continue to be shown in Classic View:

» Resource > Resource Booking

» Resource > Time Sheet

» Schedule Manager > Custom Calendars

» Schedule Manager > Schedule Sheets

The following describes the business process types and sub-types that support the new Ul:

» Cost
» Line Items with CBS codes
» Line Items with Fund codes
» Line Items with CBS and Fund codes
» Commit at Company Level
» Line Items with Company Accounts Code
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» Line Items with Multiple Codes
» Document
» With Folder Structure
» Without Folder Structure
» Line Item
» Line Item (Generic)
» Line item to filter Company Business Process Records
» Preventive Maintenance
Simple
RFB
» Generic
» Line Items with CBS Codes
» Line Items with Generic Cost manager
» Project/Shell Creation
» Project/Shell Creation - Simple
» Project/Shell Creation - Line Item
> Text

In This Section

Classic View User Interface Features Not Supported in Standard View................. 376
Classic View and Standard View Labels..........coouiiiiiiiii e, 378
Classic View and Standard View Tabs, Menus, and ACtiONS...........cocoevvveiveeeinnnnns 384
Classic View and Standard VIieW FUNCHONS .......c.viviiiiiiiiee e 386

Classic View User Interface Features Not Supported in Standard View

The following features will not be supported in the Standard View of the business processes
forms:

» Adding or Viewing of Task Notes
» View Received Task option

» Uploading images from the toolbar

» Summary Items in business processes that support Summary line items
» Spell-check feature in business process

The following explains each feature in detail:

376



Working with Business Processes

Adding or Viewing of Task Notes

In the Classic View, notes that are specific to a task can be added to a BP form. They are
temporary notes that can be used as comments for, or specific instructions to, the next user in
the workflow. Task notes are not forwarded throughout the workflow and are not archived. You
can think of them as sticky notes that stay with the form for one step in the workflow only. A task
note only applies to the current task.

View Received Task option

In the Classic View, after a Task assignee accepts a Task, the form seen is based on the Action
Form associated with the current step of the workflow. In the event that an assignee wants to
see the received task, then the assignee can click the View menu option and select the
"Received..." option.

Uploading images from the toolbar

In the Classic View, if there are multiple image-picker fields in the form, then the Upload Images
option in the toolbar can be used to upload images in bulk.
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Summary Items in business processes that support Summary line items

In the Classic View, the Summary Items window enables you to group regular line items
together, with the summary only appearing on the BP. The sub-line items are rolled up to other
areas, such as the Cost Manager.

Spell-check feature in business process

In the Classic View, the spell-check feature is available for all BP forms, including the Cost,
Document, Text, Simple, and Line Item BPs. You can spell-check information that you have
entered in the text fields and any other text areas.

Classic View and Standard View Labels

The following provides a comparison between the labels of the Classic and Standard View. The
left picture shows the label in the Classic View, and the right picture shows the label in the
Standard View.
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In a non-workflow business process, the Finish Editing label has changed to Submit label, as
shown below. When you click Submit, you submit the form changes.

In a workflow business process view form, The Add Assignee to Current Step... label has
changed to Add more assignees..., as shown below:
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In a workflow business process view form, the Copy Users to Current Step... label has
changed to CC more users..., as shown below:

In a workflow business process view form, the Send uMail... label has changed to Email as
Attachment, as shown below:
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In a workflow business process view form, the Terminate label has changed to Terminate
Record, as shown below:
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In both the workflow and non-workflow business process forms, where the business process is
enabled for Geo-Coding, the View Map label has changed to View Record Location, as
shown below:

In both the workflow and non-workflow business process forms, the Print Preview label has
changed to Print, as shown below:
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In both the workflow and non-workflow business process forms, the Attachment source Unifier
Folder label has changed to Document Manager, as shown below:

In both the workflow and non-workflow business process forms, the General Comments label
has changed to Comments, as shown below:

In the Mailbox, when mails are linked to business process records, the Show List label has
changed to business process records, as shown below:
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Classic View and Standard View Tabs, Menus, and Actions

In the Standard View of both workflow and non-workflow business processes, the right pane
displays tabs that contain additional attributes of the business process record such as
Attachments, Comments, Lined Records, Linked Mail, Reference Records, Workflow
Progress, and Audit Log, in the Standard View, as shown below:

All non-primary actions such as printing record content, reviewing upper form and line item
attachments at the record level, and setting up schedule for auto-creation are part of the Menu

option (three horizontal line icon) =, in the Standard View, as shown below:
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In the Standard View, if the signed-in user does not have permission to view certain content of
the record, the right pane does not display the corresponding tab. As an example, the following
shows the Standard View when the signed-in user does not have View permission for Audit

Log:

In the Standard View, if the signed-in user does not have permission to perform certain actions
such as Terminate Record, then the user would not see that action option under the Menu

option (three horizontal line icon) =, in the Standard View, as shown below:
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Classic View and Standard View Functions

Note: If a Workflow Business Process was created in the Classic View
and remained as draft, when you open the draft from Standard View, the
draft will open in the Classic View. After you submit the draft, the
submitted record opens in Standard View.

In a workflow business process, at any given step of a business process record, only those
options (both tabs and menu) that are applicable to the given step will be displayed. For
example, in the Classic View the Reference Records and Audit Log options were seen in the
creation stage (although not applicable to the creation step). In the Standard View, these options
are not displayed, as shown below:

In the Standard View of both the workflow and non-workflow business processes, when you add
a comment, by default the check box of Hide is selected, as shown below. This means that a
comment is hidden by default and if you want your comment to be viewed by everyone, then you
must deselect this option.

In the Standard View, when you add Linked Records to a workflow or non-workflow business
process record, the list of the business processes displayed will be based on your (the user's)
node access (items on left Navigation screen). For example, if you do not have access (for
example, view permission) to a certain node (sub-node) under the Logs, then that node (in this
case a BP record) will not appear under the Logs. As a result, you cannot add the BP record as
a linked record because you do not have permission.
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In the Standard View, the workflow details are displayed after you click Send. When the
workflow details are displayed, the data validations, filtering of assignees (if applicable), and so
forth, have already been completed.

In the Standard View, the line item forms are no longer displayed as pop-ups. Instead, the line
item detail form (Line Items Details) opens on the right-side of the line item list, as shown

below:

In the Standard View, for auto-created records (Auto Create BP) that are in Initiation Step, but
the job is not yet complete, the accept and decline actions will not be displayed.

In the Standard View, you cannot transfer ownership if the selected user is the record owner.
In the Standard View, the form design is retained without any exceptions.

In the Classic View of Change Commit BP, if the Reference Commit field is marked as
read-only, in the design (uDesigner), then in the Standard View the Reference Commit field will
be rendered as a read-only data element.
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Note: Prior to this improvement, in the Classic View, this data element
had an exception, wherein even if the field was marked as read-only, at
runtime, the field would have been enabled.

In the Standard View, if a Date Picker field has been added to the Line Item List, then the value
displayed will include both the Date and the Time.

Note: In the Classic View, the value displayed only included the Date
and not the Time.

In the Standard View, you can change the BP picker field value (referenced by a Line ltem
Picker field) in a line item. The BP picker field value cannot be changed if the Line Item Picker
field has a line item reference in the field.

Note: In the Classic View, you could not change the BP picker field
value even if the Line Item Picker field in the line item did not have a
value.

In the Standard View, the Date Picker controls will not have the Time Zone information, as
shown below:
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In the Standard View, you cannot delete multiple draft comments (from the Comments tab), as
shown below:

In the Standard View, the Document Review option is present at the time of creating the record,
unlike Classic View where the option is seen only after creating the record, as shown below:

In the Standard View, the document management picker (displayed when adding attachments
from Unifier Document Manager) does not show phase selection, as shown below:
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In the Standard View, for the Text-type business process, the way the comments are added and
displayed has changed, as shown below:

Standard View, for the Text-type business process, you can view previous comments in the
Response tab, as shown below:

In the Standard View, for the Document-type business process, the steps to create folders and
line items have changed, as shown below:
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In the Standard View, for the Document-type business process, the steps to add an attachment
to a line item has changed. In the Line Item tab, there will be an Attachments tab, similar to the

attachments tab on the main business process form.
In the Standard View, in the Linked Mail tab, the Add drop-down list includes the options:

» Mailbox: To attach existing Mailbox mails as well as Project Mailbox inbound emails
» New Mail: To compose a new email

See below for details:

In the Standard View, in the Linked Mail tab of the RFB-type (Request for Bid) business
process, you can send emails to Unifier users and bid invitees in the Proposal Management
tab. The right pane has the Mail tab, which is used to send mail to users. The option to send
mail to bid invitees is located in the Gear menu.

Note: In the Classic view, you used the New menu option to send emails
to users and bid invitees.

In the Standard View, for the RFB-type business process, when sending email to invitees, you
can click the To hyperlink to access the list of all available invitees.
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Note: In the Classic View, you clicked the To option to access the list of
all available invitees.

In the Standard View, for the RFB-type business process, after a bid is closed, the show bid
screen (Preview) has been enhanced.

In the Standard View of both the workflow and non-workflow business processes, the graphical
diagram and the list view (while viewing of reference records in the Reference Records tab)
have been enhanced, as shown:

In the Standard View, the Line Item Consolidation window has been enhanced.
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